General safety advice for users

1 General

This manual is intended for personnel technically qualified to install, operate and maintain the
products which are described herein. It contains all the necessary information for correct use of
the products. However, for advanced use of our products please contact your nearest sales office
for additional information.

The contents of this manual are not contractual and cannot under any circumstance
extend or restrict contract warranty clauses.

2 Qualification of personnel

Only qualified personnel are authorized to install, operate or maintain the products. Any work
performed by a unqualified person or non-observance of the safety instructions in this document
or attached to the equipment may risk the safety of personnel and/or cause irreparable damage
to equipment. The following personnel may be regarded as being "Qualified"

 those involved with application design. Design office personnel familiar with control system
safety concepts (for example, design engineers, etc),

 those involved with equipment installation. Individuals who are familiar with the installation,
connection and startup of control system equipment (for example installers or wiring technicians
working during the installation phase, technicians setting up the equipment, etc),

» those involved with operation. Personnel trained to operate and manage control system
equipment (for example, operators, etc),

» those performing preventive or corrective maintenance. Personnel who are trained and
experienced inthe adjustmentand repair of control system equipment (for example, installation
engineers, after sales service engineers, etc).

3 Warnings

Warnings serve to prevent specific risks encountered by personnel and/or equipment. They are
indicated in the documentation and on the products by different warning symbols, according to
the severity of the risk :

Danger or Caution or Attention
Indicates that not following instructions or ignoring the warning may cause
serious personal injury, death and/or serious damage to equipment.

Warning or Important or A
Indicates that not following a specific instruction may lead to minor injury and/or
damage to equipment.

Note or Comment
Highlights important information relating to the product, its operation or its
accompanying documentation.
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4 Conformity of use

The products described in this manual conform to the European Directives (*) to which they
are subject (CE marking). However, they can only be used correctly in the context of the
applications for which they are intended (described in the various documents) and when
connected to approved third party products.

As a general rule, if all handling, transport and storage specifications are observed, and all
instructions for installation, operation and maintenance are followed, the products will be used
correctly, with no danger to personnel or equipment.

(*) DEMC and DLV Directives, concerning Electromagnetic Compatibility and Low Voltage.

5 Installing and setting up equipment

It is important to observe the following rules when installing and starting up equipment. In
addition, if the installation includes digital links, itis essential to follow the basic wiring rules given
in the user's guide, reference TSX DG GND, and manual TSX DR NET, part C.

« safety instructions must be followed meticulously. These instructions are in the documentation
or on the equipment being installed and set up.
 the type of equipment defines the way in which it should be installed :

- a flush-mountable device (for example, a process control terminal or a cell controller) must
be flush-mounted,

- adevice which is to be built in (for example, PLC) must be placed in a cabinet or enclosure,

- the casing of alaptop or portable device (for example, a programming terminal or a notebook)
must remain closed,

« ifthe device is permanently connected, its electrical installation mustinclude a device to isolate
it from the power supply and a circuit-breaker to protect it against overcurrents and isolation
faults. If this is not the case, the power socket must be grounded and be easily accessed. In
all cases, the device must be connected to the protective mechanical ground PG using
green/yellow wires (NFC 15 100) .

* low voltage circuits (even though they are low voltage) must be connected to the protective
ground so that dangerous voltages can be detected.

« before a device is powered up, its nominal voltage must be checked to ensure that it has been
adjusted to conform with the supply voltage.

« if the device is supplied with 24 or 48 VDC, the low voltage circuits must be protected. Only
use power supplies which conform to the standards currently in force.

« check that the supply voltages remain within the tolerance ranges defined in the technical
characteristics of the devices.

< all measures must be taken to ensure that any power return (immediate, warm or cold) does
not lead to a dangerous state which may risk personnel or the installation.

e emergency stop devices must remain effective in all the device's operating modes, even those
which are abnormal (for example, when a wire becomes disconnected). Resetting these
devices must not cause uncontrolled or improper restarts.

« cables which carry signals must be located where they do not cause interference with the
control system functions by capacitive, inductive or electromagnetic interference.

e control system equipment and their control devices must be installed in such a way as to
ensure that they are protected against unintentional operation.

« appropriate safety measures must be taken for the inputs and outputs, to prevent improper
states in the control system device, if no signal is received.
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6 Equipment operation
The operational safety and availability of a device is its ability to avoid the appearance of faults
and to minimize their effects if they occur.

A system is said to be fail-safe if the appearance of faults never causes a dangerous situation.
A fault inside the control system is known as :

e passive, if it results in an open output circuit (no command is sent to the actuators).
e active, if it results in a closed output circuit (an command is sent to the actuators).

From the safety point of view, a given fault is dangerous or not depending on the type of command
given during normal operation. A passive fault is dangerous if the normal command is the
operation of an alarm. An active fault is dangerous if it maintains or activates an undesirable
command.

It is important to note the basic difference between the behavior of an electromechanical relay
and an electronic component (for example a transistor) :

« there is a high probability, approximately 90%, that the failure of a relay will cause an open
circuit (control circuit powered off).

« there is a 50% probability that the failure of a transistor will cause either an open circuit or a
closed circuit.

This is why it is important to correctly estimate the types and consequences of faults when
automating a system using electronic products such as PLCs, including when relay output
modules are used on PLCs.

The system designer must use devices external to the PLC  to protect against active faults
inside the PLC, which are not indicated and are judged to be dangerous to the application. This
may require solutions from various different technologies such as mechanical, electromechanical,
pneumatic or hydraulic devices (for example, directly wiring a limit switch and emergency stop
switches to the coil of a movement control contactor).

To protect against dangerous faults which may occur on output circuits or preactuators, it is
sometimes beneficial to resort to general principles and use the large processing capacity of
PLCs, for example by using "inputs to check the correct execution of commands requested by
the program".

7 Electrical and thermal characteristics
Details of the electrical and thermal characteristics of devices are given in the associated
technical documents (installation manuals, service instructions).
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8 Environmental conditions

Devices, such as TSX Nano PLCs, meet "TC" treatment (1) requirements. For installations in
industrial production workshops or in environments which correspond to "TH" treatment (2), these
devices should be installed in enclosures with minimum IP54 protection, stipulated by standards
IEC 664 and NF C 20 040.

TSX Nano PLCs, which themselves have P20 protection, can therefore be installed without
enclosures in restricted-access locations which do not exceed pollution level 2 (control room with
no machines or dust-producing activities).

(1) "TC" treatment : all climate treatment.
(2) "TH" treatment : treatment for hot and humid environments.

9 Preventive or corrective maintenance

Availability

The availability of a system is its ability, in terms of its combined reliability, maintainability and
maintenance logistics, to be in a state to perform a required function, at a given moment and
within a defined time period.

Availability is therefore specific to each application, since it is a combination of :

 the architecture of the automatic system,

« the reliability and maintainability : intrinsic characteristics of the equipment (PLCs, sensors,
machine, etc),

¢ maintenance logistics : characteristic intrinsic to the user of the control system (software
structure, fault indication, process, on-site replacement parts, training of personnel).

Troubleshooting procedure

« control system equipment should only be repaired by qualified personnel (after sales service
engineer, or technician approved by AEG Schneider Automation). Only certified replacement
parts or components should be used.

« hefore performing any operation on equipment (for example opening an enclosure), always cut
the power supply off (disconnect the power plug or open the power isolation switch).

« before performing any "mechanical” operation on equipment on site, cut the power supply off
and mechanically lock any moving parts.

« before performing an operation on the PLC, modifying a connection, etc, check in the manual
whether this should be done with the power off or if it is possible while the device is powered
up. Meticulously follow the instructions given in the manual.

« on positive logic outputs or negative logic inputs, take all necessary precautions to prevent a
disconnected wire from coming into contact with the mechanical ground (risk of undesirable
command).
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1 Introduction

1.1 The PLC inthe control system structure

A PLC can be divided into four main sections :

e Inputs

e Outputs

« The memory, where the user program instructions and data are stored

* The processor, which reads the input data and controls the outputs according to the
user program instructions.

The programming terminal is the tool used to :

» Create and transfer the user program to program memory
e Debug the user program and control system start-up

« Perform installation diagnostics.

Programming terminal

FTX 417/FT ZOOOA FTX 117
| |

limit | — A
P
switch mrgr%r:rr; _| contactor #
| j [ 0 .
u - solenoid
N Processor T = valve
- P b |
proximity |
sensor ér_l [ $ U [L
S T — indicator
S — lamp
push ~ | L analog
button E j L L1 | actuator k=

PLC
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1.2 Discrete I/O TSX Nano PLCs

1.2-1 Presentation
Discrete I/O TSX Nano PLCs are available in four configurations depending on whether
extendability is required :

"base PLC" non-extendable PLCs (14 and 20 I/O).

"base PLC" non-extendable PLCs with 1 integrated analog input (10, 16 and 24 1/O).
"I/0 extensions" (16 and 24 1/0O).

"base PLC or I/O extension" extendable PLCs (10, 16 and 24 1/O).

10 1/O (6 inputs + 4 outputs)

14 1/0O (8 inputs + 6 outputs)
16 1/O (9 inputs + 7 outputs)

16 1/0 (9inputs + 7 outputs) PLCwith 115 VAC inputs
20 1/0 (12 inputs + 8 outputs)
24 1/0 (14 inputs + 10 outputs)
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A "base PLC" extendable PLC can be extended by an 1/0 extension or by an
extendable PLC configured as an I/O extension

In addition, a maximum of three peer PLCs (extendable PLCs configured as peer PLCs)
can be connected to the "base PLC" extendable PLC, communicating via exchange
words.

Base PLC /0 extension Peer PLC2 Peer PLC3 Peer PLC4
”HHHHHHHH} ”HHHHHH} ”HHHHHH\HHH“
[—Y I:JlF‘ [ 1§ (Y
[ARRNRRRRRRRRRARN) ) [ARRENRRANRRARRRRRAR] o T
N N N

650 feet maximum (1)

Discrete /0 TSX Nano PLCs are programmed in PL7 language (Ladder or Instruction
List languages).

These PLCs are programmed via :

e either an FTX 117 terminal (Instruction List)
e or an FTX 417 or PC compatible terminal (Ladder or Instruction List).

(1) See Part A, Section 3.5 for the type of cable to use

1/3
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Description of discrete 1/0 TSX Nano
8 9 5 10

N AW

e

7 6 11 12
1 Hinged cover for access to items 2, 3, and 4. All PLCs
Port for connecting an ASCII or UNI-TELWAY device. B, B/E
ASCII, RS485 UNI-TELWAY Master or slave protocols.
3 Selector switch for PLC function code : B/E
0 =base PLC, 1 = 1/O extension.
5 =Peer PLC no. 2, 6 = Peer PLC no. 3,
7 = Peer PLC no. 4.
4 Potentionmeter : B, B/E
¢ 1 on PLCs with 10, 14 or 20 I/O,
* 2 on PLCs with 16 or 24 1/O,
5 Input status display (1), All PLCs
6 Output status display (1),
7 PLC status display : RUN, ERR, COM, I/O,
8 Power supply connections,
9 Sensor supply on models with 100/240 VAC :
24VDC/150 mA supply.
This supply is not available on the model with 115VAC inputs.
10 Input connections.
11 Output connections.
12 Extension connector 1/0 Extension E, B/E
Peer PLC B/E
Modbus Slave (V3) B/E
Analog input channel see 1.11
13 Removable cover for protecting the terminals. All PLCs

(1) A maximum of 16 internal bits can be displayed (%S69=1).
B : Non-extendable PLCs, E : I/O extension, B/E : Extendable PLCs.
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1.2-2 Summary of catalog references (Discrete 1/0)

No. PLC Power Type of inputs Type of outputs References
/0  type supply isolated transistor 24V —  relay
110/240V 24V 24V 115V sink source 24V —
~ - = ~ 24[240V~.

BIE © ® ® TSX07(x)01028
BIE ©® i i TSX 07 (x)01008
6/4 BIE b i ° TSX07 (x)0 1002
B/E e o ° TSX07(x)01022
B/E o o . TSX07(x)01012
BE © i b TSX 07 32 1028
8/6 B d d ° TSX 07 3L 1428
BIE © . . TSX07(x)11628
BIE © * * TSX07(x)11648
9/7 BIE ©® d d TSX07(x)11608
B/E LA . TSX07(x)11602
B/E o o . TSX07(x)11622
B/E e o . TSX07(x)11612
E d d ° TSX 07 EX 1628
E b i b TSX 07 EX 1612
BIE © d hd TSX 07 33 1628
12/8 B i i i TSX 07 3L 2028
BIE © * * TSX 07 (x)12428
BIE © ° . TSX 07 (x)12408
B/E e o e TSX07 (x)12402
14/10 B/E e o * TSX07 (x)12422
B/E e o . TSX07(x)12412
E d d ° TSX 07 EX 2428
E b i b TSX 07 EX 2412
BIE © d hd TSX 07 33 2428

B : Non-extendable PLC, E : I/O extension, B/E : Extendable PLC.
(x) 2 : V2 models; 3 : V3 models

Note :

TSX 07 33« «se« models have additional software functions to those offered by the TSX 23s eses
models, such as Uni-Telway Master/Slave on the terminal port, Modbus slave PLC on the
extension port, connection of analog I/O modules, etc.

1/5
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1.2-3 Main functions of TSX Nano PLCs

By default, all I/O are configured as discrete I/O. However, certain I/0O can be assigned
to specific tasks during configuration (RUN/STOP input, latching inputs, 10 kHz fast
counting 1/0 or 1kHz up/down counting, PLC status (SECURITY) output, pulse train
output, pulse width modulation output).

TSX Nano PLCs are programmed in reversible PL7 language (Instruction List or
Ladder) which enables the following functions to be used : schedule blocks (RTC),
timers, up/down counters, LIFO/FIFO registers, shift registers, drum controllers, step
counters.

Scanning Normal (cyclical) or periodic (2 to 150 ms)
Scan time Less than 1 ms for 1000 elementary instructions (3)
Less than 0.6 ms for 100 elementary instructions
Execution time 0.2 ps to 2 ps for a single Boolean elementary instruction
Memory capacity Data 256 internal words, 64 constant words, 128 internal

bits (64 of these retentive)
Program -1000instructions (battery-backed RAM and EEPROM)

Backup PLC RAM : by battery. Backup duration : 30 days
Language Reversible PL7 : Instruction List or Ladder
Terminal port RS 485 link, UNI-TE protocol, 9600 bits/s / 19200 bits/s.

Max. distance : FTX 117 : 10 m; UNI-TE : 50 m

I/O extension 1 per PLC.
Max. distance between base PLC and extension : 200 meters
(650 feet) (1)

Peer PLCs 3, connected to the "base PLC" extendable PLC, and communi-
cating via exchange words. Maximum distance between base
PLC and last peer PLC : 200 meters (650 feet) (1)

Modbus link Non-isolated RS485 type, length limited to 200 m. ASCIl or RTU mode
Function blocks Schedule blocks (RTC) 16 (2)
Timers 32 time base : 1ms (for the first

two), 10ms, 100ms, 1s, 1min
with a preset range from 0 to

9999
Up/down counters 16 preset range from 0 to 9999
LIFO/FIFO registers 4 16-word blocks
Shift registers 8 16 bits

(1) See Part A, Section 3.5 for the type of cable to use

(2) Available on all "base PLC" PLCs with 16 and 24 1/O : TSX 07 «» 16/24

To improve performance, it is advisable to deconfigure the unused extensions (see Section A-
1.6).
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Function blocks Drum controllers 4 8 steps, 16 control bits

(continued) Step counters 4 256 steps

Potentiometers 1 (on TSX Nano, 10/14/20 1/0O),
2 (on TSX Nano 16/24 1/0)

Analogchannel Function specific to certain modules, see Section 1.11

Displaying On a "base PLC" PLC or a peer PLC (extendable PLC configured
internal bits as a peer PLC), it is possible to display the status of 8 internal bits
(Memaory (TSX Nano with 10 and 16 1/O) or 16 internal bits (TSX Nano with
Display) 24 1/0) on the front panel, see Section 1.9.

Programmable On abase PLC or a peer PLC, itis possible to change the input filter
inputfilter time during configuration :

No filtering or filtering at 3 ms or 12 ms (see Section A-1.7).

1/0 points are configured in groups.

Special I/0 It is possible to assign specific functions to certain I/O during
configuration.

Inputs RUN/STOP : 1 of the first 6 inputs of the base or the peer
PLC (%10.0 to %I0.5).

Latching : the first 6 inputs of the base or the peer PLC
(%10.0 to %I0.5).

Analog input module connected on %10.0 according to
frequency meter

Fast counter : 10 kHz
Frequency meter : 10 kHz
Fast up/down counter : 1 kHz

OQutputs PLC status (SECURITY) : 1 of the first 4 outputs of the
base or the peer PLC (%Q0.0 to %Q0.3)

PULSE : pulse train (4.9 kHz maximum)

PWM : pulse width modulation (4.9 kHz maximum)

Analog input module connected on %Q0.0 according to
PWM (pulse width modulation)

Threshold outputs : 2 (%Q0.1 and %Q0.2), associated
with fast counting, are updated without waiting for an end-
of-scan update

Note :

PULSE and PWM outputs can be used on PLCs with relay outputs as long as the on-off period
is greater than the relay's closing response time (approximately 50 Hz). If they are used, the
maximum number of permitted operations is likely to be reached very quickly.

We therefore recommend using these outputs mainly on PLCs with transistor outputs.
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Summary of the main functions according to PLC type

Functions 10/14/16 1/0 PLC |16 I/0 PLC| 20/24 1/O PLC |1/O extension
(X)0 10 o (x)1 1648 | 3L 2028 16/24 E/S
(X1 16 o (X1 24 EX oo o
BL 1428 3(x) =28 33 2428
Inputs RUN/STOP b d d
Latching b b
Counting 10 kHz b °
Analog/
Frequency meter
Up/down b L
counting 1kHz
Outputs PLC status d d
PULSE d d
Analog/ d d
PWM
Threshold (fast courjters) b b
Programmable (X)1 16 oo °
input filters 3L 1428
Schedule block (RTC) (X)1 16 e hd (X)1 24 oo
Potentiometers o i i
Display of internal bits i i i
on /O indicator lamps
Communication
prog. UNI-TELWAY o i i
port ASCII b L L
extension I/O Ext. or Peer PLC (X)0 10 e L (X)1 24 oo
port Modbusslave (X)1 16 e ° (X)1 24 oo
Functon Timers - d d
blocks Up/down b ° 4
counters
LIFO/FIFO ° ° °
register blocks
Shift registers ° ° °
Drum ° ° °
controllers
Step counters hd e d
Instruc- Grafcet b ® i
tions (1)Master relay ° ° °
Varia-  Bit strings ° ° °
bles (1) Word table ° ° °
Indexing L L

(1) All other instructions can

be accessed by the various types of PLC.
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1.3  Programexecution

1.3-1 Normal (cyclical) operation

By default, the PLC scan executes cyclically, as follows :

Internal processing :
The system :
¢ Monitors the PLC :
- checks the execution capability of the
program memory
- managesthetime; updatesthe current
schedule block (RTC)
- updates the LEDs : RUN, I/O, ERR,
COM
- detects the RUN/STOP changeover
- monitors other system parameters
* Processes requests from the program-
ming port and the extension port.

Read inputs :

e Input memory is updated with the status
of the physical inputs (%l).

Execute program :

« The program written by the user is then
executed.

Update outputs :

« The states of the physical outputs (%Q)
are updated from the output memory.

The operating cycle
e PLC running

v

Internal processing

l

Read inputs
(%I)

RUN -

STO

Program execution

Update outputs

(%

0)

The processor manages the system, reads the inputs, executes the program and

updates the outputs.
« PLC stopped

In this case, the processor only manages the system, reads the inputs and updates

the output image table.

Warning

Watchdog timer

(the RUN and ERR LEDs flash).

The scan time of the user program is monitored by the PLC watchdog timer and must
not exceed 150 ms. Otherwise a fault appears causing the PLC to stop immediately!

1/9
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The possibilities :
1 Scan time - watchdog time (150 ms)

Normal operation, the next scan is started

2 Scan time > watchdog time

The PLC stops, the RUN and ERR LEDs flash and system bit %S11=1.

Diagram of cyclical scan time

A
Program Program
execution execution Time
%l %Q %l %Q
I.P. I.P.
Scan n time Scan n+1 time
-~
Y
Key :
I.P.= internal processing %I = read inputs %Q = update outputs
1.3-2 Periodic operation
In this case, reading of inputs, program
processing and output updating is ex-
L . . Start
ecuted periodically according to the time
. . . of period
defined by the user at configuration (2 to
150 ms).
At the start of the PLC scan, a software Reado/":pms
timer is set to the value defined during (%
configuration. The PLC scan must finish RUN 1+ STOP 4

before the time elapses. The next scan is
started when the timer finishes.

When the scan time exceeds the preset
time limit, system bit %S19is setto 1. This
bit can be tested and reset by the user or
by the user program.

Program execution

|—

Update outputs
(%Q)

Internal processing

End of period
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Warning

Watchdog timer

The scan time of the user program is monitored by the PLC watchdog timer and must
not exceed 150 ms. Otherwise a fault appears causing the PLC to stop immediately,
(the RUN and ERR LEDs flash).

The possibilities :
1 Scan time - preset time limit

Normal operation, the next scan is launched as soon as the programmed period has
elapsed.

2 Preset time limit < scan time - watchdog time
The system bit %S19 is set to 1 by the system and the program user is responsible
for resetting it to 0. The PLC remains in RUN.

3 Scan time > watchdog time
The PLC stops, the RUN and ERR LEDs flash and system bit %S11=1.

Diagram of periodic execution time

A

Y

%l %Q %l %Q

Period Period

A
y
A
'

Key :
I.P.= internal processing %I = read inputs %Q = update outputs
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1.4 Thel/O extension

"Base PLC" extendable PLCs can be extended using an 1/O extension. This extension
is created using a "base PLC" extendable PLC (10, 16 or 24 1/O) configured as an 1/0
extension (10 or 24 1/0).

1/0 extension

(LLTITTTTTTTTTTITTTITINCIN
‘ \ /
O\O/O
| 1O
| ’7 |
LI ITTITITTTIITITIT
Extension link |

The configuration of a "base PLC" extendable PLC is defined by the position of the
selector switch, as shown in the diagram above :

» Selector switch at position 0 = base PLC.

» Selector switch at position 1 = I/O extension.

An /O extension module does not require any particular configuration since it is
dedicated for this use only.

The extension link between the base PLC and the I/O extension should be a shielded
twisted pair cable.

The maximum distance between the base PLC and the 1/0O extension is 200 meters
(650 feet).

Cable product reference : TSX CAO0 003 (length 30 cm - 12 inches).

For distances greater than this, the user should use a cable whose characteristics are
defined in Part A, Section 3.5.

Recommended input and output distribution between the base PLC and the /O
extension :

To accommodate any slight variation in update times, critical 1/0 points should be
assigned to the base PLC. This will ensure optimum operation of the control system.
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1.5 1/Oaddressing
An I/O address is defined by the following characters :

% lorQ Oor1l . i
symbol I = input 0=base PLC or |point i=1/0 point number
L |Q =output peer PLC - (see table below)
1 = I/O extension

Base PLC 1/0O extension

%I10.3 %I1.3

’U [TT11 \0\1\2\3\4\5\6\7\8\9ﬁ0111213" f“ TTTT \0\1\2\3\4\5\6\7\8\9\10\11\1213"
| | | |
\[c[o[1]2[3[c[4]5]6[7[CBICIO] [ [ T[T T/ \[Co[12[3[c[4]5[6]7[C[8[C[o] [ [ [T T [/
%00.64 %Q1.6

Examples

%I0.3 : Input, I/O point n°3 on the base PLC
%Q1.6 : Output, I/O point n°6 on PLC used as I/O extension

Numbers of 1/0O points for the various PLC types

PLC model Number of 1/O Inputs Outputs
TSX Q7+« 100 10 (61 + 40) i=0to5 i=0to3
TSX 07 3L 1428 14 (8l + 60) i=0to7 i=0to5
TSX 07se 160¢ 16 (91 + 70) i=0to 8 i=0to6
TSX 07 3L 2028 20 (121 + 80) i=0to 11 i=0to 7
TSX Q7ee 240 24 (141 + 100) i=0to 13 i=0to9

1/13



1.6 Special I/O
Introduction

By default, all I/O are configured as discrete I/O. However, certain I/O of a "base PLC"
PLC or an extendable PLC configured as a peer PLC can be assigned to specific
functions during configuration. An I/O point already used for one function cannot be
used for another.

Special inputs

Input Base PLC or Peer PLC inputs
functions %I0.0 9%I0.1 %I0.2 %I0.3 %I0.4 %I0.5 %I0.6t0%I0.13
RUN/STOP ° ° d d ° ° _
Latching b o ® b o ® _
Inputs Upcounting i _ _ _ _ _ _
linked with  ~0 \nter °
fast up/ set - - - - - -
down
counting Fast counter _ _ b _ _ _ _
(FC) enable
Downcounting _ _ _ ® _ _ _
FC read _ _ _ _ ® _ _
Analog input ° _ _ _ _ _ _

Special outputs

Output Base PLC or Peer PLC outputs

functions (1) %Q0.0  %Q0.1 %Q0.2 %Q0.3  %Q0.4 % to %Q0.10
PLC status (SECURITY) e ® ® ° _

PULSE : pulse train ® _ _ _ _

PWM : pulse width ® _ _ _ _

modulation
Analog output ® _ _ _ _
Outputs linked FC OUT 0 _ ® _ _

with fast up/ —
down counting FCouT1l  _ - ° - -

(1) Outputs %Q0.0, %Q0.1, %Q0.2 and %Q0.3, when configured as special outputs, must not
be used as outputs in the application program (for example, with Boolean instructions (ST, STN,
S, R) with the command bits for drum controller blocks %DRi) or as outputs assigned to the
Schedule blocks RTC.
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Definition
Use of these 1/O is defined in detail in Part A, Section 4. The description below simply
defines each I/O function.

* RUN/STOP input (see Section 4.1)
Via an external switch, this input :
- starts program execution (RUN),
- stops program execution (STOP).

e Latching input (see Section 4.3)
This input is used to store a pulse which lasts for less than a scan, so that it is taken
into account in the following scan.
« Inputs linked with fast counting  (see Section 4.4)
Upcounting input
This input enables the counting of pulses to be taken into account, at a maximum
frequency of :
- 5 or 10 kHz if configured as a fast counter or frequency meter
- 1 kHz if configured as a fast up/down counter.
One ofthe applications is the management of an analog input module (see Section 1.11)

Set counting input

This input is used :

- either to reset the counter to 0 when using it as a fast counter.

- orto presetitto avalue defined at configuration when using it as an up/down counter.

Fast counter enable input
This input ensures that signals received at the up/down counting inputs are taken into
account.

Downcounting input
This input enables downcounting pulses to be taken into account at a maximum
frequency of 1kHz.

Fast counter value read input
This input enables the current value to be read during the scan, rather than when the
scan is completed.

» PLC status (SECURITY) output (see Section 4.2)
Normally set at 1, it changes to 0 on a PLC fault and can therefore be used in external
safety circuits.

* PULSE output (see Section 4.5)
Used to generate a signal lasting for a variable period but with a constant duty cycle,
or on to off ratio, equal to 50% of the period.

* PWM output (see Section 4.6)
Used to generate a signal lasting for a constant period with the option of varying the
duty cycle, or on to off ratio.
One ofthe applicationsis the management of an analog inputmodule (see Section 1.11)

» Fast Counter threshold outputs  (see Section 4.4)
Linked to fast counting, these outputs enable data to be read during the scan, without
waiting for an update at the end of the scan.
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1.7  Additional information about the I/O

1.7-1 Programmable input filters

Input filtering on a "base PLC" PLC or an extendable PLC configured as a peer PLC
may be configured from the terminal by altering the filter time. The values which can
be configured are as follows :

* 12 ms : filter contact bounce and electrical noise

e 3 ms : filter contact bounce and electrical noise

» No filtering : reading short signals for fast applications but with increased sensitivity

to filter contact bounce or electrical noise. In this case the use of volt-free contacts

is not advised.

Important

Each type of configurable filter value can be considered as three zones separated
by 2 values : the immunity value and the recognition value. Any signal with a
duration less than or equal to the immunity value will be rejected. Any signal with
a duration greater than or equal to the recognition value will be accepted. Any
signal with a duration between these 2 values may accepted or rejected. If no
filtering has been configured on an input, the immunity and recognition values are
set for inputs %I10.8 to %10.13 but for inputs %I10.0 to %I0.7 they will depend on
whether or not the counting function or the frequency meter function has been
configured on input %I0.0.

Filter configured Immunity Recognition
12 ms 10 ms 13 ms
3ms 2ms 4 ms
No filtering 0.125 ms for %I0.8 to %10.13  0.375 ms for %I10.8 to %I10.13

and %FC not configured

0.025 ms for %I10.0 to %I0.7

0.100 ms for %I10.0 to %I0.7

No filtering

and %FC configured as
5 khz counter or

5 khz frequency meter

0.125 ms for %I10.8 to %10.13
0.025 ms for %I10.0 to %I0.7

0.375 ms for %I10.8 to %I0.13
0.100 ms for %I0.0 to %I0.7

No filtering

and %FC configure as
10 khz counter or

10 khz frequency meter

0.125 ms for %I0.8 to %10.13
0.007 ms for %I10.0 to %I0.7

0.375 ms for %I0.8 to %I0.1.
0.037 ms for %I10.0 to %I0.7

Important

Where no filtering has been configured, and the recognition values are less than
the PLC scan time (and thus the scan time of the inputs), to ensure that a signal with
a duration greater than the recognition time is processed, use the input which
handles this signal to capture the pulses.
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« Discrete inputs

By default, all inputs on a "base PLC" PLC or an extendable PLC configured as an I/O
extension or peer PLC are configured with a filter time of 12 ms. This time can be
modified for each 1/0 point group on a base or peer PLC.

¢ Latchinginputs

Each of the first 6 inputs (%Il 0.0 to %I 0.5) on a "base PLC" PLC or an extendable PLC
configured as a peer PLC can be configured individually as latching inputs. This type
of operation is used to memorize any pulse with a duration less than the PLC scan time.
In this case, the immunity and recognition values also depend on the configuration of
the fast counting function %FC.

Inputs %I0.0 to %I0.5 in read mode Immunity Recognition
%FC not configured 0.025 ms 0.100 ms
%FC configured as 5 khz counter 0.025 ms 0.100 ms
or 5 khz frequency meter

%FC configured as 10 khz counter 0.007 ms 0.037 ms

or 10 khz frequency meter

¢ Fastcounting inputs

If a fast counter, a frequency meter or an up/down counter is declared at the time of
configuration, the following inputs are automatically assigned to the counting pulse
input.

- %I0.0 for fast counting and frequency meter,

- %I0.0 and %I0.3 for up/down counting.

Used for fast counting or as frequency meter

Two operating modes can be configured : a 10 khz mode and a 5 khz mode. Input %I10.0
then counts the pulses, which must respect the characteristics of the minimum duration
and the minimum separation between pulses to be taken into account.

Mode Immunity Min. pulse duration Min. sep. between pulses
5 Khz 0.025 ms 0.100 ms 0.100 ms
10 Khz 0.004 ms 0.045 ms 0.045 ms

1/17
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Used for up/down counting

Inputs %I10.0 and %I10.3 upcount and downcount the pulses, which must respect the
characteristics of the minimum duration and the minimum separation between pulses
to be taken into account. The maximum frequency is 1 khz.

%I10.0 and %I0.3  Immunity Min. duration of pulse Min. sep. between pulses

0.025 ms 0.100 ms 0.100 ms

Important

« While counter input %I10.0 is at state 1, no downcounting action will be processed
on input %I0.3.
* While counter input %I10.3 is at state 1, no upcounting action will be processed
on input %I0.0.

1.7-2 Protected transistor outputs on TSX 07 e e 12

Protection against overloads and short-circuits

TSX 07 «=«« 12 PLCs have 4, 7 or 10 transistor outputs which are protected against
overloads of up to 1A and short-circuits.

0.5A transistor outputs have an electronic device which enables an overload or a short-
circuit to be detected on any active output. The appearance of this type of fault causes :

* current limitation (typically 1A) of the affected output,
« tripping of all the outputs in the block (base PLC or I/O extension)

* activation with a steady light of the I/O LED on the base PLC (if base PLC outputs
tripped) or LEDs on the base PLC and I/O extension (if I/O extension outputs tripped)

* settingthe I/O fault system bit%S10to 0, and system bits %S118, %6S119, %SW118:X0
and %SW119:X0 to change state (see sections B 5.1, B 5.2 and B 6.2).

Reactivating transistor outputs

When a fault has caused tripping of the PLC outputs, they need to be reset. Since
tripping of outputs results in downgraded operation of the process being controlled by
the PLC, it is advisable to make resetting transistor outputs conditional upon manual
intervention. The operator can then, before performing the reset, take any necessary
precautions with regard to the control system and personnel, (for example, request
changeover to manual mode). The recommended programming is described in section
B 6.2.

Note :

If the process being controlled by the PLC is the responsibility of the user, it is possible to program
an automatic reset (see section B 6.2).

Important

Cold restart of the PLC (set %S0) removes the tripping fault and attempts system
reactivation.
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1.8 Potentiometers

Principle

An analog/digital converter translates the voltage at the terminals of a potentiometer
into a digital value (0 to 255) which is then stored in a word. This value can then, for
example, be used as the preset value for a timer that the user can manually adjust
without the need for a programming terminal. An example of software start-up is
described in Part B, Section 3.2.

Analog
L value 0 to 255
Digital
Adjustment Analog/digital Storage in a system
potentiometer converter word %SW

Potentiometers can only be used on "base PLC" PLCs and extendable PLCs
configured as peer PLCs.

The number of potentiometers varies depending on the type of PLC :

¢ 1 on PLCs with 10, 14 and 20 |/O, labelled 0

e« 2 on PLCs with 16 and 24 1/O, labelled 0 and 1.

Storage word depending on the potentiometers

0 1
%SW 112 %SW 113

Potentiometer 0 Storage word Potentiometer 1 Storage word

Position of the potentiometers

i
| |
o 16
[ [
\manEnEnnnnns) OO

PLC with 10, 14 and 20 PLC with 16 or 24 1/0
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1.9

Status display of the PLC and the I/0O

 Displaying the status of the PLC

The results of the self-tests performed
continually by TSX Nano modules are
displayed on the front panel via 4 LEDs :
RUN, ERR, I/0 and COM.

O o
RUN ERR

O o
COM 1/0

LED LED Base PLC or I/O extension
status peer PLC
RUN on PLCin RUN Same as base PLC
(green) flashing PLC in STOP or execution fault Same as base PLC
off Not powered or application not executable  Incorrectly or not connected
ERR on Internal faults (watchdog, etc) Same as base PLC
(red) flashing Applicationnotexecutable - ----------
off OK OK
COM on Exchanges present on extension link (1)  Same as base PLC
(yellow) flashing Exchanges present on Modbus slave (1) -----------
off No exchanges on extension link or Modbus
le} on I/O fault (outputs tripped, sensor supply)  Same as base PLC
(red) flashing _ OK
off OK

(1) Operation of the 1/0O or Modbus is exclusive

 Displaying the I/O

The status of each I/0O point is displayed on the front panel of the PLC via ared LED for
PLCs version V3.0 or earlier, and a green LED for PLCs version V3.0 or later.

OO0 (1O000O0ogao OO0 (oogoooodaodd
RUN ERR 0 1 2 3 4 5 RUN ERR 0 1 2 3 4 5 6 7 (8)
OO o0 OO O OO oO0doOQOnOOdAad
COM 1/0 0o 1 2 3 COM 1/0 0 1 2 3 4 5 (8)
PLC with 10 I/0 PLC with 14/16 1/0

LED on: I/O on
OO (10000 Y I B A o R B LED off : I/O off
RUN ERR 0 1 2 3 4 5 6 7 8 9 10 11 (12) (13) ’
OO o OO OooOo0o0odad
COM 110 0 1 2 3 4 5 6 7 (8) (9)

PLC with 20/24 1/O

When switched on, all LEDs are lit for approximately 1s.
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< Displaying internal bits
When system bit %S69 is set to 1, TSX Nano PLCs can display the status of 8 or 16

internal bits, rather than displaying the I/O status. The numbering of memory bits is fixed
from 112-127.

The corresponding display on the front panel is shown below :

10 1/0 PLC
% % % % Fla]shing 1)
[T 1 1 |
0o o 10 I o
RUN ERR 0 1 2 3 4 5
(o]
Sl cnm e
14/16 1/O0 PLC
% % % g Flashing (1)
[T T 1T |
o0 (Ooodoao Ooodao
RUN ERR 0 1 2 3 4 5 6 7 8
(Y O
COM |/o ? T T‘ T 4 5 6

20/24 1/0 PLC

| I | 1T T 1T 1 |
N o o o (0 R 0 B Ooonoao
RUN ERR 0 1 2 3 4 5 6 7 8 9 10 11 12 13
0 LF lﬁ IF IF T T T LF e
COM |/o 8 9

H

(1) series of 5 short flashes, once every second
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1.10 PeerPLCs

A maximum of three extendable PLCs configured as peer PLCs which communicate
via exchange words (%IW and %QW) can be connected to the "base PLC" extendable
PLC. In this case, only the base PLC can have an I/O extension.

EN 345 3435 34

2 6 2 6 2 6 2 6
Base PLC 07 Peer PLC2 (04 PeerPLC3 {84 PeerPLC4 W/
(MITTTTITTTTRIIN (MITTTTTTTITRT (MITTTTTTTTRT (MITTTTTTTTINI TN
! \ / ! / ! \ / ! \ /

(OO (O [ (OO

oX:

| | | | | | |
NENEEEEREREEEY, LTI LTI LTI
N\ N |
extension link
Note :
o7 The order in which they are cabled does not affect operation.

The function of each PLC is defined by the position of the selector switch, as shown in
the diagram above :

PLC function Base /0 | TSX Micro extension Peer Peer Peer
PLC Ext. (module TSX STZ10) PLC2 PLC3 PLC4

Selector position 0 1 2 3 4 5 6 7

Link address 0 1 2 3 4 2 3 4

I/O addressing for peer PLCs 2, 3, and 4 is identical to that for the base PLC (%I0.i and
%QO0.i)

The extension link between the base PLC and the extensions (I/O and/or PLCs) should
be a shielded twisted pair cable (see Part A, Section 3.5 for the type of cable to use).

The maximum distance between the PLC base and the last peer PLC is 200 meters
(650 feet).

Important :

The position of the selector switch is only taken into account when the PLC is
powered up.
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In order to optimize the communication exchange between the base PLC and the peer
PLCs or I/O extension, the number of devices to be scanned and the baud rate on the
link must be defined. See Part C, Section 3.2 for information on baud rate configuration.

Overall duration of exchange scan (complete scan )

Number of extensions Transmission speed

scanned 9600 bits/s (1) 19200 bits/s
1 17 to 19 ms 6to 8 ms

2 34 to 35 ms 16 to 18 ms
3 53 to 55 ms 26 to 28 ms
4 7210 74 ms 35 to 36 ms
Note :

System bit %S72 can be used to prevent any scanning of peer PLCs. It takes priority over
selections made during configuration.

Important

Bits X1, X2, X3 and X4 of system word %SW71 enable the status of communication
with each peer PLC to be tested on the extension link (at state 1, communication
is OK). Using PL7-07 data animation at 19200 bit/s may lead to reduced performance.

The same speed must be configured for all PLCs in the same Nanet network.
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1.11 TSX Nano PLCs with 1 integrated analog input
1.11-1 Presentation

TSX 07 32/33 =+« PLCs include a non-isolated 0/10V analog input channel. They have
the same characteristics and functions as TSX07 30/31 e = (see Section 1.2-3). In
particular, they allow use of an external analog input or output channel.

The analog input channel replacesthe extension port function in TSX 07 30/31ee es. TSX
07 32/33 PLCs cannot therefore be connected to other PLCs or to a Modbus slave type
link.

The analog input channel is managed via system word %SW2112 in the application. A

potentiometer PO is used to correct any errors caused by the analog measurement
circuit in some applications.

Potentiometer PO

— 1 o

For details on managing the analog input channel of TSX 07 32/33 «s see Part B Section
3.3.
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1.12 Analog modules
1.12-1 Presentation

TSX 07 30/31 «= «» "base PLC" PLCs with discrete I/O (starting from version VV3) are able
to manage analog 1/0 modules.

There are three types of analog module in the TSX Nano offer :

* TSX AMN 4000/4001 analog I/0 modules managed via the 1/0O extension link.

e TSX AENee» modules with one analog input using input %I0.0 of the "base PLC" PLC
in frequency meter mode.

e TSX ASNeee modules with one analog output managed via the PWM output (base
PLCs must be fitted with transistor outputs).

1.12-2 Presentation of TSX AMN 4000/4001

TSX AMN 4000/4001 analog modules are available in two configurations depending
on the power supply required. Each module includes 3 input channels and one output
channel.

These modules are managed by the "base PLC" PLC as peer PLCs (maximum of 3).
Analog modules and peer PLCs can be mixed on the same link.

110 Analog Analog Analog
Base PLC extension module 1 module 2 module 3
7 4D 4 3,
2@7& 2@7@ 2@7& 2@6
VJJJJJJJJJJJJJ_‘\‘JJ/ MJJJJJJ_‘\JC‘/ }\J MJJJJJJ_\(J\:}

200 meters maximum

Addressing I/O in TSX AMN 400- analog modules is defined by setting the selector
switch as shown in the table below.

PLC function/ Base /O TSX Micro Extension Analog Analog Analog
analog module PLC  Ext. (TSX STZ10 module) mod.1 mod. 2 mod. 3
Selector switch position 0 1 2 3 4 5 6 7

Link address 0 1 2 3 4 2 3 4
Important

The position of the selector switch is only taken into account when the PLC is
powered up.
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Analog modules are configured in the PL7-07 configuration menu.

Exchanges between the "base PLC" PLC and analog modules are managed via
exchange words %IW and %QW.

For details on managing the analog I/0O modules of TSX 07 AMN 4000/4001 see Part

B Section 4.2.

1.12-3 Status display of TSXAMN 4000/4001 modules

 Display of the PLC status

The results of the self-tests performed O O
continually by analog modules are RUN ERR
displayed on the front panel via 4 LEDs : O O
RUN, ERR, COM and I/O. com o
LED LED Meaning

status
RUN on Application in RUN
(green)  off Not powered or application not executable
ERR on Internal faults (autocalibration fault or self-tests not OK)
(red) flashing  Incorrect module addressing

off Functioning OK
COM on Communication present
(yellow) off No exchanges present
I/1O on High and low stops on analog inputs exceeded
(red) off Functioning OK
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1.12-4 Presentation of TSX AEN/ASN eee

Each "base PLC" PLC can support a maximum of one input module and one output
module.

The analog input module is managed via the fast counting input on the PLC.

The analog output module is managed via the PWM output on the PLC (base PLCs must
be fitted with transistor outputs).

Fast input counter

1 ANA input 1 ANA output
TSXNano 910.0 module module

(ENNNNERNNNNNNEEE) e [

I ! [ -

| |
LTI ° °

%Q0.0 T T

Pulse output (PWM)

The fast counting input and the PWM output are configured in the PL7-07 configuration
menu.

Management of the control of input functions, the value of the analog input read, the
control of output functions and the analog output value to be generated are determined
by reading and writing system words %SW100 to %SW103 in the application.

For details on managing the analog 1/0O modules see Part B Section 4.3 and 4.4.
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1.12-5 Summary of catalog references

Supply 110 Range Resolution References

voltage module | 0-10V| 4-20mA | +/-10V| 8 8/12 | 10/12

100/240V | 24V bits |bits |bits

~N -
° 1 b b TSXAEN101
° 1 b b TSXAEN102
° 1 b b TSXAEN105
° 10 b b TSXASN101
° 10 ° b TSXASN 102
° 10 b b TSXASN105

b 3120 b ° b i TSXAMN4000

° 31110 b ° b b TSXAMN4001
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2 Dimensions/Mounting/Installation

2.1 Dimensions
o TSX Q7 = 10-s, TSX 07 32 1028, TSX AMN4000/4001

(JFCCIIIIIII)
] ( L]

4,13 inch

85 mm
3,34 inch

5 mm

e TSX Q7 e« 16+ except TSX 07 +1 1648, TSX 07 3L 1428

’UHHHHHHHHP
e[S
] &
I B[ £
| | @ £
LT ITIITITITITIITI 0 L
! 135 mm ‘ 60 mm
5,31 inch 2,36 inch

o TSX Q7 e 24+ with 16 1/0 : TSX 07 -1 1648, TSX 07 2028

|

|

(EEEEEEEENNNEEENENNEN)
el6
E|S ]
B
| ’7 \wd E
[T TITITTTTTTT © i
\ 165 mm | 60 mm
6,49 inch 2,36 inch

+ TSX AEN 10+ and TSX ASN 10+
[T ¢

80 mm
mm
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2.2

Mounting

TSX Nano PLCs and analog modules can be mounted on :

* a mounting plate or panel using 2 @ M3 screws (not supplied)
e a 35 mm DIN mounting rail.
* Mounting on a mounting plate or panel using screws

TSX NANO TSX AEN/ASN
|
> 2x04,5 2x04,5 “
o A
® % 0
s ¢ SE
S R
%
&)
O L
X 20 min. ‘ 35
(0.787") (1.378")
45
PLCs/ TSX 07 +e10ee TSX 07 e 16 TSX 07 «1 1648 | TSX Q7 02400
Analog TSX 07 32 1028 TSX 07 3L 1428 TSX 07 2028
modules TSX AMN 400 -
X 86 mm 116 mm 146 mm 146 mm
3.38 inches 4.56 inches 5.74 inches 5.74 inches
¢ Mounting on a 35 mm DIN rail
Mounting Removal
2 t

Position the PLC and clip it on to
the DIN rail as shown in the above

diagram.

Warning

N

X
%

1 With a screwdriver, release the latch at the
back which locks the PLC onto the DIN rail.

2 Keeping the latch open, pivot the PLC as
shown in the above diagram.

When mounting PLCs and analog modules on a DIN rail, use 2 end stops, type
AB1-AB8P35 or equivalent.
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Dimensions/Mounting/Installation 2

2.3 Installationrules

TSX Nano PLCs and analog modules should be mounted on a vertical plane and at
the minimum distances shown on the figure below, in order to maintain a natural
circulation of air.

* Mounting positions
- Vertical plane

1 End stops AB1-AB8P35
2 Cover

] ] S

|

g = 2

l__ 1 Switchgear, enclosure or
machine frame.

—2 . .
E a 2 Cable ducting or clips.
a >20mm

a
‘ ‘ «© b >40 mm
(OO () &
H S[ N S[ B
@ @ C Avoid mounting heatgenerating
© devices (transformers, power
2 y supplies, contactors, etc)

beneath the PLCs.
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3 Connections

3.1 I/O wiring rules and precautions

3.1-1 General precautions and rules

The connection terminals on TSX Nano PLCs are protected by a removable cover
which protects users when the PLC is powered up. Each terminal can take up to two
1 mm? (16 AWG) wires fitted with open or closed cable ends. Coupling torque of
terminal screws : max. 0.5 Nm.

I Dimensions :
N =] 1 T s
2 3.2 mm
3 5mm
When using closed cable ends, it is necessary to remove the cover in order to take out
the screw needed for fixing the cable ends.

Removing the cover

TSX Nano PLCs have integral protective devices on the I/O, which give them a good
resistance to industrial environments. However, certain rules must be observed so as
to maintain this immunity.

e Discrete inputs
All multi-core cables carrying sensor data must include the sensor common.

< Discrete outputs
Relay outputs : the following must be connected in parallel with the terminals of the
output :
- An RC or MOV (ZNO) protection circuit for AC.
- A freewheel diode for DC.

e Cablerouting

- External to the device
All I/O wiring must be routed in cable ducting which is separate from those carrying
high voltage cables, and at least 100 mm (4 inches) from parallel power cables.

- Inside the device
Power cables (power supply, contactors, etc) must be kept separate from input
(sensors) and output wiring.
If possible, I/O wiring should be routed in separate cable ducting.
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3.1-2 Special precautions for connecting discrete low noise immunity inputs

Some inputs can be configured as :

« Fastcounters or frequency meter inputs, with a frequency of 5 or 10 kHz (input %I10.0).
¢ Up/down counter inputs, 1 kHz (inputs : upcounter %I10.0, downcounter %I0.3).

e Latching inputs (inputs %I0.0 to %I0.5).

« Discrete inputs without filter (%10.0 to %I10.3 and %10.4 to %I0.7).

The noise immunity of the inputs which have been configured in this way is reduced,
and certain connection precautions must be taken.

e Input %I10.0 used as a fast counter or frequency meter input (5 or 10 kHz), 1 kHz
counter input, latching input or discrete input without filter :

A shielded cable must be used with :

- the cable shield connected to terminal C (COM), the input common (to the power
supply - with positive logic (sinking) inputs or to the power supply + with negative
logic (sourcing) inputs),

- terminal C (COM) connected to the machine protected ground.

Example : Wiring diagram for connecting input %I10.0 to a 3-wire sensor wired for

positive logic
3-wire
sensor
+ - S
O O O

Sensor
supply
= +

shielded cable

P
PLC
supply -y, shield

I:I connection < 20 cm
3A
1 protected machine
— _|m = ground
1
IT @ c |fo;| EJ &I 3|4 EJ 13
TSX 07 e 0o 02/08/12/22/28

Note :

When using the 1 kHz up/down counting function, input %I0.3, which is used as the downcounting
input, will be connected following the same principle as for input %I10.0
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Connections 3

A

e Otherinputs used as latching inputs (%I0.1 to %I0.5) or discrete inputs without
filter (%10.1t0 10.7) :

The general principle is to group together on the same cable all the wires relating
to the sensor which is controlling the input. Thus one cable is used per I/O point.

Example : Wiring diagram with inputs wired for positive logic (sinking)
3-wire
sensor
- + S
O O O

PLC

supply | cable

3-wire
sensor
+ =

Sensor
supply

-~ N cable

|13

il

TSX 07 ee e 02/08/12/22/28
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3.2  Connection of power supply

» 24 VDC power supply

—» — to DC power
= |—— 4 input terminals

&/

+
to — output
power supply

TSX Q7 oo eee 2

Q Master switch

KM  Line contactor or circuit breaker (not essential on small installations)

3A

= 24V

TSX AMN 4001

Q Master switch

KM  Line contactor or circuit breaker (not essential on small installations)

[Key : ~ AC,= DC |

3/4




Connections 3

« 100 to 240 VAC power supply

Note :
The 24VDC power input is not available on the TSX 07
21 1648 115 VAC input model.

— +10 DC power

I—V —input terminals

+ —_—

100/240V
to ~ output i

power supply = 24V

TSX 07 oo eee 8

Q Master switch
KM  Line contactor or circuit breaker (not essential on small installations)

S
S~ SN

3A _||'

LINED

100/240V

~

TSX AMN 4000

Q Master switch
KM  Line contactor or circuit breaker (not essential on small installations)

[key : ~ AC,—= DC |
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3.3

Discrete input connection

3.3-1 24V inputconnections

» Connection of the positive logic (sinking) inputs
On PLCs with AC supply :
: TSX 07 «0 1008, TSX 07 *+ 1028

-101/0

-141/0:

-161/0

-201/0:
-241/0:

TSX 07 3L 1428

: TSX 07 +1 1608, TSX 07 *= 1628

TSX 07 3L 2028

~ 100/240V

TSX 07 «1 2408, TSX Q7 *+ 2428

3-wire prox. sens.

2-wire prox. sens.

4

3A H T

{>pPNP

0

\

Cc

-

3

:

:

:

:

:

Inputs

:

TSX 07 e« » 08/28

On PLCs with DC supply :
-101/0: TSX 07 «0 1002, TSX 07 «0 1012, TSX 07 «0 1022
-161/0 : TSX 07 «1 1602, TSX 07 07 «= 1612, TSX 07 1 1622
-241/0 : TSX 07 «1 2402, TSX 07 Q7 ¢+ 2412, TSX 07 +1 2422

I

= 24V
+

3-wire prox. sens.

2-wire prox. sens.

T

3A

<{DPNP |

]

i

C

o]\
p

:

i¢

:

:

—|:|—°"—|||T

Inputs @]

TSX 07 e o 02/12/22
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Connections 3

« Connection of the negative logic (sourcing) inputs
On PLCs with AC supply :
-101/0 : TSX 07 -0 1008, TSX 07 == 1028
-141/0 : TSX 07 3L 1428
-161/0 : TSX 07 «1 1608, TSX 07 *» 1628
-201/0 : TSX 07 3L 2028
-241/0 : TSX 07 «1 2408, TSX Q7 *+ 2428

~-100/240V 3-wire prox. sens.

s +; <{PNPN | K
:

=I5

2-wire prox. sens.

=)

1

Inputs E]

TSX 07 e = 08/28

:

—|:|—'-"—+||—|

On PLCs with DC supply :

-101/0 : TSX 07 «0 1002, TSX 07 -0 1012, TSX 07 +0 1022
-16 1/0 : TSX 07 «1 1602, TSX 07 «» 1612, TSX 07 +1 1622
-241/0 : TSX 07 «1 2402, TSX 07 *¢ 2412, TSX 07 «1 2422

— 24V
+ VY-

3-wire prox. sens.  _ 2-wire prox. sens.

=)

000 ¢

TSX Q7 e o= 02/12/22

o /—+<H>NPN J
f+_—_/i\ c|o

= =

e

:
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3.3-2 Connection of 115 VAC inputs

e PLC: TSX 07 -1 1648

~ 100/240V

3A

IR

NI

I
0
Inputs m

00t

TSX 07 1 1648

3.4

Connection of discrete outputs

3.4-1 Connection of relay outputs
(except TSX 07 -1 1648)

e PLCs with 10 I/0 : TSX 07 -0 1022, TSX 07 == 1028

Outputs

TSX 07 e« 1022/1028

\

5

}

3 L

*

(o 1 C
I Al

~24...240V/ —24V
* : fuse rated for load
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Connections

Connection of relay outputs (continued)

e PLCs with 14 1/0 : TSX 07 3L 1428
16 1/0 : TSX 07 *1 1622, TSX 07 = 1628

TSX 07 = 1428/1622/1628
Outputs

Does not exist on

|:| |:| TSX07 3L 1428
* * *
L] N Ll N L] N
A A
/ ~— ~———/
~24...240V/ 24V ~-24...240V/ -—24V

* : fuse rated for load
e PLCs with 20 1/0 : TSX 07 3L 2028

241/0 : TSX 07 1 2422, TSX Q7 = 2428

Outputs

L\

TSX 07 «» 2028/2422/2428

B
o —
[}
~
(¢
(-}
(¢
©

c|(o|j1|2|3|C

Does not exist on
I:I I:I I:I TSX07 3L 2028
* * * *
L N L] N L N/ L N
A A A
~ ~— ~ ~
~24...240V/ —24V ~24...240V/ —24V

* . fuse rated for load

Essential protection for each output |
terminal +
¢ An RC circuit or MOV (ZNO) suppressor
circuit for AC _
* A freewheel diode forboc | T _____|




3.4-2 Connection of relay outputs on TSX 07 <1 1648 PLC
TSX 07 « 1648

Outputs

I
cC|5|C|6

&
L= T*Lu A

L] N Ll N N] L] N
A A A A
— ~— —
~24...240V/ 24V ~24...240V/ =24V

*: fuse rated for load

Essential protection for each
output terminal

* AnRC circuitor MOV (ZNO) suppressor
for AC
¢ A freewheel diode for DC

3.4-3 Connection of negative logic (sinking) transistor outputs
e PLCs with 10 I/O : TSX 07 «0 1002 and TSX 07 <0 1008

TSX 070 1002/1008

e
00

*: fuse rated for load

Cc

v
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Connections 3

A

Connection of negative logic (sinking) transistor outputs (continued)
e PLCs with 16 1/0 : TSX 07 1 1602 and TSX 07 «1 1608

ﬁlﬁlfm 00

* : fuse rated for load

e PLCs with 24 1/0 : TSX 07 «1 2402 and TSX 07 «1 2408

EEECCHEEEEEn
[GZ0IEEELE

—A + =24V

* : fuse rated for load
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3.4-4 Connection of positive logic (sourcing) transistor outputs
e PLC with 10 /0O : TSX 07 «0 1012

TSX 07 «0 1012
Outputs

SRR

gt

+A - — 24V
* . fuse rated for load

*
l_l

e PLC with 16 I/O : TSX 07 « 1612

s
FHE

* . fuse rated for load
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A

Connecting positive logic transistor (sourcing) outputs (continued)
e PLC with 24 1/O : TSXQ7 «» 2412

EEECITECees
EZHLIL

*: fuse rated for load
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3.5 I/Oextension connections
The I/0 extension is connected to the "base PLC" PLC via a shielded twisted pair cable :

» Cable length 30 cm (12 inches) : reference TSX CA 0003.
« If a longer cable is required, use :
- either a UNI-TELWAY shielded twisted double pair cable :
TSX STC50: length 50 meters (165 feet), or TSX STC 200 : length 200 meters (650
feet)
- or a shielded twisted pair cable, the main characteristics of which are defined
below :

Mechanical characteristics : Structure
Tinned copper core, 18 to 24 gauge,

tinned copper shield copper core

Electrical characteristics : PVC insulation
Load resistance per unit length of one tiﬂnelcg| copper
shie

wire : - 85 Q /Km
Load resistance per unitlength of shield :
-12Q/Km

PVC insulation

The maximum authorized distance between the base PLC and the I/O extension is
200 meters (650 feet).

Base PLC 1/0O extension
TSX Nano TSX Nano
A B SG A B SG
extension link green

blue

shield

shielded twisted
pair cable

Note :
Colors shown refer to connection using cable TSX CA 0003
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Connections 3

3.6 Connection of peer PLCs

Peer PLCs are connected to the "base PLC" PLC in the same way as I/O extensions,
that is via a shielded twisted pair cable (for the cable to use see the previous page).

The maximum permitted distance between the base PLC and the last peer PLC is
200 meters (650 feet).

* Connection of an I/0 extension to the "base PLC" PLC, and a peer PLC.

Base PLC /0 extension Peer PLC 2
TSX Nano TSX Nano TSX Nano
A B SG A B SG A B SG

[ :/\\ N I/\\ N N,
T R

shield / shielded twisted shielded twisted

pair cable pair cable

Note :
If peer PLCs 3 and 4 are used, the continuity of the extension link is provided by a shielded twisted
pair cable with identical connections to those between the 1/0 extension and peer PLC 2.

e Connection of peer PLCs only to the "base PLC" PLC.

Base PLC Peer PLC 2 Peer PLC 3
TSX Nano TSX Nano TSX Nano
A B SG A B SG A B SG
A A

(A \
shield / shielded twisted shielded twisted

pair cable pair cable

Note :

If peer PLC 4 is being used, the continuity of the extension link is provided by a shielded twisted
pair cable with identical connections to those between the 1/O extension and peer PLCs 2 and
3.
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3.7  Connection of an analog sensor (TSX 07 32/33 ¢¢28 )

The analog sensor is connected to the analog input channel of the PLC via a shielded
twisted pair cable (cable identical to the one used to connect an I/O extension, see
Section 3.5).

The maximum permissible distance between the sensor and the analog channel of the
PLCis:

* isolated sensor < 30 m (99 feet) with shielded cable,
* non-isolated sensor < 10 m (33 feet) with shielded cable.
TSX Nano PLC TSX Nano PLC
analog module analog module
Do not use
rIN. 0-10V4 the NC terminal rIN. 0-10V+
[vo [ +] - [wo [+ ] -
Isolated Non-isolated
sensor (1) sensor
— ) — — )
= @7 - = T

(1) Floating with respect to ground.
(2) Grounding the - of the analog input is recommended.
(3) If a non-isolated sensor is used, the - of the analog input must be grounded.
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Connections 3

3.8 Connection of analog modules (TSX AMN 4000/4001)
3.8-1 Connection of analog modules to the "base PLC" PLC

Like discrete 1/0O extensions, TSX AMN 400+ analog modules are connected to the PLC
via a shielded twisted pair cable (cable identical to the one used to connect an 1/O
extension, see Section 3.5).

The maximum permissible distance between the "base PLC" PLC and the last analog
module is 200 meters (650 feet).

TSX Nano TSX Nano Analog module 1
"base PLC" PLC I/0O extension
A B SG A B SG A B SG

| I} N A N A
T\ \ TV \ >
shielding shielded twisted shielded twisted
pair cable pair cable

Note :

Ifanalog modules 2 and 3 are used, continuity of the extension link is provided by a shielded twisted
pair cable with connections identical to those made between the 1/0O extension and analog
module 1.

3.8-2 Connection of analog inputs

The analog input channels of the TSX AMN 400« module can take sensors with either
a voltage output or a current output.
The example below illustrates one type of configuration.

Sensor w. Sensor w. Sensor w.
voltage current voltage
output 1 output 2 output 3

() @ @

@ IN0 | INO | INO | In1 | In1| In1|In2|In2]| In2
V i |com| V i |com| V i |com

TSX AMN 400°

(1) Maximum 50 meters with @ 0.5 mm shielded cable (shielding connected at module end)

3/17
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3.8-3 Connection of analog outputs

The analog output channel of the TSX AMN 400 < module allows connection to an
actuator with either a voltage input or a current input.

TSX AMN 400- TSX AMN 400+

V I |jcom

Outo]Out0Jouto] NC| NC [ NC / Out0|

Out0[Outof NC [ NC [ NC
V i |com

Actuator
with voltage
input

(1) Maximum 50 meters with @ 0.5 mm shielded cable (shielding connected at module end)
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Connections

3.9

Connection of analog inputs (TSX AEN  ees)

3.9-1 Connection with input 0 of the TSX Nano wired as sink (positive logic)

>+ 24 vDC
= supply

_Tl__? FG

(1)

.
lelelsle]

N
+ — com 0

TSX 07 e seee

[

(except TSX 07 1 1648)

©]

2P
E4V D_C
TSX NANO [Jsce

i
EEE
[IPUT

ANALOG INPUT
rNALOG TOTSX

INPUT | (INO)

Q@@

I

(2)
Sensor

(1) Maximum 2 meters with @ 0.5 mm shielded cable
(2) Maximum 50 meters with @ 0.5 mm shielded cable (shielding connected at module end)

3.9-2 Connection with input 0 of the TSX Nano wired as source (negative logic)

11

—

TSX Q7 oo eeee

[
T

(except TSX 07 <1 1648)

g

©]

YR
;4V D_C
TSX NANO @SINK

iz
EEE
ToonenJ SCE

ANALOG INPUT
rNALOG TOTSX

INPUT | (INO)

Q@@

1

1
|
I

@1 |
Sensor J__

(1) Maximum 2 meters with @ 0.5 mm shielded cable
(2) Maximum 50 meters with @ 0.5 mm shielded cable (shielding connected at module end)
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3.10 Connection of analog outputs (TSX ASN  eee)

3.10-1 Connection with source output 0 of the TSX Nano (positive logic)

TSX 07 3¢ o012

DD ]

+ —

&)
24V DC
TSX NANO s
[OUTPUT| SCE
e |7 SINK
POWER

ANALOG OUTPUT

NALOG, TOTSX
QUTPUT| (OUT0)

|
——o+ 24 vDC
_QFG supply

/

@

Speed
controller

(1) Maximum 2 meters with @ 0.5 mm shielded cable
(2) Maximum 50 meters with @ 0.5 mm shielded cable (shielding connected at module end)

3.10-2 Connection with sink output O of the TSX Nano (negative logic)

TSX 07 3¢ «02/08

toe °

+ =
24V DC
@SCE
TSX NANO
foureu] SCE
e | SINK
POWER

ANALOG OUTPUT
rNALOG TOTSX

OUTPUT| (OUTO0)

O+

f?FG

24 VDC
supply

Q PP

@)

Speed
controller

(1) Maximum 2 meters with @ 0.5 mm shielded cable
(2) Maximum 50 meters with @ 0.5 mm shielded cable (shielding connected at module end)
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4 Special functions

4.1 RUN/STOPinput

Principle

The RUN/STOP input is used to start or stop program execution.

On abase or peer PLC, one of the first 6 inputs (%I10.0 to %10.5) may, after configuration
via the terminal, be assigned to this function.

When powering up the PLC, the PLC state is determined by the RUN/STOP input (if
configured) :

¢ PLC in STOP if the configured RUN/STOP input is at state 0,

e PLC in RUN if the configured RUN/STOP input is at state 1.

While the PLC is powered, a rising edge on the RUN/STOP input sets the PLC to RUN.
The PLC is forced to STOP if the RUN/STOP input is at 0. If the RUN/STOP input is at
state 0, a RUN command from a connected terminal will be ignored by the PLC.

Example : RUN/STOP switch on input %I0.3

Base PLC RUN/STOP
(1 ™
Cl0]1]2]3]4/5 RUN .
PLC status
[ ] sToP @——
1
( Status %I0.3

\ Cl0[1]2 L/ 0 1 I

4.2 PLCstatus (SECURITY)output

Principle

When the PLC is powered up and if no PLC error (blocking fault see appendix A.6)
is detected, the PLC status (security) outputchangesto 1. It can be used in safety circuits
external to the PLC, for example to control :

* The power supply to output devices.

¢ The PLC power supply.

On a base or peer PLC, one of the first 4 outputs (%Q0.0 to %Q0.3) may, after
configuration via the terminal, be assigned to the PLC status (SECURITY) function.

Base PLC

PLC running

PLC stopped or
faulty 1

\ \ Output %Q0.0
I C\ [1]2]

o —

Example : output %Q0.0
configuredas PLC status
(SECURITY) output

Appearance of a fault
which stops the PLC
Power supply to

outputs
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4.3 Latchinginputs

Principle

When a pulse is shorter than one scan and has a value greater than or equal to
100 ps (1), the PLC latches the pulse, which is then updated in the next scan.
Onabase PLC or peer PLC, each of the first 6 inputs (%10.0 to %I0.5) can be assigned

to the special latching function, after configuration via the terminal.

PLC scan

Physical input
status

Latching of
the physical
input status
for
processing
during next
scan

Key:

e | : read inputs
* P: process program
e O: update outputs.

Note :

-

Base PLC
(LI Iclofr[2slals[ [T T [TTTT
| |
\[LCloM2l [[TITTTTIITITITI
PLC PLC PLC PLC
scan scan scan scan
SIE|T|S|E|T|S|E|T E|T|S

A pulse which lasts longer than one scan will be treated as a pulse received at a standard input.

(1) see Part A, Section 1.7-1
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Specialfunctions 4

4.4  1/0 associated with fast counting

The TSX Nano PLC has a fast counter which can be used in three different ways :

e As a fast counter (maximum frequency 10 kHz).

« As afrequency meter (maximum frequency 10 kHz) which can, in particular, be used
to manage an analog input module.

e As a fast up/down counter (maximum frequency 1 kHz).

Sensors with transistor outputs must be used with up/down counter inputs %I0.0 and
%10.3. NOTE : Do not use sensors with contact outputs with fast counter inputs, as this
kind of sensor is susceptible to bounce because of low noise immunity.

(ILLLL L Iclo[1]2[3[4ls] [ [T T

Photoelectric Pulse

sensor S generator (3)

| |
\[CloM[ [TTTTTIITTTI

Base PLC
Functions Inputs Outputs
%I10.0 %I0.1 %I0.2 %I10.3 %l0.4 %0Q0.1%Q0.2

Upcounter ° _ _ _ _ - —
Counter set _ ° 1) _ _ _ _ _
(reset counter to 0)

Enable _ _ °@ _ _ - -
Downcounter _ _ _ ° _ _
Read the current value (2) _ _ _ _ ° 1) _ _
Threshold output 0 (HSC_Out) _ _ _ _ _ °@ _

Threshold output 1 (HSC_Out) _ ® (1)

The parameters of the function to be performed (fast counter, frequency meter, up/down
counter) are set using a special %FC function block (see Part B, Section 3.4-5).

(1) These I/O are optional. Their use must be declared during configuration.
(2) Available only for the up/down configuration of the fast counter.

4/3
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4.4-1 Use as a fast counter
The fast counter (FC) function enables counting at a maximum frequency of 10 kHz or
5 kHz depending on the selection made at configuration, with the possibility of counting
from 0 to 65535 pulses.

Set input to 0

’7 Counting input Enable counter input

Lol

(1) 50 ps at 10 kHz
100ps at 5 kHz (LLLLTIclopl2l TTTITTTITTT

|
[

|
[TIITTIITIITIIIT

Base PLC

|
\[c[ ]

[
FC threshold FC threshold
output 0 output T

The counter receives the pulses to be counted at the PLC input (%10.0). If the counter
enable input (%10.2) is configured and at state 1, the pulses are counted by the counter
and the counting value (current value FC.V) is constantly compared to 1 or 2 thresholds,
FC.S0 and FC.S1, which are defined during configuration but can be modified by the
program.

Resetting the counter to 0 is prompted by the rising edge of the input (%I10.1).
The FC threshold outputs 0 and 1 (%Q0.1 and %Q0.2) are controlled directly by the fast

counter (without waiting for the outputs to be updated at the end of the scan) according
to a matrix defined during configuration.

Output FC.V < thresh. 0 < thresh. 1 thresh.0 < FC.V <thresh. 1 thresh.0<thresh.1<FC.V
%Q0.1 Oorl Oorl Oorl
%Q0.2 Oor1l Oorl Oorl

Certain commands (enable counter, set current value to 0), can also be executed from
the user program via specific instructions.

Note :
The software setup (configuration, special instructions, etc) and the timing diagram of the fast
counter operation are explained in Part B, Section 3.4-5.
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4.4-2 Use as a frequency meter

The frequency meter function measures the frequency of a periodic signal (in Hz). The
principle of this measurement is to count the number of pulses received within a
specified period or time base. The frequency range which can be measured is from 1
Hz to 10 kHz. This function can, in particular, be used to manage an analog input
module.

Time base Measurement range Accuracy Refresh

100ms 10Hz-10kHz 0.1% for 10kHz 10 times per second
10% for 100Hz

1s 1Hz-10kHz 0.01% for 10kHz  Once per second

10% for 10Hz

D_l:l_l:l_ Counting input Enable counter input

Base PLC
”}HHHc\onHHHHHH}‘

|
[

| |
NENEREEEERNNEREREERER)Y

The frequency meter receives pulses at the PLC input (%I0.0). If the counter enable
input (%I0.2) is configured and at state 1, the pulses are accepted by the counter, and
the counting value (current value FC.V) changes throughout the measuring period. At
the end of the measuring period, the current value FC.V corresponding to the frequency
is read.

Input (%I0.1) resets the current value FC.V to 0.

This command (enable counter) can also be executed from the user program.

Note :

The software setup (configuration, special instructions) and the timing diagram of the frequency
meter operation are explained in Part B, Section 3.4-5.
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4.4-3 Use as an up/down counter

The fast up/down counter function counts up or down at a maximum frequency of 1 kHz
with the possibility of counting from 0 to 65535 pulses.

Set input Enable up/down counter input

Read current value input

‘ Base PLC
’U [[TTIclo[1[2[sla[ [TTTTTTI \}‘

|
| ’7 |
[l Rl TTTTTTITTTTITITTI

FC threshold| | FC threshold
output 0 output 1

The counter receives the pulses to be upcounted at PLC input (%10.0) and the pulses
to be downcounted at PLC input (%I10.3). If the up/down counting enable input (%10.2)
is configured and at state 1, the pulses are taken into account and the up/down counting
value (current value FC.V) is constantly compared to 1 or 2 thresholds FC.S0 and
FC.S1, which are defined during configuration and can be modified by the program.
Information about whether the counter is counting up or down is available as a bit in
system word SW111.

The preset value (0 to 65535), which is defined during configuration and can be
changed by the program, is loaded into the current value on the rising edge of the input
(10.1).

Input (%I10.4) is used to read the current value FC.V on the fly.

Fast counter threshold outputs 0 and 1 (%Q0.1 and %Q0.2) are controlled directly by
the fast up/down counter (without waiting for the outputs to be updated at the end of the
scan).

The user can program outputs to be either 0 or 1 under any of the following conditions :

- when FC.V < threshold 0 < threshold 1Z

- when threshold 0 - FC.V - threshold 1

- when threshold 0 < threshold 1 < FC.V
Certain commands (up/down counter enable, set) can also be executed from the user
program.

Note :
The software setup (configuration, special instructions) and the timing diagram of the up/down
counter operation are explained in Part B, Section 3.4-5.
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A

4.5 PULSE output : generating a pulse train

Onabase or peer PLC, output %Q0.0 can be assigned to the special "PULSE" function,
after configuration via the terminal.

Principle
A user-defined function block (%PLS) can generate a signal on output %Q0.0. This
signal has a variable period but has a constant duty cycle, or on to off ratio, of 50%

of the period.
1

%Q0.0

Constant on to off ratio

T/2 | T/2 T1/2 T1/2

Variable period
T T1

The value of period T and the number of pulses to be generated are defined by
configuration of function block %PLS.
Configuration parameters :
 Definition of the period : T = TB X %PLS.P
TB = time base
- 0.1 ms (can only be used on a PLC with transistor outputs)
- 10 ms (default value), or 1s.

%PLS.P = preset value :
-0 - %PLS.P < 32767 with TB = 10ms or 1s
-0 - %PLS.P <255 with TB = 0.1ms

« Definition of number of pulses to be generated on output %Q0.0 : %PLS.N
The number of pulses to be generated in period T (%PLS.N) can be limited or
unlimited depending on the definition made at configuration :
- 0 < %PLS.N <32767
- %PLS.N=0 : unlimited generation
Range of periods available include :
¢ 0.2 ms to 26 ms in steps of 0.1ms (38 Hz to 4.9 kHz).
e 20 ms to 5.45 min in steps of 10 ms
e 2st0 9.1 hours in steps of 1s.
Note :
The complete parameter setting for function block %PLS is defined in Part B, Section 3.4-4.

Example of application :  control of a stepper motor

Base PLC
ﬂ\ [ L[ Iclofr[2[3lals[ [ [ T [TTTT
%PLS [ Stepper
function Ampllfler/ itc?tgfer -
—block I ( translator
T
WA’ / |
Hc\?MzHHH\H\HHHH/ T
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46 PWM output : pulse width modulation

On abase or peer PLC, output %Q0.0 can be assigned to the specific "PWM" function,
after configuration via the terminal. This function, from TSX07 version V3 or later, can
be used, in particular, to manage analog output modules.

Principle

A user-definable function block (%0PWM) generates a signal on output %Q0.0. This
signal has a constant period with the possibility of varying the duty cycle, or on to off
ratio.

1
%Q0.0

50%T Variable on to off ratio 75%T

T Constant period T

The value of period T and the percentage of the signal at state 1 in a period are defined
in the configuration of function block %PWM :

Configuration parameters

* Definition of period : T = TB x %PWM.P
TB =time base :
- 0.1ms (obligatory for analog output management; can only be used on a PLC with
transistor outputs),
- 10ms (default value), or 1s

%PWM.P = preset value (not used for analog output management) :
-0 < %PWM.P - 32767 with time base 10ms or 1s
- 0 < %PWM.P - 255 with time base 0.1ms
« Definition of period ratio : %PWM.R = Tx(%PWM.R/100)
%PWM.R gives the percentage of signal at state 1 in a period (0<%PWM.R-100).
Range of periods available :
e 0.2 msto 26 ms in steps of 0.2 ms (38 Hz to 4.9 kHz).
e 20 ms to 5.45 min in steps of 10 ms.
e 2s1t09.1 hours in steps of 1s.

Note :
The complete parameter setting for function block %PWM is defined in Part B, Section 3.4-3.

Example of application :  control of a dimmer switch

Base PLC
ﬂ\ [[TTIclol1[2[3[als] [ [ TTTT1 \P

-1 %PWM [~

function ®
— block -
‘ [

WA’ / |
\\c\?\1\2\\\HHHHHHHb T
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5 Characteristics/Service conditions

5.1  Powersupply characteristics

PLC TSX Q7 e+ «208/28/48 TSX Q7 e #202/12/22
TSX AMN 4000 TSX AMN 4001

Power supply ~ (AC) — (DC)
Supply voltage nominal 100 to 240V 24V

limit 85 to 264V 19.2 to 30V
Frequency nominal 50/60 Hz _

limit 47 to 63 Hz _
Power required -30VA -14W
Inrush current typical 20 A for 1 ms, max 40 A
Integral and electronically — 24V /150 mA _
fused (1) sensor supply
Micro-cuts duration -10ms -1 ms

Primary/ground
isolation

2000V rms -50/60 Hz

2000V rms -50/60 Hz

IEC 1131-2 conformity

yes

yes

(1) Except on TSX 07 1 1648 PLC
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5.2 24VvDCand 115VACdiscrete input characteristics
PLC TSX Q7 e «02/08/12/22/28 TSX 07 <1 1648
Type — 24V (resistive) ~~ 115V (capacitive)
Logic (1) pos. (sink) neg. (source) _
Sensor common to + of supply to - of supply
Type isolated isolated
Nominal yojtage 24V 24V 110/120V
input
P current 7 mA (2) TmA (2) 10 mA
values
peak current _ 300 mA (at 110V)
on activation
sensor 19.2 to 30V (including ripple) _
supply
frequency _ _ 50 to 60 Hz
current limitation  N/A - 1.5A N/A
Input state 1 voltage 11V -8V *79V
limit
current  *2.5mA «[J2.50mA *4mAat79V
values
at 11V at 8V
state O voltage - 5V Vps - 5V - 20V
current - 1.2 mA - [L.20mA - 2mA
frequency _ _ _ 47 to 63 Hz
Filtering Otol 12 ms 12 ms 12 ms
default 1to0 12 ms 12 ms 12 ms
values 0tol 100ps/3ms/12ms on %I0.0 to %I0.7
program- 375ps/3ms/12ms on %I0.8 to %I0.13 _
mable 500 100ps/3ms/12ms on %I0.0 o %I0.7 _
values
375ps/3ms/12ms on %I0.8 to %I0.13 _
Isolation between input 1500V rms -50/60 Hz 1500V rms -50/60 Hz
and grounding
Compatibility 2-wireproxsens  yes (TE) yes (TE) yes (TE)
Compatibility 3-wire proxsens yes yes _
IEC 1131-2 conformity yes (type 1) N/A yes (type 1)

Note : The I/O characteristics are given for a load rate of 100% for PLCs with 10 I/0O and 80%
for PLCs with 16 and 24 1/O.
Load = total number of 1/O simultaneously at state 1 divided by total number of I/O in the PLC.

(1) Positive or negative logic depending on the wiring (sink or source).
(2) 13 mA (or -13 mA) for %ls.0 Input.
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Characteristics/Service conditions 5

5.3  24VvDCdiscrete transistor output characteristics

PLC TSX 07 e «» 02/08 TSX Q7 oo o0 12

Type Unfused Protected transistor
transistors (sink) transistors (source)

DC nominal voltage — 24V ~ 24V

load nominal current 05A 05A

tungsten filament lamp - 10W - 10w

Limit voltage (including ripple) 19.2 to 30V 19.2 to 30V

values  crrent 0.625 A at 30V 0.625 A at 30V

Logic negative (sink) positive (source)

Load common

to + of power supply

to - of power supply

Leakage current at state 0

- 1mA

- 1mA

Voltage drop at state 1

- 1.5V (for I = 0.5 A)

- 2V (for1 =0.5A)

Response time Otol - 1ms - 1ms
on resistive load 1to0 - 1ms -1ms
Electronic short-circuits none (fit 1 fuse per yes
fusing for and overloads output common)
overvoltages yes yes
polarity yes yes
inversions
Isolation betw. output and grounding 1500V rms -50/60 Hz 1500V rms -50/60 Hz

IEC 1131-2 conformity

N/A

yes

Notes :

* The I/O characteristics are given for a load rate of 100% for PLCs with 10 1/O and 80% for PLCs

with 16 and 24 1/0.

Load rate = total number of /0 simultaneously at state 1 divided by total number of I/O in the PLC.
« In this case, it is possible to place 2 outputs in parallel. A discharge diode must be placed on
the PLC output terminals (not the load terminals).
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5.4  Discreterelay output characteristics

PLC TSX Q7 e o0 22/28/48
Type relay
AC12 voltage ~ 24V ~ 48V ~ 110V ~ 220V
AC resistive current 2A (1) 1A (2) 1A (2) 1A (3)
load duty 1A (2) 05A (4) 0.5A (4)
AC15 voltage ~. 24V ~ 48V ~ 110V ~ 220V
inductive
(continuous) current 1A (1) 0.5A (3) 0.45A (3) 0.22A (3)
duty 0.5A (3) 0.2A (5) 0.090A (5) 0.045A (5)
DC12 voltage — 24V _ _ _
DC resistive
load duty current 1A(1) _ _ _
DC13 voltage -=24V _ _ _
inductive
duty current 0.4A (3) _ _ _
openin - 5ms
Response 2 E
time closing - 10 ms
Electronic overlogds r?\nd none, fit 1 fuse per I/O point or group of /O points
. short-circuits
fusing
for inductive ~~ none, an RC circuit or an MOV (ZNO) suppressor must be
overvoltages fitted in parallel with the terminals of each output
inductive — none, a freewheel diode must be fitted in parallel with the
overvoltages terminals of each output
Isolation  betw. output and grounding 1500V rms - 50/60 Hz
IEC 1131-2 conformity yes yes yes yes
Note :

The 1/O characteristics are given for a load rate of 100% for PLCs with 10 I/O and 80% for PLCs
with 16 and 24 1/0.
Load rate = total number of I/O simultaneously at state 1 divided by total number of I/O in the PLC

(1) 0.3 x 106 operations
(2) 0.5 x 106 operations
(3) 1 x 108 operations
(4) 2 x 106 operations
(5) 10 x 10° operations
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Characteristics/Service conditions

5.5 Characteristics of analog /0 (TSX AMN 4000/4001)

5.5-1 Characteristics of analog inputs

Input channel number

3 (high level)

input range

0..10 V, +/-10 V
0..20 mA, 4..20 mA

input impedance

100 KQ (1) 125 Q (2)

permissible voltage without damage

+/- 30 V as voltage
+/- 7.5 V as current

Resolution channel 0

11 bits (+ sign at +/- 10 V)
(4000 points at +/- 10 V)

channel 1

7 bits (+ sign at +/- 10 V) (4)
11 bits (+ sign at +/- 10 V) (3)
(250 points at +/- 10 V) (4)
(4000 points at +/- 10 V) (3)

channel 2

7 bits (+ sign at +/- 10 V)
(250 points at +/- 10 V)

Conversion conversion time

10 ms per channel

maximum error from 0 to 60 °C

0.5% of the full scale

Isolation voltage between supply

~~ 2000 V
and input channels
voltage between input channels ~~ 1000 V
resistance between input channels > 10 MQ

and ground

(1) Voltage type input

(2) Current type input

(3) Value when channels 0 and 1 are configured
(4) Value when channels 0, 1 and 2 are configured
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5.5-2 Characteristics of the analog output

Output channel number 1 (high level)
output range 0..10 V, +/-10 V
0..20 mA, 4..20 mA
load impedance >2KQ (1),< 600 Q (2)
permissible voltage without damage +/- 30 V (1), +/- 12 V (2)
Resolution 11 bits (+ sign at +/- 10 V)
(4000 points at +/- 10 V)
Conversion conversion time 2 ms
max. error from O to 60 °C as voltage 1% of the full scale
max. error from O to 60 °C as current 1.5% of the full scale
Isolation voltage between supply ~~ 2000 V
and the output channel
voltage between I/O channels ~~ 1000 V
resistance between output channel >10 MQ

and ground

(1) Voltage type output
(2) Current type output

5/6



Characteristics/Service conditions 5

5.6

Characteristics of analog I/0 (TSX AEN/ASN  ««)

5.6-1 Characteristics common to analog inputs and outputs

Supply nominal voltage — 24V
limit voltages — 21V to 30V
nominal current at 24V 104 mA
inrush current 10 A max
power drawn 25W

Isolation voltage between supply and ground ~~ 1500 V
voltage between input or output and ground ~~ 1500 V
resistance between supply and ground (500V) > 10 MQ
resistance between input or output and ground (500V) > 10 MQ

Shocks 300 m/s?, 3 shocks per axis, 3 axes

Vibrations 5 to 55Hz, 60 m/s2, 2 hours per axis, 3 axes

Climatic operating temperature 0to 60 °C

environment

storage temperature

-25°Cto 70 °C

relative humidity (without condensation) 45 to 85 %
altitude 0 to 2000m

5.6-2 Characteristics of analog inputs

Input channel number 1 (high level)
input impedance 6.6 MQ (1) 250 Q (2)
permissible voltage without damage +/- 16 V

Conversion conversion method U (V) OF (HZ)
resolution 10 bits or 12 bits
conversion time 125 ms (3) /500ms (4)

precision (full scale)

+/- 1% 0 to 60 °C

Frequency output

nominal voltage

— 24V

logic (switch on front panel)

positive or negative

protection against short-circuits no
Isolation voltage between input and frequency output ~~ 500 V
resistance between input and frequency output >10 MQ

(1) 0/10V and -10/+10V modules
(3) 10-bit resolution

(2) 4/20 mA module
(4) 12-bit resolution
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5.6-3 Characteristics of analog outputs

Output channel number 1 (high level)
output signal value 0/10 V
load impedance -5 KQ (1) -250 Q(2)
permissible voltage without damage +- 12V
protection against short-circuits yes (continuous)
Conversion conversion method F (Hz) O U (V)

resolution

8 bits

conversion time

from 0 to 90%: 500ms max

precision (full scale)

+/- 1% 0 to 60 °C

Frequency input

nominal voltage

= 24V

logic (switch on front panel)

positive or negative

input frequency 312.5 Hz
Isolation voltage between output and frequency input ~~ 500 V
resistance between output and frequency input >10 MQ

(1) 0/10V and -10/+10V modules

(2) 4/20 mA module
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Characteristics/Service conditions

5.7  Characteristics of the analog input (TSX 07 32/33 #¢28)

Analog input channel number 1 (high level)
input signal value 0/10V
value of an LSB 40 mV
input impedance 16 KQ<Z<18KQ
maximum permissible voltage without damage +/- 16 V
protection against polarity inversion yes
Conversion conversion method approx. successive
resolution 8 bits
conversion time 1 PLC scan
precision at full scale +/- 0.8% at 25 °C
+/- 2% at 60 °C
drift 0.34% /10 °C
repeatability at full scale +/-0.8% from 0 to 60 °C
Isolation between analog channel and CPU none
distance between sensor and analog input :
isolated sensor <30mwithshielded cable
non-isolated sensor <10mwithshieldedcable
Important

If using a sensor which is not isolated from ground, the - of the analog input must be

grounded.
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5.8 Service conditions

5.8-1 Standards
TSX Nano PLCs have been developed to comply with the main national and interna-
tional standards concerning electronic industrial control devices.

« Specific PLC requirements : operating
characteristics, filtering, ruggedness,
safety, etc.

EN61131-2 (IEC1131-2), CSA 22.2,
UL508

e Strict limitation of electromagnetic
interference generated : CE marking
(European Directives on Low Voltage
and EMC) EN 50081-1, class B.

e Electrical qualities and self-
extinguishing capability of insulating
materials : UL 746C, UL 94, etc.

e Marine certification
- Bureau Veritas
- DNV
- GL (pending)

5.8-2 Environment, normal service conditions

» Climatic environment, normal conditions

Temperature Humidity and altitude

Operating temperature : 0 to 60°C (1) Relative humidity : 5% to 95% (2)
(non-condensing)

Storage temperature : - 25°C to + 70°C Altitude : 0 to 2000 meters (0-6500 feet)

¢ Resistance to vibration :  In accordance with IEC 68-2-6 FC tests

» Resistance to mechanical shocks :  In accordance with IEC 68-2-27 EA tests

(1)0 to 55°C with TSX 07 e« ¢« 12 when mounting vertically (on vertical plane)
(2)45% to 85% for TSX AMN 4000/4001 modules
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6 Setup

6.1  Procedure for first power-up

The TSX Nano incorporates several self-
tests which continually monitor its
operation.

Theresults of these self-tests are displayed
on the front panel of the PLC. They can be
made more detailed using the terminal. (1)

The diagram below shows the procedure
for powering up the PLC for the first time.

M

Power up, outputs
E not powered

B (@_l F——

_| Ok F&f; _L_ NOK: ERR
ERR (see Part D,
@ v Section 1)

Initialize the PLC
2 memory

—— memory initialized by the terminal
OK: RUN

D

3 Possible actions

—— OK: RUN

v

Key
® LED flashing

‘ LED lit continuously

) L
TSX Nano PLC Termi-
nals
NOK: 1/0
(see Part D,
Section 1)

e Connect the terminal.

« Initialize PLC memory by clearing the
whole memory (Prg menu, Cir
command).

Note : if using the PL7-07 software, create a
"new" application and transfer it to the PLC.

» Check 1/O connections.

» Configure and enter the program from
the terminal :

- either directly into PLC memory (TSX
mode)

- or into terminal memory (FTX mode),
then transfer to the PLC memory.

* Setto RUN using RUN/STOP input%10.«
if it is configured, or via the terminal.

(1) herein, the word "terminal" represents the FTX 117 Handheld terminal, or a PC compatible
terminal or FTX 417/517/FT 2000 running PL7-07 PC programming software for the TSX Nano

PLC.
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Summary

h 4

Power up the PLC

Connect the terminal and clear
the PLC memory from the
terminal (FTX 117) or create a
new application

Configure the application and
enter program from the termi-
nal :

e either directly into PLC
memory (TSX)
« orintoterminalmemory (FTX)

A
No Enter program in
terminal memory
A\ 4

Yes

Transferthe programtothe PLC
RAM and EEPROM memories

Start program execution us-
ing the RUN command :

« either by the RUN/STOP in-
put if it has been configured

» or from the terminal, using
the RUN command

EEPROM
|

Cy

\ NENARRRAN IR ARER),

—

—_—

T
g ? g RUN/STOP

]

[

—
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Setup 6

6.2 Checkingthe I/O connections

* Principle
This check ensures that :
- data from the sensors is received by the inputs and transmitted to the processor,
- commands from the processor activate the outputs and are transmitted to the
corresponding output devices.

¢ Recommendations
In order to avoid any random movement of the machine, it is recommended that :
- power fuses be removed from the motor controls,
- pneumatic and hydraulic inputs be closed.

¢ Procedure

- Power up for the first time, as shown @
in Section 6.1. Ensure that the 1/O (ENARENNRRRNRRNNN) |:| o

LED is not lit continuously. ] ’
)N c =
- Leave the PLC in STOP. [ _I | 7
- Selectthe Data Editoronthe FTX 117 TSX Nano PLC Terminals

terminal, or the PL7-07 software.
- Change the state of system bit %S8 (PLC status output) to state 0.

- Check the inputs by activating each sensor :
- Check that the LED on the front panel for the corresponding input changes state.
- Check on the terminal screen that the corresponding bit also changes state.

- Check the outputs using the terminal :
- Force the bit corresponding to each output to state 1.
- Check that the LED for the corresponding output changes state, as well as the
associated output device.

- Using the terminal :
- Remove all forcing
- Reset system bit %S8 to state 1 (the outputs are set at 0).

Note :
If the PLC does not contain the application program, this entire procedure can be performed in
RUN. In this case, bit %S8 can remain at state 1 (default state).
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7 Addendum

7.1  Poweroutagesandreturns

» Characteristics of power outages
- If power outages < power supply ridethrough :normal execution of the program
- If power outages > power supply ridethrough : processor powered down with
context (data & program) saved.

» Warm restart : PLC restarts with the contents of the data memory in the same
state as at the time of the power outage.

List of possible causes :
- PLC restart after power outage > power supply ridethrough
- System hit %S1 set to state 1 by the program or the terminal

Consequences upon return of power

- System bit %S1 set to state 1,

- Non-forced inputbits setto state O (warning : settingto zero generates a "false"
rising edge on an input physically at 1 during a warm restart, see part B, section
2.1-2).

- AllI/O bits set to 0,

- All unsaved internal bits set to state 0 (%M64 to %M127)

- The state of the stored internal bits (%MO0 to %M63) and current values of the function
blocks (timers, counters, etc) are maintained

- The scan is restarted from the point at which it stopped at the power outage, without
updating the outputs at the end of the scan. The scan is then restarted normally :
Reading the inputs [ program processing [ updating the outputs and setting
system bit %S1 to 0

» Cold restart : PLC restarts with loss of contents of the data memory

List of possible causes :

- Back-up battery defective or absent

- System bhit %S0 set to 1 by the program or the terminal
- Initialization of the PLC by the terminal

Consequences upon return of power

- System bit %S0 set to state 1

- All internal bits, I/O bits and internal words set to state 0

- The current values of the function blocks (timers, counters, etc), registers and step
counters set to state 0

- Adjustment values modified by the terminal lost, and preset values defined during
configuration recalled

- System bits and words initialized (except %S0 and the schedule block (RTC) data)

- Forcing cancelled

- Grafcet reinitialized

- Scan restarted from the beginning :
Reading the inputs [ program processing [1 updating the outputs and setting
system bit %S0 to 0.

7/1



Programming example

In order to avoid automatic restarting of the control system when power returns, the
program below enables manual intervention by pressing a "RESTART" button and
keeps the outputs at 0 during the power outage. This program must be added to the

application program.

One part of this program must be at the start of the program (pre-processing zone), the
other part must be at the end of the program (post-processing zone).

%M10

(s)
%S9

\

%M10
|| > %L0
%L0

%M10 %I10.1 %M10

I | | | | (R !
End of program

000 LD %S0 If %S0 is at logic level 1: cold restart ) )
001 OR %S1  OR %S0 is at logic level 1: warm restart | /N Preprocessing
002 OR %M10 OR %M10 is at logic level 1: latch zone (start of
003 S %M10 Set internal bit %M10 to 1 program)
004 ST %S9 Set outputs to 0
005 JMPC %L0 Jump to label %LO if %S9 is at 1 -
006
007 L
. Application
program
098
099 = _
100 %LO: Jump address In post-processing
101 LD %M10 If %M10 is at logic level 1 zone (end of
102 AND %I0.1 AND input 1 is at logic level 1: RESTART | Program)
103 R %M10  Setinternal bit %M10 to O
104 END End of program —
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Addendum 7

A

7.2 Initializing the PLC

Presentation

The PLC can be initialized by the program by setting system bit %S0 to 1, which
corresponds to a cold restart (see Section 7.1). During awarm restart, it may be necessary
to initialize the PLC. The example below shows how this can be programmed. Initializa-
tion can also be requested from the terminal using the INIT command.

Programming

%S1 %S0
\ (
\ \

LD %S1 If%S1 =1 (warm restart), set %S0 to 1 toinitialize the PLC. These two
ST %S0 bits are reset to 0 by the system at the end of the following scan.

IMPORTANT
System bit %S0 must not be set to 1 for more then one PLC scan.

7.3  Savingthe program and data

Saving in the RAM

The user program and the data are contained in the PLC RAM memory. A battery in
the PLC provides the memory with independent operation for 30 days.

WARNING

This independence is ensured only if the battery is charged for at least 6
consecutive hours before the PLC is stopped.
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EEPROM storage

It avoids the risk of corrupting the program held in the RAM during a battery failure or
a power outage lasting longer than 30 days.

On power-up, the PLC checks the integrity of the programs contained in the RAM and
EEPROM memories. In the event of data corruption, the program contained in the
EEPROM is automatically transferred to the RAM if the MST option (autoloading) has
been selected (see part C, section 12.4).

(EEENENEEENNNNNNEEEEN)
PLC memory
prc'?:r'\;'m EEPROM
and data program
\NEEENEEEEERENNEREENN])

WARNING

Once the application has been debugged, itis advisable to transfer itinto EEPROM
with the MST option selected
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Preface

Part B contains 2 levels of information :

« That which enables the user to carry out simple functions. In this case, it is not
necessary to read the entire manual, only to refer to the paragraphs in gray.

* That which enables the user to carry out all the functions offered by the TSX Nano. In
this case, the whole manual is relevant.







1 Introduction

1.1 General

The control decisions a PLC makes are based on a control program that you create.
Creating a TSX Nano PLC control program consists of writing a program in one of the
control languages supported by the TSX07 PLCs.

The FTX 117 Handheld Terminal supports the List Programming Language. The List
language is a line based textual boolean-like language which can also process
numerical operations.

The PL7-07 PC Programming Software supports the List and Ladder programming
languages. Ladder is a rung-based graphical Boolean language. Further, PL7-07
allows you to reverse a program from Ladder to List and from List to Ladder.

In addition, the TSX Nano PLCs support Grafcet List instructions.

1.2 Instruction List (List or IL)

Program structure
A program in PL7 language comprises a series of instructions (up to 1000 instructions)
of various types.

Each program line has a number which is generated automatically, an instruction code
and a bit or word type operand.

Example of an instruction : 003 LD %I0.1
Number @ | ~ —— Operand

Instruction code

Ladder diagrams are a graphical means of displaying a logical expression. An
alternative to a Ladder diagram is an Instruction List program. An Instruction List
program is a series of logical expressions written as a sequence of Boolean
instructions. All the Boolean instructions, except for LOAD, STORE and NOT, operate
on two operands, which can be either TRUE or FALSE, and produce a single value,
either TRUE or FALSE.

As written, List instructions have only one explicit operand; the other is implied. The
implied operand is the Boolean accumulator. In operation, a List instruction performs
the specified operation on the contents of the accumulator and the operand, and
replaces the contents of the accumulator with the result.

For example, the operation AND %I1.2 would perform a logical AND between the
contents of the accumulator and Input 1.2, and would replace the contents of the
accumulator with that result.

1/1



The LOAD and STORE instructions either load the accumulator with the value of the
operand, or store the accumulator to the operand, respectively. The NOT instruction
has no explicit operands and simply inverts the state of the accumulator.

Instructions

Types of instruction Example

* Bit instruction 004 LD %M10 Reads internal bit %M10
* Block instruction 008 IN %TMO Starts the timer %TMO

* Word instruction 010 [%MW10 := %MW50+100] Addition

e Program instruction 015 SR5 Calls up subroutine #5
 Grafcet instruction 020 -*- Step #8
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Introduction

1

1.3 Grafcet

Grafcet is an analytical method which divides any sequential control system into a
series of steps, with which actions, transitions and conditions are associated.
PL7-07 language has specific Grafcet instructions.
Graphical Grafcet is not supported in PL7-07 PC Programming Software.

_k 3
-+ %M10 LD  %M10
# 4
L sH Tk
- %I0.7 %M15 LD %10.7
# 6
ko 5
4 | # 7
Graphical Grafcet Grafcet list
==
4
¥ML@
— | .
5
#—|
=
3
%1@.7
— #—]
=
7
¥MLS
— #—]

Graicet Ladder
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1.4 Ladderdiagrams

Ladder diagrams are similar to relay logic diagrams used to represent relay control
circuits. The main differences between the two are that in ladder programming, all
inputs are represented by contact symbols ( -| |- ) and all outputs are represented by
coil symbols (-( )-), and that numerical operations are included in the graphical Ladder
instruction set.

LS1 PB1 CR1
PB1 CRi1 M1 %|0_‘0 %|02 %|o4 %QO4
\
32 SS
/—E_SZ SS1 %I01 %10.7

The figure above illustrates a simplified wiring diagram of a relay logic circuit and its
equivalent Ladder diagram. Notice that in the Ladder diagram, all inputs associated
with a switching device in the relay logic diagram are shown as contacts. The M1 output
coil in the relay logic diagram is represented with an output coil symbol in the Ladder
diagram. The address numbers appearing above each contact/coil symbol in the
Ladder diagram reference the location of the external input/output connections to the
PLC.

Aprogramwritten in Ladder is composed of rungs—sets of specific graphical instructions
drawn between the two vertical outer bars representing potential—that are executed
sequentially by the PLC. The set of graphical instructions represent :

« the inputs/outputs of the PLC (push buttons, sensors, relays, pilot lights...),

¢ the functions of the PLC (timers, counters...),

» the math and logic operations (addition, division, and, xor...),

 the comparison operators and other numerical operations (A< B, A =B, shift, rotate...),
¢ the internal variables in the PLC (bits, words...).
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Introduction 1

These graphical instructions are arranged
with vertical and horizontal connections
leading ultimately to one or several out-
puts and/or actions.

A rung cannot support more than one
group of linked instructions.

For example, this Ladder program is com-
posed of two rungs.

%l10.1

|

%M42

%I10.3

—HH

%M42

(-

%Q1.2

(-

By

%MW22 := %MW15 + KW1 #
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1.4-1 Programming principles

Each Ladder rung is comprised of 7 lines and 11 columns and are organized in two
zones :

Lines
1 k- e )+‘
| | | | | |
2 }H i et (et o] [ 2l (el [t el el [ o (sl ),%‘
| | | | | 1l | | |
I m m m m | L It m | L i
3 }H F-todbdtedbdredb=1E Edbatedbathdbated a4 R4 ( )f‘
| | | | | |
. ! i
4 R i
| |
I J \‘\
5 | {4 = it
L It il
6 oA E- i
| |
n i
7| A L

Test Zone

Action Zone

-~}

* atestzone which contains the conditions that must be true for an action to take place.

° an action zone which contains the output or operation that results from the tests
connected to it.

IThe rung is visualized by a 7 by 11 programming grid, starting in the upper-leftmost cell
of the grid. You program test instructions, comparisons, and functions in the test zone
and these test instructions are left-justified. This test logic then provides continuity to
the action zone where you program coils, numerical operations and program flow
control instructions. These action instructions are right-justified. The rung is solved, or
executed (tests made and outputs assigned), from top to bottom and from left to right.

In addition to the rung, there is the Rung Header that appears directly above the rung.
The rung header is used to document the logical intent of the rung. The rung header
contains the rung number, any labels (%Li:) or subroutine declarations (SRi:), the rung
titte, and rung comments. For more information about the Rung Header, and its
correspondence to List Line Comments, see section B.1.4-3.
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Introduction 1

e Contacts, coils and program flow instructions

Contacts, coils and program flow (jump
and call) instructions occupy a single cell ;
of the programming grid. Function blocks, 1
Comparison blocks and Operate blocks !
occupy multiple cells.

¢ Function Blocks

Function blocks are placed in the Test
Zone of the programming grid. The block | N |

must appear in the first line; no Ladder Cyb-ilr %o eliiqpo+
instructions or lines of continuity may ap- } } }
pear above or below the Function block. s o
Ladder test instructions lead to the Func- = F’T D :}5?4 Fj}’
tion block's input side, and test instruc- H CU \ |
tions and/or action instructions lead from i
the block's output side. }

il

71

Function blocks are vertically orientated
and occupy 2 columns by 4 rows of the
programming grid.

e Comparison Blocks

Comparison blocks are placed in the Test
Zone of the programming grid. The block

: e L3l
may appear in any line or column in the [alle el mshies) Faitiesl e
testzone as long as the entire length of the i i )
instruction resides in the test zone. == =4 %MWO:%SWSO-I‘ | |-
il

Comparison blocks are horizontally ori-
entated and occupy 2 columns by 1 row of
the programming grid. e
FedE-te

[eyeE

s
T
——
s
T
PR 4‘, — =
s
T
I
Fr—— et — -t — 4

L
T

]

[

1
L
T
.

},4

1
L
T

]

¢ Operate Blocks

Operate blocks are placed in the Action
Zone of the programming grid. The block
may appear in any line in the action zone.
The instruction is right-justified; therefore,
it appears on the right and ends in the last
column.

ANTRET AT AT
|
il

|
%MW120 := SQRT (%MW15) [T

- e s s
B e e B R

}—i44~|44r44}—54

Operate blocks are horizontally orientated
and occupy 4 columns by 1 row of the
programming grid.
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1.4-2 Reversibility

In this manual, the term reversibility refers to the ability of the PL7-07 Programming
software for the TSX Nano to convert TSX Nano application programs from the Ladder
programming language to the List language and back again. PL7-07 programs can be
displayed in either format at will by setting a preference for one or the other. You can
even convert (reverse) individual Ladder rungs to List and back simply by selecting the
Tools menu’s Toggle Ladder/List option.

LD %05
%I0. %Q0.4
%l05 7 OR %I04

|
%104 \ ST %Q0.4

Understanding of reversibility lies in the relationship of the “Rung"—the collection of
Ladder programming instructions that constitute a logical expression—and the
“Sequence”—the collection of List programming instructions that accomplish the
same. The figure above demonstrates an example of a common rung in Ladder in any
user program. Next to the Ladder rung is the equivalent program logic expressed as
a List sequence.

In essence, the program you write, whether it be in Ladder or List, is kept internally as
List. PL7-07 takes advantage of the program structure similarities between the two
languages and uses this internal List image of your program to display it in the List /
Ladder Viewer and Editors as either a List program (its basic form), or graphically as
a Ladder diagram, depending upon the preference you select. Therefore, everything
created in Ladder can always be reversed to List, but some List logic may not reverse
to Ladder. To ensure reversibility from List to Ladder, it is important to follow the set of
List programming conventions contained in section B.1.4-3.
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1.4-3 Reversible List programming conventions

The structure of a reversible function block in List language requires the use of certain
specific instructions. They are :

- BLK which marks the block start, and defines the beginning of the rung and the start
of the input portion to the block,

- OUT_BLK (marks the beginning of the output portion of the block)

- END_BLK (obviously, marks the end of the block and the rung).

The use of the reversible Function Block instructions are not mandatory for a properly
functioning List program. For some instructions it is possible to program in List which
is not reversible. Non-reversible List programming is described in the Function Block
descriptions in section B2.2.

Another important convention is to avoid the use of certain List instructions, or certain
combinations of instructions and operands, which have no equivalence in Ladder. For
example, the N instruction (bit Not inverses the boolean accumulator) has no equiva-
lent Ladder instruction. In the table below is a listing of all the List programming
instructions that will not reverse to Ladder.

ListInstruction Operand Description

JMPCN %Li Jump Conditional Not

N none Negation (NOT)

ENDCN none End Conditional Not

XORN any XORN preceded by OR logic

Unconditional rungs also follow a List programming convention to ensure List-to-Ladder
reversibility. An unconditional rung is a rung in which there are no tests or conditions; the
output and/or action instruction(s) is (are) energized, or executed, all the time. The figure
below illustrates unconditional rungs and List equivalent sequences.

%Q0.4
/N LD 1
\/ ST %Q0.4
LD 1
4{ %MWS5 := 0 }7 [%MWS5 := 0]
IJMP  %L6
>>%L6
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Notice that each of the unconditional List sequences, with one exception, begin with
a Load instruction followed by the number 1. The combination sets the boolean
accumulator value to one, and therefore sets the coil (store instruction) to one and sets
%MWS5 to zero on every scan of the program. The exception is the unconditional jump
instruction. This List instruction is executed regardless of the value of the accumulator,
and consequently does not need the accumulator set to one as do the previous two
examples.

If you try to reverse a List program that is not completely reversible, the reversible
portions are displayed in Ladder and the irreversible portions are displayed in “Ladder
List Rungs.” Ladder List Rungs function just like a small list editor, enabling you to view
and modify the irreversible parts of a Ladder program.

Program Documentation

The List editor allows you to document your program with List Line Comments. These
comments may appear on the same line as programming instructions, or they may
appear on lines of their own. The Ladder Editor allows you to document your program
with Rung Headers found directly above the rung.

PL7-07 uses these comments for reversibility. When reversing a program from List to
Ladder, PL7-07 uses some of the List comments to construct a Rung Header. Simply,
the comments that may be found between List sequences are used for the Rung
Headers.

PL7-B87 - c™windows™.oven_3.pl7

File Edit Uiew Tools Configuration PLC Window Help
=] LIST Editor

5 I e O

---- (x THIS IS THE TITLE OF THE HEADER FOR RUNG @ =)

---- (x THIS IS THE FIRST HEADER COMMENT FOR RUNG 8 =)

---- (x THIS IS THE SECOND HEADER COMMENT FOR RUNG 8 =)
a LD v18.1

1 OR ¥18.8 (» THIS IS A COMMENT ON A LINE WITH 1
Z ANDN HMiB (n IT IS IGNORED WHEN REVERSING TO Lf
3 ST nin1

---- (» THIS IS THE HEADER TITLE FOR RUNG 1 »)
---- (x THIS RUNG CONTAINS A LABEL »)
----  (x THIS IS THE SECOND COMHENT FOR RUNG 1 =)
---- (x THIS IS THE THIRD COMMENT FOR RUN 1 »)
----  (» THIS IS THE FOURTH COMHENT FOR RUNG 1 =)
4 x5
5 LD #M181
6 [ #MUZB := “KHZ = 16 ]
----  (x THIS RUNG CONTAINS ONLY A HEADER TITLE »)
7 LD #08.5
8 OR 11,3
9 ORR »I8.13
18 ST Z08.5
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The first comment found on a line by itself (no instruction appears on the line with it)
after the end of a List sequence is used for the Rung Title. Then, the next comments
found after the first, if any exist, are used for the body of the rung. Once the body lines
of the header are occupied, then the rest of the line comments between List sequences
are ignored, as are any comments that are found on List lines that also contain List
instructions.

When a Ladder rung that contains a Rung Header is reversed to List, the Rung Header
documentation is inserted between the List sequences. Any labels or subroutine
declarations (%Li: or SRi:) are placed on the next line following the header, immediately
prior to the beginning of the List Sequence. If the rung that is reversed was originally
written in List, and there were comments ignored when List was reversed to Ladder,
those comments will reappear in the List Editor.

File Edit Uiew Tools Configuration PLC UWindow Help

e ; et it AT b i
RUNG 8 THIS IS THE: TITLE OF. THE HERDER FOR BUNG B ]
THIS (5 THE FIRST: HEADER . COMMENT. FOR RUNG A 1

#»I[B.1 «xMi@ »M1B1
- I >

“xI\e.8

Mk
RONG 1 | THIS IS THE HERDER TITLE FOR RUNG 1
25 THIS BUMG EENTHINS HLABEL

“MHZE = XKHZ2 * 16

THIS HUNG CONTRINS ONEY A HERADER TITLE
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2 Combinational and sequential instructions

2.1 Boolean processing

2.1-1 Definition of the main bit objects

* 1/Obits

The addressing system for these bits is described in Part A, Section 1.5.

These bits are the "logical images" of the electrical state of the I/O. They are stored in
the data memory and updated during each scan of the program logic.

¢ Internal bits
Internal bits are internal storage areas available to the user for program use.
Note : 1/O bits which are not in use cannot be used as internal bits.

e System bits

System bits %S0 to %S127 are used to monitor the correct operation of the PLC as well
as the correct execution of the application program. The role and use of these bits are
explained in Part B, Section 6.

« Step bits

Bits %X1 to %X62 are the bits associated with the Grafcet steps. Step bit Xiis setto 1
when the corresponding step is active, and to 0 when the step is deactivated.

 Bits extracted from words : see Section 3.1-1

List of operand bits

The following table lists all types of operand bits.

Type Address Maximum Write See
(or value) number access (1) Sect.

Immediate value Oorl _ _ _

Bits input %I0.i or %lI1.i (2) 28 no 1.5
output %Q0.i or %QL.i (2) 20 yes Pt. A

Bits internal %Mi 128 (3) yes

Bits system %Si 128 depends on i 5.1

Bits of Grafcet % Xi 62 yes 2.3-1
steps (5)

Bits of function %TMi.Q, %DRI.F, etc no (4) 2.2-1
blocks

Bits of reversible E,D,F,Q,THO,TH1 no 3.3-1
function blocks

Bits word extracts | varies varies varies 3.1-1

(1) Written by the program or in the Data editor by the terminal.

(2) Where i =0 for a PLC base or a peer PLC, i = 1 for an I/O extension, and j = I/O point. I/O bits
can be forced to 0 or 1 in the Data editor.

(3) The first 64 are saved in the event of a power outage.

(4) Except for %SBRi.j and %SCi.j, these bits can be read and written.
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2.1-2

Introduction to Boolean instructions

Boolean instructions can be compared to Ladder language elements.

Test elements , example : the LD (LOAD) instruction is equivalent to an open contact.

LD %I0.0

Contact closed when the
controlling bit is at state 1.

Action elements , example : the ST (STORE) instruction is equivalent to a coil.

ST %Q0.0

Boolean equation :
LD %lI0.0
AND %I0.1
ST %Q0.0

Rising and falling edge

The associated bit object takes the logical
value of the bit accumulator (result of
previous logic).

The Boolean result of the test elements is
applied to the action element.

Testinstructions can be used to detect rising or falling edges on the PLC inputs. An edge
is detected when the state of an input has changed between scan n-1 and the current
scan n, and it remains detected during the current scan.

The LDR instruction (R : Rising edge) is
equivalent to a rising edge detection
contact : %10.0

LDR %I0.0 4{"}7(1)

Rising Edge : detects a change of the
controlling input from 0 to 1.

The LDF instruction (F : Falling edge) is
equivalent to a falling edge detection
contact :

LDF %I0.0

%10.0

—N—@

Falling Edge : detects a change of the
controlling input from 1 to O.

time time
%I10.2 %I10.2

Boolean Boolean =~ > 1 PLC scan .
result 1 PLC scan time result time
Instructions on a rising or falling edge LD %MO . . .
apply to inputs %I, but it is possible to ANDT\I %M10 %oMO0 %M10 %M11
detect edges on any other bit (or Boolean ST % Mlol H/ <
result) using 2 internal bits. D O/OMO %MO %M10
Inthe example opposite, bit%M211 records ST 0/0M10 7
the rising edge of bit %MO. 0

(1) Positive transition sensing contact
(2) Negative transition sensing contact

(3) On a cold or warm restart, the application detects a rising edge even if the input has
remained at 1. This phenomenon can be masked by starting the program on LD %S1 and

ENDC instructions.
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Combinational and sequential instructions 2

Instruction format

The Boolean instruction described appears
) in bold type. Each equation is illustrated by
the corresponding Ladder diagram.

Load instructions LD, LDN, LDR, LDF
The instructions LD, LDN, LDR and LDF correspond respectively to the
open, closed, rising edge and falling edge contacts.

%I0.1 %Q0.3 LD 9%10.1
_| | ( )_ .
[ \ ST ©Q0.3
%MO %Q0.2 LDN 9%MO
— ( H ST %Q0.2
| \ 0 -
%I0.2 %Q0.4 LDR  %I0.2
_|pl ( )_ ST ZA)QOA
L %10.3 %Q0.5 ;2': gj'OQg .
| ( 0Q0.
—in| (-
CoE)[CPEET LD LDN LDR LDF
LD 0/1,%I,%Q,%M,%S,%X,%BLK .x,%*:XK,[ ¢
'> LDN | %1,9Q,%M,%S,%X,%BLK.X,%#:XK,[ 0T VOB 0.2 (a0
LDR | %I m
LDF % %Q0.3  |%Q02 |%Q0.4 |%Q0.5
List of operands Timing diagram
0/1 immediate value 0 or 1 The 4dt|m|nghd|agrams have been
%l PLC input %li] grouped together. = |
| S%Q PLC output %Qi.] LD —  Timing (_1|agram for
%M internal bit %Mi | the LD instruction
%S system bit %Si ——— Input state
%X step bit %Xi %I10.1
%BLK.xfunction block bit, e.g. %TMi.Q
%e:Xk word bit, e.g. %MWi:Xk |
[ Comparison expression Output state
e.g. [%6MWi<1000] %Q0.3
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2.1-3 Load instructions LD, LDN, LDR, LDF

The instructions LD, LDN, LDR and LDF correspond respectively to the open, closed,
rising edge and falling edge contacts (LDR and LDF only on PLC inputs).

%I0.1 %Q0.3
4{ | />7 LD %10.1
X M\ °/c\:402 ST  %Q0.3
G A LDN  %MO
md () ST  %Q0.2
%I10.2 %Q0.4 LDR %l0.2
—{P| { H ST %Qo.4
%10.3 %Q0.5 LDF  %I0.3
\ ( 0
—N| ( H ST  %Q0.5
LD
Code | Operand I
LD 0/1,%I1,%Q,%M,%S,%X,%BLK.x,%*:Xk,[| _|
LDN | %I,9Q,%M,%S,%X,%BLK.x,%*:Xk,[ %10.1
LDR | %I
LDF | %l
%Q0.3

2.1-4 Assignment instructions ST, STN, S, R

The instructions ST, STN, S and R correspond respectively to the direct, inverse, set
and reset coils.

%l01 %Q0.3 LD  %I0.1
— | O ST %Q03
%‘/’°-2 STN  %Q0.2
O S %Q0.4
%Q0.4
I 0
\s% LD 0/o|o.2
%10.2 °%Q0.4 R Q0.4
\ /
— | (R)—

Code | Operand

ST %Q,%M,%S,%BLK.x,%-*:Xk
STN | %Q,%M,%S,%BLK.x,%¢*:Xk

S %Q,%M,%S,%X,%BLK.x,%¢:Xk
R %Q,%M,%S,%X,%BLK.X,%¢*:Xk
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Combinational and sequential instructions 2

2.1-5 Logic AND instructions : AND, ANDN, ANDR, ANDF

These instructions perform a logic AND between the operand (or its inverse, or its rising
or falling edge) and the Boolean result of the preceding instruction.

[D  %I0.1
%10.1 %M1 %Q0.3 AND Ea
L (] | | & oo
%M2  %I10.2 %Q0.2 LD %M2
P % ANDN %I0.2
< ST  %Q0.2
%10.3  %I0.4 %Q0.4 LD  %I0.3
ANDR %10.4
i O s %Q0.4
%M3  %I0.5 %Q0.5 LD %M3
% }—{N}—@% ANDF %10.5
S %Q0.5
Code Operand AND ANDN ANDR ANDF
AND | 0/1,%!,%Q,%M,%S,%X,%BLK.x,%¢:Xk,[ I I I I
ANDN | %I,%Q,%M,%S, %X, %BLK.x,%¢:XK,[ %10.1 %M2 %10.3 %M3
0,
ANDR | %I 1 1N iy
ANDF | %I %M1 %10.2 %10.4 | %I0.5
4 M |
%Q0.3 |%Q0.2 |%Q0.4 |%Q0.5

2.1-6 Logic OR instructions : OR, ORN, ORR, ORF

These instructions perform alogic OR between the operand (the inverse of the operand,
a rising or falling edge) and the Boolean result of the preceding instruction.

%I10.1 %Q0.3 LD %01
| (% OR %M1
%M1 ST  %QO0.3
LD  %M2
%M2 %Q0.2 ORN  %I0.2
| ( H ST  %Q0.2
%I0.2 LD  %M3
s ORR  %I0.4
%M3 %Q0.4 S %Q0.4
| (S LDF  %I0.5
%I10.4 ORF  %l0.6
o %Q0.5 ° e
%I10.5 6Q0.
o o
%mrs_' OR ORN ORR ORF
N | | —
Code |Operand %10.1 %M2 %M3 %10.5
OR | 0/1,%I,%Q,%M,%S,%6X, %BLK.x,%sXk
ORN | %1,%0Q,%M,%S, %X, %BLK X, %9 Xk AT ' %|'°_2 ' %‘IO.4 IO
ORR | %I | I
ORF | %I
%Q0.3 |%Q0.2 |%Q0.4 |%Q0.5
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2.1-7 Exclusive OR instructions : XOR, XORN, XORR, XORF
These instructions perform an exclusive OR between the operand (the inverse of the
operand, a rising or falling edge) and the Boolean result of the preceding instruction.
The XOR instruction can be used in either of the following ways, for example :

Special cases
 In Ladder, XOR contacts cannot be
- situated at the left (first position) of a

rung,
- placed in parallel.

For example, attempting to enter the fol-
lowing rung will generate a Validation
error.

LD %10.1
%I10.1 %M1 %Q0.3 XOR %M1
| |XOR| < ST  %Q0.3
%10.1 %M1 %Q0.3 ;'i“;/,‘il'oé/%m
/ OR( %M1
%M1 %I10.1 ANDN %I10.1
/ )
ST %Q0.3
XOR
Code [Operand 10 1|
XOR [ 9%1,%Q,%M,%S,%X,%BLK.x,%¢: Xk .
XORN | %1,%Q,%M, %S, %X, %BLK.x, %¢: Xk
XORR [ %l %M1
XORF [ %l Il
%Q0.3

| °/0‘M13 %I11.5

‘ }xon}

2K

%M10
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Combinational and sequential instructions 2

2.1-8 NOT instruction: N
This instruction negates the Boolean result of the preceding instruction.

LD %10.1
OR %M2
ST %Q0.2
N
AND %M3
ST %Q0.3
|
%I10.1
Code | Operand
N
= %M2
Note : The instruction N is not reversible.
%Q0.2
|
%M3
|
%Q0.3

2.1-9 Using parentheses

The instructions AND and OR can use parentheses. These parentheses are used for
parallel branches in Ladder diagrams. Opening the parenthesis is associated with the
AND or OR instruction. Closing the parenthesis is an instruction, which must be given
for each open parenthesis.

Example : AND(...)

%I0.0  %I0.1 %Q0.0 /';ﬁD Zf’:g-fl’
/ 01U,

\ || \% OR  %l0.2

%10.2 ST %Q0.0

— LD  %I0.0

%10.0  %I0.1 %Q0.0 AND( 9%I0.1

\ | | [ OR  %l0.2
4{ \ | \% )

0y
%10.2 ST %Q0.0
Example : OR(...)

LD %10.0

%IOO %10.1 %Q0.0 AND  %I0.1

OR(  %I0.2

%I02 %10.3 AND  %I0.3
)

ST %Q0.0

27




The following modifiers can be assigned to parentheses N, F, R or [ :
* N negation, for example, AND(N or OR(N

* R rising edge, for example, AND(R or OR(R

« F falling edge, for example, AND(F or OR(F

* [ comparison, see Section 3.1-5

LD %I0.0

%10.0 %l0.1 %Q0.0 AND  %I0.1

— OR(N %10.2

%102 %10.3 AND  %I0.3
dan )

ST %Q0.0

Nesting parentheses
It is possible to nest up to 8 levels of parentheses.

Example
LD %I0.0
AND( %I0.1
%10, %I0. %Q0.0
4"0}0 A}"O}‘ > OR(N %I0.2
%l0.2 %M3 \ AND — %6M3
= ;
ST  %Q0.0
Example
LD %I10.1
%l0.1  %l0.2 %I0.3 %I10.4 %Q0.0 AND( %I0.2
— — AND  %10.3
OR( %I0.5
%l0.5 %I0.6 AND  %I0.6
’—{ )
AND  %10.4
%l10.7 %IO0.
%10.7 %l0.8 OR(  %l0.7
AND  %10.8
)
)
ST %Q0.0
Note :

* Each parenthesis opened must be closed again.

* %Li: labels and SRi: subroutines must not be placed in expressions between parentheses. This
is also the case for jump (JMP), subroutine (SRi) and function block instructions. See Section
2.4-3 for more information.

* Assignment instructions ST, STN, S and R must not be programmed between parentheses.
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Combinational and sequential instructions 2

2.1-10 Instructions MPS, MRD, MPP

These 3 types of instruction are used to process the routing to the coils.

They use a temporary storage area referred to as the stack which can store up to 8
Boolean expressions.

The instruction MPS pushes the accumulator (the result of the last logical operation)
onto the top of the stack and shifts the other values towards the bottom of the stack.
The instruction MRD reads the top of the stack into the accumulator.

The instruction MPP pops the top of the stack into the accumulator and shifts the other
values towards the top of the stack.

Examples :
%10.0 %MO  %lI0.1 %Q0.0 LD  %I0.0
% H }7< % AND  %MO
PS t %10.2 %Q0.1 X'ES 9%10.1
H — ST %Q0.0
MRD ¢ | %l0.3 %Q0.2 MRD

AND  %10.2
H }—< % ST  %QO0.1
MPP %10.4 %Q0.3 MRD
\(H < % AND  %I0.3
ST  %Q0.2

MPP
AND  %I0.4
ST %Q0.3
%l0.0 %l0.1 %l0.3 %Q0.0 TR
01U.
| — MPS . l:l:l:l:l:l:l:le
%MO AND  %I0.1 >
MPS S T
BT
AND( %I0.3
%M1 %001% OR  %MO
)
%104 Bl I\SII-II;P 0o |
l:l:l:l:l:l:l:l
ANDN %M1 _]
%M10 %003 ST %Q0.L
MRD
}—<% AND  %I0.4 SERNREEI

ST %Q0.2° -

MPP BTTTTTTT]
AND  %M10 _

ST %Q0.3

Note : These instructions cannot be used within an expression between parentheses.
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2.1-11 Special Ladder instructions OPEN and SHORT

As a special convenience to the Ladder programmer, there are two instructions that can
be used during, debugging and troubleshooting. The OPEN and SHORT instructions
provide a means to alter the logic of a rung by either "shorting" the continuity of the rung
(allow continuity to pass through the rung regardless of the result of the last logical
operation), or by "opening" the continuity of the rung (discontinuing the continuity of the

rung regardless of the result of the last logical operation).

In list, the OR and AND instructions accompanied by the immediate values of 1 and 0

are used to create the OPEN and SHORT instructions.

%I10.1 %M3 %Q0.1
PR ()
%Q1.5
%MP %?LG
‘ \

LD
OR
ANDN
AND
ST
LD
OR
ST

%10.1
%Q1.5
%M3
0
%Q0.1
%10.9
1
%Q1.6
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Combinational and sequential instructions 2

2.2  Standardfunction blocks
2.2-1 Bitand word objects associated with standard function blocks
Function blocks set up bit objects and specific words.

« Bit objects :

These correspond to the block outputs.

They can be accessed by Boolean test %Ci
instructions. —R E —
They can be addressed :

- either directly (for example, LD E) if they —|s

are wired to the block in reversible Q%‘ij}g,ggg B
programming (see Section 2.2-2), _{cu

- or by specifying the block type (for

example, LD %Ci.E), A ecp F -
Inputs can be accessed in the form of

instructions. Up/down counter block

* Word objects :
These correspond to :
- The block configuration parameters. These parameters can be accessed (for
example, preset parameter) or not (for example, time base) by the program.
- The current values (for example, %Ci.V current count value).

List of function block bit and word objects which can be accessed by the program

Standard Associated words and bits Address  Write See
function blocks access Sect.
Timer Word Current value %TMi.V no 2.2-3
%TMi (i=0 to 31) Preset value %TMi.P yes
Bit Timer output %TMi.Q no
Up/down Word Current value %Ci.V no 2.2-4
counter Preset value %Ci.P yes
%Ci (i=0 to 15) Bit Underflow output (empty) %Ci.E no
Preset output reached %Ci.D no
Overflow output (full) %Ci.F no
LIFO/FIFO registerWord Access to register %Ri.l yes 2.2-5
%Ri (i= 0 to 3) Register output %Ri.0O yes
Bit Register output full %Ri.F no
Register output empty %Ri.E no
Drum controller  Word Current step number %DRi.S  yes 2.2-6
%DRi (i=0 to 3) Bit Last step equals current step %DRIi.F yes
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2.2-2 Programming principles
Standard function blocks can be programmed in two different ways :

Using function block instructions (for example, BLK %TM2): This reversible method
of programming for the Ladder language enables operations to be performed on the
block in a single place in the program.

Using specific instructions (for example, CU %Ci): This non-reversible method
enables operations to be performed on the block's inputs in several places in the
program (for example, line 100 CU %C1, line 174 CD %C1, line 209 LD %C1.D).

Principles of reversible programming of standard function blocks
This programming uses instructions BLK, OUT_BLK and END_BLK.
BLK indicates the start of the function block.

OUT_BLK is used to directly "wire" the block outputs.

END_BLK indicates the end of the block.

Example of reversible programming with wired outputs

BLK %C8
%I1.1 [“o,cq LDF %l1.1
NF R E [ R Input processing
s %M1 %Q0.4 LD %I1.2
%2 %Mo | ABdY, B | | AND %MO
e cy
OUT BLK  _
— cD F - LD D Output
AND %M1 processing
ST %Q0.4|
END_BLK

Example of reversible programming without output wiring

%I1.1 %C8 BLK %C8
0,
N}i . Er :iDF lL.1 Input processing
s
%I1.2 %MO | ADJY DL LD  %I1.2
# ’7 i P 9999 AND  %MO
CuU —
e I END_BLK
LD %C8.D Output
%C8.D %M1 %Q0.4 AND %M1 processing

H | O}f | | 57 weos

Note :

Only test and input instructions on the relevant block can be placed between BLK and OUT_BLK
instructions (or between BLK and END_BLK, when OUT_BLK is not programmed).
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2.2-3 Timer function blocks %TMi

There are 3 types of timer :

%TMi e TON:thistype Qf timeris u.sed to contrpl
- al— on-delay actions. This delay is
programmable and can be modified via

the terminal.
PéﬂE,,Tiﬁ" e TOF:thistype oftimeris used to control
ADJY off-delay actions. This delay is
ol HP ek programmable and can be modified by

the terminal.
Timer block « TP :this type of timer is used to create a
pulse of an exact duration. This dura-

tion is programmable and can be modi-
fied by the terminal.

Note : The larger the preset value, the

greater the timer accuracy.

Characteristics

Timer number %TMi 0to 31
Type TON  on-delay (by default)
TOF - off-delay
TP * pulse (monostable)
Time base B 1min (by default), 1s, 100ms, 10ms, 1ms (for
TMO and TM1).
Current value %TMi.V Word which increments from 0 to %TMi.P

when the timer is running. Can be read and
tested but not written by the program (1).

Preset value %TMi.P 0-%TMi.P-9999. Word which can be read,
tested and written by the program. It is set to
9999 by default. The length or delay gener-
ated is equal to %TMi.P x TB.

Data Editor Y/N Y : possibility of changing the preset value
%TMi.P in the Data editor.
N : no access in the Data editor.

Setting input IN The timer starts on a rising edge (type TON
(or instruction) or TP) or a falling edge (type TOF).
Timer output Q Associated bit %TMi.Q is set to 1 depending

on the function performed : TON, TOF or TP

(1) %TMi.V can be modified via the terminal in the Data editor.
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Using as an on-delay timer : type TON

o | [] [ ]

%TMi.P
%TMi.V

Using as an off-delay timer : type TOF

%TMi.P
%TMi.V

Using as a pulse : type TP

%TMi.P
%TMi.V

(1) Or activation of instruction IN.
(2) Or deactivation of instruction IN.

Thetimeris started on arising edge atinput
IN (2) : the current value %TMi.V increases
from 0to % TMi.P by one unitfor each pulse
of the time base TB. Output bit %TMi.Q
changes to 1 when the current value
reaches %TMi.P and then remains at 1 as
long as a falling edge is not detected at
input IN.

When a falling edge is detected at input IN
(2), the timer is stopped, even if the timer
has not reached % TMi.P.

The current value %TMi.V is set to 0 on a
rising edge atinput IN (1) (even if the timer
is still running). When the falling edge is
detected on input IN, the timer is started.
The current value increases to %TMi.P by
one uniton each pulse of the time base TB.
Output bit %TMi.Q changes to 1 when a
rising edge is detected on input IN and the
timer returns to 0 when the current value
reaches %TMi.P.

Thetimeris started on arising edge atinput
IN (1) : the current value %TMi.V is setto O
if the timer has not already started.

The current value increases from 0 to
%TMIi.P by one unit for each pulse of the
time base TB. Output bit %TMi.Q changes
to 1 when the timer is started and returns
to 0 when the current value reaches
%TMi.P.

This timer cannot be reset. Once % TMi.V
equals %TMi.P, and the input IN is at state
0, %TMi.V is set to 0.
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Programming and configuration

Timer function blocks are programmed in the same way irrespective of how they are
to be used. The function TON, TOF, and TP is selected during configuration.

Reversible programming
BLK %TM1
%10.1 — %Q0.3 D 0/°| 01
IN Q ( N L1
TYPE TON OUT_BLK
ADJY LD Q
%TMi.P 9999 ST %Q0.3
END_BLK
Configuration Non-reversible programming
The following parameters mustbe entered
during configuration. LD %10.1
o ;rB : 1_m|r1, 1s, 100ms, 10ms or 1ms LD %TM1.Q
e Adjust: Y or N

Special cases

o Effect of a cold restart:  (%S0=1)
- forces the current value to O,
- sets output %TMi.Q to O,
- the preset value is reset to the value defined during configuration.

« Effect of a warm restart: (%S1=1) has no effect on the current value of the timer,
nor on the preset value. The current value does not change during a power outage.

» Effect of a PLC stop : stopping the PLC does not freeze the current value.

« Effectofaprogramjump: Jumping over atimer block does not freeze the timer. The
timer will continue to increment untilitreaches the presetvalue (%TMi.P). Atthat point,
the done bit (% TMi.Q) assigned to output Q of the timer block changes state; however,
the associated output wired directly to the block output is not activated and not
scanned by the PLC.

¢ Testing of bit %TMi.Q (done bit) : itis advisable to test bit % TMi.Q only once in the
program.

« Effect of master control relay instructions MCS/MCR : atimer block programmed
between 2 MCS/MCR instructions is reset when the MCS instruction is active.

« Effectof modifying the preset%TMi.P:  modifying the presetvalue via aninstruction
or by adjusting it only takes effect when the timer is next activated.
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Timers with 1ms time base (TSX Q7 3¢ seee)

The 1 ms time base is only available on %TMO and %TM1 timers.
If the user so requires, he can use the four system words %SW76, %SW77, %SW78
and %SW79 as "hourglasses".

These four system words are decremented individually by the system every millisecond
if they have a positive value

Multiple timing can be achieved by successive loading of one of these words or by
testing the intermediate values.

If one of these four system words is less than 0, it will not be modified, a timer can thus
be "frozen" by setting corresponding bit 15 to 1 then "unfrozen" by resetting it to O.

Programming example

LDR%I0.1 (launching the timer on rising edge of %I10.1)
[20SW76:=XXXX] (XXXX= required value)
LD %l0.2 (optional management of the freeze, input 10.2 freezes)

ST %SW76:X15
LD [%SW76=0] (timer end test)

ST %MO
%10.1
4{ F’} %SW76:=XXXX |>
%I10.2 %SW76:X15

(
\ \

4 %SW76=0 < %

2/16



Combinational and sequential instructions 2

2.2-4 Up/down counter function blocks %Ci

: The up/down counter function block is
L used to up/down count events. These

—R E |- . .
two operations can be simultaneous.
s
ADJY D |
%Ci .P 9999
_| cu
— co F =

Up/down counter
block

Characteristics

Counter number %Ci Oto 15

Current value %Ci.V Word incremented or decremented
according to inputs (or instructions) CU
and CD.

Can be read and tested but not written by
the program (1).

Preset value %Ci.P 0-%Ci.P-9999. Word can be read, tested
and written (default value: 9999).

Edit via terminal Y/N Y : possibility of modifying the preset value

in the Data editor. N : no access in the Data
editor.

Reset input (or R At state 1 : %Ci.V = 0.

instruction)

Set input S At state 1: %Ci.V = %Ci.P.

(or instruction)

Upcount input Cu Increments %Ci.V on a rising edge.

(or instruction)

Downcount input CD Decrements %Ci.V on a rising edge.

(or instruction)

Underflow output E (Empty) The associated bit %Ci.E=1, when

downcounter %Ci.V changes from 0 to
9999 (set to 1 when %Ci.V reaches 9999,
and reset to 0 if the counter continues to
count down).

Preset output D (Done) The associated bit %Ci.D=1, when
reached %Ci.V=%Ci.P.
Overflow output F (Full) The associated bit %Ci.F =1 when %Ci.V|

changes from 9999 to 0 (set to 1 when
%Ci.V reaches 0, and reset to O if the
counter continues to count up).

(1) %Ci.V can be modified via the terminal in the Data editor.
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Operation

* Upcount: when arising edge appears at the upcounting input CU (or instruction CU
is activated), the current value is incremented by one unit. When this value is equal
to the preset value %Ci.P, the "preset reached" output bit %Ci.D assigned to output
D changes to state 1. Output bit %Ci.F (upcount overflow) changes to state 1 when
%Ci.V changes from 9999 to 0, and is reset to O if the counter continues to count up.

* Downcount : when a rising edge appears at the downcounting input CD (or
instruction CD is activated), the current value %Ci.V is decremented by one unit.
Output bit %Ci.E (underflow) changes to state 1 when %Ci.V changes from 0 to 9999,
and is reset to O if the counter continues to count down.

» Up/downcount: touse boththe upcountand the downcountfunctions simultaneously
(orto activate instructions CD and CU), the two corresponding inputs CU and CD must
be controlled. These two inputs are then scanned in succession. If they are both at
1, the current value remains unchanged.

¢ Reset: whenthisinputis setto state 1 (or the instructionis activated), the currentvalue
%Ci.V is forced to 0, outputs %Ci.E, %Ci.D and %Ci.F are at 0. The reset input has
priority.

e Set: ifinput S is at state 1 (or instruction S is active) and the reset input is at state 0
(or instruction R is inactive), the current value %Ci.V takes the value of %Ci.P, and
output %Ci.D is setto 1.

Special cases

« Effect of a cold restart :  (%S0=1)
- The current value %Ci.V is set to zero.
- Output bits %Ci.E, %Ci.D and %Ci.F are set to zero.
- The preset value is initialized with the value defined during configuration.

« Effect of a warm restart (%S1=1), ofa PLC stop:  this has no effect on the current
value of the counter (%Ci.V).

« Effect of modifying the preset %Ci.P:  modifying the preset value via an instruction
or by adjusting it takes effect when the block is processed by the application
(activation of one of the inputs).
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Configuration and programming

Example : Count a number of items up to 5000. Each pulse on input %I1.2 (when
internal bit %MO is at 1) increments the upcounter %C8 up to its final preset value (bit
%C8.D=1). The counter is reset by input %I1.1.

Configuration
%I1.1 o8 The following parameters mustbe entered

4{ F R E | during configuration :

* %Ci.P, set to 5000 in this example

%l1.2 %MO | ARJY DL « Adjust : Y
T

— cp F
%C8.D %Q0.0

H (H

Reversible programming Non-reversible programming

BLK %CS8 LD %I1.1

LD %I11.1 R %C8

R LD %I1.2

LD %I11.2 AND %MO

AND %MO CU %C8

CuU LD %C8.D
END_BLK ST  %Q0.0

LD %C8.D

ST  %Q0.0
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2.2-5 LIFO/FIFO register function blocks %Ri

—R

-0

%Ri

TYPE FIFO

F L

Register block

Aregister isamemory block whichis used
to store up to 16 words of 16 bits in two
different ways :

* Queue (FirstIn, First Out) known as FIFO.
* Stack (Last In, First Out) known as LIFO.

Characteristics

Register number %Ri Oto3
Type FIFO Queue (default selection)
LIFO Stack

Input word %Ri.| Register input word. Can be read, tested
and written.

Output word %Ri.O Register output word. Can be read, tested
and written.

Storage input I (In) On a rising edge, stores the contents of

(or instruction) word %Ri.l in the register.

Retrieval input O (Out) On a rising edge, loads a data word into

(or instruction) word

Reset input R (Reset) %Ri.0.

(or instruction) At state 1 initializes the register.

Empty output E (Empty) The associated bit %Ri.E indicates that
the register is empty. Can be tested.

Full output F (Full) The associated bit %Ri.F indicates that

the register is full. Can be tested.
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Operation
FIFO (First In, First Out)

The first data item entered is the first to be
retrieved.

When a storage request is received (rising edge
at input | or activation of instruction I), the con-
tents of input word %Ri.l (which have already
been loaded) are stored at the top of the queue
(Fig a).

When the queue is full (output F=1), no further
storage is possible.

When aretrieval request is received (rising edge
at input O or activation of instruction O) the data
word lowest in the queue is loaded into output
word %Ri.O and the contents of the register are
moved down one place in the queue (Fig b).
When the register is empty (output E=1) no
further retrieval is possible. Output word %Ri.O
does not change and retains its value.

The queue can be reset at any time (state 1 at
input R or activation of instruction R).

LIFO (Last In, First Out)

The last data item entered is the first to be
retrieved.

When a storage request is received (rising edge
at the input or activation of instruction I), the
contents of input word %Ri.l (which have al-
ready been loaded) are stored at the top of the
stack (Fig c).

When the stack is full (output F at 1), no further
storage is possible.

When aretrieval request s received (rising edge
at input O or activation of instruction O) the
highest data word (last word to be entered) is
loaded into word %Ri.O (Fig d).

When the register is empty (output E=1), no
further retrieval is possible. Output word %Ri.O
does not change and retains its last value. The
stack can be reset at any time (state 1 atinput R
or activation of instruction R). The element indi-
cated by the pointer is then the highest in the
stack.

Example :

Storage of the contents of %Ri.l at the

top of the queue.

IR —

%Ri.l

20

@

80

50

Retrieval of the first data item which is

then loaded into %Ri.O

20
80

(b)
%Ri.0

50 —%

50

20
80

Example :

Storage of the contents of %Ri.l at the

top of the stack.

I —

%Ri.

20

(©

80

50

Retrieval of the data word highestin the

stack.
%Ri.0
20 20
80 (d)
50
80
50
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Special cases

» Effect of a cold restart : (%S0=1) initializes the contents of the register Output bit
%Ri.E, assigned to output E, to 1 and resets %Ri.l and %Ri.O words to 0.

» Effectofawarmrestart: (%S1=1) has no effect on the contents of the register, nor

on the state of its output bits.

Programming and configuration

%R2
AR E |-
%M1
H |
TYPE FIFO
%10.3
(o}

%10.3 %R2.E

ﬂ }—M—| %MW20:=%R2.0 |

%l10.2 %R2.F

— /- %Rat=%mwas |

%M1

(H

Reversible program

The programming example shows word
%MW34 being loaded into %R2.1 at the
storage request %I0.2, if register R2 is not
full (%R2.F=0). The storage requestin the
register is made by %M1. The retrieval
requestis made by input%10.3 and %R2.0
is loaded into %MW?20 if the register is not
empty (%R2.E=0).

Configuration

The only parameter which must be entered
during configuration is the type of register :
FIFO (default) or LIFO.

Non-reversible program

BLK %R2
LD %M1
[

LD  %I0.3
o)

END_BLK
LD  %I0.3

ANDN %R2.E
[%MW20:=9%R2.0]
LD  %I0.2
ANDN %R2.F
[%R2.1:=%MW34]
ST %M1

LD %M1
I %R2
LD  %I0.3
(0] %R2

ANDN %R2.E
[%MW20:=%R2.0]
LD  %I0.2
ANDN %R2.F
[%R2.1:=%MW34]
ST %M1
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2.2-6 Drum controller function block %DRi

The drum controller operates on a similar
%DRi principle to an electromechanical drum
— R F |- controller, which changes step according
to external events. On each step, the high
point of a cam gives a command which is

B gTEPSS executed by the control system. In the
case ofadrum controller, these high points
are symbolized by state 1 for each step

Drum _ controller and are assigned to output bits %Qi.j or

block internal bits %Mi, known as control bits.

Characteristics

Number %DRi 0Oto3
Current step %DRi.S 0-%DRIi.S-7. Word which can be read
number and tested.

Can only be written in the program with a
decimal immediate value.

Number of steps 1 to 8 (default)

Return to step 0 R (RESET) At state 1, sets the drum controller to step

input (or instruction) 0.

Advance input U (UP) On a rising edge, causes the drum

(or instruction) controller to
advance by one step and updates the
control bits.

Output F (FULL) Indicates that the current step equals the

last step defined. The associated bit
%DRi.F can be tested (for example,
%DRi.F=1 if %DRi.S= number of steps
configured - 1).

Control bits Outputs or internal bits associated with
the step (16 control bits) and defined in
the Configuration editor.
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Operation

The drum controller comprises :

» Amatrix of constant data (the cams) organized in 8 steps (0to 7) and 16 data bits (state
of the step) arranged in columns numbered O to F.

 Alist of control bits (1 per column) corresponding either to outputs %Q0.i or %Q1.i,
ortointernal bits %Mi. During the current step, the control bits take on the binary states
defined for this step.

The table below summarizes the main characteristics of the drum controller.

Column 0 1 2 D E F
Control bits %Q0.1 %Q0.3 %Q1.5 %Q0.6 %Q0.5 %Q1.0
Step 0 0 0 1 1 1 0
Step 1 1 0 1 1 0 0
Step 5 1 1 1 0 0 0
Step 6 0 1 1 0 1 0
Step 7 1 1 1 1 0 0

In the example above, step 5 is the current step, control bits %Q0.1; %Q0.3 and %Q1.5
are set to state 1; control bits %Q0.6; %Q0.5 and %Q1.0 are set to state 0.

The current step number is incremented on each rising edge at input U (or on activation
of instruction U). The current step can be modified by the program.

Operating diagram

Input u: N N Y L PO W Y W ! LA I

Input R:
Step No. %DRi.s _0 [ 1 [ 23 L-1 0 | 1 [ 2 o0]1
Output %DRI.F ‘

|

Special cases

» Effectofacoldrestart: (%S0=1) resets the drum controller to step 0 (updating the
control bits).

» Effect of awarmrestart: (%S1=1) updates the control bits, after the current step.

 Effect of a programjump: If the drum controller is not scanned, the control bits are
not reset to 0.

» Updating the control bits:  only occurs when there is a change of step or in the case
of a warm or cold restart.

 Effect of master control relay instructions MCS/MCR : Having a drum controller
between 2 MCS/MCR instructions means that the control bits are reset to O if the
Boolean result of the instruction preceding the MCS instruction is O.
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Programming and configuration
In this example, the first 6 outputs %Q0.0 to %Q0.5 are activated in succession, each
time input %I10.1 is set to 1.
Input 10.0 resets the outputs to 0.
Reversible programming

BLK %DR1
%10.0 %DR1 %Q0.8 LD %10.0
(| | R
%10.1 LD  %Il0.1
4{ ;'TEPSG U
OUT_BLK
LD F
ST %Q0.8
END_BLK
Non-reversible programming
Configuration
The following information is defined LD %10.0
during configuration : R %DR1
e The number of steps : 6 LD %I10.1
) u %DR1
» The output states (control bits) for each LD %DR1.F
drum controller step. ST %Q0.8
Q0.1:2:3:4:5:
Step1: 00000
Step2: 10000
Step3: 01000
Step4d: 00100
Step5: 00010
Step6: 00001
» Assignment of the control bits
1 :%Q0.0 4 :%Q0.1
2 :%Q0.2 5 :%Q0.3
3 :%Q0.4 6 : %Q0.5
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2.3  Grafcetinstructions

2.3-1 Description

Grafcet instructions in PL7 language offer a simple method of translating a control
sequence (Grafcet chart).
The PL7 language comprises a maximum of 62 steps, including the initial step(s). The
number of steps active at any one time is limited only by the total number of steps.

The table below lists all the instructions and objects required to program a Grafcet chart.

Graphic
representation

Transcription
in PL7 language

f

Role

Initial step
Transition

Step

Xi

-
o

Xi

o

=*= |

#i

#Di

=*= POST

%Xi

LD %Xi,

AND %Xi, ANDN %Xi
OR%Xi,

XOR%Xi, XORN%6Xi

S %Xi

R %Xi

Start the initial step (1)

Activate step i after deactivating the
current step

Start step i and validate the
associated transition (1)

Deactivate the current step
without activating any other steps

Deactivate step i and the current
step

Start post-processing and end
sequential processing

Bit associated with step i, can be
tested and written (max. no. of
steps : 62).

LDN %ZX:i, Test the activity of step i

ORN%Xi

Activate step i

Deactivate step i

(1) The first step =*=i or -*-i written indicates the start of sequential processing and thus the end

of preprocessing.
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Combinational and sequential instructions

2

Examples
Linear sequence
E [==1_] ke 1
%10.1 0.1 2 LD %I0.1
‘ # 2
% 02 [=2 ] .
5] *lo.2 : LD %I0.2
# 3
Alternative sequence
%I10.3 5 LD %10.3
e # 5
%10.4 6 LD %I0.4
] # 6
[=5 1] -
%10.5 7 LD %I0.5
U # 7
| ko 6
%l0.6 7 LD %l0.6
(] # 7
Simultaneous sequences
¥a _*_
%l0.7 9 LD %I0.7
#— # 9
10% # 10
# -k
*.9
e 11 LD %i0.8
— ‘i u
%l 12 LD %I0.9
o # 12
Note : 4{ <#>7 -+ 11
For a Grafcet Chart to be [ 11] LD %MO
operational, at least one %MO0  %X12 12 AND %X12
active step must be de- | +— | F——(#0)— #D 12
clared using the =*=i in- 13 # 13
struction (initial step) or .
the chart should be pre- .12 —(#)— * 1‘2
positioned during prepro- %MO0  %X11 11 LD %MO
cessing using system bit —(#D)— AND 9%X11
%S23 and the instruc- 13 #D 11
tions S %Xi. # 13

See example of
prepositioning a chart in
appendix A.10 part G.
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2.3-2 Program structure
A PL7 Grafcet program has 3 parts, each of which has a specific role.

Processing Example

Preprocessing

This comprises a series of %10.6 %522 000 LDN %I0.6
olV.

instructions for processing :
/ S
* power returns 4{ 4< % 001 s %S22

%MO0 002 ST %MO

« faults

« changes of operating mode ( % 003 LDR 3/‘"0'6

* prepositioning Grafcet %10.6 %S21 004 S %S21
steps P}—<S

* input logic 4{ %

Preprocessing ends with the first =*= or -*- instruction which occurs.
Sequential processing

This comprises the chart 005 =*= 1
(instructions representing %l10.2 %l0.3 2 006 LD  9%Il0.2
the chart) : | —J/F——#){| | 007 ANDN%I0.3
* steps %10.3  %I0.2 3 008 # 2
* actions associated with 009 LD %I10.3
}—{/}—(#
steps (see Appendix A.11 # % 010 ANDN %l0.2
Part G) =-=2] 011 # 3
« transitions %l10.4 1 012 *- 2
* transition conditions ﬂ }—<#>4 013 LD %l0.4
Sequential processing =3 014 # 1
ends with execution of %10.5 ; 015 -*- 3
the =*=POST instruction 016 LD %I10.5
—{#
% ‘ % 017 # 1

Post-processing

This comprises a series of %X1 %Q0.1 018 =*= POST
instructions for processing : % ( % 019 LD %X1
e commands from the N 020 ST %Q0.1
sequential processing %X2 7%Q0.2 021 LD %X2
for controlling the outputs # }—< % 022 ST %0Q0.2
« safety interlocks specific %X3 %Q0.3 023 LD %X3
to the outputs. # % 024 OR( %M1
%M1 %10.2 %10.7 025 ANDN 910.2

026 AND 9%I0.7
027 )
028 ST %Q0.3

H - H

Note :
The scan cycle is that defined in Part A, Section 1.3. In sequential processing, only active steps
at the start of the scan and their associated instructions are executed.
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Combinational and sequential instructions 2

2.4 Programinstructions

2.4-1 Program end instructions END, ENDC, ENDCN

The end of the execution of a program scan is defined using the instructions END, ENDC
and ENDCN :

END . unconditional end of program

ENDC : end of program if Boolean result of preceding test instruction is 1
ENDCN : end of program if Boolean result of preceding test instruction is 0.

By default (normal mode) when the end of program is activated, the outputs are updated
and the next scan is started.

If scanning is periodic, when the end of period is reached the outputs are updated and
the next scan is started.

Example :
%M1 %Q0.1 LD %M1
\ ( ST %Q0.1
o ]| | 205
o -} . 0,
Ny 3 ST %Q0.2
END
END >
o - LD %M1
/°M‘1 /0(/10.1 ST %Q0.1
\ \ >> LD %M2
%M2 %Q0.2 ST %Q0.2
\ AN I I I
| (H LD %I0.2
" ENDC —> If %10.2 =1, end of
/‘"0"2 LD %M2 program scanning.
| END ) ST %Q0.2 _
%M2 w02 (| If %I10.2 =0, continues
—{ } < >> END program scanning until
new END instruction.
END >

2.4-2 NOP Instruction

The NOP instruction does not perform any operation. It is used for "reserving" lines in
a program which allow the user to insert instructions later without modifying the line
numbers.
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2.4-3 Jump instructions JMP, JMPC, JMPCN to a label %Li:

Instructions JIMP, JIMPC and JMPCN cause the execution to be interrupted immediately
and the program to be continued from the line after the program line containing label
%Li (i = 0 to 15).

JMP : unconditional program jump
JMPC  : program jump if Boolean result of preceding logic is 1
JMPCN : program jump if Boolean result of preceding logic is 0.

Examples :

000 LD %M15
001 JMPC %L8
002 LD [YoMW24>%MW12]
003 ST %M15

004 JMP %L12

005 %LS8: - | Unconditional jump to label
006 LD %M12 %L12 :

007 AND %M13
008 ST %M2
009 JMPCN %L12

Jump to label %L8
if %M15 is at 1

010 OR %MI11 Jump to label %L12
011 S %0Q0.0 if %0M2 is at 0
012 %lL12: <

013 LD %I0.0

Note :

» These instructions are not permitted between parentheses, and they must not be placed between
the instructions AND(, OR(, and a close parenthesis instruction ")".

* The label can only be placed before a LD, LDN, LDR, LDF or BLK instruction.

 The label number of label %Li must be defined only once in a program.

 The program jump is performed to a line of programming which is downstream or upstream. When
the jump is upstream, attention must be paid to the program scan time. Extended scan time can
cause the watchdog timer to expire.
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Combinational and sequential instructions 2

2.4-4 Subroutine instructions SRn, SRn:, RET

The SRn instruction calls the subroutine referenced by label SRn: if the result of the
preceding Boolean instruction is 1.

TheRETinstruction placed atthe end of the subroutine commands the return to the main
program.

The subroutine is referenced by a label SRn: with n=0 to 15.

Example :

000 LD  %M15

001 AND %M5

002 ST  %QO0.0

003 LD [Y%oMW24>%MW12]

004 SR8

005 LD %I10.4 < _
006 AND %M13

007 _

008 _

009 _

010 END

011 SRS: <
012 LD 1

013 IN %TMO

014 LD %TMO0.Q

015 ST %M10

016 RET

Note :

« A subroutine should not call up another subroutine.

« This instruction is not permitted between parentheses, and thus it must not be placed between
the instructions AND(, OR(, and a close parenthesis instruction ")".

* The label can only be placed before a LD or BLK instruction marking the start of a Boolean equation
(or rung).

« Calling the subroutine must not be followed by an assignment (e.g. output or transfer) instruction,
example :

%10.0 R %1070

@ SR0 S
I—{ b %Q0.0 %Q8Y
—

LD %10.0
ST %Q0.0
SRO
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2.4-5 Master control relay instructions MCR and MCS

When the Boolean result of the instruction preceding the MCS instruction is 0, the
execution of the program lines following this instruction are modified as shown in the
table below until the MCR instruction is (unconditional) executed.

Instructions / blocks Behavior
ST,STN Associated object set to 0
S,R Instructions not executed
SRi, JMP, JMPC, JMPCN Not executed
%TMi Reinitialized
%DRi Control bits set to 0
%FC Counter stopped and threshold outputs reset to 0
% PWM, %PLS Generation of output signals stopped
Other function blocks Not executed (maintain their current state)
Operation blocks Not executed
Example : %I0.1
002 LD %l0.1 — | (MFS%
003 MCS - |
004 LD %M1 1
005 ST  %QO0.1 %M1 %Q0.1
006 LD  %l0.2 — | ( H
007 S %Q0.2
%10.2 %Q0.2

007 MCR ‘ /
............. % | \S%
When %I0.1 is at 0, the MCS instruction is /MCR>—
activated, %Q0.1is forced to 0, and output \
%0Q0.2is maintained.
Itis possible to use several MCSinstructions %10.1
for a single MCR instruction. All the MCS \ (mcs
instructions are deactivated by a single MCR % ! \ %
instruction.

. Sequence 1
When %I0.1is at0, sequences 1 and 2 are ’ %02 g ‘
modified, sequence 3 is executed normally. s [ /
When%I0.lisat1and%I0.2isat0, sequence % \ \MCS%
2 is modified, and sequences 1 and 3 are
executed normally. ’ Sequence 2 ‘
Ifno MCRinstructionis programmed afteran /
MCS instruction, the MCS instruction is ef- \MCR%
fective untilthe END instruction or the end of
the program. ’ Sequence 3 ‘
Important

Do not use MCS and MCR instructions in subroutines, transition conditions or Grafcet actions.

2/32



Section 3

3 Numerical and special instructions

3.1  Numerical processing

3.1-1 Definition of word objects

Word objects are addressed in the form of words of 16 bits, which are stored in the data
memory, and which can contain an integer value between -32768 and 32767 (except
for the fast counter which is between 0 and 65535).

Immediate values

These are integer values of the same format as the 16-bit words, which enable values
to be assigned to these words. They are stored in the program memory and contain a
value between -32768 and 32767.

Word formats
The contents of the words or values are stored in the user memory in 16-bit binary code
(two's complement) using the following convention :

F EDC B A 9 8 1 0 it position
lol1]of1]o]of[1]olol1]o]o][1]1]0]1]Bistae
I YT 0 0 © ¥ 0 © @ ¥ O © © ¥ « — DBitvalue
L O O ¥ A — b N © O ~
® - & © © b A +
© ©® ¥ & =

In signed binary notation, bit 15 is allocated by convention to the sign of the coded value

e Bit 15 at 0 : the content of the word is a positive value.
e Bit15at1:the content of the word is a negative value (negative values are
expressed in two's complement logic).
Words and immediate values can be entered or retrieved in the following format :
« Decimal 1579 (max : 32767, min :-32768)
* Hexadecimal 16#A536 (max : 16#FFFF, min : 16#0000)
alternate syntax : #A536.

Internal words %MWO0 16 b
Internal words are used to store values
during the operation.

They are stored in the data memory.
Words %MWO0 to %MW255 are read or
written to directly by the program. They are
used as working words.

- %MW255
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Constant words
%KWO

Constant words store constant values or 16 bits

alphanumeric messages. Their contents

can only be written or modified by the

terminal (inthe CONFIGURATION editor).

Constant words %KWO0 - %KW63 have

read-only access by the program. %KW63

I/O exchange words
I/O exchange words %IW/QW are assigned to PLCs connected by extension cable.
They are used for exchanges between PLCs (see Section 3.5).

System words

These 16-bit words have several functions. They provide access to data coming directly
from the PLC by reading %SWi words (for example, potentiometers). They are used
to perform operations on the application (for example, adjusting the schedule blocks).
The role of each of these words is explained in Section 6.

Bit objects extracted from words

Itis possible to extract one of the 16 bits from some words. The position of the extracted
bit separated by a colon is added to the word address.

Syntax : % Word object : Xk where k = 0 to 15 position of the bit in the object word.
Example : %MWS5:x6 : bit position 6 of internal word %MWS5.

List of word operands

Type Address Maximum  Write See
(or value) number access Sect.

Immediate values No
* base 10 example : 2103
* base 16 example : 16#AFOD
Internal words %MWi 256 Yes _
Constant words %KWi 64 No (1) _
System words %SWi 128 Depends on i 5.2
Function block %TMi.P %Ci.P etc. 2.2-1
words 3.3
Exchange words 3.5
Input words %IWi.j 8 No
Output words %QWi.j 8 Yes
Bits extracted from words

* internal %MWi:Xk 256 x 16 Yes

e system % SWi: Xk 128 x 16 Depends on i

* constant %KWi: Xk 64 x 16 No

* input %IWi.j: Xk 8 x 16 No

* output %QWi.j: Xk 8 x 16 Yes

(1) constant words are entered in configuration mode.
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Numerical and special instructions

3.1-2 Structured objects

Bit string

Bit strings are series of adjacent object bits of the same type and of a defined length :

L

Example of bit strings :

%M8 %M9 %M10

%M11 %M12 %M13

%M8:6 (1)
I I I I I |
Type Address Maximum Write
size access
Discrete input bits %I0:L or %I1:L 0<L<17 No
Discrete output bits %QO:L or %Q1:L 0<L<17 Yes

System bits %Si:L 0<L<17 and i+L-128 Depending on i
with i multiple of 8

Grafcet Step bits %Xi:L 0<L<17 and i+L-63 Yes (by program)
with i multiple of 8

Internal bits %Mi:L 0<L<17 and i+L-128 Yes

with i multiple of 8

Bit strings can be used with the assignment instruction := (see assignment instruction,
Section 3.1-4).
Word tables

Word tables are series of adjacent words of the same type and of a defined length : L.

Example of word tables :

%KW10 16 bits
%KW10:7

%KW16
Type Address Maximum Write

size access

Internal words %MWi:L 0<L<256 and i+L-256 Yes
Constant words %KWi:L O<L and i+L-64 No
System words %SWi:L 0O<L and i+L-128 Depending on i

Word tables can be used with the assignment instruction := (see assignment instruction,
Section 3.1-4).

(1) %M8:6 is acceptable (8 is a multiple of 8)
%M10:16 is unacceptable (10 is not a multiple of 8)
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Indexed words

 Direct addressing

The addressing of an object is said to be direct when the address of the objects is fixed
and defined when the program is written.

Example : %M26 (internal bit with the address 26)

 Indexed addressing

Inindexed addressing, an index is added to the direct address of an object : the content
of the index is added to the object address. The index is defined by an internal word
%MWi. The number of "index words" is unlimited.

Example : %MW108[%MW2] : word with direct address 108 + contents of word
%MW?2.
If word %MW2 has a value of 12, writing to %MW108[%MW?2] is equivalent
to writing to %MW120.

Type Address Maximum Write
size access

Internal words %MWi[%MWij] 0-i+%MWj<256 Yes

Constant words %KWIi[%MW]] 0-i+%MWj<64 No

Indexed words can be used with the assignment instruction := (see assignment
instruction, Section 3.1-4) and in comparison instructions (see comparison instruc-
tions Section 3.1-5).

This type of addressing enables series of objects of the same type (internal words,
constant words, etc) to be scanned in succession, by modifying the content of the index
word via the program.

« Index overflow, system bit %6S20

There is an overflow of the index when the address of an indexed object exceeds the

limits of the memory zone containing the same type of object, that is to say when :

» The object address + the content of the index is less than 0,

» The object address + the content of the index is greater than 255 (for words %MWi)
or 63 (for words %KWi).

In the event of an index overflow, the system sets system bit %S20 to 1 and the object

is assigned an index value of 0.

Note : The user is responsible for monitoring any overflow : bit %S20 must be read by the user
program for possible processing. The user must see that it is reset to 0.

%S20 (initial state = 0) :
* On index overflow : set to 1 by the system.
» Acknowledgment of overflow : set to 0 by the user, after modifying the index.
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3.1-3 Introduction to numerical instructions

Numerical instructions generally apply to 16-bit words (see Section 3.1-1). They are
written between square brackets. If the result of the preceding logical operation was
true (the Boolean accumulator = 1), the numerical instruction is executed. If the result
of the preceding logical operation was false (the Boolean accumulator = 0), the
numerical instruction is not executed and the operand remains unchanged.

Note : Numerical instructions are displayed in 2 or 3 lines on an FTX117 terminal.

3.1-4 Assignment instructions
These are used to load operand Op2 into operand Opl

Syntax : [Op1:=0p2] <=> Op2->0pl

The following assignment operations can be performed :
¢ On bit strings

e On words

e On word tables

Assignment of bit strings ( see bit string object in Section 3.1-2)
Operations can be performed on the following bit strings :

bit string -> bit string (ex 1)

bit string -> word (ex 2)

word -> bit string (ex 3)

immediate value -> bit string

Examples
LD 1
—| %Q0:8:=%M64:12 F [%6Q0:8:= %M64:12] (ex 1)
%I10.2 LD  %I0.2
— 1 %Mwioo=%l0:16 | [%6MW100:= %I0:16 ] (ex 2)
%10.3 LDR %I0.3
ﬂp}—| %M104:16:=%KW0 [ [%6M104:16:=%KWO0] (ex 3)

Usage rules

e For bit string -> word assignment : the bits in the string are transferred to the word
starting on the right (first bit in the string to bit 0 in the word), and the word bits which
are not involved in the transfer (length<16) are set to 0.

« For word -> bit string assignment : the word bits are transferred from the right (word
bit O to the first bit in the string).
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Syntax

Operator Syntax Operand 1 (Op1) Operand 2 (Op2)
= [Opl: = Op2 ] %MWi,%QWi, %SWi Immediate value, %MWi,
Y%MWI[MWi], YKWi,%IW,%QW,%SWi,
Operand 1 (Opl) assumes | %Mi:L,%0Qi:L,%Si:L, %BLK.X,%MWIi[MWi],
the value of operand 2 (Op2)| %Xi:L %KWI[MWi], %Mi:L,%Qi:L,
%Si:L,%Xi:L, %li:L

Note : The abbreviation %BLK.x (e.g. %CO0.P) is used to describe any function block word.

Assignment of words
Assignment operations can be performed on the following words :

word -> word (ex 1) word -> indexed word
indexed word -> word indexed word -> indexed word (ex 2)
immediate value -> word (ex 3) immediate value -> indexed word
bit string -> word word -> bit string
Examples :
LD 1
—| %SW112:=%MW100 f [%0SW112 := %MW100] (ex 1)
%I10.2 LD %I10.2
o H%MWO[%MW10]:=%KWO[%MW20]|» [%MWO[%MW10] :=
%KWO[%MW20] ] (ex 2)
%10.3
{FH %MW10:=100 H LDR %I0.3
[%6MW10:=100] (ex 3)
Syntax
Operator Syntax Operand 1 (Opl) Operand 2 (Op2 )
= [Opl: = Op2 ] %MWi,%QWi, %SWi |Immediate value, %MWi ,
%MWI[MWI], %KWi, %IW, %QW, %SWi,
Operand 1 (Opl) assumes | %Mi:L,%Qi:L,%Si:L, %BLK.x, %MWIi[MWi],
the value of operand 2 (Op2)| %Xi:L %KWI[MWi] , %Mi:L,%Qi:L,
%Si:L,%Xi:L,%li:L

Notes :
» The abbreviation %BLK.x (e.g. R3.l) is used to describe any function block word.

* For bit strings %Mi:L, %Si:L and %Xi:L, the base address of the first of the bit string must be
a multiple of 8 (0, 8, 16, ..., 96, ...).
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Assignment of word tables (see word table object in Section 3.1-2)

Assignment operations can be performed on the following word tables :
immediate value -> word table (ex 1)

word -> word table (ex 2)

word table -> word table (ex 3)

Examples
| %Mwo:10:=100 [ Lo 1
[%6MWO :10:= 100] (ex 1)
%l0.2 - - LD %I0.2
R A [%MWO0:10 := %MW11] (ex 2)
%I10.3
LDR %I0.3
Pl {reMw10:20-%Kwa0:20 [%MW10:20=%KW30:20] (ex 3)
Syntax
Operator Syntax Operand 1 (Opl) Operand 2 (Op2)
= [Opl: = Op2 ] %MWi:L,%SWi:L DOMWI:L, %KWi:L, %SWi:L
Immediate value, %MWi,
Operand 1 (Opl) assumes %KWi, %IW, %QW, %SWi,
the value of operand 2 (Op2) %BLK.x
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3.1-5 Comparison instructions

Comparison instructions are used to compare two operands.

> :testif operand 1 is greater than operand 2.
>= : test if operand 1 is greater than or equal to operand 2.
< :testif operand 1 is less than operand 2.
<= : testif operand 1 is less than or equal to operand 2.
= :testif operand 1 is equal to operand 2.

<> : testif operand 1 is different from operand 2.

Structure

The comparison is executed inside square brackets following instructions LD, AND and
OR. The result is 1 when the comparison requested is true.

%Q0.3
ﬂ %MW10>100 |7< % LD  [%MW10 > 100]
ST %0Q0.3
%MO0 %Q0.2 LD %MO
— —— %MW20<%KW35 |—< = AND  [%MW20 < %KW35]
ST %0Q0.2
%10.2 %Q0.4 LD %I0.2
4 } ( >4 OR  [%MW30 >= %MW40]
ST %Q0.4
| %MW30>=%MW40 }J
Syntax
Operator Syntax Operand 1 (Op1l) Dperand 2 (Op2)
> >= < <= LD[ Opl Operator Op2] %MWi,%KWi,%IW, Immediate value, %MWi,
= <> AND[ Op1 Operator Op2] %QWi,%SWi,%BLK.X  [%KWi,%IW,%QW,%SWi,
OR[Opl Operator Op2] %BLK.X,%MWi[%MWi],
%K Wi[%MWi]
Note

Comparison instructions can be used within parentheses.

Example :

LD  %MO

AND( [%MW20>10]
OR  %I0.0

)
ST %Q0.1
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3.1-6 Arithmetic instructions

These instructions are used to perform arithmetic operations between two operands
or on one operand.

+ : add two operands REM : remainder of division ofthe twooperands
- . subtract two operands SQRT : square root of an operand
* © multiply two operands INC : increment an operand
[ divide two operands DEC : decrement an operand
Structure
Arithmetic operations are performed as follows :
%MO .
— ] %mwo:=s%mw10+100 LD  %MO
w02 [%6MWO := %MW10 + 100]
'olU. 0
}—| %MWO0:=SQRT(%MW10) |» LD 010.2

[%MWO := SQRT(%MW10) |
%10.3
LDR %I0.3
— P——|  INC%mMwioo [INC %MW100]

Syntax
This depends on the operators used : see the table below.

Operator Syntax Operand 1 (Opl) Operands 2 and 3 (Op2 & 3)
+,-*/,REM (1) |[Opl: = Op 2 Operator Op3]|%MWi,%QWi, %SWi |Immed.value (2),%MWi,%KWi,
SQRT [Op1: = SQRT(Op2)] %IW,%QW,%SWi,%BLK.x
INC, DEC [Operator Op1]

Rules for use

e Addition : Overflow during operation

If the result exceeds the limits of -32768 or +32767, bit %S18 (overflow) is setto 1. The
resultis then, initself, not correct (see nextpage). The user program manages hit %S18.

Example :
%MO
H ’—|%MWO:=%MW1+%MW2|» LD  %MO
%S18 [%6MWO := %MW1+ %MW?2]
o .—o LDN %S18
—{ %MW10:=%MWO0
%s;}s—| X [%MW10 := %MWO ]
—| %MW10:=32767 |» LD %S18
7578 [%6MW10 := 32767 ]
/| R %S18
(R

If %MW1 =23241 and %MW2=21853, the real result (45094) cannot be expressed in
one 16-bit word, bit %S18 is set to 1 and the result obtained (-20442) is incorrect. In
this example when the result is greater than 32767, its value is fixed at 32767.

(1) with TSX 07s V2.2 or lower, the result (Opl) of division (/) or of the remainder (REM) is not
significant when the contents of operand 3 (Op3) is greater then 255.
(2) with SQRT, Op2 cannot be an immediate value.
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Absolute overflow of the result (unsigned arithmetic) :

During certain calculations, it may be necessary to interpret an operand in unsigned
arithmetic (bit 15 then represents the value 32768). The maximum value for an operand
is 65535. Adding 2 absolute values (unsigned) whose result is greater than 65535
causes an overflow. This is signaled by system bit %S17 (carry) changing to 1, which
represents the value 65536.

Example 1 : [%MW2:=%MWO0 + %MW1] where %MWO0 =65086, %MW1=65333
Word %MW?2 contains the number 64883. Bit %S17 is setto 1 and represents the value
65536. The unsigned arithmetic result is then equal to :

65536 + 64883 = 130419.

Example 2: [%MW2:=%MWO0 + %MW1] where %MWO0 =45736 (that is, a signed value
of -19800), %MW1=38336 (that is, a signed value of 27200).

The two system bits %S17 and %S18 are setto 1. The signed arithmetic result (+18536)
isincorrect. In unsigned arithmetic, the result (18536 + the value of %S17, thatis 84072)
is correct.

e Subtraction :
Negative result
If the result of a subtraction is less than 0, system bit %S17 is set to 1.

* Multiplication :

Overflow during operation

If the result exceeds the capacity of the result word, bit %S18 (overflow) is set to 1 and
the result is not significant.

* Division/Remainder :

Division by 0

If the divider is 0, the division is impossible and system bit %S18 is set to 1. The result
is then incorrect.

Overflow during operation
If the division quotient exceeds the capacity of the result word, bit %S18 is set to 1.

e Square root extraction :

Square root extraction is only performed on positive values. Thus, the result is always
positive. If the square root operand is negative, system bit %S18 is setto 1 and the result
is incorrect.

Note :

The user program is responsible for managing system bits %S17 and %S18. These are set to
1 by the PLC and must be reset by the program so that they can be reused (see previous page
for example).
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Numerical and special instructions 3

3.1-7 Logicinstructions

The associated instructions are used to perform a logic operation between two word
operands or on one word operand.

AND : AND (bit-wise) between two operands

OR : Logic OR (bit-wise) between two operands

XOR : Exclusive OR (bit-wise) between two operands

NOT : Logic complement (bit-wise) of an operand

Structure
Logic operations are performed as follows :

[D  %MO
%MO [%MWO := %MW10 AND 16#FF00]
—{ H%MWO::%MW10 AND 16#FF00|»
LD 1

[%6MWO := %KW5 OR %MW10]

4| %MWO0:=%KWS5 OR %MW10 |» b o0a
0 .

%10.3 [%MW102:= NOT (%MW100)]

—{ ’—' %MW102:=NOT (%MW100) |>

Syntax

This depends on the operators used : see table below.

Operator Syntax Operand 1 (Op1l) Operands 2 and 3 (Op2 & 3)
AND, OR, XOR|[Opl: = Op2 Operator Op3] |[%MWi,%QWi, %SWi |Immed.val. (1), %MWi,%KWi,
NOT [NOT (Op2)] %IW,%QW,%SWi, %BLK.x

Example : [%6MW15:=%MW32 AND %MW12]

(1) with NOT, Op2 cannot be an immediate value.
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3.1-8 Shiftinstructions

Shift instructions consists of moving bits of an operand a certain number of positions

to the right or to the left.
There are two types of shift operation :

F 0

%S17 0
%S17

F 0
%S17
F 0
%S17
Structure

Logic operations are performed as follows :

 Logic shift :
- SHL(op2,i) logic shift of i positions to
the left.

- SHR(op2,i) logic shift of i positions to
the right.

* Rotate shift :

-ROL(0p2,i) rotate shiftof i positions to
the left.

- ROR(0p2,i) rotate shift of i positions to
the right.

As the operand to be shifted is a single
length operand, the variable i must be
between 1 and 16.

The state of the last output bit is stored in
bit %S17.

%I0.1
PL— %MW0:=SHL(%MW10.5)

%10.2
PL—]{ %MW10:=ROR(%KW2.8)

LDR  %l0.1
[%MWO := SHL(%MW10,5)]

LDR %l0.2

[%MW10 := ROR(%KW9,8)]

Syntax

This depends on the operators used : see the table below.

Operator Syntax Operand 1 (Op1) Operand 2 (Op2)

SHL, SHR [Op1: = Operator(Op2,i)] %MWi,%QWi, %SWi | %MWi,%KWi,

ROL, ROR %IW,%QW,%SWi, %BLK.x
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3.1-9 Conversion instructions

There are two types of conversion instruction :
e BTl : BCD --> Binary conversion
e |ITB : Binary --> BCD conversion

Review of the BCD code :

The BCD code (Binary Coded Decimal) represents a decimal digit (0 to 9) by coding
4 bits. A 16-bit word object can thus contain a number expressed in four digits
(0 - N -9999).

During a conversion, if the value isn't a BCD one, the system bit %S18 is placed at 1.
This bit must be tested and reset to 0 by the user program.

Decimal 0 1 2 3 4 5 6 7 8 9
BCD 0000 0001 0010 0011 0100 0101 0110 0111 1000 1001
Example :

¢ Word %MWS5 expresses the BCD value "2450" which corresponds to the binary
value : 0010 0100 0101 0000

* Word %MW12 expresses the decimal value "2450"which correspondsto the binary
value : 0000 1001 1001 0010

Word %MWS5 is converted to word %MW212 by using instruction BTI.
Word %MW12 is converted to word %MWS5 by using instruction ITB.

Structure
Conversion operations are performed as follows :

LD %MO

%MWO0:=BTI(%MW10) [Y6MWO := BTI (%6MW10)]

%10.2
’—| %MW10:=ITB(%KW9)

LD  %I0.2
[%MW10 := ITB (%KW9)]

Syntax

This depends on the operators used : see the table below.

Operator Syntax Operand 1 (Op1l) Operand 2 (Op2)

BTI, ITB [Op1: = Operator (Op2)] %MWi,%QWi, %SWi  |%MWi,%KWi, %IW,%QW,
%SWi, %BLK.x

Application examples

The BTl instruction is used to process a setpoint value at PLC inputs via BCD encoded
thumbwheels.

The ITB instruction is used to display numerical values (for example, the result of a
calculation, the current value of a function block) on BCD coded displays.
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3.2 Potentiometers

Review from Part A, Section 1.8 :

"Base PLC" TSX Nano PLCs have on the front panel :

» One potentiometer for TSX Nano PLCs with 10, 14 and 20 1/O.
» Two potentiometers for TSX Nano PLCs with 16 and 24 1/O.

Programming

The numerical values from 0 to 255 corresponding to the analog values provided by
these potentiometers are contained in the following two system words :

* %SW112 for the first potentiometer (leftmost, potentiometer no.0)

* %SW113 for the second potentiometer (rightmost, potentiometer no.1)

These words can be used in arithmetic operations. They can be used for any type of
adjustment, for example, presetting a time-delay or a counter, adjusting the frequency
of the pulse generator or machine preheating time.

Example :

Adjusting the duration of a time-delay
from 5 to 10s using potentiometer no.0.
For this adjustment practically the entire
adjustment range of the potentiometer
from 0 to 250 is used.

10s

5s

The following parameters are selected at
configuration for the time-delay block
%TMO : 0 250
* Type TON

* Time base TB : 10ms

The preset value of the time-delay is calculated from the adjustment value of the
potentiometer using the following equation %TMO0.P :=2*%SW112+500.

LD 1

%MWO:=2%SW112 |- [Y%6MW0:=2*%SW112]
[%TMO.P:=%MWO0+500]

/oTMO.P::%MWO+500|> BLK %TMO
LD %I10.0

%l0.0  %TMO %Q0.0 IN
—{ F IN 04< % OUT_BLK

LD Q
ST %0Q0.0
END_BLK
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3.3 Analog channel (TSX 07 32/33 es ¢)

TSX Nano TSX 07 32/33 «s e« PLCs include a non-isolated 0/10 V analog channel.

Principle
An analog to digital converter converts the input voltage 0-10 V to a digital value from
0 to 255 which is stored in system word %SW112.

Inputvoltage %SW112

oV 0

40 mV 1

80 mV 2

9.96 V 249

10V 250

02v. T 288

The digital value 255 is used to detect whether the maximum value of the input signal
has been exceeded.

Potentiometer PO, located on the front panel, can be used to correct any errors caused
by the analog measurement circuit in some applications.

Programming example
Controlling the temperature of an oven. LD [%SW112 = 175]
The cooking temperature is setat 315°C. | ST 9Q0.0

A variation of +/- 3.6 °C results in tripping LD [%SW112 <= 173]
of outputs %Q0.1 and %Q0.2 respectively. ST %QO0.1

Practically all of the possible setting range LD [%SW112 >= 177]
of the potentiometer from O to 250 isused | ST 9Q0.2

in this example.

0°C > 0V -> %SW112 =0 °%Q0.0
311.4 °C -> 6.92V -> %SW112 =173 4| %SW112=175
315°C > 7V -> %SW112 = 175
318.6 °C -> 7.08 V -> %SW112 = 177
450 °C -> 10V -> %SW112 = 250

-

%Q0.1

%SW112<=173

%Q0.2
%SW112>=177 |—< >7

1
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3.4 Dedicatedfunctionblocks

3.4-1 Bitand word objects associated with dedicated function blocks
Dedicated function blocks use the same type of dedicated words and bits as standard
function blocks (See Section 2.2).

Function block bit and word objects accessible by the program

Dedicated
function blocks
Sect.

Associated words and bits

Address  Write See

access

Pulse width Word % of pulse at 1 in %PWM.R yes 3.4-3
modulation relation to the total
output period
%PWM Preset period %PWM.P  No
Pulse Word Preset value %PLS.P yes 3.4-4
generator No. of pulses to generate  %PLS.N yes
%PLS Bit Current output %PLS.Q no

Generation done output %PLS.D no
Fast Word Threshold i (i =0 or 1) %FC.Si yes 3.4-5
counter %FC Current value %FC.V no

Preset value %FC.P yes

Bit Overrun output %FC.F no

Overrun threshold i output %FC.THi  no
Send Bit Comm. fault output %MSG.E no 3.4-6
message %MSG Comm. done output %MSG.D no
Shift bit Bit Registerbit,j=0t0 15 %SBRi,j yes 347
register
%SBRi(i=0t0 7)
Step counter Bit Step counter bit, j=0t0 255 %SCi, no 34-8

%SCi (i=0 to 7)

3.4-2 Programming principles
As with standard function blocks, special function blocks can be programmed in 2

different ways :

» Non-reversible programming : using special instructions.
» Reversible programming : by simulating Ladder language function blocks.

See Section 2.2-2.
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3.4-3 Pulse width modulation output % PWM

%PWM

—IN

BT
%PWM.P

%PWM block

The %PWM function block is used to generate a square
wave signal on PLC output %Q0.0. The signal width (duty
cycle) can be varied by the program (for description, see
Part A, Section 4.6).

This function can also be used to control an analog output
module wired to the output %Q0.0 (see Section B-4.4).

-~ _ - bl idth
T programmable wi

<« » fixed period which can be configured
T

Characteristics

Time base B

0.1ms (1), 10ms, 1s (default value)

Preset period  %PWM.P

0<%PWM.P-32767 if time base is 10ms or 1s.
0<%PWM.P-255 if time base is 0.1ms

(0= function not in use)

The preset value and the time base can be modified
during configuration. They are used to fix the signal
period T = %PWM.PXTB.

The lower the ratios to be obtained, the greater the
selected %PWM.P must be.

Range of periods obtained :

* 0.2 to 26ms in steps of 0.1ms

» 20ms to 5.45 min in steps of 10ms
* 2510 9.1 hours in steps of 1s

Ratio of the %PWM.R

0-%PWM.R-100 (2), this word gives the period
percentage of the signal at state 1 in a period (0 =
default value).

The "width" Tp is thus equal to : Tp = T x (%PWM.R/100)
Word %PWM.R is written by the user program. It is this
word which performs the width modulation.

Pulse IN
generation input
(or instruction)

At state 1, the pulse width modulated signal is
generated at output %QO0.0.
At state 0, output %Q0.0 is set to 0.

Warning :

The algorithm for processing width modulation %PWM has been refined between versions V3.0
and V3.1 of TSX Nano. For the same %PWM.R, this may result in a different duty cycle at the
output between the two versions.

(1) This time base is not advisable for TSX Nano PLCs with relay outputs.
(2) Values greater than 100 will be considered as being equal to 100.
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Operation

The frequency of output signal %Q0.0 is set during configuration by selecting the time
base TB and the preset %PWM.P. The width of the signal is modulated by modifying
the %PWM.R ratio in the program.

Input IN

80% |
50%
Ratio %PWM.R 20%[T0

ouput oo — MU A A A FAe|ee

Programming and configuration

In this example, the signal width is modified by the program according to the state of
PLC inputs %I10.0 and %I0.1.

The signal period is set at 500 ms during configuration. (See configuration note below.)
If9%10.0 and %I0.1 are setto 0, the %PWM.R ratio is set at 20%, the duration of the signal
at state 1 is then : 20% x 500 ms = 100 ms.

If %10.0 is set to 0 and %l0.1is set to 1, the %PWM.R ratio is set at 50% (duration 250
ms).

If %10.0 and %I0.1 are set to 1, the %PWM.R ratio is set at 80% (duration 400 ms).

%I10.0 %I0.1 LDN  %10.0
01V,
e wpwmRi20 1| DN 06101
2%10.0 %I10.1 [%PWM.R:=20]
| /] wpwmr=so H|| LD w%l0.0
%10.0 %l0.1 ANDN %I0.1
— - ] wpwmm=so ||| [%PWM.R:=50]
LD  %I0.0
%l0-2 %PMW AND  9%10.1
ﬂ }7," [%6PWM.R:=80]
BLK %PWM
LD  %I0.2
IN
END_BLK
Configuration

Output %Q0.0 = output %PWM  TB=10ms  %PWM.P=50

Special cases
» Effect of a cold restart :  (%S0=1) sets the %PWM.R ratio to O
» Effect of a warm restart: (%S1=1) has no effect

» Effect of a PLC stop :
The output %Q0.0 is set to 0 regardless of the state of system bit %S8. For PLCs,
version 2.2 or lower, the output %Q0.0 is set to 0 if %S8 is at 1 or maintained (signal
generation) if %S8 = 0.

» With 0.1 ms time base , forcing output %Q0.0 using a programming device does not
stop the signal generation.
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3.4-4 Pulse generator output % PLS

%PLS

— IN Q-

BT
%PLS.P

Adjust
R DI

%PLS block

The %PLS function block generates a square wave
signal (on to off ratio, or duty cycle, of 50%) at PLC output
%Q0.0.

This signal can be :

« of limited length, the number of pulses and the period
are written by the program (or during configuration).

« of unlimited length, the period is written by the program
or during configuration.

(see description in Part A, Section 4.5).

-

T Variable period

Characteristics

Time base B

0.1 ms (1), 10ms, 1s (default value)

Preset %PLS.P 0<%PLS.P<32767 if TB =10 ms or 1s.

0<%PLS.P<255 if TB = 0.1ms (1)(2)

(0 = output at 0, 1 = output at 1). The preset value is
used to modulate the signal period T = %PLS.PxTB .
Range of periods obtained :

« 0.2 to 26ms in steps of 0.1ms

» 20ms to 5.45 min in steps of 10ms

* 25 t0 9.1 hours in steps of 1s.

Note : %PLS.P must be an even number

Number of %PLS.N 0<%PLS.N-32767, this word gives the number

pulses

of pulses of the train to be generated.
0 =square wave signal of unlimited length (by default).
%PLS.N is tested and written by the program.

Adjustment Y/N
via the terminal

Y : possible to modify the preset value
%PLS.P.N in the Data editor.
N : no access in the Data editor

Pulse generation IN
input (or instruction)

At state 1, generates the signal on output %Q0.0.
At state 0 sets output %Q0.0 to 0.

Reset input R
(or instruction)

At state 1, resets the number of pulses of
outputs %PLS.Q, and %PLS.D to zero

Current pulse %PLS.Q State 1, pulse signal is generated at %Q0.0.

generation output

Pulse generation %PLS.D State 1, signal generation is done

done output

PLS counter (2)

N=no, Y=yes. This option enables input %I0.0 to
be used as a counting input.

(1) This time base is not advisable for TSX 07s with relay outputs.

(2) The PLS counting option is required when a time base of 0.1 ms is selected. In order for
the PLS to work properly, it is necessary to physically loop output %QO0.0 to input %I10.0. In this
type of operation, the %PLS.P must be greater than or equal to 6 (max. freq. =1.6 Khz) to ensure
correct operation of the function.
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Operation

Input IN | |_| |
Number of pulses ’_I_I_I_‘ ’_l—,_,—‘
Output 4Q0.0 AEmE M m
Output %PLS.Q [ | [ |
Output %PLS.D 1 [l

Special cases

* Effectofacoldrestart: (%S0=1) sets the value of %PLS.P to that defined during configuration
« Effect of a warm restart :  (%S1=1) : no effect

« Effect of a PLC stop : see effect of a PLC stop page 3/18.

« Effect of modifying the preset %PLS.P : modifying the preset value %PLS.P via an
instruction or by adjusting it takes effect instantly

* With the time base of 0.1 ms , forcing the loop input %I10.0 does not stop generation.

Comment :

Using a time base of 0.1 ms may create a discrepancy of one pulse between the
number of pulses requested (%PLS.N) and the number actually generated.
To overcome this, the function must be reset once generation is complete :

LD %Mi
IN  %PLS
N

R %PLS

However, this action restarts generation of %PLS.N pulses once input IN changes
to 1.
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3.4-5 Fast counting functions, frequency meter and up/down counter %FC

The %FC function block can be used to perform one of
%FC : .
the three following functions :
* Fast counting
N e Fi- « Frequency meter
%FC.S0  Up/down counting
%FC.S1 (see detailed description, Part A, Section 4.4). The
] THO |- function is selected during configuration.
TH1 Note : Fast counting functions can be used without any
programming, simply by configuring the I/O and the
parameters.
9%FC black

Characteristics of block %FC

The function block offers a group of words, input and output bits which are used to
generate the 3 counting functions. To fully understand the role of each object in the
function to be performed, refer to the detailed description of the function.

Current value %FC.V Word incremented or decremented according to
the inputs and the function selected.

Can be read and tested but not written.

Preset value %FC.P Only used by the up/down counting function :
0-%FC.P-65535. Word can be read, tested and
written.

Threshold value SO (1) %FC.S0 0-%FC.S0-65535 word containing the value of
threshold 0, defined during configuration can be
read and written by the program.

Threshold value S1 (1) %FC.S1 0-%FC.S1-65535 word containing the value of
threshold 1, defined during configuration can be
read and written by the program.

Enable input IN At state 1, validates the current function.

(or instruction) At state 0, inhibits the current function.

Set input S At state 1 :

(or instruction) « sets the current value to the preset value (up/
down counting function) or resets the current
value to 0.
« initializes operation of the threshold outputs
(HSC_Out)

* takes into account threshold values %FC.SO
and %FC.S1 modified by the program.
Overflow output %FC.F State 1, when the current value %FC.V exceeds
65535. %FC.F can be cleared by a Preset (%10.1
or S instruction) or a cold restart.

Threshold %FC.THO State 1, when the current value is greater than
bit 0 (2) or equal to the threshold value %FC.S0
Threshold %FC.TH1 State 1, when the current value is greater than
bit 1 (2) or equal to the threshold value %FC.S1

(1) Threshold value %FC.S0 must be less than threshold value %FC.S1.
(2) It is advisable to test bit %FC.THx only once in the program.
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Fast counting function

The fast counting function counts at a maximum frequency of 10 kHz in fast mode (or
5 kHz in normal mode, selected during configuration), with a range of 1- 65535.
The counter receives the signals to be counted at PLC input %I10.0. The counting value
(current value %FC.V) is compared to 2 thresholds %FC.S0 and %FC.S1, which are
defined during configuration and can be modified by the program (modification is taken
into account when the Set input is activated).

Fast counter

Diagram :
Counting input %I10.0 —»
Enable inout Counter
nable inputs %10.2
IN %FC
zjertelsr:eriutI)SO) %10.1 i | °%FC.F Overflow output
SO Current %FC.V Current value
Instruction [READ %FC.V] value
(] Threshold bit 0
%FC.THO
Threshold value 0 %FC.S0 Compari- %FC.TH1 Threshold bit 1
Threshold value 1 %FC.S1 —=———son ?E %Q0.1 Threshold output 0
Threshold output 1
‘ & %Q0.2
Enable %SW111:X1 L

Comment : Apart from counting input %I10.0, all other function block discrete 1/O are
optional (they can be selected during configuration). The equivalent programming
objects and instructions are available for each of these (marked by a box on the
diagram).

Threshold outputs :  Threshold outputs are controlled directly by the fast counter
(without waiting for the outputs to be updated at the end of the scan) according to the
settings established by the user during configuration.

Output FC.V< thres.O<thres.1 thres.0-FC.V-thres.1 | thres.O<thres.1<FC.V
%0Q0.1 Oorl Oorl Oorl
%0Q0.2 Oorl Oorl Oorl

When they are initialized the threshold outputs must be enabled by a fast counter preset
command. Programming example :

BLK %FC SFC

LD %S0 N

S %S0

END_BLK }— s

LD %S0 . . . %S0 %SW11:X1

S %SW111:X1 (enable bit %SW111:X | (s
is setto 1) !

3/22



Numerical and specialinstructions 3

Reading the current value
The current %FC.V value is updated at the end of each PLC scan. %FC.V can also be
updated by the READ instruction :

syntax : [READ %FC.V] Timing diagram

Counter input (%I0.0)
65535
Threshold 1 %FC.S1

Threshold 0 %FC.S0

Current value %FC.V

Enable input

IN or %I0.2

Set input
S or %10.1 (1)

Overflow
%FC.F

Threshold bit 0
%FC.THO

Threshold bit 1
%FC.TH1

Threshold output 0
%Q0.1 (2)

Threshold output 1
%0Q0.2 (2)

s

—

(1) Input %I0.1 operates on a rising edge (see timing diagram), while input S operates on a state.
(2) In this timing diagram the status matrix configured by the user is as follows :

Output FC.V< thresh O<thresh 1 | thresh 0-FC.V-thresh|1 threshO<thresh 1<FC.V|
%Q0.1 0 1 0
%Q0.2 1 0 0
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Frequency meter function

The frequency meter function is used to measure the frequency of a periodic signal
in Hz on input %I10.0. There is a choice of two modes : fast (10kHz filtering) or normal
(5kHz filtering).

The frequency range which can be measured is from 1Hz to 10kHz. The user can
choose between 2 time bases, the choice being made by system bit %SW111:X2 (1
= time base of 100 ms, 0 = time base of 1s).

Time base Measurement range Precision Update

100ms 100Hz-10kHz 0.1% for 10kHz 10 times per second
10% for 100Hz

1s 10Hz-10kHz 0.01% for 10kHz |Once per second
10% for 10Hz

System bit %SW111:X3 is set to 1 during an update of the current value. The user
program must reset the system bit to O.

Frequency meter

Diagram :
Counter input %10.0 —»] E
i Counter
(Elr;able inputs %10.2
IN %FC i
Set inputs ‘ ——| %FC.F Overflow output
(current value to 0) Current oFC.y Current value (2)
9 Updat
SAARC value %SWA11:X3 oo
Select the
time base
%SW111:X2 —= “

(1) Input %I0.2 is optional, its use is selected during configuration.
(2) Current value FC.V is expressed in Hz.

Note :

This function can also be used to obtain the value of the analog module wired to
input %I10.0 (see part B Section 4.3 : managing analog 1/O).

Timing diagram

Counter input (%10.0) ERENERENERERENEREREEEERENE

Enable input [ |
(IN or %I10.2)

Set input (S) 1

Time base TB [ | | | | [

Current value %FC.V F1 F2 F3 |
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Up/down counting function

The up/down counting function counts up or down at a maximum frequency of 1 kHz,
with an up/down counting range of 0 to 65535.

The counter receives the signals to be upcounted on PLC input %I10.0, and the signals
to be downcounted on PLC input %I10.3. It provides an output indicating the direction
of movement : whether the counter is upcounting %SW111:X0 = 1 or downcounting
%SW111:X0=0.The up/down counting value (currentvalue %FC.V) is compared with
2 thresholds, %FC.S0 and %FC.S1, which are defined during configuration and can
be modified by the program (modification is taken into account when the preset input
is activated).

Diagram : Up/down counter
Upcounter input %10.0 —» E
Downcounter input %10.3 —»l Upcounter %SW111:X0
: E downcounter direction of movement

Enable inputs

%I0.2

IN%FC —~ !
Preset value Preset
%FC.P value

Set inputs

o —
Read input 7%l0.1 A | %FC.F Overflow output

5 >
Instruction [READ Vs \/?F..? L Cu:rent %FC.V Current value

%l10.4 ] : Capture value
Threshold value 0 7 alue p

val A val %SW110
Threshold value 1 L | [ Threshold bit 0
9 Threshold bit 1
%FC.S0 :"FC'THO
Compari- %FC.TH1 Threshold output 0
Enable %FC.S1 5on
& %Q0.1
Threshold output 1
‘ & %Q0.2
%SW111:X1 L

Apart from upcounting input %I10.0 and downcounting input %I10.3, all other function
block discrete I/O are optional (they can be selected during configuration). The
equivalent programming instructions and objects are available for each of these
(marked by a box on the diagram).

Preset : the preset value of 0 to 65535 is defined during configuration and can be
modified by the program. The current value is loaded with the preset value on a rising
edge at input %I10.1 or at state 1 of input S.

Threshold outputs :  see fast counting function
Reading the current value
The value %FC.V is updated automatically at the end of the scan. %FC.V can also be

updated by the READ instruction, syntax : [READ %FC.V]
A rising edge on Read input %10.4 causes the value %FC.V to be copied to %SW110.
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Upcounter input %I10.0

Downcounter input %I0.3

65535

Threshold 1 %FC.S1
Threshold 0 %FC.S0

Preset value %FC.P
Current value %FC.V
Enable input

IN or %I0.2

Set input
S or %I0.1 (1)

Direction of movement
%SW111:X0

Overflow
%FC.F (2)

Threshold bit 0
%FC.THO

Threshold bit 1
%FC.TH1

Threshold output %Q0.1 (3)

Threshold output %Q0.2 (3) Ii

(1) Input %I0.1 operates on a rising edge, while input S operates on a state.
(2) The overflow output %FC.F is reset to zero after reinitialization of the counter.
(3) See status matrix for the fast counting function.

Important :

1 1

[ALAA

If one of the 4 inputs %I0.0, %I0.1, %I10.3, or %10.4, on a rising or falling edge is at
state 1, no action linked to the other 3 will be performed.
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Numerical and special instructions 3

Special cases (fast counting, frequency meter and up/down counter)

» Effect of a cold restart: (%S0=1) changes the current value, outputs %FC.F,
%FC.THO, %FC.TH1 and enable bit of the threshold outputs (%SW111:X1) to 0, and
copies the values defined during configuration to words %FC.P,%FC.S0/S1.

« Effectofawarmrestart: (%S1=1)andPLCstop: hasno effectonthe currentvalue.

After an activated master control relay instruction MCS, high-speed outputs are set
to 0, after deactivation of the MCS, they are only reset after the threshold is crossed
in upcounting mode or after an up/down counting action in downcounting mode.

¢ Displayed %FC values :
For all values related to the %FC function block, values are displayed :
-bythe FTX 117 terminal as two's complement numbers (Decimal) or as adirect value
(Hexadecimal).
- by PL7-07 as direct value (Decimal or Hexadecimal).

For example :

Displayed values
%FC.V (PL7-07) (FTX 117) (PL7-07 - FTX 117)
0 0 0 0000
1 1 1 0001
2 2 2 0002
32766 32766 32766 7FFE
32767 32767 32767 TFFF
32768 -32768 8000
65533 65533 -3 FFFD
65534 65534 -2 FFFE
65535 65535 -1 FFFF
0 0 0 0
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Example of the fast counting function
Description of the application

T ] Tl

O

— STORE

Photo-electric cell

]
|:| —= REJECT
T2

A- —
%
At —» —— START
|

e i

The parts to be measured are put on a conveyor belt driven continuously without
slipping by a motor to which a rotary incremental encoder is attached. The measure-
mentis made by counting the number of pulses during the time cell C detects the moving
part. A cylinder V controls the lateral movement of belt T so as to position it opposite
conveyor T1 or conveyor T2, according to the measurement results.

The number of pulses measured is compared to 2 extreme values (length measure-
ment tolerance)

* If it is between these 2 values,

m the part is directed towards the
STORE (belt T1, control A+ on
cylinder V)

« If this is not the case, the part is
directed towards the reject bin

Pulse LJ:I—D—D-/A:'—D—D—D— (belt T2, control A- on cylinder V)

1 part corresponds to

10000 pulses

The START pushbutton is used to start the whole operation.

Beam

Assigning the I/O

Inputs

* %10.0 counter input connected to the incremental encoder
* %10.1 reset input connected to the photoelectric cell

* %10.2 enable input connected to the start button

Outputs

* 9%Q0.1 cylinder A+ control output
* 9%Q0.2 cylinder A- control output
* %Q0.0 belt control output
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Processing the application

The fast counting function can be processed without the need to program the PLC by
configuring only the %FC function block.

%FC . counter

Mode . fast

Counting input : %I0.0

Set : %I0.1

Enable input : %I0.2

%FC.S0 : 9950 threshold O corresponds to the minimum tolerance level
%FC.S1 : 10000 threshold 1 corresponds to the maximum tolerance level

Output matrix

Output FC.V<thresh O<thresh 1 thresh 0-FC.V-thresh 1 l thresh O<thresh 1<FC.V/|
%Q0.1 0 1 0
%Q0.2 1 0 1
Program
%10.2 %Q0.0 LD %I0.2
4{ \ / % ST %0Q0.0
\ \ LDF %I0.1
%10.1 %SW111:X1 S %SW111:X1
—N| (s LDR %I0.1
%10.1 %SW111:X1 ORN  %I0.2
\ [ R %SW111:X1
P (R
%10.2
4{ /}7
Operation

Input %I0.0 counts the number of pulses sent from the incremental encoder as soon
as the enable input %I10.2 (start button) is activated.

On arising edge at input %I0.1, the current value of the counter is reset to 0.

When the cell (input %I0.1) detects that there are no more parts on the conveyor belt,
outputs %Q0.1 and %Q0.2 are enabled (by bit %SW111:X1) and set to 0 or 1 at this
moment depending on the current value of the counter %FC.V (according to the output
matrix).

Output %Q0.1 is set to 1 when the part is within tolerance. It controls the output of
positioning cylinder A on conveyor belt T1 (see the output matrix).

Output %Q0.2 is setto 1 when the part is outside tolerance (return cylinder Ato belt T2).
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3.4-6 Transmitting/Receiving messages and controlling data exchanges

The TSX Nano can communicate with a programming terminal (either the FTX117 or
the PL707 software) and with other UNI-TELWAY devices connected to the terminal
port. The TSX Nano can also be configured to send and/or receive messages in
character mode (ASCII protocol).

PL7 language offers for this :

* EXCH instruction to transmit/receive messages,
* %MSG function block to control the data exchanges.

The TSX Nano determines the protocol according to the pinout of the cable being used,
and provides this information to the system bit %S100 (management of /DPT).

An overview of UNI-TELWAY compatible products and configurations appears in Part
F of this manual.

EXCH instruction

The SEND instruction allows the TSX Nano to send and/or receive information to/from
UNI-TELWAY or ASCII devices. The user defines a table of words (%MWi:L or %KWi:L)
containing the data to be sent and/or received (up to 64 data words in transmission and/
or reception). The format for the word table is described in the paragraphs about each
protocol (ASCIl and UNITELWAY).

A message exchange is performed using the EXCH instruction.
Syntax: [EXCH %MWi:L] (1) or [EXCH %KWi:L]

Note : Devices such as XBT or CCX man-machine interfaces, or Inductel identification devices,
which support UNI-TELWAY protocol, can send information to, or get information from the TSX
Nano without any special TSX Nano programming.

The TSX Nano must finish the exchange from the first EXCH instruction before a second can
be launched. The %MSG block must be used when sending several messages.

(1) L : Number of words in the word table.
Values of the internal word table %MWi:L are such as i+L - 255.

Note

The PL7-07 V1 software can only be used for transmission, using the SEND
instruction for TSX07 V1 and V2.

TSX Nano V3 PLCs (TSX 07 3¢ e= ¢¢) authorize transmission and/or reception of
messages using the EXCH instruction (the EXCH instruction in reception mode on
TSX 07 3¢ 10 *» PLCs is only possible in version V3.1).

(For PL7-07 V1, the EXCH instruction is called SEND).
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%MSG function block

The use of the %MSG function block is optional; it can be used to manage data

exchanges. The %MSG function block has three purposes :

e Communications error checking
The error checking verifies that the block length (word table) programmed with the
EXCH instruction is large enough to contain the length of the message to be sent
(compare with length programmed in the least significant byte of the first word of the
word table). It also verifies that a UNI-TELWAY message was received by the UNI-
TELWAY device.

¢ Coordination of multiple messages
To ensure the coordination when sending multiple messages, the %MSG function
block provides the information required to determine when a previous message is
complete.

e Transmission of priority messages
The %MSG function block allows current message transmissions to be stopped, in
order to allow the immediate sending of an urgent message.

Exchange control block

The %MSG function block manages
exchanges.
%MSG Programming it is optional.
E -
%MSG block
Characteristics of the %MSG block
Reset input R At state 1, reinitializes communication,
(or instruction) %MSG.E = 0 and %MSG.D =1
Comm. done %MSG.D State 1, comm. done if :
output » End of transmission if transmission,
» End of reception (end character received),
e Error,

* Reset the block.
State 0, request in progress

Fault (Error) output %MSG.E State 1if:
» Bad command,
* Table incorrectly configured
* Incorrect character received (speed, parity, etc)
» Reception table full (not updated)
State 0, message length OK, link OK

If an error occurs when using an EXCH instruction, bits %MSG.D and %MSG.E go to
1 and system word %SW69 contains the error code. See Section 6.2-2.
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Reset input (R) : When the Reset input is set to 1, it immediately stops any messages
that are being transmitted, resets the Fault (Error) output to O and sets the Done bit to 1.
A new message can now be sent.

Fault (Error) output (%MSG.E) : The error output is set to 1 either because of a
communications programming error or a message transmission error. The error
outputis set to 1 if the number of bytes defined in the data block associated with

the EXCH instruction (word 1, least significant byte) is greater than 128 (80 in
hexadecimal).

The error output is also set to 1 if a problem exists in sending a UNI-TELWAY message
to a UNI-TELWAY device. In this case, the user should check wiring, and that the
destination device supports UNI-TELWAY communication.

Communications Done output (%MSG.D): When the Done outputis setto 1, the TSX
Nano is ready to send another message. Use of the %MSG.D bitis recommended
when multiple messages are sent. If it is not used, messages may be lost.

Transmission of several successive messages

Execution of the EXCH instruction activates a message block in the application program.
The message is transmitted if the message block is not already active (%MSG.D=1). If
several messages are sent in the same cycle, only the first message is transmitted. The
user is responsible for managing the transmission of several messages using the
program.

Example : Transmission of 2 messages in succession.

%10.0 %MSG.D LDR 9%I0.0
—{P}—{ }—% EXCH%MW?2:4 |» AND %MSG.D
%MO0 [EXCH %MW2:4]

U SR S %Mo
%MSG.D %MO0 >> LD %MSG.D

{ H %4 EXCH%MWS8:3 |» AND %MO
%MO0 [EXCH %MW8:3]

—<R} R %MO

Reinitializing exchanges

An exchange is cancelled by activating the input (or instruction) R. This input initializes
communication and resets output %MSG.E to 0 and output %MSG.D to 1. It is possible
to reinitialize an exchange if a fault is detected.

Example : BLK %MSG

IE{D %MO %MO %MSG
}7 R D
END_BLK
E

Special cases
 Effect of a cold restart:  (%S0=1) forces a reinitialization of the communication.
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o Effect of a warm restart:  (%S1=1) has no effect.
» Effect of a PLC stop : if a message transmission is in progress, the PLC stops its
transfer and reinitializes the outputs %MSG.D and %MSG.E.

Characteristics of ASCIl mode

The ASCII output communications mode is selected by jumpering pins on the terminal
port (see Part F for specific information). Status bit %S100is setto 1 whenthe TSX Nano
is in ASCIl mode. It also confirms that, with the necessary jumpers, the cable is
connected.

The three possible uses of this instruction are :

e Transmission

« Transmission / Reception

¢ Reception

The maximum size of the frames transmitted and/or received is 128 bytes.

The word table associated with the EXCH instruction is composed of transmission and
reception tables.

Most significant byte

Least significant byte

Command

Length LgT / LgR

Control

Byte transmitted 1

Byte transmitted 2

Byte transmitted n

Byte transmitted n+1

Transmission table

Byte received 1

Byte received 2

Byte received p

Byte received p+1

Reception table

The Length byte (LgT) contains the length to be transmitted, which is overwritten by the
number of characters received (LgR) at the end of reception.

The command byte must contain one of the following values :

e 0 : Transmission

e 1 : Transmission followed by reception

e 2 : Reception
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The table can only be type %KWi in the case of transmission.

Reception ends when the end of frame byte is received (1). The value of this byte can
be modified by the user (least significant byte of system word %SW68). The default
value of this word is H'OD' (carriage return).

(1) Warning :
The system does not manage a reception time-out

Sending a message to an ASCII device : Pure transmission
The content of the data block associated with the SEND instruction needed to write data
to an ASCII device (such as a display or printer) is as follows :

Most significant byte ]Least significant byte

0 (transmission) Length of message (bytes)

ASCII data

The maximum length of a message is 128 bytes.

Example 1: requestto display message "FAULT 10" on a printer using ASCII protocol.

%10.0 %MSG.D LDR %l0.0

pH ‘—| EXCH %KW10:7 AND %MSG.D

[EXCH %KW10:7]

Word table contents :

Word Contents Most significant byte east significant byte
%KW10 12 0 Length LgT in bytes
%KW11 'DE'

%KW12 'FA' ASCII text

%KW13 uT'

%KW14 "1

%KW15 0’

%KW16 16#0A0D Line return Carriage return
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ASCII Transmission / Reception

At the end of transmission, the TSX Nano switches to wait for reception, then after
receiving a response, copies it into the %MWi zone contiguous with the transmission
table if the status of the reception is OK and if the length of the question (LgT) and the
response (LgR) is less than the %MWi reserved zone (length L). If this is not the case,
bit %MSG.E changes to 1.

Reception is ended when the end code is detected (H'OD' by default but may be
modified in %SW68) or when the reception table is full.

There is no reception time-out management.

Note

TSX Nano V1 or V2 cannot receive ASCIl messages.

The contents of the word table associated with the EXCH instruction necessary for
transmission / reception of ASCII data is described below :

Most significant byte Least significant byte
1 (transmission / reception) Length LgT or LgR Control
Byte to be transmitted 1 Byte to be transmitted 2

Transmission table

Byte to be transmitted n

Byte to be transmitted n+1

Byte received 1 Byte received 2

Reception table

Byte received p

Byte received p+1 End code (H'0OD)

Notes

%KWi type words are prohibited.

When the exchange is finished (end of frame character received), the transmission
length byte (LgT) contains the number of characters received (LgR).

The transmission length byte must therefore be updated before each ex-
change.

The message reception zone is aligned to the word following the transmission
zone.
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Example :

Words Most signif. | Least signif.
%MW10 16#0001 16#0007
%MW11 V' ‘A
%MW12 L' ‘U’
%MW13 'E' v
%MW14 N not used

Associated program :
LDR %I0.0 %l(;(})l{MSG.D
AND %MSG.D

[EXCH %MW10:9]

EXCH %MW10:5

This program transmits the following frame: VALUE : 7 bytes and waits to receive a
response (8 bytes maximum).
The characters received are accessible in the words %MW15 to %MW18.

Calculation of the length of the word table

LgT =7

LgR =8

L=1+LgT +LgT%2 + LgR + LgR%2 =9
2 2

Note

TSX 07 2..... Nano-PLCs cannot receive ASCIl messages.
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Receiving a message from an ASCII device

On execution of the EXCH block, which has been set for reception, the TSX Nano
switches to wait for reception, then copies the response into the %MWi zone if the status
of the reception is OK and if the length of the response (LgR) is less than the %MWi
reserved zone (length L). If this is not the case, bit %MSG.E is set to 1.

Reception is ended when the end code is detected (16#0D by default but may be
modified in %SW68) or when the reception table is full.

There is no reception time-out management.

Note

The TSX Nano V1 or V2 cannot receive an ASCIl message.

The contents of the word table associated with the EXCH instruction necessary for
receiving ASCII data is described below :

Most significant byte Least significant byte
2 (reception) 0 (1) Control
Byte received 1 Byte received 2

Reception table

Byte received p
Byte received p+1 End code (H'0OD")

Note

%KWi type words are prohibited.

The communication type is managed in the first word of the table.

(1) In reception mode, this least significant byte is not taken into account.
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Exchange control

Exchange control is performed using the %MSG function block and system word
%SW69.

After each exchange, %SW69 (report of EXCH block) is updated and takes one of the
following values :

» 0: Exchange OK.

: Transmission table too large (LgT>128).

: Transmission table too small (LgT=0).

: Word table too small (1).

: Bad ASCII command (command byte <> 0, 1 or 2).
: Not used

L]
© 00 N W N P

: Reception error (problem with communication format (speed, parity)).
* 10: %KWi table prohibited in reception or transmission / reception.

(1) L< 1+LgT +LgT%2 + LgR + LgR%2
2 2
where L in words
LgT and LgR in bytes
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Dialog with a UNI-TELWAY device

The word table associated with the EXCH instruction used to send a request to a UNI-
TELWAY device such as ATV speed controllers or man-machine interface devices
(CCX 17 or XBT) is made up of transmission and reception tables.

Most significant byte Least significant byte
Target address Length LgT / LgR (bytes) Control
Category code Request code
First word (MSB) First word (LSB) Transmission table
Word n-1 (MSB) Word n-1 (LSB)
Word n (MSB) Word n (LSB)
00 (forced) Response code received
Data received 2 Data received 1 Reception table
Data received p-1
Data received p

The maximum size of the messages transmitted and received is 128 bytes.
The message reception zone is always aligned on the word following the transmission
zone.

The EXCH block reads the length to be transmitted (LgT) in the transmission length field.
Whenthe exchange has finished, itwrites the length of the message received there (LgR).
The transmission length byte must therefore be updated before each transmis-

sion.

The response code received is written in the least significant byte of the first word of
the reception table. The most significant byte of this word is forced to 0. The following
data, if there is any, is aligned on the next word.

Important

From TSX Nano V3, the order for transmitting data from a UNI-TE request becomes
Most Significant byte then Least Significant byte.

Applications operating with TSX Nano V1 or V2 must be modified to take account
of this inversion if they are loaded onto a TSX Nano V3.
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Unitelway Master

In this mode, the TSX Nano normally manages two devices distributed over 5 slave
addresses. Itis possible to control 2 devices and a PL7 07 programming terminal, if the
programming terminal is configured on a single address.

The TSX Nano does not manage slave to slave routing.

The TSX Nano Master can transmit a request to any slave address from 1 to 5, using
the EXCH block. It uses the source address 0.254.16.

The target address coded in the word table associated with the EXCH block must be
one of the following :

» 0: Transmission of a request to slave 4 (compatible with TSX07 2.).
» 1to 5: Transmission and reception of a request to a slave with address 1 to 5.

If the target address is 0, the characteristics of the EXCH block are as follows :
 The reception buffer is not used,

* The table can be situated in zone %KWi,

* Bit %MSG.D changes to 1 when the response from the slave is received,
» The response from the slave is ignored.

* Only Write and non-solicited Data requests can be used.

If the target address is between 1 and 5 :

* The reception table is obligatory (1 word minimum),

» The word table must be situated in zone %MW,

» Bit %MSG.D changes to 1 when the response from the slave is received,
» The response from the slave is copied into the reception table.

Example of use :

Transmission of the request "Read word" %MW513 (16#0201) to a device at address
2:

Words Most signif. LLeast signif.
%MW10 02 04
%MW11 07 04
%MW12 02 01

Associated program :
LDR %l0.0 %l0.0 %MSG.D
AND %MSG.D P
[EXCH %MW10:5]

EXCH %MW10:5

The EXCH block uses %MWi:L as parameters :
* iindicates the number of the first word in the table
e L indicates the number of words in the word table.
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When bit %MSG.D = 1 and bit %MSG.E = 0, the table contains the following data :

Words Most signif. Least signif.
%MW10 02 04
%MW11 07 04
%MW12 02 01
%MW13 00 34
%MW14 'AB’ 'CD’

The data in bold signifies :

« 4 bytes received,

e response code received = 16#0034,
¢ value of word %MW513 = 16#ABCD.
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Unitelway Slave

Any device (local or remote) can question the system server from the TSX Nano Slave
using AdO (server) as a target address.

A TSX Nano slave can transmit (client) arequest to any Master or Slave device (address
0 to 98) using the EXCH block (when the master is a TSX 37/57 PLC).

The target address coded in the word table associated with the EXCH block must be
between 100 and 198 (when the master is a TSX 47/67/87/107 PLC).
The characteristics of the EXCH block are as follows :

» The reception table is obligatory (1 word minimum),

» The word table must be situated in zone %MWi,

» Bit %MSG.D changes to 1 when the response from the slave is received,
» The response is copied into the reception table.

Example of use :
Transmission of the request "Read word" %MW513 to the Master :

Words Most signif.  Least signif.
%MW10 00 04
%MW11 07 04
%MW12 02 01

Associated program :
LDR %I0.0

AND %MSG.D
[EXCH %MW10:5]

The EXCH block uses %MWi:L as parameters :
* iindicates the number of the first word in the table
» L indicates the number of words in the word table.

When bit %MSG.D = 1 and bit %MSG.E = 0, the table contains the following data :

Words Most signif.  |Least signif.
%MW10 00 04
%MW11 07 04
%MW12 02 01
%MW13 00 34
%MW14 'AB' 'CD’
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The data in bold signifies :

« 4 bytes received,

e response code received = 16#0034,
« value of word %MW513 = 16#ABCD.

Other example :
Transmission of the request "Read word" %MW513 to slave 32 :

Words Most signif. L east signif.
%MW10 20 04
%MW11 07 04
%MW12 02 01

Associated program :
LDR %Il0.0

AND %MSG.D
[EXCH %MW10:5]

The EXCH block uses %MWi:L as parameters :
¢ jindicates the number of the first word in the table
¢ L indicates the number of words in the word table.

When bit %MSG.D = 1 and bit %MSG.E = 0, the table contains the following data :

Words Most signif. | east signif.
%MW10 20 04
%MW11 07 04
%MW12 02 01
%MW13 00 34
%MW14 'AB' 'CD’

The data in bold signifies :

e 4 bytes received,

* response code received = 16#0034,
« value of word %MW513 = 16#ABCD.
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Exchange control

Exchange control is performed using the %MSG function block and system word
%SW69.
Bit %MSG.D is set to 1 in the following cases :

» When the response has been received.

« If there is a transmission error (negative acknowledgment)

« If the block is reinitialized.

« If the response does not arrive within 7 seconds (application time-out).

Bit %MSG.D changes to 1 for any other errors (detailed in word %SW69) :

After each exchange, word %SW69 (report of EXCH block) is updated and takes one
of the following values :

e 0: Exchange OK.

: Transmission table too large (LgT>128).
e 2 : Transmission table too small (LgT=0).
: Word table too small (1).

. Incorrect Unitelway address (target address does not belong to [0...98] or
00...198] in UNI-TELWAY Slave mode or to [1...5] in UNI-TELWAY Master.

: Time-out expired.

°
s W N -

[

: Transmission error (target responds with Nack).
: Bad ASCII command (command byte <> 0, 1 or 2).
: Not used

L]
© 0 N o O

: Reception error (problem with communication format (speed, parity)).
* 10 : %KWi table prohibited in reception or transmission / reception.

(1) L< 1+LgT+LgT%2 + LgR + LgR%2
2 2
where L in words
LgT and LgR in bytes
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3.4-7 Shift bit register function blocks %SBRi

A shift bit register is used to enter binary data (0 or 1) and
%SBRi to move them in one direction or the other.
1R
— CU
— CD
Shift register block

Characteristics

Register number %SBRi Oto7

Register bit %SBRi.j Bits 0 to 15 (j=0 to 15) of the shift register can
be tested by a testinstruction and written by an
assignment instruction.

Reset input R On a rising edge, set register bits 0 to 15

(or instruction) %SBRi.j to 0.

Shift to left Ccu On arising edge, shift a register bit to the left.
input (or instruction)

Shift to right CD On arising edge, shift a register bit to the right.

input (or instruction)

Operation
Initial state [1]1]ofoofoofo1]1]o[1]1][1]o]o]

Bit 15 Bit 0
CU %SBRi performs a
shift to the left

. [1]ofofofofofo[1]1]o[1]1]1]0]0]0]
Bit 15 is lost Bit 15 Bit 0

This is also true of a request to shift a bit to the right (bit 15 to bit 0) using instruction CD.
Bit O is lost.

If a 16-bit register is not adequate, it is possible, using the program, to cascade several
registers.
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Programming
Example : Shift a bit to the left every second : bit 0 assumes the opposite state to bit 15.

Reversible programming

%SBR0.15 %SBR0.0
|| ( LDN %SBRO0.15
" (] ST %SBRO.0
BLK %SBRO
%SBRO LD %S6
Cu
R END_BLK
%S6
} } cu Non-reversible programming
il . LDN %SBRO0.15
ST %SBRO0.0
LD  %S6
Cu %SBRO

Special cases
» Effect of a cold restart:  (%S0=1)
- sets all the bits of the register word to 0

» Effect of awarm restart: (%S1=1) has no effect on the bits of the register word.
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3.4-8 Step counter function blocks %SCi

A step counter is a series of steps to which actions can be

%SCi

Ccu

(20]

IStep counter function block

assigned. Moving from one step to another depends on
external or internal events. Each time that a step is active,
the associated hit is set to 1. Only one step of a step
counter can be active at a time.

Characteristics

Step counter number  %SCi Oto7
Step counter bit %SCi.j Step counter bits 0 to 255 (j=0 to 255) can be
tested by an LD logical operation and written
by an assignment instruction.
Reset input R On arising edge, resets the step counter.
(or instruction)
Increment input CuU On arising edge, increments the step counter
(or instruction) by one step.
Decrement input CD On arising edge, decrements the step counter
(or instruction) by one step.
Operation
CU input
L S Y W Y
CD input
| W Y T Y
N°inactive
o[ + | 2 [ 3] 2 [ 1 | 0 |
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Programming
Example : To program the step counter 0 incremented by input %I10.2. It is reset to O by
input %I10.3 or when it arrives at step 3.
Step 0 controls output %Q0.1, step 1 controls output %Q0.2 and step 2 controls output
%0Q0.3.

Reversible programming

BLK %SCO
LD  %SC0.3
%S\c?s OR  %I0.3
| R
0,
%‘,lo‘.s %SC0 (L:llDJ %10.2
| R END_BLK
%02 LD  %SC0.0
| cu ST %Q0.1
LD  %SC0.1
ST %Q0.2
e LD  %SC0.2
ST  %Q0.3
%SC0.0 %Q0.1 Non-reversible programming
| (
K o LD  %SCO0.3
/OS‘C(‘M “a02 OR  %I0.3
a \ R %SCO
LD  %l0.2
%SC0.2 %Q0.3 oz
| ( LD  %SC0.0
ST %Q0.1
LD  %SC0.1
ST %Q0.2
LD  %SC0.2
ST  %Q0.3

Special cases
» Effect of a cold restart: (%S0=1)
- initializes the step counter

» Effect of a warm restart : (%S1=1) has no effect on the step counter.
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3.5 Communication between PLCs

Words %IW and %QW are used to exchange data between PLCs. The diagram below
illustrates the exchange words for each PLC.

e @ @
‘44 o ﬁr‘ o
J:D::::::ID:IT:L J]IIIIER

%IW2.0 %QWO0.0
%IW2.1 %QWO0.1
%QW?2.0 %IW0.0
%QW2.1 %IW0.1
%IW3.0 %QWO0.0
%IW3.1 %QWO.1
%QW3.0 %IWO0.0
%QW3.1 %IWO0.1
%IW4.0 %QWO0.0
%IW4.1 %QWO0.1
%QW4.0 %IWO0.0
%QW4.1 %IWO0.1

These exchange words are updated automatically when the PLCs are in RUN mode.
The user program for each PLC is limited to :

« Writing to output words %QWi.j

¢ Reading input words %IWi.j

The update cycle for %IW/%QW words is synchronized with the PLC scan. System bit
%S70 is set to 1 when a complete update cycle has taken place. It is reset to 0 by the
program or the terminal.

Bits %S71 / %S72 and word %SW?71 are also used to control data exchanges (see
Section 5).

Note : Each PLC address is defined according to the position of the selector switch located on
the PLC front panel, and this position is taken into account on every power-up.
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Example 1 : The base PLC transmits data to peer PLC #2 indicating the end of
production (bit %M0=1). Once it has received this data, the peer PLC starts a materials
handling machine by activating output %Q0.0.

Base PLC programming

LD %MO
ST %QW2.0:X0

Peer PLC programming

LD  %IW0.0:X0
ST %Q0.0

%MO %QW2.0:X0
|| (
\ \
%IW0.0:X0 %Q0.0
(
I \
Example 2 :

The base PLC transmits the current value of the counter 0 to peer PLC #4. When this
current value is higher than the threshold contained in word %MWO, the peer PLC stops

a machine by deactivating output %Q0.1.

Base PLC programming

%QW4.0:=%C0.V |»

%Q0.1

| %IW0.0>%MWo |—</%

LD 1
[%QW4.0:=%C0.V]

Peer PLC programming

LD [%IW0.0>%MWOQ]
STN  %Q0.1
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4 Managing analog modules

4.1 Presentation

TSX 07 30/31 «» «» "base PLC" PLCs with discrete /O (starting from version V3) are able
to manage analog 1/0 modules.

There are three types of analog module in the TSX Nano offer :

¢ TSX AMN 4000/4001 analog I/O modules

These modules communicate with the "base PLC" PLC via the 1/O extension link.
They are managed via exchange words %IW and %QW.

e Input module :

These modules perform a voltage/frequency conversion which requires the use of input
%I0.0 in frequency meter mode on the PLC. A single input module can be connected
by the PLC. The module is managed from the application program via system words
%SW100 and %SW101.

e Output module :

These modules perform a PWM/voltage conversion, by integrating the signal sent to
output %Q0.0 of the PLC (pulse width modulation). A single module can be connected
per PLC (base PLCs fitted with transistor outputs).

The module is managed from the application program via system words %SW102 and
%SW103.

4/1



4.2 TSXAMN 4000/4001 analog modules

4.2-1 Operating principle of analog modules

Words %IW and %QW are used to exchange application data between a "base PLC"

PLC and TSX AMN 400 analog modules.

This data, which is limited to four words (two in read mode, two in write mode) for both
the "base PLC" PLC and analog modules, can be exchanged in both directions.
The figure below shows the words exchanged for each PLC.

Base
PLC

Analog
module 1

%)
)

Analog
module 2

Analog
module 3

%IW2.0

%QWO0.0

%IW2.1
%QW2.0

%QWO.1

%IW0.0

%QW2.1
%IW3.0

%IWO0.1

%QW0.0

%IW3.1
%QW3.0

%QWO0.1
%IW0.0

%QWS3.1

%IW4.0  |—

%IWO0.1

%IW4.1
%QW4.0

%QWO0.0
%QWO0.1

%QW4.1

%IW0.0
%IWO0.1

These exchange words are automatically updated when the "base PLC" PLC is in RUN
mode. For each PLC, the user program is limited to :
 writing to output words %QWi.j
 reading input words %IWi.]

The updating scan for %IW/%QW words is synchronous with the PLC scans. System
bit %S70 is set to 1 when a complete scan has taken place. It is reset by the program

or terminal.

Note

The address of each PLC is defined according to the position of the selector switch located on
the PLC's front panel. Its position is taken into account whenever the PLC is powered up.
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4.2-2 Programming analog modules

TSX AMN 400+ analog I/0 modules are programmed using 2 sets of exchange words :
%QWi.0, %QWi.1 and %IWi.0, %IWi.1.

Exchange word %QWi.0

This word is used to configure the analog input channels of a module.
It contains :

e the number of input channels used,

« the type of input for each channel,

« the type of filtering for each channel.

Chann. 2 Chann. 1 Chann. 0 Chann. 2 Chann. 1 Chann. 0 Conf.

ll ll l; l; il il
ns | ns [f21|f20 [ f11(f10 | fo1 [foO | 12 |U2 [ 1 U1 | 10 [UO | c1 | cO

o 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
C1 Cco Number of input channels used

0 0 None

0 1 Channel 0

1 0 Channel 0 and channel 1

1 1 Channel 0, channel 1 and channel 2

In un Type of input for channel n

0 0 Voltage input +/-10 V

0 1 Voltage input 0..10 V

1 0 Current input 0..20 mA

1 1 Current input 4..20 mA

fnl fn0 Type of filter for channel n (digital filter of the 1st order)
0 0 Hard filtering

0 1 75 ms

1 0 300 ms

1 1 15s

ns : not significant
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Exchange word %QWi.1
This 16-bit word contains the value of analog output 0 in a module.

Bit n° Meaning
x0 to x14 Value of output O coded on 15 bits
x15 Sign bit

Exchange word %IWi.0
This 16-bit word contains the value of analog input 0 and the module status.

Bit n° Meaning

x0 to x10 Value of input O coded on 11 bits
x11 Sign bit of channel 0

x12 =1 Self-calibration fault

x13 =1 Stop overshoot channel 0

x14 =1 Stop overshoot channel 1

x15 =1 Stop overshoot channel 2

Exchange word %IWi.1

This 16-bit word either contains the value of analog input 1 or the values of analog inputs
1 and 2 in a module.

Bit n° Meaning when inputs Meaning when inputs

0 and 1 are configured 0, 1 and 2 are configured
0to6 Value of input 1 coded on 7 bits
7 Value of input 1 coded on 15 bits Sign bit of channel 1
81t0 14 Value of input 2 coded on 7 bits
15 Sign bit of channel 1 Sign bit of channel 2
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Range of values of input modules

Type of input Range of values Overshoot detection threshold
7 bits + sign 11 bits + sign for low and high stops

10V /+10 V -125 .125 -2000 .. 2000 +/- 2.5% of the full scale

0/10V 0..125 0 .. 2000 +/- 2.5% of the full scale

0/20 mA 0..125 0 .. 2000 +/- 2.5% of the full scale

4120 mA 25 .. 125 0 .. 2000 +/- 2.5% of the full scale

All stop overshoot faults are signaled by setting one of the status bits in word %IWi.0
of the module to 1. For the 4/20 mA range, a fault is declared if the current is less than
3.5 mA, but the module is capable of feeding back values up to -0.5 mA.

Range of values of output modules

Type of output Values written Max. overshoot values

in word %QWi.1 of low and high stops
-10 vV / +10 V -2000 .. 2000 +/- 2.5% of the full scale
0/10V 0 .. 2000 +/- 2.5% of the full scale
0/20 mA 0 .. 2000 +/- 2.5% of the full scale
4120 mA 400 .. 2000 +/- 2.5% of the full scale

If an internal fault occurs, the output is set to fallback mode by the module (0 V for the
voltage output, 0 mA for the current output, whatever the range).

Warning

When the PLC is set to STOP, the analog output is maintained at the value it had
before the STOP. There is no automatic fallback in this case.

4.2-3 Using %IW words in the user program

In order for %IW exchange words to be manipulated by PL7-07 instructions, they must
be converted to a 15-bit + sign format.

The table overleaf shows the conversion operations to be inserted in the user program :
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Value of the ¥-bitword 1-bit word Channel n° Cpnversion to 15-bit

sign bit T sign 1 sign + sign format

0 %IWi.0 %MWO0:= %IWi.0 AND 16#0FFF

1 %IWi.0 %MWO:= %IWi.0 OR 16#F000

0 %IWi.1 %MWO0:= %IWi.1 AND 16#00FF

1 %IWi.1 %MWO:= %IWi.1 AND 16#00FF
%MW1:= %MWO0O OR 16#FF00

0 %IWi.1 %MWO:= %IWi.1 AND 16#FF00
%MW1:= ROR (%MWO0,8)

1 %IWi.1 %MWO:= %IWi.1 AND 16#FF00
%MW1:= ROR (%MWO0,8)
%MW2:= %MW1 OR 16#FF00

Note :

Internal words %MWO0, %MW1 and %MW?2 are used as examples of logging variables in the

conversion operations.

Example of a user program

Compares the analog value of channel 2 in module 1, all the inputs of which are
configured, with a threshold contained in word %MW100 (hexadecimal value 16#05C4).
Output Q0.1 inthe "base PLC" PLC is setto 1 when the value is equal to or greater than

the threshold.

LD 1
[%0MW100 := 16#05C4]
LD 1

[%MWO := %IW2.1 AND 16#FF00]
LD 1

[%MW1 := ROR ( %MWO, 8 )]

LD %IW2.1:X15

[%MW2 := %MW1 OR 16#FF00]
LDN %IW2.1:X15

[%MW2 := %MW1]

LD [%MWO >= %MW100]

ST  %Q0.1

%MW100:=16#05C4 |*

4' %MWO0:=%IW2.1 AND 16#FF00 |

%MW1:=ROL(%MWO, 8)

%IW2.1:X15

H %MW2:=%MW1 + 16#FF00 |>
1

%IW2.1:X15

%MW2:=%MW1

4' %MWO0>=%MW100

4.2-4 Diagnostics of communication status with analog modules
These diagnostics are identical to those carried out on a peer PLC and are indicated

by word %SW?71 (see Part B Section 6.2-2).
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4.3  Analog input modules TSX ASN eee
4.3-1 Configuringanaloginputs

Using input %I0.0 in frequency meter mode to connect the analog input module
requires the following parameter settings :

e Fast counter type : to be set to Frequency to use the input in frequency
meter mode
« Max. frequency : to be set to 10 KHz

4.3-2 Programming analog inputs

The input module is programmed using the two system words %SW100 and %SW101
and by enabling the fast counter %FC (see example in Section 4.4-4).

e %SW100 : analog input functions command word

* %SW101 : acquired value of analog input

The operating mode is selected by writing, via the program, word %SW100 and the
acquired value of the analog input can be read in word %SW101.

These two words are reset to zero by the system on a cold restart.

Depending on the choice of operating mode, the system offers a scaling function. This
scaling is within a range of 0 to +10 000 for unipolar modules (4/20mA and 0/10V input
modules) and -10 000 to +10 000 for bipolar modules (-10/+10V).

%SW100 Operation Value range of %SW101

0 Disable analog input 0

function on %I0.0
1 Operate without scaling 0...1 000

Period of measurement 125 ms

2 Scale for unipolar range 0...10 000

(4/20mA, 0/10V) Period of measurement 125 ms
3 Scale for bipolar range -10 000 ... +10 000

(-10/+10V) Period of measurement 125 ms
4 Scale for unipolar range 0...10 000

(4/20mA, 0/10V) Period of measurement 500 ms
5 Scale for bipolar range -10 000 ... +10 000

(-10/+10V) Period of measurement 500 ms

417



The raw or scaled analog value is available in %SW101 if %SW100 is written with a
value of 1 to 5. The validity of this measurement can be checked using system bit
%SW111:X3 (set to 1 by the system if the measurement is valid).

If system bit %0SW111:X3 is set to zero by the application, an analog acquisition function
is launched, measurement acquisitions continue to be made when the PLC is in STOP.

The raw frequency measurement remains available in word %FC,V associated with
input %I10.0 but it is a measurement which is a function of the measurement period (eg :
the full scale 8KHz will give 1000 for 125ms and 4000 for 500ms). It is therefore
recommended, to simplify the application program, that system word %SW101 is used
by preference.

Note

The period of measurement can be modified during operation by rewriting word
%SW100 but this mode of use is not recommended because the first measurement
after the change in period may be wrong.

Using analog input modules on V2 PLCs

It is possible to use analog input modules on TSX 07 2eee V2 PLCs, according to the
following rules :

 use of input %I10.0 as frequency meter (enabling of operation by instruction IN %FC)
 configuration of the measurement period by the application writing bit %SW111:X2.

%SW111:X2=0 measurement every second (default)
%SW111:X2=1 measurement every 100 ms

 the image of the analog input value is available in object %FC,V;
the value is interpreted in the following way :

Range Formula

0/10V U(V) = 1.25 x (%FC,V x 10 )
4/20 mA I(mA) =2 x [(%FC,V x 10 ®) + 2]
-10/+10V U(V) = 2.5 x [(%FC,V x 10 ) - 4]
Note

In the case of a 4/20 mA module, the frequency is zero between 0 and 4 mA.
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4.3-3 Response time of analog inputs

The response time IRT in acquiring an analog input, between the actual variation of
the electrical value at the module terminals and the correspondence in word %SW101
of the measured value, depends essentially on the measurement period selected
(125/500 ms) and less so on the PLC scan time. The variation of the electrical value
has a negligible effect on the response time.

e For acquisition at a period of 125 ms : IRT is less than 500 ms.
» For acquisition at a period of 500 ms : IRT is less than 1.2 s.

Note

A change in the operating mode (changing %SW100) is taken into account by the system on each
scan or immediately on a rising edge of "IN %FC". The measurements are linked in realtime one
after another at the chosen period (125 ms or 500 ms). The result of the last measurement taken
is transmitted at the beginning of the PLC scan to %SW101. The value of this word does not change
during the PLC scan.

4.3-4 Example of analog input programming

(* ENABLE ANALOG INPUT FUNCTIONS *)

LD 1 (* ANA INPUT MODE 0..1000 ON 125 MS *)
[%SW100 := 1] (* SELECTED MODE TAKEN INTO ACCOUNT *)
BLK %FC

LD 1

IN

END_BLK

(* ACQUISITION OF MEASUREMENT?¥)

LD %SW111:X3 (* MEASUREMENT VALID *)

[0MW1 := %SW101] (* MEMO MEASUREMENT *)

R %SW111:X3 (* MEASUREMENT ACKNOWLEDGED¥)
S %M1 (* MEASUREMENT INDEX VALID *)

(* USE OF THE MEASUREMENT, DEPENDING ON THE APPLICATION *)
LD %M1

%SW100:=1

%FC
IN

S

%SW111:X3
4( } %MW1:=%SW101

%SW111:X3

O

%M1

%M1 4@%
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4.3-5 Characteristics of analog inputs

Type Input %SW101 value |Resolution(1) %%SW101 value Resolution (1)
value period 125ms increment period 500ms /increment

4/20mA [4mA 0 16pA/10 Isb 0 4pA/2.5 Isb
12mA 5000 5000
20mA 10000 10000

0/10Vv ov 0 10mV/10 Isb 0 2.5mV/ 2.5 Isb
10v 10000 10000

-10/+10V|-10V -10000 20mV/10 Isb -10000 5mV/ 2.5 Isb
+10V 10000 10000

The values of %SW101 are given for the operating mode with scaling.

(1) Resolution

measurement variation varies in "steps" called increments.

: Minimum value of the input variation to obtain a measurement variation. The
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4.4 Analog output modules TSX AEN eee

4.4-1 Configuringanalog outputs

Using output %Q0.0 to connect the analog output requires the following parameter
settings :

e Output %Q0.0: to be used for pulse width modulation %PWM.
e Time base : to be setto 0.1 ms.
e Preset : must be set to 249 so that operation remains enabled

after a warm restart.
Adjustment of this parameter is only appropriate for
"base PLC" TSX Nano PLCs (V3.0).

4.4-2 Programming analog outputs

The output module is programmed using the two system words %SW102 and %SW103
and by enabling output %PWM (see example in Section 4.3-4).

* %SW102 : analog output functions command/status word
¢ %SW103 : value of analog output to be generated

The operating mode is selected by writing, by the application program, word %SW102
and the value of the analog output to be generated must be written in word %SW103.

These two words are reset to zero by the system on a cold restart.

Depending on the choice of operating mode, the system offers a scaling function. This
scaling is within a range of 0 to +10 000 for unipolar modules (4/20mA and 0/10V input
modules) and -10 000 to +10 000 for bipolar modules (-10/+10V).
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%SW102 Operation Value range of %SW103

0 Disable analog output Not used
function on %Q0.0

1 Operate without scaling 5...249

2 Scale for unipolar range 0...10 000
(4/20mA, 0/10V)

3 Scale for bipolar range -10 000 ... +10 000
(-10/+10V)

The effective resolution of the analog outputs is 245 points.

Ifthe value written in %SW103 s less than the minimum value (eg : less than O in unipolar
mode), the minimum value in the range will be applied to the output module.

If the value written in %SW103 is greater than the maximum value (eg : greater than
10000 in unipolar mode), the maximum value in the range will be applied to the output
module.

These two types of programming error are not indicated to the application.

Important

In the fallback conditions of discrete outputs, the PWM is no longer generated and
a signal is no longer sent to the output modules.

From this, the bipolar modules take their lowest value ( -10V).

This fallback mode must be taken into account by the user.

4.4-3 Response time of analog outputs

The response time ORT of an analog output, between writing the setpoint in word
%SW103 and reaching the voltage (and/or current) corresponding to the module
terminals, depends on the amplitude of the variation and the PLC scan time.

» For a full scale variation, ORT is less than 500 ms.

The shorter the PLC scan time and the lower the setpoint variation, the shorter the
response time will be. For a scan time of 10 ms and a variation of1/10th of the full scale,
this response time will go down to approximately 50 ms.

Note

A change in the operating mode (changing %SW102) is taken into account on a rising edge of
input IN of the PWM (execution of the instruction "IN %PWM") or if setpoint %SW103 is changed.
A change of setpoint (%SW103) is taken into account by the system on each scan and becomes
effective from the next application program scan (Max. delay of 3ms).
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4.4-4 Example of analog output programming

(* ENABLE ANALOG OUTPUT FUNCTION *)

LD 1
[20SW102 := 1] (* ANA OUTPUT RAW MODE 5..249 *)
IN %PWM (* MODE TAKEN INTO ACCOUNT *)

(* GENERATION OF SETPOINT IN PWM *)

(* SETP. CALC. DEPENDING ON APPLICATION *)
LD 1
[26SW103 := %MWO0] (* APPLICATION OUTPUT SETPOINT *)

%SW102:=1 L

%PWM

%SW1 03:=%MWOL

4.4-5 Characteristics of analog outputs

Type Value %SW103 value Resolution Isb resolution (1)
to be generated  to be written by outputmodule %SW103
atoutput applicationprogram
4/20mA 4mA 0 65pA 40
12mA 5000
20mA 10000

0/10v ov 0 40mV 40
5V 5000
1ov 10000

-10/+10vV  -10V -10000 81mV 81
ov 0
+10V 10000

Values of %SW103 are given for the operating mode with scaling.

(1) LSBresolution: Minimum variation to be applied to %SW103 to obtain a variation of the output
module equal to its resolution.
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5 Clock functions

5.1 Introduction

TSX 07 1 16/24 «» PLCs have a time-of-day clock which is used to perform three
functions :

¢ Schedule blocks are used to control actions at predefined or calculated times.

« Time/date stamping is used to date events and measure duration .

The TSX Nano schedule blocks and the time-of-day clock can be accessed from the
TSX PLC operations menu. Additionally, the time-of-day clock can be set by the
program. They continue to operate for up to 30 days when the PLC is switched off if the
battery has been charged for at least 6 consecutive hours before the PLC is switched
off.

The time-of-day clock has a 24-hour format and takes leap years into account.

5.2 Schedule blocks

The schedule block is used to control actions at a particular predefined time.

A maximum of 16 schedule blocks can be used, each one performing this function.
These blocks do not require any program entry. They can be configured (see
operating modes, Part C).

5.2-1 Characteristics

Schedule block RTC:n n=0 to 15
number
Output Q: Output assignment is activated by schedule

block : %Mi or %Qj.k.

This output is set to 1 when the current date
and time are between the setting of the start
of the active period and the setting of the end
of the active period.

Start date DD:MMM Shows the day from 1 to 31 and the month Jan
to Dec of the start of activation of schedule
block.

End date DD:MMM Shows the day from 1 to 31 and the month Jan
to Dec of the end of activation of schedule
block.

Day MTWTFSS Shows the days of activation in the week
(M : Monday to S : Sunday)

Start hour hh:mm Shows in hours (0 to 23) and minutes (0 to 59)
the start of activation of schedule block.

End hour hh:mm Shows in hours (0 to 23) and minutes (0 to 59)

the end of activation of schedule block.
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The bits of system word %SW114 enable (bit set to 1) or disable (bit set to 0) the
operation of each of the function blocks.

wswita [ [ [T ITTITTITTTL]

Schedule block #15 Schedule block #0

By default (or after a cold restart) all bits of this system word are set to 1. Use of these
bits by the program is optional

Comments :

« If the same output (%Mi or %Qj.K) is assigned by several blocks, itis the "OR" of the
results of each of the blocks which is finally assigned to this object (which means
it is possible to have several "operating ranges" for the same output).

Example : Configuration of a schedule block, for summer month spray program.
* RTC 6 : schedule block #6

*Q: %Q0.2 : output activated by the schedule block RTC:6 Q: %Q0.4
e 21 -Jun -> 21-Sep : period of activation 21-Jun --> 21-Sep
* MeWsFee : activation days (Monday, Wednesday and Friday) | ,, MV

*21:00-22:00 : scheduled activation period

LD %I0.1
%I0.1 %SW114:X6 ST %SW114:X6
| <
%01 | ==
21 June
%Q0.2 nnm nmnn
MWF MWF MW F

In this example the user can disable the schedule block using a switch or a humidity
detector wired to input %I10.1.

Note :
It is important to check the state of bit %S51 which shows any schedule block errors.

5.2-2 Time dating by program

Date and time are both available in system words %SW50 to %SW53 (see Section 6.2).
Itis therefore possible to perform time and date stamping by the PLC program by making
arithmetic comparisons between the current date and time and the immediate values
or words %MWi (or %KWi) which can contain setpoints.
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5.3 Time/date stamping

System words %SW50 to %SW53 (see Section 6.2) contain the current date and time
in BCD format, which is useful for display on or transmission to a peripheral device.
These system words can be used to store the date and time of an event.

To date an event it is sufficient to use assignment operations, to transfer the contents
of system words to internal words and then process these internal words (for example,
transmission to display unit by EXCH instruction).

Example :

%10.1
PH %MW12:4:=%SW50:4

LDR %I0.1
[%MW12:4 :=%SW50:4]

Once an event is detected, the word table contains :

Coding: | Most significant |Least significant Example : Monday 19 April 1994
byte byte In hex 13H, 40min, 30s

%MW12 | Second Day of the week(1)| 3000 30s, 0=Monday

%MW13 |Hour Minute 1340 13H, 40min

%MW14 | Month Day 0419 4=April, 19

%MW15 | Century Year 1994 1994

(1) Where 0=Monday, 1=Tuesday, 2=Wednesday, 3=Thursday, 4=Friday, 5=Saturday, 6=Sun-
day

Reading the date and time of the last stop using system words

System words %SW54 to %SW57 (see Section 6.2) contain the date and time of the
last stop, and word %SW58 contains the code showing the cause of the last stop, in
BCD format.
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5.4  Setting the date and time

5.4-1 Setting the date and time using the terminal

When the programming terminal is in TSX (online) mode, the date and time can be
updated quickly and easily (see operating modes, Part C).

5.4-2 Updating date and time using system words
System words offer 2 other possibilities for updating the date and time :

Updating using system words %SW50 to %SW53

(see Section 6.2)

For this, bit %S50 must be set to 1. This bit :

 cancels the update of words %SW50 to %SW53 via the internal clock
 transmits the values written in words %SW50 to %SW53 to the internal clock.

%850 %330 LD %S50
o (R} R %S50
%l0, LDR  %0.1

—{P}—H [%SW50:=%MW10] |»
—| [%SW51:=%MW11] F
——{ esws2:=%mw12] [
1 [%SW53:=%Mw13] [

%/850
(s

[%SW50:=%MW10]
[%SW51:=%MW11]
[%SW52:=96MW12]
[%SW53:=%MW13]
s %S50

Words %MW10 to %MW13 will contain the new
date andtime in BCD format and will correspond
to the coding of words %SWS50 to 53.

The word table must contain the new date and time.

Coding: |Mostsigni ficant [Least significant | Example : Monday 19 April 1994

byte byte Hex 13H 40min 30s
%MW10 |Second Day oftheweek (1) 3000 30s, 0=Monday
%MW11 |Hour Minute 1340 13H, 40min
%MW12 |Month Day 0419 4=April, 19
%MW13 |Century Year 1994 1994

(1) Where 0=Mon., 1=Tues., 2=Wednes., 3=Thurs., 4=Fri., 5=Satur., 6=Sun.

To ensure that the realtime clock is updated on a TSX Nano V1, V2 or V3.0 at the
changeover to the year 2000, the PLC must be powered up during this time. It is
however, possible to update the realtime clock via the program.

To do this, add the following to the application :

LD [%SW53]=16#1900

ST %S50
[%SW53:=

16#2000]

5/4



Clockfunctions 5

Updating using system word %SW59

Another method of updating is to use enable bit %S59 and adjustment word %SW59.

Setting bit %S59 to 1 enables adjustment of the current date and time by word %SW59.
Word %SW59 is described in Section 6.2. It increments or decrements each of the date
and time components on a rising edge.

Example : Afront panelis created in order I:I:I:' Hours
to modify the hour, minutes and seconds F— Minutes
of the internal clock. + -
econds
%MO %859 ;? zf'\s"é’g
\ [ 0
4{ | \)’ LD %10.2 (hour)
ANDR %I0.0
%'0"2 %'0"0 %SWS59:X3 ST %SW59:X3
\ [ :
| P { } LD %I0.2
%l0.2  %I0.1 %SW59:X11 ANDR %I0.1
# } M ( ST %SW59:X11
LD %I0.3 (minute)
%I10.3 %I10.0 %SW59:X2 ANDR %10.0
—P| ( H ST %SW59:X2
%10.3  %I0.1 %SW59:X10 LD 24"0-3
# | Ipl / ANDR %I0.1
\ [ \ ST %SW59:X10
%l0.4  %I0.0 %SW59:X1 LD %10.4 (second)
# } M < ANDR %I0.0
%l0.4  %I10.1 %SW59:X9 ST %SWS9:X1
Pl / LD %10.4
4{ }—{ | \)‘ ANDR %I0.1
ST %SW59:X9

¢ Inputs %I10.2, %10.3 and %I0.4 are controlled by the Hours/Minutes/Seconds switch.
¢ Incrementation is performed by input %I0.0, pushbutton +.
e Decrementation is performed by input %I10.1, pushbutton -.
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6 Role of system bits and words

6.1 Systembits

6.1-1 List of system bits

Bit Function Init state | Control
%S0 1 = cold restart (power return with 0 S or U->S
loss of data)
%S1 1 = warm restart (power return without 0 S or U->S
loss of data)
%S4, %S5 Time base 10ms, 100ms - S
%S6, %S7 Time base 1s, 1min - S
%S8 0 = outputs saved when the PLC stops U
%S9 1 = PLC outputs reset to zero if the U
PLC is running
%S10 0 =1/0 fault 1 S
%S11 1 = watchdog overflow - S
%S13 1 =first scan after setting to RUN 1 S
%S17 1 = overflow of an unsigned arithmetic 0 S->U
operation or rotate shift
%S18 1 = arithmetic overflow or error 0 S->U
%S19 1 =scan period overshoot 0 S->U
%S20 1 =index overflow 0 S->U
%S21 1 = Grafcet initialization : sets the steps 0 U->S
to 0 and the initial steps to 1
%S22 1 =reset Grafcet to zero 0 U->S
%S23 1 = enable Grafcet presetting. 0 U->S
If held at 1, Grafcet freezes
%S49 1 =request to reset every 10s 0 U->S
transistor outputs which have been
tripped by overcurrent or short-circuit
%S50 1 = set schedule block (RTC) U
%S51 1 = schedule block not initialized or error 0 S
0 = schedule block are set
%S59 1 = adjust current date 0 U
%S69 1 =display internal bits 0 U
%S70 1 = update exchange words %IW/OW on 0 S
extension. Process Modbus request
%S71 1 = exchange via extension link S
%S72 0 = scanning of peer PLCs u
%S100 State of /DPT - S
%S118 1 = base PLC fault 0 S
%S119 1 = peer PLC fault 0 S

S = controlled by the system, U = controlled by the user, U->S = set to 1 by the user, reset to 0

by the system, S->U = set to 1 by the system, reset to 0 by the user.
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6.1-2 Detailed description of system bits

TSX 07 PLCs have system bits %Si which indicate the status of the PLC or enable the
user to intervene in its operation.

These bits can be tested in the user program in order to detect any operating event which
requires special processing. Some of them must be reset to their initial or normal state
by the program. However, the system bits which have been reset to their initial or normal
state by the system must not be reset by the program or the terminal.

System | Functio n| Description
bits
%S0 Cold Normally at 0. It is setto 1 by :
restart * A power return with loss of data (battery fault)
e The user program
* The terminal (in the Data editor).
This bit is set to 1 during the first complete scan. It is reset to O before
the next scan.
For operating information : see Part A, Section 7.1.
%S1 Warm Normally at O. It is reset to 1 by :
restart » A power return with saving of data
e The user program
* The terminal (in the Data editor).
It is reset to O by the system at the end of the first complete scan and
before updating of the outputs.
For operating information : see Part A, Section 7.1.
Time Changes in the status of these bits are controlled by an
bases internal clock. They are not synchronized with
%S4 10ms the PLC scan.
%S5 100ms
%S6 1s Exampl e : %S4 L 5ms
%S7 Imin
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System| Functio n | Description

bits

%S8 Output Initially at 1, it can be set to 0 by the program
freeze or by the terminal (in the Data editor) :

« At state 1 PLC outputs are set to 0 if the program is not being
executed normally or if the PLC changes to STOP

* At state 0 PLC outputs are kept in their existing state if a
program operation fault occurs or if the PLC changes to STOP.

%S9 Reset Normally at 0. It can be set to 1 by the program
outputs or by the terminal (in the Data editor) :

« At state 1 outputs are forced to 0 when the PLC is in RUN mode
* At state 0 outputs are updated normally.

%S10 110 Normally at 1. It is set to O when a I/O fault is detected on

fault the base PLC or the peer PLC (configuration fault, exchange fault,
hardware fault). Bits %S118 and %S119 indicate in which PLC the
fault is and words %SW118 and %SW119 detail the nature of the
fault (see Section 5.2).
Bit %S10 is reset to 1 when the fault disappears.

%S11 Watch- Normally at 0, it is set to 1 by the system when the program execution
dog time (scan time) exceeds the maximum scan time (software watchdog).
overflow Watchdog overflow causes the PLC to change to STOP.

%S13 First Normally at 0, it is set to 1 by the system during the first scan
scan after the PLC has been changed to RUN.

%S17 Carry Normally at 0, it is set to 1 by the system :
overflow ¢ In the case of carry overflow during a non-signed

arithmetic operation (remainder)

« During a rotate or shift operation it indicates the output of a bit at
1. It must be tested by the user program after each operation where
there is a risk of overflow, then reset to O by the user if an overflow
occurs.
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System | Function Description
bits
%S18 Arithmetic Normally at 0. It is set to 1 in the case of an overflow
overflow when a 16 bit operation is performed, that is :
or error « A result greater than + 32767 or less than - 32768
« Division by 0
* The square root of a negative number
* BTI or ITB conversion not significant : BCD value out of limits
It must be tested by the user program after each operation
where there is a risk of an overflow, then reset to 0 by the user
if an overflow occurs.
%S19 Scan Normally at 0, this bit is set to 1 by the system in the event
period of a scan period overrun (scan time greater than
overrun than the period defined by the user at configuration or
(periodic programmed in %SWO0).
scan) This bit is reset to 0 by the user.
%S20 Index Normally at 0, it is set to 1 when the address of the
overflow indexed object becomes less than 0 or more than the maximum size
of an object.
It must be tested by the user program after each operation where
there is a risk of overflow, then reset to 0 if an overflow occurs.
%S21 GRAFCET Normally at 0, it is set to 1 by :
initialization * A cold restart, %S0=1
* The user program, in the preprocessing program part only, using
a Set Instruction (S %S21) or a set coil -(S)- %S21.
¢ The terminal.
At state 1, it causes GRAFCET initialization. Active steps are
deactivated and initial steps are activated.
It is reset to 0 by the system after GRAFCET initialization.
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System | Function Description
bits
%S22 GRAFCET Normally at 0, it can only be set to 1 by the program in
reset pre-processing.
At state 1 it causes the active steps of the entire GRAFCET
to be deactivated. It is reset to 0 by the system at the start of the
execution of the sequential processing.
%S23 Preset Normally at 0, it can only be set to 1 by the user program
and freeze in the pre-processing program module.
GRAFCET At state 1, it validates the presetting of the GRAFCET chart.
Maintaining this bit at 1 freezes the GRAFCET (freezes the chart).
It is reset to 0 by the system at the start of the execution of the
sequential processing to ensure that the GRAFCET chart moves
on from the frozen situation.
%S49 Reactivate Normally at 0, it is set to 1 by the user to request a reactivation every
transistor 10 s of the transistor outputs which have been tripped by an
outputs overcurrent or short-circuit, the first attempt occurring 10 s after the
outputs have been tripped.
%S50 Updating Normally at 0, this bit can be set to 1 or to 0 by the program
the date or the terminal.
and time * At0, the date and time can be read.
using words » At 1, the date and time can be updated.
%SWS50 to 53
%S51 Time-of-day * AtO0, the date and time are set.
clock status » At 1, the date and time must be set by the user.
When this bitis setto 1, the time of day clock data is not valid. The date
and time may never have been configured, or the battery may be low.
%S59 Updating Normally at 0, this bit can be set to 1 or to 0 by the
the date program or the terminal.
and time * At 0, the date and time remain unchanged.
using word * At 1, the date and time are incremented or decremented
%SW59 according to the control bits set in %SW59.
%S69 Displaying Normally at 0O, this bit can be set to 1 or to 0 by the
internal program or the terminal.
bits on the e At 0 :the PLC LEDs display the status of the I/O
front panel » At1:the status of 8 internal bits (TSX 07 10, 14 and 16 I/O) or 16
of the PLC internal bits (TSX 07 20 and 24 I/O) is displayed on the PLC LEDs

(see Part A, Section 1.9).
The LED farthest to the right flashes to indicate that displaying
internal bits has been selected.
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System | Function Description
bits
%S70 Update For the base PLC, this bit is set to 1 as soon as the PLC
of has performed a complete cycle of transmitting exchange
exchange words %IW/%QW to the peer PLCs.
words For each peer PLC, this bit is set to 1 as soon as the peer PLC
has received and transmitted the exchange words with the
base PLC.
This bit is reset to 0 by the program or by the terminal.
Process This bit is set to 1 when a Modbus request is processed.
Modbus It can be used by the operator.
request This bit is reset to zero by the program or terminal.
%S71 Exchange Initially set to 0. Set to 1 until an exchange via the
via extension link is detected.
extension This bit is set to 0 when no exchange is performed via
link the extension link. Word %SW71 of the base PLC shows the
list and status of the available extensions.
%S72 Scanning Applies only to PLCs version 2.2 or lower.
of peer Normally at 0. Can be set to 1 by the program or the terminal.
PLCs * At 0 the base PLC communicates with the peer PLCs
* At 1 communication is disabled
%S100 | State of Shows the state of INL/DPT strap on the terminal port :
/DPT signal * No strap : UNI-TELWAY master protocol (%S100 = 0)
« Strap present : (/DPT at 0V) protocol defined by the application
configuration (%S100 = 1)
%S118 |Base Normally at 0. It is set to 1 when an I/O fault is detected
PLC on the base PLC. Word %SW118 determines the nature
fault of the fault.
Bit %S118 is reset to 0 when the fault disappears.
%S119 | Peer Normally at O. It is set to 1 when an I/O fault is detected
PLC on the I/0O extension. Word %SW119 determines the
fault nature of the fault.
Bit %S119 is reset to 0 when the fault disappears.
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6

6.2  Systemwords

6.2-1 List of system words

Word Function Control
%SWO0 Value of PLC scan period (periodic task) U
%SW11 Software watchdog time S
%SW14 UNITELWAY time-out Sand U
%SW15 PLC version and Ul S
%SW30 Time of last PLC scan cycle S
%SW31 Maximum time of PLC scan cycle S
%SW32 Minimum time of PLC scan cycle S
%SW50 Schedule block (RTC) function : words containing current date and|S and U
%SW51 time values (in BCD)

%SW52 %SW50 = seconds and day of the week
%SW53 %SW51 = hour and minute

%SW52 = month and day

%SW53 = century and year
%SW54 Schedule block (RTC) function : words containing the data and timeg S
%SW55 of the last power failure or PLC stop (in BCD)
%SW56 %SW54 = seconds and fault code
%SW57 %SWS55 =hour and minute

%SW56 = month and day

%SWS57 = century and year
%SW58 Identification code of last stop S
%SW59 Adjust current date U
%SW67 Value of Modbus end of frame character in ASCII mode U
%SW68 End of frame character value (reception) in ASCIl mode (TER port) U
%SW69 EXCH block error code S
%SW70 Function and type of TSX 07 PLC S
%SW71 Devices on extension link S
%SW76 Timer 1 ms S
%SW77 Timer 1 ms S
%SW78 Timer 1 ms S
%SW79 Timer 1 ms S
%SW100 | Analog module input function command word U
%SW101 | Value of acquired analog module input S
%SW102 | Analog module output function command word U
%SW103 | Value of analog module output to be generated U
%SW110 | Read counter value S
%SW111 | Fast counting functions Sand U
%SW112 |Value of potentiometer O S
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Word Function Control
%SW113 | Value of potentiometer 1 S
%SW114 |Enable schedule blocks (RTC) U
%SW118 | Base PLC status word S
%SW119 | Peer PLC status word S

S = controlled by the system,
U = controlled by the user.
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6.2-2 Detailed description of system words
TSX Nano PLCs use the following system words :

System | Function Description
words
%SWO0 PLC scan Modifies PLC scan period defined at configuration via the user
period program or the terminal (in the Data editor).
%SW11 | Watchdog Reads watchdog time (150ms).
time
%SW14 | Unitelway Is used to modify the value of the UNITELWAY time-out, via the
time-out user program (see part F Section 1.6)
%SW15 | PLC version | From versions V3.1 upwards, is used to show the version of
and Ul the PLC (most significant byte) and its Ul (least significant byte).
Eg : 0x000 : version before V3.1
0x3119 : PLC is version V3.1 and Ul : 25
%SW30 | Last Shows execution time of the last PLC scan cycle
scan (in ms).
time (1)
%SW31 | Max Shows execution time of the longest PLC scan cycle
scan since the last cold start (in ms).
time (1)
%SW32 | Min Shows execution time of shortest PLC scan cycle
scan since the last cold start (in ms).
time (1)
%SW50 | Schedule System words containing current values of the date and
%SW51 | block time (in BCD) :
%SW52 | function %SW50 : SSXN Seconds and day of the week with
%SW53 (N= 0 for Monday to 6 for Sunday)
%SW51 : HHMM Hour and Minute
%SW52 : MMDD Month and Day
%SW53 : CCYY Century and Year.
These words are controlled by the system when bit %S50 is at
0. These words can be written by the user program or by the
terminal when bit %S50 is set to 1.
%SW54 | Schedule System words containing the date and time of the last
%SWS55 | block power failure or PLC stop (in BCD) :
%SW56 | function %SW54 : Seconds and day of the week
%SW57 %SW55 : Hour and minute
%SW56 : Month and day
%SW57 : Century and year.

(1) This time corresponds to the time elapsed between the start (acquisition of inputs) and the
end (update of outputs) of a scan cycle.
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System Function Description
words
%SW58 |Code of Displays code giving cause of last stop :
last 1= Terminal switch changed from RUN to STOP
stop 2= Stop at software fault (PLC scan overshoot)
4= Power outage
5= Stop at hardware fault
%SW59  |Adjust Contains two sets of 8 bits to adjust current date.
current The operation is always performed on rising edge of
date the bit. This word is enabled by bit %S59.
Increment Decrement Parameter
bit 0 bit 8 Day of the week
bit 1 bit 9 Seconds
bit 2 bit 10 Minutes
bit 3 bit 11 Hours
bit 4 bit 12 Days
bit 5 bit 13 Months
bit 6 bit 14 Years
bit 7 bit 15 Centuries
%SW67 |End of Modbus| Is used to set 'LF' at the end of the Modbus frame in ASCII mode.
frame This word is written at 16#000A by the system on a cold start. The
user can modify this word using the program or Adjust mode when
the Master uses an end of frame character other than 16#000A.
%SW68 |End of Is used to set the parameters for the value of the end of frame byte
Reception frame| in ASCII mode. Reception ends as soon as this is received.
ASCIll mode | The default value is 16#000D.
%SW69 |EXCH block If an error occurs when using the EXCH block, output bits
error code %MSG.D and %MSG.E change to 1. This system word contains

the error code. The possible values are as follows :

0 :No error, exchange correct

1 :Transmission buffer too large

2 :Transmission buffer too small

3 :Table too small

4 :Incorrect Unitelway address (Unitelway mode only)
5 :Time - out elapsed (Unitelway mode only)

6 :Transmission error (Unitelway mode only)

7 :Bad ASCIl command (ASCII mode only)

8 :Not used
9 :Reception error (ASCII mode only)
10 : Table %KWi prohibited.

This word is set to 0 every time the EXCH block is used.
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System
words

Function

Description

%SW70

Address
and type
of PLC

Contains the following information :
* bit 0 : 0=TSX 07 3L =28 model
1= other models
« bit 2 : 1=presence of schedule block (RTC)
*hit4  bit3 PLC type TSX 07
0 0 TSX Nano with 6 inputs/ 4 outputs (10 1/O)
0 1 TSX Nano with 9 inputs/ 7 outputs (16 1/0)
1 0 TSX Nano with 14 inputs/ 10 outputs (24 1/O)
1 1 TSX Nano with AC inputs (16 1/0)
* bits 7, 6 and 5 : address of PLC (copied from address
code selector).
If there is an 1/O extension :
* bits 12 and 11 : I/O extension type (same coding as
bits 3 and 4)
* bits 13 : 1 =there is an I/O extension
The unused bits are at 0.

%SW71

Devices
on
extension
link

Shows the communication status of each extension

with the base PLC :

bit 1 : 1/O extension

bit 2 : peer PLC or analog module #2

bit 3 : peer PLC or analog module #3

bit 4 : peer PLC or analog module #4

Bit at O if there is no extension or peer, no power, or a fault.
Bit at 1 if there is an extension and exchange with

the base PLC.

%SW76
to
%SW78

Downcounting
Words
1ms

These 4 words serve as 1 ms timers.

They are decremented individually by the system every
millisecond if they have a positive value. This gives 4
downcounters downcounting in milliseconds, which is equal to an
operating range of 1 ms to 32767 ms. Setting bit 15 to 1 can be
used to stop decrementation.

LASW100

Analog
input

Analog input functions command word.
Value : 0  Analog input not valid

Value: 1  Operation without scaling

Value :2  Unipolar scale range (period 125ms)
Value : 3  Bipolar scale range (period 125ms)
Value : 4  Unipolar scale range (period 500ms)

Value : 5  Bipolar scale range (period 500ms)
Writing this word is the responsibility of the application program.
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System  |Function Description
words
%SW101 |Analog Word containing the value of the acquired analog input. The value
input range depends on the selection of operation made in %SW100.
%SW100=0 %SW101=0
%SW100=1 %SW101 varies from 0 to 1000
%SW100=2 or4d %SW101 varies from 0 to 1000
%SW100=3 or 5 %SW101 varies from -10000 to 10000
%SW102 |Analog Analog output functions command word.
output Value : 0 Normal %PWM operation
Value : 1  Operation without scaling _‘ analog
Value : 2 Unipolar scale range %PWM
Value : 3  Bipolar scale range —
Writing this word is the responsibility of the application program
%SW103 |Analog Word containing the value to be applied to the analog output. The
output value range depends on the selection of operation made in
%SW102.
%SW102=0 %SW103=0
%SW102=1 %SW103 between 5 and 249
%SW102=2 %SW103 between 0 and 10000
%SW102=3 %SW103 between -10000 and 10000
Writing this word is the responsibility of the application program
%SW110 |Up/down Read value of the counter on a rising edge at input %I0.4
counter
%SW111 |Fast Bit O : counting direction (1= upcounting, 0= downcounting)
counter Bit 1 : 1= enable HSC (direct) outputs
Bit 2 : 1= select frequency meter time base
(1=100ms, 0=1s)
Bit 3 : 1= update %FC frequency (also indicates the validity of the
acquired value on the analog input module)
This bit is reset to 0 by the user.
%SW112 |Value of Contains the conversion on 8 bits (0 to 255) of the position
potentiometer  of potentiometer number 0.
%SW113 |Value of Contains the conversion on 8 bits (0 to 255) of the position
potentiometer 1 of potentiometer number 1.
%SW114 |Schedule Enables or disables operation of schedule blocks (RTC)
block by the user program or the terminal.
enable bit 0 : 1 = enables schedule block #0
bit 15 : 1 = enables schedule block #15
Initially all schedule blocks are enabled.
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System
words

Function

Description

PoSW118

Base PLC
status

Shows faults detected on base PLC.

bit 0 : 0= tripping of one of the outputs (1)

bit 3 : 0= sensor supply fault

bit 8 : 0= TSX Nano internal fault or hardware fault

bit 9 : 0= external fault or comm. fault

bit 11 : 0= PLC performing self-tests

bit 13 : 0= configuration fault (I/O extension configured but
absent or faulty)

All the other bits of this word are at 1 and are reserved. Thus,

for a PLC which has no fault, the value of this word is :

16#FFFF.

%SW119

1/0 peer
PLC
status

Shows faults detected on 1/0O peer PLC (this word is only used by

the base PLC). The bit assignment of this word is identical

to that of word %SW118, except for :

* bit 13 : not significant

* bit 14 : peer PLC now missing although it was present at
initialization (2)

(1) after a shortcircuit or overload of the protected transistor outputs.
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7 Programming guide

7.1  Operatingmodes

PL7 language is used to take into account the three main operating mode groups (1) :
e Checking.

¢ Running or production.

» Stopping.

These different operating modes can be obtained around or starting from Grafcet using
the following methods :

e Grafcet initialization.

* Prepositioning of steps.

¢ Maintaining a situation.

e Freezing charts.

Preliminary processing and use of system bits ensure effective operating mode
management without complicating and overburdening the user program.

Structuring preliminary processing

The diagram below shows the structure which should be assigned to preliminary
processing so that each processing operation is performed in order of importance for
the following :

* Powering up Powering up yes

initialization
Processing

e Changing operating Request for
mode mode change
* Input logic Input logic
|

v

Grafcet system bits

Use of bits %S21, %S22 and %S23 is reserved for preliminary processing only. These
bits are automatically reset by the system. They must be written by operation code S
only.

Initializing Grafcet, %S21

Causes :

* on cold restart

* setting %S21 to 1 via the program or terminal.

Consequences : deactivation of all active steps and activation of all initial steps.

(1) These operating modes are defined in the "Design Guide for Operating and Stoppping Modes"
produced by the Applied Industrial Automation Development Agency.
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Resetting Grafcet, %S22

Causes : %S22 set to 1 via the program or terminal.

Consequences :
« deactivation of all active steps
» scanning of sequential processing stopped.

Prepositioning Grafcet, %S22 and %S23

Procedure :

« reset Grafcet by setting %S22 to 1

* preposition the steps to be activated by a series of S Xi instructions
 enable prepositioning by setting %S23 to 1.

Freezing a situation :

« in initial situation : by maintaining %S21 at 1 by program

« in "empty" situation : by maintaining %S22 at 1 by program
« in situation determined by maintaining %S23 at 1.

7.2  Programming advice

Handling program jumps
Use program jumps with caution to avoid loops which are too long and can increase
scan time. Avoid program jumps towards instructions which are located upstream.

Programming of outputs

An output bit or internal bit can only be controlled once in the program. In the case of
output bits, only the last value scanned is taken into account when the outputs are
updated.

Using directly-wired emergency stop sensors
Sensors used directly for emergency stops must not be processed by the PLC. They
must be connected directly to the corresponding outputs.

Handling power returns

Make power returns conditional on a manual operation, as an automatic restart of the
installation could cause unexpected operation of equipment (use system bits %S0,
%S1 and %S9).

Time and schedule block management
The state of bit %S51, which indicates any schedule block faults, should be checked.

Note : When the program is entered, the terminal checks the syntax of the instructions, the
operands and their association. The terminal diagnostics function checks programming errors
(see Appendices, Part G).
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Programming guide

Additional notes on using parentheses
* Assignment operations should not be placed within parentheses.

%I0.0

‘VTIO.1

%Q0.1
(

: %Q0.0

\

In order to perform the same function,

%IO‘.O

%IO 1

%Q0.1

%IO 2

\
%IO 2 %I10.3

oF

%Q0.0

(A

LD %I10.0

AND  %I0.1

OR(  %I0.2

S .

AND  %I0.

)

ST %Q0.1
the following equations must be programmed :

LD %10.0

MPS

AND( %I0.1

OR( %l0.2

AND  %I0.3

)

)

ST %Q0.1

MPP

AND  %I10.2

ST %Q0.0

« If several contacts are placed in parallel, they should either be nested within one
another or totally dissociated from each other.

Example 1

%IO.‘O %IO 1 %IO 5 %/00.1

\ \
%IO 2 %I10.3

%I0. 6 %I0. 7

Example 2

%IO.‘O %‘IO.‘1 %‘IO.‘S %Q0.1

The following schematics cannot be programmed.

Example 3

Example 4

%IO‘.O

O/‘TIOI1

%Q0.1

%IO.‘O

%I0.1

‘ %IO

%I0. 3

5 %Q0.1

\ I
%10.4 i i

\ \
B{IO .2
E 5 %10.4
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In order to execute schematics equivalent to those on the preceding page, they must
be modified as follows :

Example 5 (see example 3) Example 6 (see example 4)

%100 %0.1 %Q0.1 %100 %0.1 %105 %Q0-1
1] \ | | !
%l0.2  %10.3 %l0.2  %I0.3

%0.4 %I0.3 %l0.2 %l0.4

LD  %l0.0 LD  %I0.0

AND( %I0.1 AND( %Il0.1

OR(  %l0.2 OR(  %I0.2

AND  %I0.3 AND  %l0.3

) )

) AND  %l0.5

OR( %l0.4 OR(  %I0.2

AND  %10.3 AND  %10.4

) )

ST %Q0.1 )

ST %QO0.1

7.3  Reactivating protected transistor outputs on TSX 07ee ee12

When a channel fault has caused all the PLC outputs to trip (base PLC or I/O extension),
they need to be reactivated. The reset may be :

* requested by an operator command. This is the recommended type of reactivation
(see Part A Section 1.7-2)

e automatic. When using this procedure, it is essential to know in advance how
automatic reactivation of the outputs will effect the process or machine being
controlled.

This selection is made by programming system bit %S49.

Outputtripping

The appearance of an overload or short-circuit on an output causes :

 current limitation of the affected output

« tripping of all the outputs in the block (base PLC or I/O extension)

« activation with asteady light ofthe I/O lamp onthe base PLC (ifbase PLC outputs tripped)
orlamps onthe base PLC and I/O extension (if I/O extension outputs tripped)

« setting to 0 of I/O fault system bit %S10

 setting to 1 of the system bit %S118 (tripping of base PLC outputs) or system bit
%S119 (tripping of I/O extension outputs),

 setting to 0 of system word bit %SW118:XO0 (tripping of base PLC outputs) or system
word bit %SW119:X0 (tripping of I/O extension outputs).
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Manual reactivation of outputs (dependent on an operator command)
System bit %S49 is set to 1 by an external action. System bit %S49 must be resetto 0
after the outputs have been reset :

LDN %SW118:X0

ORN %SW119:X0 %SW118:X0 %10.3 %S49
AND  %I0. 3 (input 10.3 for example) /| | | (s
S %S49 %SW119:X0

LD %SW118:X0

AND %SW119:X0

%SW118:X0 %SW119:X0 %S49
R %S49 \

| | G

The minimum time between two reactivate commands allowed by the system is 10s.
If the fault which caused tripping has disappeared :

 the outputs are once again active in the state defined by the program
 the I/O lamps are extinguished

¢ the system bits and system word bits are set to their default state (normal state) :
%S10, %SW118:X0,%SW119:X0 atstate 1,%S118 and %S119 at state 0 (see Part B
Section 6.2).

Automatic reactivation of outputs
System bit %S49 is permanently set to 1 by the following program :

LD 1 %S49
ST  %S49 , (>—l

Reactivation is automatically requested every 10 seconds. When reactivation occurs,
the behavior of the outputs, the indicator lamps and system words and bits is identical
to that described for manual reactivation.
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7.4  Reversibility conditions

The following conditions must be checked so that a program can be fully reversible (1) :

The following instructions should not be s
used for reversibility : XOR, XORN, L \/%Tm %Q0-1
XORF, XORR, JMPCN, ENDCN, or N. I Q/\

Function blocks must be programmed in

such a way as to be reversible (see
Section 2.2-2).

IN Q

Function blocks cannot be cascaded or %001
o/ .

nested. %
Assignment instructions are prohibited %l0. %TMO \
};% I

between BLK and OUT_BLK N Q[
instructions, and BLK and END_BLK
instructions (if OUT_BLK is not pro-

grammed).
Permitted programming
Prohibited programming BLK  %TMO
BLK %TMO LD %I10.0
LD %l0.0 IN
ST  %Q0.1 END_BLK
IN LD  %I0.0
END_BLK ST  %Q0.1

(1) Note : When a sequence of instructions is not reversible, it remains in List Language, while
the remainder of the reversible program is converted into Ladder diagrams.

7.5 Reversibilityrules

A canonical rung cannot exceed a height of 7 cells, and a width of 11 cells (7x11
grid).

A sentence beginning with LD must end with a conditional action instruction.
JMPCN, ENDCN, NOP, and N instructions are not reversible.

Action instructions within parentheses are not reversible.

Stack instructions within parentheses are not reversible.

An OR instruction after an action instruction is not reversible.

RET, JMP, and END instructions are unconditional. No other instructions can be
in the rung.

Function block inputs and outputs can only be accessed through reversible
standard function block instructions. Direct access instructions for function blocks
are not reversible.
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« Instructions after an END_BLK in a sequence cause the sequence to be non-
reversible.

» Function block outputs used with AND and OR instructions are not reversible.

* An OR instruction inside a function block output rung must be inside parentheses.

< An unconditional action instruction between a BLK and an END_BLK is not revers-
ible.

e An OUT_BLK must be followed by a LD of a valid function block output or an
END_BLK.

e An instruction preceding an MRD or MPP instruction must be either a conditional
action instruction or a stack operation.

« A non-nested OR instruction between an MPS and MPP pair is not reversible.

¢ An OR instruction after an MPS, MRD, or MPP instruction is not reversible.

¢ An MCS instruction cannot be used in the same rung with any other action instruction.

* A subroutine call or IMPC instruction must be the last action instruction of a rung.

* When putting a title and comments before a List instruction, there can only be 1 title
line and up to 4 comment lines. If a blank line is placed anywhere between the title
and the List instruction, part of the header may not show up in the corresponding
Ladder rung header.

« If more than 4 lines of comments are placed ahead of the List instruction, the 5th
comment line will be interpreted as a title line and the comment lines above will not
appear in the corresponding Ladder rung header.

When a sequence of instructions is not reversible, it remains in List Language, while
the remainder of the reversible program is converted into Ladder diagrams as shown
below.

m RUNG 8

*I8.8 «10.1 «0@. o
I I

— 't 171
ZQB.J
—

RUNG 1

[BLE YTHY
LD
AMDN  xMB
[| oUT_BLK
LD

ST Xee.1
END_ELK
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Section 1

1 Overview

1.1  Introduction

Part C describes how to use the PL7-07 PC programming software to develop and
manage applications for TSX Nano PLCs.

1.2  Featuresofthe PL7-07 PC programming software

The PL7-07 PC programming software is a graphical development environment for
writing and maintaining applications for the TSX Nano PLCs.

The PL7-07 PC programming software is a Windows-like development tool that is used
to develop applications on IBM-AT compatible PCs with MS-DOS 3.3 or later. Among
the PL7-07 PC programming software features are :

» multi-windows capability (up to 3)
* easy use with keyboard or mouse
« reversible Ladder and List programming
* two-step, point and click Ladder programming
« offline and online programming
 program and/or data animation
 easy configuration by simply selecting desired functions in dialog boxes,
* cut, copy, and paste program editing
» symbolic programming
* independent data files
* import/export features
« cross referencing
* print-out
- program in List and/or Ladder
- configuration

1.3  Otherinformation

Part G contains appendices that are referenced in part C. The following is a list of the
appendices :

A.1 Boolean List and control instructions with Ladder equivalent
A.2 Tool bar and instruction bar menu options
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A3
A4
A5
A.6
A7

A.8
A9

PL7-07 PC programming software variables

Security features

Instruction scan time and memory usage

Importing and Exporting ASCII program files and symbol files

Transferring applications from FTX 117 terminal to PC with TSX Nano
or memory card

Troubleshooting installation problems
Running PL7-07 under Windows

A.10 Example of prepositioning Grafcet steps
A.11 Actions associated with steps

14

Conventions

The following typographic conventions are used in part C :

Format Represents

bold

A word or phrase shown in bold text indicates that you should
enter the word or phrase exactly as it appears. The names of
menu options and dialog box fields are also shown in bold type.

italics A word in italics indicates a place holder for information that you

must provide. A word in jtalics also indicates a new term, which
is then followed by a definition.

<carats> A word in <carats> indicates the name of a key on the keyboard,

such as <delete>.
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2 Installing PL7-07 PC programming software

2.1  Systemrequirements

2.1-1 Machine compatibility

The following class and/or types of computers can run the PL7-07 PC programming
software :

* IBM PC-AT compatible machines

e Programming terminals
-FTX 417 20/ 417 40 (1) / FT 2000 (1)
- FTX 507 or FTX 517 (1)

(1) recommended terminals for optimal performance

2.1-2 System requirements

The computer system should meet these minimum requirements :
* 20MHz 286 microprocessor

* 640 KB of RAM and 2 megabytes of available extended memory
* 3 megabytes of available hard disk space

* EGA, VGA, or SVGA monitor

* One available COM serial port - COM1 through COM4

* One parallel port for printing - LPT1 through LPT4

* MS-DOS version 3.3 or higher

Typical configuration :
» 386 microprocessor or higher

Although the PL7-07 PC programming software will run on a computer with the
minimum requirements above, you may experience slow performance if you have
multiple windows open simultaneously, a large amount of animated data, or a very
large application.
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2.2  Connections

The connections specific to the PC or FTX 417/FTX 507 terminals (display, keyboard,
mouse, and printer) are described in their documentation. This section describes the
following :

 connection of power supply

e connection of communications cable.

WARNING

A communication cable should never be connected to the PLC port before being
connected to the peripheral device (programming terminal, operating terminal
etc).

2.2-1 Connection of power supply
See part A, section 3.2 for connection of the power supply.

2.2-2 Connection of communication cable from PC to PLC

This connection requires communication cable TSX PCU 1030 (2.5 meters long),
supplied with TLX L PL7 07P 30E software. For a 25-pin serial connector, use the
TSX CTC 07 adaptor with communication cable TSX PCU 1030.

Supply
émm . PC-compatible

— S T
ey e HnnuungnunnnnnDﬂ
L I.I o

COM
serial port

TSXPCU 1030

2.2-3 Connection of communication cable from FTX 417 / FTX 507/517 / FT 2000
terminals to PLC

This connection requires communication cable T FTX CBF 020 (2 meters long),
supplied with software TLX L PL7 O7F 30E.

Sunot COM
i upply serial port
1 F‘"
\NEEENNERERNERNRENENI|)

T FTX CBF 020 FTX507/517

| T FTX CBF 020 Supply Supply
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2.3 Installing the PL7-07 PC programming software

The PL7-07 PC programming software is contained on two, high-density 3.5" disks. To
install the PL7-07 PC programming software :

1. With the DOS prompt atc:, insertinstallation Disk #1 in the 3.5" floppy disk drive.
2. Select the disk drive by typing a: or b: at the DOS prompt and press <enter>.
3. Type install and press <enter> to launch the PL7-07 PC programming software.

4. Select the language for installing the program. The PL7-07 PC programming
software can be installed in one of the following five standard languages : English,
French, German, Italian, and Spanish. Other languages can be installed using a
3.5" disk (supplied separately) containing the files translated into the required
language.

Note :
Contact your nearest SCHNEIDER distributor to obtain information on how to install PL7-07 in
a language other than E/F/G/I/S.

The PL7-07 PC programming software can operate in only one language at a time.
If support for multiple languages is required, create a new directory with a different
name and reinstall the software in the new directory. If you reinstall the software in
the same directory as the original installation, the newly-installed version will
overwrite the old one.

5. When prompted, select a target drive for installing the PL7-07 software.

6. When prompted, select a name for the PL7-07 PC programming software directory.
The default subdirectory is <drive>:\PL707.

7. Ifthe operating system used is DOS or Windows 3.1/95/98, when prompted select a
communication port for the PLC.
If the operating system used is Windows NT, the communication port for the PLC will
be selected using the XWAY drivers manager (see Section 2.4).

8. The program decompresses the installation files and writes the PL7-07 PC
programming software files to the selected drive.

9. When prompted, insert installation Disk #2 in the floppy drive.

10. RespondYes(orNo, seenote) tothe prompt:“"May | create/modify your CONFIG.SYS
file if needed (Y/N)?

11.Respond Yes (or No, see note) to the prompt : "May | create/modify your
AUTOEXEC.BAT file if needed (Y/N)?

12. When prompted, insert installation Disk #1 in the floppy disk drive.
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13.

When prompted, press any key to terminate the installation program and reboot the
computer.

Note : If you replied No in steps 10 and 11, write down the data displayed at the end of the
installation program to manually update your configuration files. Before terminating the installation
program, modify your configuration files as follows :

1.

3.

Display your AUTOEXEC.BAT file in a text editor. Insert the statement, C:\PL707, to the path
statement :

PATH=C:\WINDOWS;C:\DOS;C:\PL707

where C: is the drive selected and \PL707 is the name selected for the PL7-07 PC
programming software directory.

Display your CONFIG.SYS file in a text editor. Insert these statements :
FILES=30 or more
DEVICE=C:\PL707\DUNTLW.EXE PROFILE=C:\PL707\DUNTLW.001

COML1 is the default communications port. To change the COM port setting, edit
DUNTLW.001 in directory C:\PL707. In the Basic Parameters section, change the COM
setting in the line PORT=COM1:0,8,1 to the desired COM port.

Reboot the computer.

Note :

The

PL7-07 installation software, INSTALL.EXE, requires at least 370 Kb of available memory

in the 640 Kb of RAM memory to run correctly.
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2.4 Installing the UNI-TELWAY driver in Windows NT

The NT version of the UNI-TELWAY communication driver, supplied on a 3.5" high-
density floppy disk, has its own installation procedure which is different from that of
PL7.07 V3.0.

The UNI-TELWAY driver can be installed before or after installation of PL7.07 software.

To install the UNI-TELWAY driver :

1. Insert the UNI-TELWAY driver floppy disk in the disk drive.
2. Inthe Start/Run menu, select A:\Setup.exe and click OK.
3. Confirm the welcome screen by clicking Next.
4. Select a target drive for installation of the UNI-TELWAY software.
5. Define the program group (the software suggests the Modicon
Telemecanique group by default).
6. Select the language.
7. Configure the communication port by selecting :
- the communication port for the PLC
- the transmission speed
- the UNI-TELWAY address
then save the configuration.
'H Duntlw - UNI-TELWAY Configuration
File Edit 2
— COM Part—  — Rate [Baud]
= COMY; 300 = 9600 ;I
 COM2Z | | C B0 ¢ 19200 Open |
 COM3 | | 1200 ¢ 38400 Defal |
EraLl
" COM4 o200 © 57600
4800 ¢ 115200 M odern |
Self-bdaptation
[in zec] |1_
— LUNI-TELWwWAY Addresses
Base I'l Murmber |3
8. Close the dialog box by clicking on xl

9. Reboot the computer.

The configuration parameters of the UNI-TELWAY driver can be displayed and/or
modified using the XWAY drivers manager located in the program group defined during
installation (Modicon Telemecanique by default).
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This tool is made up of XWAY Manager, UNI-TELWAY Driver and XWAY Test tabs.
The XWAY Manager tab :

- provides information on the driver(s) installed
- can be used to install, update or uninstall a driver.

The Unitelway Driver tab is used to modify the configuration parameters of the UNI-
TELWAY driver.

The XWAY Test tab is used to test the link of the driver selected :

HWAY Drivers management Properties

P Manager' LIMITELWAY Driver  #wia Test I

Diriver Fequest
Marne : [IRTEEA B Request:

Diiser sz m Type :IMIHHDH [3 octets) 'l
FRemoate address :ID.254.D T|meout[ms]|3UUU %33

. R
Locsl addiess 3|— m State . Dizconkectad ":

Connect | Sart | [ Ere ititar.. | About |

Driver group
* Name : Name of the driver to be used for the UNI-TELWAY test.
« Driver instance :Instance number of the driver to be used for the test (usually 1).
* Remote address : XWAY address of the remote station in “network.station.port”
format. The address “0.254.0” is the default address (terminal port for example).

Request group

* Type : Type of request. Different sizes of mirror requests are provided.

e Time-out : Time-out in ms of the response to the request sent.

e State : Connection status : “disconnected”, “connecting...” or “connected”.

(3) Control buttons

e Connect : Opens an internal communication channel on the driver selected.

e Start : Starts sending requests to the station defined in the “Remote address” field
of the “Driver” group. This button is active in online mode only.

e More info... : Displays system information on the driver. This button is active in
online mode only.

e About : Displays the version and copyright of the XWAY drivers manager.
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2.5 Filemanagement

2.5-1 Types of files

Seven different types of file are used in the PL7-07 PC programming software. The
following describes the file types and how they are used :

Application file
(.PL7 extension)

Binary file
( .APP extension)

Data files
(.DAT extension)

Symbol files
(.SYM extension)

ASCI!I text files
(.TXT extension)
Export files

(.IL extension)

Export files
(.LD extension)

This file type (.PL7 extension) is used for storing applications
developed in the PL7-07 PC programming software. Application
files are accessed from the File menu.

This file type ((APP extension) is used for storing applications
developed in the PL7-07 PC programming software to a format
that allows the file to be transferred to the FTX 117 terminal using
a memory card or vice versa.

This file type (.DAT extension) is used for storing data pages
developed in the Data Editor. Data files are accessed from the
Tools menu when the Data Editor window is displayed. The .dat
extension allows for these files to be transferred to the FTX 117
terminal via the memory card without saving them as a binary file
type.

This file type (.SYM extension) is used when exporting symbols
from PL7-07 application to another

This file type (.TXT extension ) is used when importing and
exporting List program files.

This file type (.IL extension) is used when exporting PL7-07
List source programs to PL7 Micro.

This file type (.LD extension) is used when exporting PL7-07
Ladder source programs to PL7 Micro.

2.5-2 Backup files

When changes are made to an application file (.pl7 extension) and the file is saved,
a backup file is automatically generated with a .bak extension. The .bak file is the latest
version of the application file before the changes were made. The .bak file is stored in
the same directory as the application file. If you desire to use a different backup
extension, change the setting in the "BackupExtension=" line of the "AppDefaults"
section of the PL707.INI file using the DOS editor. If you do not want to automatically
generate a backup file, leave the space blank after "BackupExtension=".

If you want to use the .bak file, select All (*.*) from the List Files of Type field in the File
Selection dialog box. All the files in the selected directory will be displayed. Select the
.BAK file for the desired application.
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2.5-3 Making directories for the application and data files

To assist in managing the application and data files created during the development

of an application, it is recommended that separate directories be created for the

application (.PL7) and data (.DAT) files.

Note : The following access paths assume the PC programming software has been installed

in the default directory C:\PL707.

1. At the prompt C:\PL707, type MKDIR APPS to create a subdirectory for the
application files. The full path designation is C:\PL707\APPS\filename.

2. Atthe promptC:\PL707, type MKDIR DATAto create a subdirectory for the datafiles.
The full path designation is C:\PL707\DATA\filename.

2.5-4 Import/Exportinformation

The PL7-07 PC programming software allows you to import and export ASCII Program

files and Symbols files. It also allows source programs (List or Ladder ) to be exported

to PL7-Micro. The Import and Export options are accessed from the File menu. The
following describes the files that can be imported and exported :

1. List programs can be developed by external ASCII text editors. ASCIlI Program
Import and Export allows you to import and export these files between the PL7-07
software and the ASCII text editor.

2. Symbols Import and Export allows you to copy symbols from one PL7-07 software
application to another. This type of import/export uses an internal file format with
the file extension .SYM. This file type is not usable by any external tools such as text
editors and spreadsheets. Symbols Import and Export also allow you to create
default Symbols files for common applications.

3. A current PL7-07 application source program can be exported to PL7-Micro in
reversible List or Ladder. The extension used, IL (List) or LD (Ladder), determines
in which programming language it is exported. The default extension is that of the
current editor selected.

When the LD extension is used, the export file contains the program, the rung
headers (only the titles are exported in Ladder), the symbols and configuration data.
Objects which cannotbe interpreted by PL7-Micro (fast counter, Grafcetinstructions,
etc) are replaced by an empty line.

When the IL extension is used, the export file contains the program, the comment
lines, the symbols and the configuration data. Instructions comments are not
exported.

2.5-5 Importing symbols and comments

The PL7-07 PC programming software enables you to import program comments and
symbols from a file in another application. This option is used to import object symbols
and comments from a standard program without having to re-enter them.

This option is a sub menu of the "Import" function which can be accessed from the "File"
menu. An application must be open to use this option. When the option is launched,
a screen appears, enabling the source application file to be selected.
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The symbols loaded from the source application file are placed in the symbol table of
the current application. The comments (placed at the end of the program line or a whole
line) are merged with the current application.

Rules for importing symbols and comments :

e The current application should not include any symbols or comments for the import
operation to be performed successfully.

« End of line comments are placed in a rung and line with the same number and row
as the source application.

« If the rung line row does not exist in the current application, the end of line comment
is inserted as a whole line comment at the end of this rung.

« If the rung number does not exist in the current application, the end of line comment
is inserted as a whole line comment at the end of the program.

* Whole line comments are inserted as a new line in a rung and line with a number and
row equivalent to the source application.

« If the rung line row does not exist in the current application, the whole line comment
is inserted at the end of this rung.

« If the rung number does not exist in the current application, the whole line comment
is inserted at the end of the program.

Example
« Application 1 containing symbols and comments :

(* FIRST LINE COMMENT AT START OF APPLICATION¥)

(* SECOND LINE COMMENT AT START OF APPLICATIONY*)
LD INPUT_1

ST OUTPUT_1 (* PROGRAM COMMENT?)

where %I0.1=INPUT_1 and %Q0.1=OUTPUT_1

e Current application without symbols or comments :

LD %10.0
AND  %l0.1
ST %Q0.1

e After importing symbols and comments from application 1, the current application
becomes :

(* FIRST LINE COMMENT AT START OF APPLICATION®)

(* SECOND LINE COMMENT AT START OF APPLICATION*)
LD %I10.0

AND INPUT_1 (* PROGRAM COMMENT?)

ST OUTPUT_1

The comments are inserted in the program and the objects are linked to the imported
symbols.
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2.6  Runningthe PL7-07 PC programming software

2.6-1 Starting the PL7-07 PC programming software
1. Atthe prompt C:\PL707 (or other specified subdirectory), type PL707 to run the
PL7-07 programming software.

2. Thefirsttime the PL7-07 programming software is run, a PL7-07 Registration dialog
box is displayed. After entering your name and company, select Ok to open the
program in the initial state.

When the program is subsequently run, the PL7-07 Registration dialog box is
displayed briefly and the program is automatically opened at the initial state.

2.6-2 Openinganapplication
To open a new or existing application, see sections 4.2 and 4.3.

2.6-3 Closing anapplication

Only one application can be open at a time. If you try to open a second application with
one already open, an Information dialog box is displayed with the following message :
"Please close your application before opening another."

To close an application :

1. Select Close from the File menu.

If the application file is not saved before it is closed, a Warning Exit dialog box
appears.

2. SelectYesto save changes and exitthe application file orNo to close the file without
saving the changes. Select Cancel to return to the application file.

Avertissement de sortie

Uotre application a ete modifiee. Souhaitez uous sauvegarder |:
votre application 7 |:
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2.6-4 Exiting the PL7-07 PC programming software
To exit the PL7-07 PC programming software :

1. Select Exit (CTRL Q) from the File menu.

2. If Exit is selected from the initial state, the program is immediately closed and the
system returns to DOS.

3. If an application with unsaved changes is open, in either the offline or online state,
a Warning Exit dialog box is displayed.

4. SelectYestosave changes and exitthe application file orNo to close the file without
saving the changes. Select Cancel to return to the application file.

For information on executing PL7-07 in a Windows environment, see Appendix A.9.
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3 Software features

3.1 Introduction

This section explains the concepts needed to develop and manage applications with
the PL7-07 PC programming software.

3.1-1 Glossary of terms

Active window The window being currently used or currently selected. Only one
window can be active at a time. Keystrokes and commands affect
the active window. If a window is active, its title bar changes color
to differentiate it from other windows.

Applicationfile The PL7-07 application file is the main storage file for TSX Nano
programs within the PL7-07 software. In the file is the source
code, comments, and symbols for the program. Application files
are distinguished by the .pl7 file extension.

Binary file A file containing information that is in machine-readable form—
it can only be read by the TSX Nano PLC, the FTX 117 handheld
programmer, and the PL7-07 software. The binary file contains
the program that was compiled (validated) from an application
file. It contains the PLC instructions in machine language form.
No comments or symbols (program documentation) are con-
tained in this file. Binary files are distinguished by the .app file
extension.

Check box A small, square box that appears in a dialog box that can be
selected or cleared. When the check box is selected, an X
appears in the box. A check box represents an option that can be
turned on or off.

Choose Touse the mouse or keyboard to pick anitem that begins an action
in the PL7-07 software. Menu options are chosen to perform
tasks.

Clear To turn off an option by removing the X from a check box. A check
box is cleared by clicking it, or selecting it and pressing the
<spacebar>.

Click To press and release the mouse button quickly.

Clipboard Atemporary storage location used to transfer program segments

between areas of the program and between applications. Pro-
gram segments are transferred to the clipboard by using the Copy
or Cut option from the Edit menu. Program segments are trans-
ferred from the clipboard by using the Paste option from the Edit
menu.

Close To remove a window or dialog box , or to remove an application
from memory.
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Command button

Copy

Cursor

Cursor keys

Cut

Device

Device driver

Dialog box

Double-click

File

File name

Grayed-out

Inactive window

List box

In a dialog box, a button that carries out an action. A command
button has a label in it to describe the action carried out (for
example, Cancel, Help, or OK).

To duplicate a selected program segment into the clipboard to be
transferred to another location. The program segment selected
is not removed from its original location.

The place where text or programming instructions are inserted.
The PL7-07 software uses a vertical, flashing cursor for most text
insertions. The Ladder editor uses a square cursor the size of one
cell of the programming grid.

On the computer keyboard, the keys used to navigate around the
screen. These include the <home>, <end>, <page up>, <page
down>, up arrow, down arrow, right arrow, and left arrow keys.

To remove a selected program segment and place it in the
clipboard.

A component of the computer hardware configuration, such as a
modem, printer, mouse, or PLC.

The software that controls how a computer communicates with a
device, such as a PLC. For example, the PL7-07 device driver
translates information from the computer into information the PLC
can understand.

A small window that appears temporarily to request information.
Many dialog boxes have multiple options. An option must be
chosen before the PL7-07 software can continue with an action
or command.

To rapidly press and release a mouse button twice without
moving the mouse.

A collection of information that has been named and stored on a
disk.

The name of a file. The PL7-07 software uses the MS-DOS file
naming conventions.

A dimmed button, option, or menu that is displayed in light gray
instead of black. The button, option, or menu cannot be chosen.

Any open window not currently being used.

Within an application window or dialog box, a type of box that lists
available choices—for example, a list of files in a directory. If all
the choices do not fit in the list box, there is a scroll bar present
to the right of the box.
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Menu

Menu bar

Mouse pointer

Option

Paste

Point

Radio button

Scroll

Scroll arrow

Scroll bar

Scroll box

Select

Shortcut key

Status bar

System button

A list of available options, summarized by the items in the menu
bar at the top of the PL7-07 software main window. A menu is
opened by selecting the menu name.

The horizontal bar near the top of the PL7-07 software main
window containing the names of the PL7-07 software menus. The
menu bar appears below the title bar.

The arrow-shaped cursor on the screen that follows the move-
ment of the mouse. The mouse pointer indicates which area of the
screen will be affected when you press the mouse button.

A choice inamenu. For example, for File/Open, Openis an option
in the File menu.

To copy the contents of the clipboard at the location of the cursor.

To position the mouse pointer to the desired location on the
screen.

A small, round, option button that appears in a dialog box. Within
a group of related radio buttons, only one can be selected.

To move through lists and program displays (up and down) in
order to view the entire contents of the list or program.

An arrow on either end of a scroll bar that is used to scroll through
the contents of the window or list.

A bar that appears at the right edge of a window or list box when
the contents exceed the capacity of the display. Each scroll bar
contains a scroll box and two scroll arrows.

In a scroll bar, the small box that shows the position of the
information in the window or list box relative to the contents of the
entire amount of information to be displayed.

To highlight and pick the desired option from a menu, window, or
dialog box. This can be done with either the mouse or keyboard.

A key or key combination that is pressed to carry out a command
or menu option. If an option has a shortcut key, the key combina-
tion is listed to the right of the option name on the menu.

A bar that appears at the bottom of the PL7-07 software screen.
It displays information and error messages, available memory in
the PLC, whether the PLC is running or stopped, and the status
of the application with respect to the PLC (initial, offline, online,
or monitor).

A button located at the left side of the title bar that is used to close
a window by clicking on it with the mouse pointer.
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Text box A box located in a dialog box in which you type information
needed to carry out an option or action. The text box may be blank
or may contain text when the dialog box is opened.

Title bar The horizontal bar (at the top of a window) that contains the title
of the window or dialog box.
Window A rectangular area on the screen in which you view programs,

data, and documentation. A window can be opened, closed, and
have its vertical size changed. Up to 3 windows can be opened
at a time. For EGA monitors, only 2 windows can be opened at a
time.

3.2 Usingthe PL7-07 PC programming software

You can use the PL7-07 PC programming software with either a mouse and keyboard,
or keyboard only. This section describes how to perform some of the most common
actions for both methods.

3.2-1 Selecting a menu option

1. To select a menu option with a mouse, position the cursor on the desired menu
name and select it with the left mouse button. A menu appears. Position the cursor
on the desired option and select it with the left mouse button.

2. To select a menu option using keystrokes , hold down the <alt> key and enter the
letter that is underlined on the menu name. A menu appears. To select the option
from the menu, enter the letter that is underlined on the menu option name.

3. To select a menu option using a "quick key" , hold down the combination of keys
for the desired option. See the tables in appendix A.2 of part G for the options that
have quick keys.

3.2-2 Selecting a toolbar item

To select a tool bar option, position the cursor on the desired "button” and select it with
the left mouse button. See the tables in appendix A.2 of part G for the description of the
tool bar buttons.

3.2-3 Menu charts

The following two illustrations show the PL7-07 software Main menu options and the
Tools menu options. The Tools menu options vary depending on the window that is
open.
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3.3 Usingthe editors

The PL7-07 PC programming software is used to develop applications for the TSX
Nano PLC. The term application includes a program, configuration data, symbols, and
comments.

The PL7-07 software makes use of four editors in constructing an application—List/
Ladder editor, Data editor, Configuration editor, and Symbol editor. For example, you
write or edit a software program in the List/Ladder editor, construct and save data pages
in the Data editor, enter or modify symbols in the Symbol editor, and enter or modify
configuration data in the Configuration editor. Developing each application part in a
separate editor makes the application development process more systematic, result-
ing in more clearly defined applications.

You can construct the application in any order. For example, you can choose to define
configuration data first, then define data variables, and then write the program
instructions—or complete these tasks in the reverse order. There is no prescribed
order. The sections that follow describe each application part in detail.

3.3-1 Using the List and Ladder editors

The List and Ladder editors are used to develop the main program—the core of the
application. The development of the main program includes:

« assigning addresses to the inputs and outputs being used for the program..
« selecting the pre-defined data variables to be used for the program.
« constructing the order in which the program is to be executed.

You can write a program for the PLC in either the List or Ladder format. Selecting one
method over the other is a matter of preference and does not affect the application.

Ladder is a diagrammatic language that uses both graphic elements and text. Each
segment of a Ladder diagram is called a rung. For more information on developing a
Ladder program, see section 7.

List is a Boolean text-based instruction set. For more information on developing a List
program, see section 8.

In either Ladder or List, you write the program in the logical order required to control
a machine or process. You can automatically convert or reverse Ladder instructions
to List instructions. You can also reverse List to Ladder instructions, if the structure of
the program and the instructions comply with the reversibility rules. (See Section 10
of Part C.)

You can document your program using comments in both the List and Ladder Editors.
Comments are notes that you put into your program instructions in free-format text.
Comments are used primarily to document the meaning and purpose of program
instructions.
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3.3-2 Using the Data editor

The Data editor is used to construct and save data pages. A data page is used for listing
all or part of the data variables used in the main program. The data page consists of
variable addresses, current values, retained values, and associated symbols. This is
useful for adjusting and debugging an application. For more information on using the
Data editor, see section 14.

3.3-3 Using the Configuration editor

The Configuration editor is used to assign specific values to the hardware and software
resources of the PLC—timers, counters, latched inputs, external run/stop switches,
etc.—to control the behavior of these resources. The assigned values are called
configuration data. For more information on configuring PLC resources, see section 5.

3.3-4 Using the Symbol editor

The Symbol editor is used to document a program by assigning tag words (symbols)
to the data variables used in the program. Symbols are an optional part of an
application. Symbols can be used in writing the program instructions, rather than the
associated memory variable address. Symbols and their associations are defined and
edited in the Symbol Editor. For more information on the Symbol editor, see section 6.

Note that only certain parts of an application reside in the PLC. For example, while you
have an application online in the PLC, the symbols and comments remain in the PC
memory, while the program and configuration data are maintained in the PLC memory.
PL7-07 PC programming software maintains the relationship between the parts of the
application.

3.4  PL7-07PC programming software operating states

The PL7-07 PC programming software has four operating states:

* Initial

« Offline

* Online

» Monitor

The following describes the significance and attributes of each operating state.

3.4-1 Initial State

The PL7-07 software is in the initial state when the program is first started or when an
application is closed. When in the initial state, the word “Initial” appears on the right side
of the status bar at the bottom of the screen.
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3.4-2 Offline State

When you open a new or existing application, the PL7-07 software changes from the
initial to the offline state. An application in the offline state is not connected to the PLC
and exists completely within the PC memory. In the offline state, you can create and
edit program instructions and configuration data, and modify data variables, symbols,
and comments. When you open an application in the offline state, the word “Offline”
appears on the right side of the status bar at the bottom of the screen.

From the offline state, selectConnect from the PLC menuto make an online connection.
The flow chart shows the decisions made by the software when the Connect option is
chosen.

3.4-3 Online State

An application in the online state is directly connected to the PLC memory. In the online
state, you have unrestricted access to an application, unless the application is
protected. Changes that you make to the application program, configuration data, and
data variables are written directly to the PLC memory. Program documentation, such
as symbols and comments, remain in the PC memory.

Online, you have complete access to all PL7-07 software features. When the PL7-07
software has an application in the online state, the word “Online” appears on the right
side of the status bar at the bottom of the screen.

If you want to return to the offline state, selectDisconnect fromthe PLC menu. You can
also select the Close option from the File menu to return to the initial state, without
passing through the offline state. If you select Close, you will be prompted to save your
changes.

3.4-4 Monitor State

The monitor state provides access to the operating states and to the adjustment of the
PLC. For instance, you may start, stop or reboot the PLC and view, modify, or transfer
data in the Data Editor. However, the List/Ladder Editor, Symbol Editor, and Configu-
ration Editor are not available in the monitor state. If the application in the PLC is
protected (see section 12.4), the monitor state is the only online state available.

If you are in the offline state, and the application in the PLC is not protected—but is
different than the application in the PC's offline memory you may choose to enter the
monitor state. This allows you to monitor the PLC while maintaining the application in
the PC's offline memory.

When the PL7-07 software is in the monitor state, the word “Monitor” appears on the
right side of the status bar at the bottom of the screen. In the monitor state, select
Disconnect from the PLC menu to change from the monitor state to the offline state.
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3.5 Statusbar

The status bar appears at the bottom of the PL7-07 software screen. The following

shows the different parts of the status bar:

(1) Information and error messages. For a complete description of the message, click

on this area of the status bar.
(2) Available memory in the PLC (in bytes).
(3) Whether the PLC is running or stopped.

(4) The state of the PL7-07 software (initial, offline, online, or monitor).

1)

@ ©6 @
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3.6  Developing an application

3.6-1 Design phase

The following flowchart shows the recommended steps and associated sections for
creating an application in List or Ladder using the PL7-07 PC programming software.

Analysis
*Progran
*Requirements

L

1 Enter configuration
Application
Function blocks
Inputs

Outputs
Constants

L

2 Configure schedule blocks

L

3 Enter program
«Create

« Insert

* Modify
*Delete
«Duplicate

4 Backup
*On hard drive
* On floppy disk

2

Configuring PLCresources,
section 5

Configuring PLC resources,
section 5

Developinga
Ladder program, section 7

Developinga
Listprogram,
section 8

Archiving anapplication,
section 11

Optional, enabling the application being created to be customized. This
operation can also be performed in parallel with operation 3.
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Software features 3

3.6-2 Adjusting and debugging phase

The adjusting and debugging phase is done in the online or monitor state. The following
flow chart shows the recommended steps and associated sections for adjusting and
debugging an application.

Application Application
inonlinemode in offline mode
Transferthe application Transferring an application,
l section12
Startup Starting up an application,
« Adjust clock section 13
« Initialize

*RUN application

L

Debug and adjust Debugging and adjusting
« Data entry an application, section 14
« Data table entry

«Forcing

« Modification in RUN

L

Archive Archiving an application,

«in EEPROM memory section11

< on hard disk Transferring an application
and/or floppy disk section 12
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Section 4

4 Getting started

4.1 Introduction

From the initial state, you can:

« create a new application file.

¢ open an existing application file.

« transfer an application to or from the PC, the PLC, or the EEPROM.
« connect the PC to the PLC.

« open a binary file.

4.2  Creating a new application file

SelectNew from the File menu to create a new application file. Selecting New changes
the menu bar display. Menu bar items that were previously grayed out are active. In
addition, the application state displayed in the status bar is changed from initial to offline
state. PL707 V3.0 or later automatically opens the List editor or the Ladder viewer
according to the choice made in the Preferences dialog box. The Ladder viewer is open
by default.

4.3 Opening an existing application file

From the File menu, selectOpen to access an existing application file. A File Selection
dialog box is displayed.

File Selection

Filename: Directories:

[=pI7 | erpl7@87~app
[=r= 2
(= pl7a7 R
&
2 TS

List Files of Type: Drives:

Er—

Binary (*_app)
All (%)

To select a file:

1. If the drive that stores the file you want to open is not the current drive, open the
Drives field selection box by selecting the down arrow, and select a drive.
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2. IntheDirectories field, select the directory containing the file that you want to open.
3. InthelListFiles of Type field, open the list box by selecting the down arrow. Select:
 Application (*.pl7) file type to display application files

* Binary (*.app) file type to display binary files

« All (*.*) to display all files in the directory.

4. IntheFilename listbox, select afile to display in the Filename field or type the name
of the file you want to open.

5. Select Ok to open the file. When the file is opened, the application state changes
from initial to offline. Select Cancel to close the File Selection dialog box without
selecting a file.

4.4 Transferringanapplication

In the offline state, select Transfer from the PLC menu to copy an application between
the PC and the PLC. You can also select Transfer to copy an application between the
PLC and the EEPROM. The EEPROM is a permanent memory area in the PLC where
an application can be stored.

For detailed information about the Transfer option, see section 12, "Transferring an
application."

4.5 Connectingthe PCtoa PLC

In the offline state, select Connect from the PLC menu to initiate communication
between the PC and the PLC. For detailed information about the Connect option, see
section 13.1.

4.6  Opening a binary file

A binary file has an .app file extension and contains the program and the configuration
data in binary machine code.

Generally, a binary file is opened from a PC card (memory card). You can use the PC
card to transfer an application from the FTX 117 terminal to the PC (TFTX REM/RSM
cards only). For more information, see appendix A.7 in part G.
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Section 5
5 Configuring PLC resources

5.1 Introduction

The Configuration options are the hardware and software resources of the PLC. You
can configure these resources before you write a program, while you write a program,
or after you have completed a program.

The Configuration option can be selected by one of the following :

1. Aresource can be configured from the Configuration menu on the main menu bar.

2. Aresource can be configured from the Configuration Editor, accessed from the View
menu.

3. Afunction block can be configured directly from the Ladder Editor or Ladder Viewer
window.

4. A resource can be configured from the Object Browser dialog box in the Symbol
Editor.

5.1-1 Configuration menu on the main menu bar
You configure resources ESRIGNSNE £.C Lo

. N Timers
from the Configuration Counters
_ Constants
menu on the main menu LIFOFIFO Registers
. . Drum Controllers
bar. Use the Configuration Fast Counter
menu when you want to ot e
configure single objects as EAA
PLC Stah (& ity
you construct other parts of o s Security
the application. fpplication_Name
Programming Port
Schedule Blocks
Change PLC Version

5.1-2 Configuration Editor, accessed from the View menu

Aresource can be configured from the Configuration Editor, which you access from the
View menu. When you use the Configuration Editor, the Configuration Editor tool bar
is displayed.

File Edit View Tools Configuration P

The buttons on the tool bar correspond to resources in the Configuration menu and
Tools menu. Appendix A.2-1 in part G lists the options on the Configuration and Tools
menu with the corresponding buttons on the tool bar.

When a resource is selected with the Configuration Editor window open, the current
configuration of the selected resource appears. To configure Timers, Counters,
Constants, and LIFO/FIFO Registers, select the resource directly from the list displayed.
For Change PLC Version, the PLC Version Management dialog box appears instead
ofalist. To configure the other resources, select configuration editor from the View menu
to display the appropriate dialog box.
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5.1-3 Configuring a resource from the Ladder Editor or Ladder Viewer window

A resource can be configured directly from the Ladder Editor or Ladder Viewer window.
Select the desired resource by double-clicking with the mouse or pressing <enter> on
the resource in the Ladder program. The dialog box that appears allows you to
configure the resource.

5.1-4 Configuring a resource from the Symbol Editor window

A resource can be configured from the Symbol Editor window via the Object Browser
dialog box. The Symbol Editor window is selected from the View menu. Select the
desired resource from the Symbol Editor list. The Object Browser dialog box appears.
Select the Configure radio button to configure the resource.

5.2  Validate Program

Validate Program is available from the Tools menu when the Configuration Editor is
displayed. See Section 10.1 for a full description of Validate Program.

5.3  Validate Configuration

Validate Configuration is available from the Tools menu when the Configuration Editor
is active.

After changes or additions have been made to the configuration information :

1. Select Validate Configuration from the Tools menu. An Exit Warning dialog box
appears.
Note : After configuration information is changed or added, Validate Configuration must be run

to commit the new configuration information to the application. If you try to print, transfer, or save
the application without running Validate Configuration, the previous information will be used.

VERIFICATION OF ACTION t
Press YES to ACCEFT & Exit the Configuration Editor

Press CANCEL to RETURN to the Configuration Editor with no
action.
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Configuring PLC resources 5

2. Select Yes to accept the changes and exit the Configuration Editor. Select Cancel
to return to the Configuration Editor.

3. If Validate Configuration is not run after changes have been made, and you attempt
to exit the Configuration Editor window, an Exit Warning dialog box appears.

The Cowf iguration Editor is being closed. +
Changes have been made to Conf iguration Data.

Do you want to ACCEPT the changes?

Press YES to ACCEPT. Press NO to DISCARD.

Press CANCEL to return to Configuration Editor with no

Lancel

4. Select Yes to accept the changes and exit the Configuration Editor. Select No to
discard the changes and exit the Configuration Editor. Select Cancel to return to
the Configuration Editor.

5.4  Cancel Configuration

Select Cancel Configuration to exit the Configuration Editor window without making
any configuration changes to the application file.

5.5 Application Name

The Application Name is printed on the first line of an application printout. The
application name and the file name can be the same name or a different name.

Using a method described in Sections 5.1-1 through 5.1-4, select Application Name
to display the current name of the application. Select Edit to display the Application
Name dialog box.
1. Enter or change the name for the current application.

Range : 1-8 characters

Default : No default value.

2. SelectOkto committhe name entered. SelectCancel to close the dialog box without
entering or changing the application name.
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5.6 Timers

For general information about Timers, see Section 2.2-3 in Part B.

Using a method described in Sections 5.1-1 through 5.1-4, select Timers . All of the
Timers are listed. Select the Timer to be configured. The Timers dialog box appears.

Timer: Symbol:

Preset: 9999

Timer Type Timebase —————————— Ad just
(®) TON 1 ms (1168 ms CINo
) TOF (118 ms i1 sec (®)Yes

TP (®)1 min

[ provioss | [ nem | [ o | [ coea |

1. Enter the Timer number, if it is different from the one selected. For example, to
identify timer %TMO, enter O in the Timer field.
Range : 0-31

2. The Symbol field is not active in this dialog box. This field is for information only.
You can only assign a symbol to a data variable in the Symbol Editor. For more
information, see Section 6.

3. Select a Timer Type .
Range : TON (Timer On-delay), TOF (Timer Off-delay), TP (Timer Pulse).
Default : TON.

4. Select the Timebase value, which is the unit of time of the Timer.

Range : 1 millisecond (%TMO0 and %TM1 only), 10 milliseconds, 100 milliseconds,
1 second, 1 minute.

Default : 1 minute

5. Selectthe Adjust value. Select Yes or No to indicate whether a user can adjust the
Preset value in the Data Editor.

Default : Yes

6. Select Previous or Next to scroll to the Timer listed just before or after the current
Timer without closing the Timers dialog box. These buttons are only shown when
the Timers resource is accessed from the Configuration Editor window.

7. Select the Preset value.
Range : 0 to 9999
Default : 9999

8. Select Ok to commit the values selected or Cancel to close the dialog box without
changing the configuration.
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5.7 Counters

For general information about Counters, see Section 2.2-4 in Part B.

Using a method described in Sections 5.1-1 through 5.1-4, select Counters . All of the
Counters are listed. Select the Counter to be configured. The Counters dialog box
appears.

Counter: Symbaol:

Ad just
Preset: 9989 FON:- ®)ves
| Previous I ‘ Next I | 0Ok I Cancel! I

1. Enter the Counter number, if it is different from the one selected. For example, to
identify Counter %C8, enter 8 in the Counter field.

Range : 0 to 15

2. The Symbol field is not active in this dialog box. This field is for information only.
You can only assign a symbol to a data variable in the Symbol Editor. For more
information, see Section 6.

3. Selectthe Adjust value. Select Yes or No to indicate whether a user can adjust the
Preset value in the Data Editor.

Default : Yes

4. Select a Preset value.
Range : 0 to 9999
Default : 9999

5. Select Previous or Next to scroll to the Counter listed just before or just after the
current Counter without closing the Counters dialog box. These buttons are only
shown when the Counters resource is accessed from the Configuration Editor
window.

6. Select Ok to commit the values selected or Cancel to close the dialog box without
changing the configuration.

5.8 Constants

For general information about Constants, see Section 3.1-1 in Part B.

Using a method described in Sections 5.1-1 through 5.1-4, select Constants . All of the
Constants are listed. Select the Constant to be configured. The Constants dialog box
will display.

1. Enter the Constant number, if it is different from the one selected. For example, to
identify Constant %KW2, enter 2 in the Constant field.

Range : 0-63
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Constant: [2__ |

Value Format: |Decimal *
Value: [8 |
Sumbol: | |

Previous I Mext I Ok I Cancel I

2. The Symbol field is not active in this dialog box. This field is for information only.
You can only assign a symbol to a data variable in the Symbol Editor. For more
information, see Section 6.

3. Select a Value Format .
Range : Decimal, Hexadecimal, Binary, or ASCII.
Default : Decimal
4. Enter a value for the Value field, which is the value of the Constant.
Decimal Range : -32768 to 32767
Hexadecimal Range : 0000 - FFFF
Binary Range : 0000000000000000 to 1111111111111111
ASCII Range : Any ASCII character
Default : 0, decimal

5. SelectPrevious orNextto scrollto the Constant listed just before or after the current
Constant without closing the Constants dialog box. These buttons are only shown
when the Constants resource is accessed from the Configuration Editor window.

6. Select Ok to commit the values selected or Cancel to close the dialog box without
changing the configuration.

5.9 LIFO/FIFORegister

For general information about LIFO/FIFO Registers, see Section 2.2-5 in Part B.

Using amethod described in Sections 5.1-1 through 5.1-4, selectLIFO/FIFO Registers .
All of the registers are listed. Select the register to be configured. The LIFO/FIFO
Registers dialog box will display.

LIFO-FIFO REGISTERS

Register:

Symbol: |

Type
FO LIFO ®IFIFD
Previous I Next I | Ok I
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1. Enter the LIFO/FIFO Register number, if it is different from the one selected. For
example, to identify LIFO/FIFO Register %R0, enter 0 in the Register field.
Range : 0-4

2. The Symbol field is not active in this dialog box. This field is for information only.
You can only assign a symbol to a data variable in the Symbol Editor. For more
information, see Section 6.

3. Select the Register Type :

FIFO - The firstdata item entered in the register is the first to be retrieved, also known
as a queue.

LIFO - The last data item entered in the register is the first to be retrieved, also known
as a stack.

Default : FIFO
4. SelectPrevious orNext to scroll to the register listed just before or after the current
register without closing the LIFO/FIFO Registers dialog box. These buttons are only

shown when the LIFO/FIFO Register resource is accessed from the Configuration
Editor window.

5. Select Ok to commit the values selected or Cancel to close the dialog box without
changing the configuration.

5.10 Drum Controllers

For general information about Drum Controllers, see Section 2.2-6 in Part B.
Using a method described in Sections 5.1-1 through 5.1-4, select Drum Controllers .
1. Enter the Drum number. For example, to identify Drum Controller %DR2, enter 2
in the Drum field.
Range : 0to 3

2. The Symbol field is not active in this dialog box. This field is for information only.
You can only assign a symbol to a data variable in the Symbol Editor. For more
information, see Section 6.

3. Inthe Num. Steps field, enter the number of steps in the drum.

The check boxes for the number of steps you define remain active. The other check
boxes are grayed out. For example, if four steps are defined in theNum. Steps field,
then the first four rows of check boxes are enabled.

Range :1to 8

4. Inthe Command bits field, assign either a physical bit or a memory bit to each of
the 16 (0-15) logical bits that you want to use.
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Drum *DR Num. Step(s: [4 | Command bits:
Sumbol: | | %0.8.7, or %0.1.7, or xM?
B 123456 7 68 9 10111213 1415 Bit &[x08.1 | Bit 8 | |
step @: [1] [o] [1] [o] (1] [o] [o] [=] (0] [&] [o] (@] [o] [2] [@] [2] @it 1:[>08.2 | Bit 9: | |
step 1: [3] [1] [2] (1] [a] [1] [2] [] [@] [<] [2] [l [@] [<] [2] [@] Bit 2:[x0B.3 | Bit 16 |
step 2: [1] [o] [0 [e] [ [e] [2] [€] [ [l [e] [=] [2] (2] (o] [2] Bit 3:[x08.4 | Bit 11: | |
step 3: [0 [1 [ [T (o] [T (9] [o] [9] [o] [o] [o] [o] [0 [of [o] Bit 4[xn8 | Bit 12 [ |
step 4 [3] [2] [2] [&] [&] [&] [2] [ [E] [&] [2] [ [E] [=] [o] (] Bt S:[=Miw | Bit 13 | |
step 5: [0] [2] [2] [5] [&] [&] [2] [&] [E] [&] [2] (] [E] [&] [2] [ Bit & | Bit 14: [ |
step & [o] [2] [o] [o] [0] [2] [o] [o] [o] [2] [o] [ [a] [2] [o] [o] Bit 7| | Bit 15 [ |
step 7: [3] [l [2] [&] [&] [&] [ [&] [E] [e] [ (] [E] [e] [ [&]
| Previous I | Hexrt I | Ok I ‘ Cancel I

Range :

%0Q0.0-%Q0.9 : Output bit on the base PLC.
%Q1.0-%Q1.9 : Output bit on an 1/0 PLC extension.
%MO0-%M127 : Internal memory bit.

Default : No default values

5. For each step that you defined, click on the check boxes for each logical bit that you
want to activate in each step. For example, if you run Step 0, three logical bits are
activated : %Q0.1, %Q0.3, and %M8, as indicated by the "1" or ON indicator in each
check box.

6. SelectPrevious orNextto scroll to the Drum Controller listed just before or just after
the current Drum Controller without closing the Drum dialog box. These buttons are
only shown when the Constants resource is accessed from the Configuration Editor
window.

7. Select Ok to commit the values selected or Cancel to close the dialog box without
changing the configuration.

5.11 FastCounter

The Fast Counter is a single resource, which you can configure as one of three counter
types : an Up Counter, a Frequency Meter, or an Up/Down Counter. For more
information about the Fast Counter, see Section 4.4 in Part A and Section 3.4-5 in Part
B.

Using a method described in Sections 5.1-1 through 5.1-4, select Fast Counter .
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5.11-1 Up Counter

For the Up Counter, the counting input is always from input %I10.0. The counting input
is not configurable. When the state of input %10.0 changes from 0 to 1, then the current
value of the Fast Counter (%FC.V) is incremented by 1.

FAST COUNTER

Fast C

Type

{_JNone

(®)Up Counter

OFrequencg OUp/Down Counter

Input: =188 Symbol: |

Down Count Input: %18.3

Preset: l:l

Threshold Zero:
Threshold One:

Max Frequency

(S it
Ad just

[

r Read Counter Input —‘

Preset Input
None (®)18.1

Enable Input x0B8.1-2 States

None (&2 *FC.V <58 >58 51

Threshold Outputs %08.1: m @ m
(I None (®=08.1 _x08.2 =08.22 [o] [0 [9

1. Select Up Counter in the Fast Counter Type field. The following fields become
active.

* Preset Input

» Enable Input
 Threshold Outputs
* Threshold Zero

* Threshold One

* Max Frequency

2. The Symbol field is not active in this dialog box. This field is for information only.
You can only assign a symbol to a data variable in the Symbol Editor. For more
information, see Section 6.

3. Inthe Preset Input field, select %I0.1 to dedicate input %I0.1 for the Up Counter
function. When the state of input %10.1 changes from O to 1, the current value of the
Up Counter (%FC.V) is set to 0. Select None if you do not want to use input %I10.1
as a dedicated input.

4. In the Enable Input field, select %I10.2 to dedicate input %I0.2 to the Up Counter
function. If the state of %I0.2 is 1, the Up Counter is turned on; the counter counts
pulses from input %10.0 and updates the current value of the count. If the state of
%I0.2 is 0, then the Up Counter is disabled and the pulses at %I10.0 are ignored.
Select None if you do not want to use input %I0.2 as a dedicated input.
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5.

In the Threshold Outputs field, select%Q0.1 _%Q0.2 to dedicate these outputs for
the Up Counter function. The state of these two outputs is a function of the Threshold
Zero and Threshold One values' (%FC.S0 and %FC.S1, respectively) relationship
to the Fast Counter current value (%FC.V) as defined in the %Q0.1-2 States field.

For example, in the %Q0.1-2 States field shown :

»x08.1-2 States
=FC.V <58 >58 >51

=081 [ [¢ [
=08.22 [o] [ [d

When %FC.V is less than %FC.S0, output %Q0.1 is 1 and output %Q0.2 is 0.

When %FC.V is greater than %FC.S0 and less than %FC.S1, output %Q0.1is 0 and
output %Q0.2 is 1.

When %FC.V is greater than %FC.S1, output %Q0.1 is 1 and output %Q0.2 is 0.

Select None if you do not want to use outputs %Q0.1 and %Q0.2 as dedicated
outputs.

In the Threshold Zero and Threshold One fields, enter the desired values.
Range : 0 to 65535

Default : 65535

In the Max Frequency field, select5 kHz for normal mode or 10 kHz for fast mode.

Configure the relationship between %FC.S0-S1 and %Q0.1-2 in the %Q0.1-2
States field. %Q0.1 _%Q0.2 must be selected in the Threshold Outputs field for this
field to be active. In each box, enter O or 1, as desired.

Select Ok to commit the values selected or Cancel to close the dialog box without
changing the configuration.

5.11-2 Frequency Meter

For the Frequency Meter, the frequency counting input is from input %I0.0 and is not
configurable.

1.

Select Frequency in the Fast Counter Type field. The following fields become
active.

* Enable Input
e Max Frequency

The Symbol field is not active in this dialog box. This field is for information only.
You can only assign a symbol to a data variable in the Symbol Editor. For more
information, see Section 6.

For the Enable Input field, select %I10.2 to dedicate input %I0.2 to the frequency
meter function. If %10.2 is at 1, the frequency meter is turned on; that is, the input
counts pulses and updates the current value of the count. If %I0.2 is 0, then the
frequency meter is disabled and the pulses at %10.0 are ignored. Select None if you
do not want to use input %I0.2 as a dedicated input.
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FAST COUNTER

Fast C

{JNone

Type
(JUp Counter

®©

{JUp~Down Counter |

Input: =188 Symbol: |

Down Count Input: *18.3

Preset: l:l

r Read Counter Input —‘

Threshold Zero: l:l
Threshold One: [ |

Max Frequency
CEftigerry

r Preset Input —‘

Ad just
C

%08.1-2 States

Enable Input
None ®)=18.2
r Threshold Outputs —‘

4. Inthe Max Frequency field, select5 kHz for normal mode or 10 kHz for fast mode.

5. Select Ok to commit the values you selected or Cancel to close the dialog box
without changing the configuration.

*FC.V <58 >58
=0.8.1:
=0.8.2:

»51

5.11-3 Up/Down Counter
For the Up/Down Counter, the up counting input is from input %I0.0. The down counting
input is from %I0.3. Neither input is configurable.

1. Select Up/Down Counter
become active.

in the Fast Counter Type field. The following fields

* Preset
» Read Counter Input
* Preset Input
» Enable Input
* Threshold Outputs
* Threshold Zero
e Threshold One
* Adjust
2. The Symbol field is not active in this dialog box. This field is for information only.

You can only assign a symbol to a data variable in the Symbol Editor. For more
information, see Section 6.

3. In the Preset field, select the number of events to be counted by the Up/Down
Counter.

4. Inthe Read Counter Input field, select %10.4 to dedicate input %I10.4 for the Up/
Down Counter function. When input %10.4 is 1 or ON, the current value of the fast
counter is written to a system memory word in the program. Select None if you do
not want to use input %I10.4 as a dedicated input.
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FAST COUNTER

Fast C Type N |

O None O Up Counter O Frequency
Input: *18.8

Symbol: | |

Threshold Zero: | 65535

Down Count Input: %18.3

Preset: Threshold One: [ 65535
Read Counter Input Max Frequency
Chons™™" i .
Preset Input Ad just
None [OF R (JNo ®)Yes
Enable Input x08.1-2 States
None (#2182 *FCV <58 >58 >51
Threshold Outputs %0.8.1: m @ IIl
{JNone ®=008.1 _=08.2 =082 [0 [ [2]

5. In the Preset Input field, select %l0.1 to dedicate input %I0.1 for the Up/Down
Counter function. When the state of input %I10.1 changes from 0 to 1, the current
value of the Up/Down Counter (%FC.V) is set to 0. Select None if you do not want
to use input %I10.1 as a dedicated input.

6. In the Enable Input field, select %I0.2 to dedicate input %I0.2 to the Up/Down
Counter function. If the state of %10.2 is 1, the Up/Down Counter is turned on; the
counter counts pulses from inputs %I0.0 and %I10.3 and updates the current value
of the count. If the state of %10.2 is 0, then the Up/Down Counter is disabled and the
pulses at %10.0 and %i0.3 are ignored. Select None if you do not want to use input
%I0.2 as a dedicated input.

7. Inthe Threshold Outputs field, select%Q0.1 _%Q0.2 to dedicate these outputs for
the Up/Down Counter function. The state of these two outputs is a function of the
Threshold Zero and Threshold One values' (%FC.S0 and %FC.S1, respectively)
relationship to the Fast Counter current value (%FC.V) as defined in the %Q0.1-2
States field.

For example, in the %Q0.1-2 States field shown :

%08.1-2 States
=FC.V <58 >58 >51
x08.1: 1] [=] |
002 [¢] [ [o

When %FC.V is less than %FC.S0, output %Q0.1 is 1 and output %Q0.2 is 0.

When %FC.V is greater than %FC.S0 and less than %FC.S1, output %Q0.1is 0 and
output %Q0.2 is 1.

When %FC.V is greater than %FC.S1, output %Q0.1 is 1 and output %Q0.2 is 0.

Select None if you do not want to use outputs %Q0.1 and %Q0.2 as dedicated
outputs.

8. Inthe Threshold Zero and Threshold One fields, enter the desired values.
Range : 0 to 65535
Default : 65535
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9. IntheAdjust field, selectYes orNo to indicate whether a user can adjust the Preset
value in the Data Editor.

10. Configure the desired relationship between %FC.S0-S1 and %QO0.1-2 in the
%Q0.1-2 States field. %Q0.1 _%Q0.2 must be selected in the Threshold Outputs
field for this field to be active. In each box, enter 0 or 1, as desired.

11. Select Ok to commit the values selected or Cancel to close the dialog box without
changing the configuration.

512 %PLS

The %PLS/%PWM Pulse Generator function block is used as a square wave generator.
For %PLS, the on time equals the off time for a period (50% duty cycle). For %PWM,
the signal width (duty cycle) can be varied. For more information about the Pulse
Generator, see Sections 4.5 and 4.6 in Part A and Sections 3.4-3 and 3.4-4 in Part B.

Using a method described in Sections 5.1-1 through 5.1-4, select %PLS/%PWM.

5.12-1 %PLS Configured
For the %PLS pulse generator, the output is from %Q0.0 and is not configurable.
1. In the %PLS/%PWM Configured field, select %PLS Configured . The following
fields become active.
» Timebase
* Preset
* Adjust
2. The Symbol field is not active in this dialog box. This field is for information only.

You can only assign a symbol to a data variable in the Symbol Editor. For more
information, see Section 6.

*%PLS PN

*PLS-%PHM Configured
{JNot Configured ()%PWM Configured () |
Ouiput:  %0.0.8 Symbol: [ |
Timebase ——— Preset: Ad just
(1 ms (iYes (®No
OlB ms %PLS Counting Loop
®1 sec (iYes (®)No

[1]3 I Cancel I

Note : If you configure either the %PLS or the %PWM, output %Q0.0 is dedicated to %PLS or
%PWM processing and should not be assigned to any other function in the program.
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3. For the Timebase field, select the unit of time. When .1 ms is selected the %PLS
Counting Loop field becomes active.

Range : .1 ms, 10 ms, or 1 sec
Default : 1 second
4. In the Preset field, specify the length of the period in timebase units.

Range : If Timebase = 10 ms or 1 second, the value can be between 0 and 32767.
If Timebase = 0.1 ms, the value can be between 0 and 255.

Default : 0

5. Select the Adjust value and then select Yes or No to indicate whether a user can
adjust the Preset value in the Data Editor.

6. If.1 mswasselectedinthe Timebase field, the%PLS Counting Loop field becomes
active.

Select Yes to implement the Fast Counter. The period of the pulse is less than the
total scan time, requiring auxiliary processing from the Fast Counter. For the %PLS
to work properly, physically loop output %Q0.0 to input %I10.0.

Select No if you choose not to loop to the Fast Counter to perform auxiliary
processing.

7. Select Ok to commit the values selected or Cancel to exit the dialog box without
changing the configuration.

5.12-2 %PWM Configured
For the %PWM pulse generator, the output is from %Q0.0. This is not configurable.
1. Inthe %PLS/%PWM Configured field, select %PWM Configured . The following
fields become active.
» Timebase
* Preset

2. The Symbol field is not active in this dialog box. This field is for information only.
You can only assign a symbol to a data variable in the Symbol Editor. For more
information, see Section 6.

3. For the Timebase field, select the unit of time.
Range : .1 ms, 10 ms, or 1 sec
Default : 1 second

»%PLS%PUM

%PLS-%PHM Configured |

[ (®)%PHM Configured ()%PLS Configured
Output:  %0.8.8 Symbol: | |
Timebase —— Preset: Ad just
(1 ms r

(18 ms

*PLS Counting Loop
®1 sec r
[1]3 I Cancel I
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4. In the Preset field, specify the length of the period in timebase units.
Range : 0 to 9999
Default : 0

5. Select Ok to commit the values selected or Cancel to close the dialog box without
changing the configuration.

5.13 Input Filters

Input Filters is used to reduce the effect of noise on the input. For more information, see
Section 1.7-1 in Part A.

Using a method described in Sections 5.1-1 through 5.1-4, select Input Filters .

FILTER

*l8.9-3

=l8.4-7

=l8.8-13

{_INo Filter {_INo Filter {_INo Filter
(13 ms (13 ms (13 ms
(®12 ms (®12 ms (®12 ms

Cancel

1. Ineachinputfield,%I0.0-3, %I10.4-7, and%I0.8-13, selectNo Filter ,3ms, or12ms.
If No Filter is selected, the input filtering device is not activated on the inputs.
If 3 ms is selected, any pulses which are 3 ms or less in duration are filtered.
If 12 ms is selected, any pulses which are 12 ms or less in duration are filtered.
Default : 12 ms

2. Select Ok to commit the values selected or Cancel to exit the dialog box without
changing the configuration.

5.14 LatchInput

Latch Input captures and records an incoming pulse on an input. For more information,
see Section 4.3 in Part A.

Using a method described in Sections 5.1-1 through 5.1-4, select Latch Input . The
current Latch Input configuration is displayed. Select Edit to display the Latch Input

dialog box.
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LATCH INFUT

— %68 — — %18.3 —
(®)No O
IYes {IYes
— %81 — — x84 —
®ho @no
IYes {IYes
— %82 — — %8.5 —
(:)No (:)No
{IYes {IYes
1. For each input, %I0.0 through %I0.5 :
C Select Yes to enable Latch Input processing for the selected input.
Select No to disable Latch Input processing for the selected input.
Default : No

2. Select Ok to commit the values selected or Cancel to exit the dialog box without
changing the configuration.

5.15 Run/Stop Input

Run/Stop is used to start or stop the PLC from an external input. A stop command from
the PL7-07 PC programming software or the FTX 117 overrides a run command from
the Run/Stop input. For more information, see Section 4.1 in Part A.

Using a method described in Sections 5.1-1 through 5.1-4, select Run/Stop Input .

RUN-STOF INFUT

Run~Stop input
None
[@F: ] (@]
@K1 (Cy=e.4
(yxe.z [@F: R
| Ok I | Cancel I

1. Select the desired input to the PLC for the Run/Stop input.
Range : Inputs %I10.0 through %I0.5
Default : None

2. Select Ok to commit the values selected or Cancel to exit the dialog box without
changing the configuration.
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5.16 PLC Status (Security)

Use PLC Status (Security) to configure an output to indicate whether the PLC is running.
For more information, see Section 4.2 in Part A.

Using a method described in Sections 5.1-1 through 5.1-4, select PLC Status

(Security) .
PLC Status (Security)

PLC Status (Security)
HNone
()%0.8.8
[@E TR
(x08.2
(%08.3
Ok I ‘_Qancel I

1. Inthe PLC Status (Security) field, select a designated output to provide the status
of the PLC.

Range : Outputs %Q0.0 through %Q0.3
Default : None

2. Select Ok to commit the values selected or Cancel to exit the dialog box without
changing the configuration.

5.17 Scan Mode

Use Scan Mode to define whether you want to scan your program in normal or periodic
mode. For more information, see Section 1.3 in Part A.

Using a method described in Sections 5.1-1 through 5.1-4, select Scan Mode .

Scan Mode
{®) Normal Period: (2-158 ms)
OPeriodic

1. Inthe Scan Mode field :

Select Normal to scan a program one operational cycle after another, regardless
of the length of the scan.
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Select Periodic to define the minimum rate at which the CPU scans a program in
the PLC. You define the minimum rate in the Period field.

Default : Normal
2. Inthe Period field, type a value from 2 to 150 milliseconds.
Default : None

3. Select Ok to commit the values selected or Cancel to exit the dialog box without
changing the configuration.

5.18 ScheduleBlocks

For general information about Schedule Blocks, see Section 5.2 in Part B.

Using a method described in Sections 5.1-1 through 5.1-4, select Schedule Blocks .

SCHEDULE BLOCK (RTC)

Schedule Block (RTC): [
Output Bit:
Start HMonth: Start Date:
End Month: [December  [¥] End Date:
Days of Heek
Eﬂondag ET day E" d day EThursdag
’7& Friday (4] saturday [ Sunday
Start Time: Stop Time:
| Previous I \_ﬂext I ‘ Ok I ‘ Cancel I

1. Select the Configured box to activate all fields in the dialog box.

Enter the Schedule Block Number . You can define up to 16 schedule blocks in a
program.
Range : 0-15.

3. Enter anOutput Bit address. For example, if you are configuring a sprinkler to turn
on, enter the address of the output terminal connected to the sprinkler system.

4. Select the Start Month (the month that you want to activate the schedule block
output).

5. Select the End Month (the month that you want to de-activate the schedule block
output).

6. Select the Start Date (the day of the month that you want to activate the schedule
block output).

7. Selectthe End Date (the day of the month that you want to de-activate the schedule
block output).
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8. Select the Days of Week that you want to activate the schedule block output.
Checked boxes indicate the days that the output device is activated.

9. Enterthe Start Time (the hour that you want to activate the schedule block output).
Default : 00:00

10. EntertheEnd Time (the hourthatyouwantto de-activate the schedule block output).
Default : 23:59

11. SelectPrevious orNextto scroll to the Schedule Block listed just before or just after
the current Schedule Block without closing the Schedule Block dialog box. These

buttons are only shown when the Schedule Block resource is accessed from the
Configuration Editor window.

12. Select Ok to commit the values selected or Cancel to exit the dialog box without
changing the configuration.

5.19 ExtensionPort

Use Extension Port to define the PLC communications configuration.

Using a method described in Sections 5.1-1 through 5.1-4, select Extension Port .

EXTENSION PORT
Tupe
|—OPL[: E i (®)Modbus_Slave ‘

Bits/ sec
(1zee ()24@@ ()48AA (¢)9688 (119208 ‘

Extension Slave Address :
I;l Time Out (Char.) :
1D Extension Data Bits
|— ®8 AT ()7 (ASCID
PLCZ Parity ————————————
[ Ow ] (@am

PLC3 Codd
r (_INone
PLC4 Stop Bits
|— (®1 Bit )2 Bits
e |

SelectPLC Extension to configure the 1/0 extension link orModbus Slave foraModbus
Slave type link.

PLC Extension :

1. The Extension field is used to detect communication errors with the 1/O extension.
Select Yes if you want the base PLC to generate an error when communication is
not possible with the 1/0 extension.
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Select No if you do not want the base PLC to generate an error when no
communication is received from one of the PLCs defined in the dialog box.

Default : No

2. Inthe Bits/sec field, indicate the speed at which you want connected PLC units to
communicate. Communication quality decreases, or becomes less reliable, as
distance increases or as electrical noise in the environment increases. Therefore,
when communicating across large distances or in a noisy environment, decrease
the communication rate to increase reliability.

Note
| The same speed must be configured for all PLCs in the same Nanet network.

Select 9600 bits per second if the distance between PLC units is relatively large or
if there is a substantial amount of electrical noise in the environment.

Select 19200 bits per second if the distance between PLC units is relatively short
or if there is relatively little electrical noise in the environment.

Default : 19200
3. In the 1/O Extension field, indicate whether you have a PLC configured and

connected as an I/O extension. The 1/0O Extension supplies additional inputs and
outputs to the base PLC. For more information, see Section 3.5 in Part A.

Default : No

5. Inthe PLC2,PLC3, andPLCA4 fields, select Yes or No to indicate whether you have
a corresponding PLC configured as a peer PLC connected to the base PLC.

Defaults : No

6. Select Ok to commit the values selected or Cancel to exit the dialog box without
changing the configuration.

Modbus Slave : (see Section F-2.1)

1. The Bits/sec field indicates the data rate of the Modbus link.

2. The Slave Address field configures the address of the TSX Nano Modbus slave
(1 to 98).

3. The Time-out (Char) field sets the parameters for the intercharacter time (1 to 127
characters).

4. The Data Bits field selects ASCIl mode (7 bits) or RTU mode (8 bits).
It specifies the size of the data on the line.

5. The Parity field defines the addition or not of a parity bit as well as its type.

6. The Stop Bits field specifies the number of stop bits used.

Note

These parameters should be the same as those for the Modbus link Master.
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5.20 Programming Port

Use the programming port box to select the type of protocol for the TSX Nano PLC
programming port.

PROGRAMHMING PORT

Tupe ‘

(IASCH () UNI-TELWAY Master (#)

Bits~sec
(1zee  ()z4e@ (4868 (#)9680 (119208 ‘

UNI-TELHAY Slave Base Address: [4]
Parity —— Data Bits
{(#0dd (#)8 Bits ()7 Bits
OEUB" |>’ Stop Bits
{_None (&1 Bit ()2 Bits

UNI-TELWAY Time out
’7 Master and Slave Modes (char.: 38 ‘

| DK I | Cancel I

ASCII mode

Select ASCII to configure the TSX Nano terminal port in ASCII mode.

1: The Bits/sec field specifies the transmission speed of data on the line.
Available speeds are : 1200, 2400, 4800, 9600 and 19200 bits/second.

The Data Bits field selects the size of the data exchanged on the line.

The Parity field defines the addition or not of a parity bit as well as its type.

The Stop Bits specifies the number of stop bits used.

The UNI-TELWAY Time-out (Char.) field is used to set the value of the Uni-telway
time-out.

UNI-TELWAY Slave mode

Select UNI-TELWAY Slave to configure the TSX Nano terminal port in UNI-TELWAY

Slave mode :

1: The UNI-TELWAY slave address field is used to select the ADO link address of the
TSX Nano.
The PLC uses 2 consecutive logic addresses :
ADO : base address (configuration address) is the server address, which all the
UNI-TELWAY bus devices use to send requests to the TSX Nano.
AD1: ADO+1 is the client address used by the EXCH block to send requests to other
UNI-TELWAY bus devices.

2: The other fields are the same as for ASCIlI mode and should be identical to those
of the UNI-TELWAY bus Master.
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UNI-TELWAY Master mode
The format of this protocol is fixed. Only the Time-out can be configured (30 to 255).

To configure Time-outinUNI-TELWAY Master mode, modify its value intheUNI-TELWAY
Time-out (Char.) field.

5.21 ChangePLC Version

Use the Change PLC Version options to specify the model number or version of the
TSX Nano Programmable Logic Controller that you are using as the base PLC.

Using a method described in Sections 5.1-1 through 5.1-4, select Change PLC
Version . The PLC Version Management dialog box appears.

1. Locate the model number or version of your TSX Nano PLC on the left side panel :

PLC Version Management

Current Version: TSX Zx or 3% without MCR-MCS

Uersions
{TSX 2A-/2B

®XT8X 2% or 3x withoul HCRATICS
(ITSX 2z or 3x with MCR-HMCS

0K Cancel I

TSX 2A/2B : version 1 of the TSX Nano PLC.

TSX 2x or 3x without MCR/MCS : Provides all functionality, except the Master
Control Relay functions.

TSX 2xor 3x with MCR/MCS : Provides all functionality, including the Master Control
Relay functions. Use of this function will slightly improve performance.

Default : TSX 2x or 3x without MCR/MCS

2. Select Ok to commit the values selected or Cancel to exit the dialog box without
changing the PLC version.
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6 Defining symbols

6.1 Introduction

In the Symbol Editor, you assign easily recognizable alphanumeric names, called
symbols, to data variables in your program. Symbols can help you quickly examine and
analyze your program logic, greatly simplifying the development and testing process.
You can display the Symbol Editor offline and online, but it is restricted in the monitor
state.

6.2  Selecting the Symbol Editor

To display the Symbol Editor window, select Symbol Editor from the View menu.

File Edit View Tools Configuration PLC Window Help
Symbol Editor

Address Symbol Comment

6.3  Using the Symbol Editor Tools menu

The Symbol Editor window is used for defining symbols for the program addresses. The

table in appendix A.2-2 in part G lists the options on the Symbol Editor Tools menu and
the corresponding buttons on the tool bar.

File Edit View Tools Configuration PLC Window Help
- Ualidate Program hol Edito

= | 96 ?
= Insert  Ins

Delete  Del Comment

Address Sumb

Sort by Address
Sort by Symbol

[ [+

6.3-1 Validate Program

Validate Program is used to compile a program and check for errors. For more
information, see section 10.1, "Validating a program."
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6.3-2 Insert
Insert is used to add an object to the symbol table.

1.

2.

From the Symbol Editor window, select Insert. The Object Browser dialog box is
displayed.

Object Browser

fAddress: Symbolk:

[=CA | [BOTTLE_COUNTER | Configure |
zCa + Comment:

“C1 Counts up to 1088 bottles.| +

xC2

*C3

%C4 +

*C5 + - +

Filter:

’ZE—E | Previous I Hext I Ok I Cancel I

In the Address field, enter the variable address that you want the symbol to
represent. You can enter an address in two ways.

« If you know the address, you can type it directly in the Address field selection box.

* To assist you in selecting the correct address, open the Filter list box and select
a variable type.

The Address list box automatically lists all instances of the type selected.

In the Symbol field, type a symbol that describes the variable, such as
BOTTLE_COUNTER.

Guidelines:

» A symbol cannot be longer than 32 characters.

» A symbol can only contain letters (A-Z), numbers (0-9), underscores (_) and some
accented characters. When an unauthorized character is entered, a dialog box
appears on the screen to help the user. The authorized characters correspond to
page 850 of the code.

'\..l"

' A- ZAARARBMCEEEETITTONG
‘B-9', et’_"' (underlining)

A symbol must start (first character) with an alphabetical or accented character.
» A symbol cannot have any spaces or special characters.

» A symbol is not case sensitive. For example, the symbol names Pumpl and
PUMP1 are the same symbol and can only occur once in an application.

In the Comment field, type a description of the variable up to 128 characters.

If you want to configure the defined variable, select the Configure button. The
appropriate dialog box appears. For more information, see section 5.

Select Previous or Next to select the object just before or after the current object
in the symbol table.

Select Ok to commit the values or Cancel to exit the dialog box and return to the
Symbol Editor window.
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6.3-3 Delete

Delete is used to remove an object from the symbol table.

1. Select the object to be removed from the symbol table. Select Delete. A Warning
dialog box appears to prompt you to confirm the deletion.

2. Select Ok to delete the object or Cancel to exit the dialog box and return to the
Symbol Editor window.

6.3-4 Sort by Address

Sort by Address is used to list the symbol table, in alphabetic and numeric order, by
address.

1. From the Symbol Editor window, select Sort by Address .

2. The symbol table is listed, in alphabetic and numeric order, by address.

6.3-5 Sort by Symbol
Sort by Symbol is used to list the symbol table, in alphabetic order, by symbol.

1. From the Symbol Editor window, select Sort by Symbol .
2. The symbol table is listed, in alphabetic order, by symbol.

6.4  Using the Symbol Editor Edit menu

With the Symbol Editor window open, Find is the only function that is available from the
Edit menu.

Find is used to locate a symbol or address in the symbol table.

1. From the Symbol Editor window, select Find. The Find dialog box is displayed.

2. In the Find dialog box, enter the symbol or address to be located.
3. Select Ok to initiate the search or Cancel to return to the symbol table.

If the symbol or address is found, the symbol table is displayed with the line
containing the symbol or address highlighted.
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4.

For the case where you are trying to locate by symbol, if the symbol is not found,
a Warning dialog box is displayed with the message: "Symbol not found. Would you
like to create it?"

Select Ok to display the Object Browser dialog box to create the symbol. Select
Cancel to return to the symbol table.

For the case where you are trying to locate by address, if the address is not found,
the Object Browser dialog box is displayed with the desired address shown in the
Address field.

6.5

Editing a symbol

A symbol that has no variable address is an unresolved symbol. You can write a program
with unresolved symbols, while you design your program logic, and then complete the
symbol table after you complete the program. You can also choose to define symbols in

the

Symbol Editor before you write a program or while you write a program.

For example, in the program function block displayed in the List Editor, the symbol
BOTTLE_COUNTER has no assigned address and is an unresolved symbol.

Select Symbol Editor from the View menu to display the symbol, BOTTLE_COUNTER,
in the symbol field.

PL7-B7 - c\pl787app™appli.pl?
File Edit View Tools Configuration PLC Hindow Help

Symbaol Editor

F
Slx| Q] [si])

BOTTLE_COUNTER

BLK  BOTTLE_COUNTER
LD »Ia. 1
R

To define (or resolve) the symbol with an address:

1.

Select the symbol in the Symbol Editor window to display the Object Browser dialog
box.
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fiddress:

Symbol:

[=Ca

[BOTTLE_COUNTER | _

Comment:

Cerovius J[ et ] [ o J[ conco ]

2. In the Address field, assign an address to the symbol. If the address is already
assigned, an Error dialog box is displayed indicating a duplicate entry exists. Select
Ok to return to the Object Browser dialog box to assign another address.

3. After assigning the address to the symbol and making any other entries in the Object
Browser dialog box, select Ok to commit the values or Cancel to exit the dialog box
without making any changes.

4. After assigning addresses to unresolved symbols, Validate Program must be run
to allow you to toggle between Show Addresses and Show Symbols in the List Editor

window.

Note: When editing an existing symbol, if you re-name the symbol to a name not previously used
as a symbol and use an address that is already assigned to an existing symbol, the new symbol
name will be assigned to the existing address.
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7 Developing a Ladder program

7.1 Introduction

The PL7-07 PC programming software provides a user-friendly method for programming
in the Ladder format.

A ladder program is framed vertically by the power and return rails. Ladder rungs start
on the left with the first connection of the rung to the power rail and end on the right with
the outputs connected to the return rail.

Easily distinguishable icons located on tool bars and instruction bars allow the
programmer to quickly and accurately build and edit the Ladder program. The selection
and placement of the Ladder elements can be done with either the mouse or the
keyboard.

Editing of the Ladder diagram is done using a two-window format. The top window is
the Ladder Editor and the bottom window is the Ladder Viewer. You use the Ladder
Editor to insert and edit rungs. The Ladder Viewer window is used to scroll through and
view a program. Before you begin to write a program, the Ladder Viewer displays the
first rung number, Rung 0, and the END OF PROGRAM delimiter.

File Edit View Tools Configuration PLC MWindow Help
- ADDER Edito ert Rung

vI®| [of2] [w]w] &
ﬁ& TR LR | AR ke

[+

RUNG 8

«]

LADDER Viewer
jiti | i
|'RUN|3 @ END OF PROGRAM | |

[+

ﬁ%'

]

[ Orfline
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7.2

Configuring the Ladder Editor

To configure the Ladder editor :

1.

Select Preferences from the View menu to display the Preferences dialog box.

Preferences

— Editing — List~Ladder Animation —
List Hex
@Ladde; @Qecimal
— Ladder Information —————— — Display Attributes
1 line () Sumbols
()3 lines (symbols AND addresses) (#)Addresses
(_)3 lines (sumbols OR addresses) [ Display Toolbars
[ Close Ladder viewer on Edit Rung
0K Cancel |

In the Editing field, select Ladder .

After selecting Ladder in the Editing field, the Ladder Information field becomes
active.

Select1line to display one line of either the symbol oraddress, depending on which
one is selected in the Display Attributes field, defined in step 5.

Select3lines (symbols AND addresses) to display three lines with the symboland
the address at the same time. This option affects coils and contacts only. List rungs,
compare blocks, and operate blocks will show only one line; either Symbols or
Addresses depending on which one is selected in the Display Attributes field.

Select 3 lines (symbols OR addresses) to display three lines of either the symbol
or the address, depending on which one is selected in the Display Attributes field,
defined in step 5. This option affects coils and contacts only. List rungs, compare
blocks, and operate blocks will show only one line; either Symbols or Addresses
depending on which one is selected in the Display Attributes field.

You animate a program to display the current value of a variable in the PLC.

In the List/Ladder Animation box, select Hexadecimal or Decimal format for
displaying the current values when the program is animated.

In the Display Attributes field, select the desired attribute, either Symbols or
Addresses , to be displayed. When 3 lines (symbols AND addresses) is selected
inthe Ladder Information field, both attributes are displayed. Only coils and contacts
are affected. List rungs, compare blocks, and operate blocks will show only one line.
Select Display Toolbars to display the tool bars in all editor windows.

Select Close Ladder viewer on Edit rung  to display the full-screen Ladder editor
when program modifications are being entered. The Ladder viewer will automatically
reopen when the Ladder editor window is closed.

Select Ok to commit the values you selected. Select Cancel to exit the dialog box
without changing the preferences selected.
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7.3 Using the Ladder Editor

1. SelectLadder Editor from the View menu. The Ladder Viewer window is displayed.
2. Todisplay the Ladder Editor, selectinsert Rung from the Tools menu.

Above eachrungisarung header. The rung header displaysthe rung numberand can, optionally,
display atitle, alabel or subroutine declaration, and comments. Inthe Ladder Viewer window
the rung header can be toggled on or off using Toggle Rung Header .

The status bar is located at the bottom of the screen. The left side displays any error or
informational messages that may occur from the entry of a program rung.

The two-window Ladder programming environment has two tool bars and one instruction bar.

PL7-B7 - DEFR
File Edit View Tools Configuration PLC Hindow Help

1) & Y kg LI L] cE 4
(2)—— P T (R S AT | ormat tpen oo
—||[ RuNG B hd
(3) m ]
3 + + + + + + + + + + E
(€O —
k + + + + + + + + + + 1151

- LADDER Viewer

[+

RUNG @ END OF PROGRAM | |

]

(6)_ | Ortline

(1) Ladder Editor tool bar (4) Programming grid
(2) Ladder Editor instruction bar (5) Ladder Viewer tool bar
(3) Rung header (6) Error message status bar

Theicons onthetool bars correspondto optionsin the Tools menu. The Tools menu changes
depending on which window is active. The Ladder Editor and Ladder Viewer each have a
separate Tools menu.

Thetables showninappendix A.2-3and A.2-3.1inpart G listthe instructions that are available
fromthe Ladder Editor instruction bar. The right side of the Ladder Editor instruction bar gives
the name of the instruction thatis selected.
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Inserting a graphic instruction

extended ladder palette

PPN A [ S R

ra]Fin

I e 2 I Y

left section middle section right section

7.4-1 Rules for inserting graphic instructions

The following are rules for inserting graphic instructions in a Ladder rung :

1.

From lefttoright, there are eleven columnsinthe grid. The graphicinstructions locatedin
the left section of the Ladder Editor instruction bar cannot be inserted in the last column of
the grid. Additionally, the compare block instruction, which takes up two cells, cannotbe
inserted in the last two columns of the grid.

The coil, inverse coil, reset cail, set coil, and jump/subroutine call instruction can only be
insertedinthe lastcolumn of the grid. Ifyoutry to insertthese instructions anywhere else,
ahorizontal connector line is automatically inserted from that pointto the last column, where
the instruction will be inserted.

The operate block, which takes up four cells, can only be inserted inthe last four columns
ofthe grid. Ifyoutry toinsertthis instruction anywhere else, a horizontal connectorline is
automatically inserted from that point to the last four columns, where the block will be
inserted.

Thetimerand counter blocks, each which take up two horizontal cells, cannotbe inserted
in the first column of the grid or the last two columns of the grid.

The special contacts, located on the left side of the Extended Ladder Palette, cannot be
insertedinthe firstand last column ofthe grid. The exceptions tothis are the Openand Short
special contacts, which can be inserted in the first column of the grid.

Thefunction blocks, located on the Extended Ladder Palette, each of which take up two
horizontal cells, cannot be inserted in the first column or the last two columns of the grid.
There can only be one function block per rung.

Extended Ladder Palette

Special Contacts Function Blocks Special Coils
| -txgRn - | [%BRi - Shift register | | <pwp>-
| LOPENI- | |4FC-Fastcowter || -C# )
[tswrrr ;s [[am [
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7. The special coils, located on the right side of the Extended Ladder Palette, can only
be inserted in the last column of the grid. If you try to insert these instructions
anywhere else, a horizontal connector line is automatically inserted from that point
to the last column, where the instruction will be inserted.

The Ladder Editor instruction bar is used for inserting graphic instructions.
To insert graphic instructions from the Ladder Viewer window :

1. Select Insert Rung from the Tools menu to display the Ladder Editor above the
Ladder Viewer window.

2. If you want the programming grid to show, toggle the grid onfrom the Tools menu
or from the icon in the Ladder Editor tool bar.

The graphic instructions can be entered either by using the mouse or the keyboard.

7.4-2 Inserting graphic instructions using the mouse

1. Select an instruction from the instruction bar by pointing to the instruction and
clicking the left mouse button . The instruction name appears in the right section
of the Ladder Editor instruction bar.

For instructions on the Extended Ladder Palette, select the graphic instruction for
the palette from the instruction bar. The Extended Ladder Palette display appears.
Select the desired instruction from the palette using the left mouse button . The
Ladder Editor window appears with the selected instruction's name listed in the right
section of the instruction bar.

2. Place the instruction by pointing to the cell and clicking the right mouse button
The instruction selected stays active until another instruction is selected. To insert
the same instruction in another cell, point to the cell and click the right mouse button.
If you insert an instruction in a cell that already has an instruction, the previous
instruction is overwritten.

3. Press <delete> to remove an instruction from a selected cell.

7.4-3 Inserting graphic instructions using the keyboard

1. Select an instruction from the instruction bar using the listed function key. For
example, press F2 to select a normally open contact. The name of the instruction
will appear in the right section of the instruction bar.

For instructions on the Extended Ladder Palette, hold down the <shift> key and
press F10. The Extended Ladder Palette appears. Select the desired instruction.
The Ladder Editor window appears with the selected instruction's name listed in
the right section of the instruction bar.

2. Selectacellinthe Ladder Editor window using the arrow keys. Insert the instruction
in the cell by pressing the <spacebar> .

The instruction selected stays active until another instruction is selected. To insert
the instruction in another cell, select the cell and press the <spacebar> .
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If you insert an instruction in a cell that already has an instruction, the previous

instruction is overwritten.

3. Press <delete> to remove an instruction from a selected cell.

The following summarizes how to select and insert a graphic instruction, using either

the mouse or the keyboard.

Select
[] (111 Select Place
(1]
L]
[]
(][] n— [
PlaceCursor
Keys
7.5 Inserting specific contacts, coils, and function blocks
7.5-1 Inserting a contact

A contact can be inserted in any column except the last column of the grid. To insert
a normally open contact, normally closed contact, rising edge contact, or falling edge
contact :

1.

Select the contact from
the instruction bar or by
pressing the
corresponding function
key.

Place the contact by
clicking the right mouse
button in a cell. Or,
select a cell with the
cursor keys and press
the <spacebar> .

To complete the
programming of the
contact, insert an
operand or symbol as
described in Section
7.6.

File Edit Uiew Tools Confi
v | & ny I w | w
el 1 HAHFPHH = ST

|HUNE 8

File Edit View Tools Confi

v | & 0f? "
HEL o HHH{HPHNH— =

F2 | F3 | F4 | F5 ) Fb J F7 | FA | F9 | FiO

RUNG H
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7.5-2 Inserting a coil or jump/subroutine call

A coil or jump/subroutine call can only be inserted in the last column of the grid. To insert
a coll, inverse caoill, reset coil, set coil, or jump/subroutine call :

1. Select the coil or jump/
subroutine call from the
instruction bar or by
pressing the <shift>
key plus the
corresponding function
key.

2. Select the cell after the
last graphic instruction
in the rung.

— ———— N

PL7-B7 - DEFAULT
File Edit View Tools Configuration PLC HWindow Help
LADDER Editor - Insert Rung

% E-IEIE.IZIBI.H.
i i i e S

RUNG B

— ——

3. Place the coil or jump/
subroutine call by
clicking the right mouse
button in the cell, or
select the cell with the
cursor keys and press
the <spacebar> .

The horizontal connector is inserted automatically and the coil is inserted in the last cell.

4. To complete the programming of the coil, insert an operand or symbol as described
in Section 7.6.
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7.5-3 Inserting a timer or counter block

A timer or counter block cannot be inserted in the first column or the last two columns
of the grid.

1. Select the timer or
counter block from the
instruction bar or by

pressing the <shift>

key plus the

corresponding function Q’:’:L_fli‘l"ﬂq: T.'ﬁ' Timer Function Block

key. S | LIES

2. Place the contact by
clicking the right mouse
button in a cell. Or,
select a cell with the
cursor keys and press
the <spacebar> .

— ———— ;

File Edit View Toeols Configurat

v | & nl W
o e R b S e A B i
RUNG 1

The timer or counter
block is inserted

mf

3. To complete the
programming of the
timer or counter block, =« TM@

configure the block as IN
described in Section 5. || /] I

%EPE TON

B min
AN ¥
¥TMG. P 9999
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7.5-4 Inserting and removing a down connector

To insert a down connector :

1. Insert the desired instruction, such as a normally open contact, in the rung.

File Edit Ujiew Tools Cunflgurallun PLC Hindow Help

v | & L]
7 = 0 S 2 S YT
RUNG @ i
L
+ + + + + + + + + +
+ + + + + + + + + + T

2. Select the down connector from the instruction bar or by pressing F7.

3. The down connector appears on the right side of the cell just below the cell selected.
Point to the highlighted cell and click the right mouse button. Click the right mouse
button again if you want to remove the down connector.

File Edit UView Tools Configuration PLC Window Help
- dito g
v | & L] [
HEL- ﬂ' 4 |‘|P|'|‘|N|'| | |§ ':S | |{ra)l|(:;)l| ’E}l ﬂ‘g‘l’mlftl . | Down Connector
‘RUNG 3 i
IQ + + + + + + + + +
&
o + + + + + + + + + + 1+

4. To remove a down connector after it has already been placed, select erase down
connector from the instruction bar or by pressing F8.

5. Pointtothe cell above and to the left of the down connector and click the right mouse
button.

7.5-5 Inserting a comparison block
A comparison block cannot be inserted in the last two columns of the grid.

1. Selectthe comparison
block from the File Edit WUiew Tools Configu
instruction bar or by
pressing F10.

\II RUNG @
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2. Place the comparison block by clicking

the right mouse button in the cell. Or, File Edit View Tools Confi
select the cell with the cursor keys and - - - B
press the <spacebar> . v | & 0Ol w | w
The comparison block is inserted. HE';F -Irai- -I:aI-I-IE'I- -IrNsI- :) Flr'l § -:-1 rﬁ:
RUNG @

3. To complete the programming of the
comparison block, insert an operation
string as described in Section 7.6.

C

7.5-6 Inserting an operate block

An operate block is used for numerical instructions. An operate block can only be
inserted in the last four columns of the grid. If you try to insert this instruction anywhere
else, a horizontal connector line is automatically inserted from that point to the last four
columns, where the block is inserted.

1. Selectthe operate block
from the instruction bar
or by pressing <shift>
+F7.

DEFAULT
dow Help
- Insert Rung

ﬂgjzlnhg T@' | Operate |

Ly | I }l
2. Placethe operate block

by clicking the right FAULT

mousebuttoninthecell. W Help

Or, select the cell with Insert Rung

the cursor keys and
press the <spacebar> . T
#l =L |+ Operate

FT | FA ] F1 FI.I;-
The operate block is +
inserted.

3. To complete the
programming of the
operate block, insertan
operation string as
described in Section
7.6.

7/10



Developing a Ladder program 7

7.5-7 Inserting special instructions from the Extended Ladder Palette
The Extended Ladder Palette contains special contacts, function blocks, and special
coils. To insert an instruction from the Extended Ladder Palette :

1. Select the Extended Ladder Palette (+... instruction) from the instruction bar or by
pressing <shift> + F10. The Extended Ladder Palette appears.

Extended Ladder Palette

Special Contacts Function Blocks Special Coils

il

2. Select the desired instruction. The Extended Ladder Palette closes and the
selected instruction's name appears on the right side of the instruction bar.

3. Place the instruction in the desired location.

7.6 Inserting an operand or symbol

Simple Ladder instructions, such as contacts and coils, use a single operand. However,
some instructions, such as compare and operate blocks, require multiple operands
with operators or option calls, called operation strings. For example, "%MW50 :=
%MW3 + %KW5" in an operate block or "%MW15<0" in a compare block are operation
strings. You enter operation strings directly from the keyboard, just as you do when you
specify a single operand.

To insert an operand or a symbol above a contact or coil instruction :

1. Select the cell and ——— ——————
double-click with the RUNG 8 RUNG @
mouse pointer or use
the arrow keys to select
the cell and press Dg
<enter>. A rectangular — L
box appears above the '
instruction.

Note : The % character appears automatically when Show Addresses is selected in
the Ladder Viewer Tools menu
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2. Type the operand or symbol in the
rectangular box. Press <enter>. The
rectangular box closes and the oper-
and or symbol appears above the in-

struction.

To insert an operation string in a comparison or operate block :

RUNG H

RUNG H

~ila. a8

»Ie.a

T

1. Select the comparison or operate block and double-click with the mouse pointer
oruse the arrow keysto select the celland press<enter> . Arectangular box appears
in the block.

_H T

Fr | FB

2Cl+..
&

Operate

[

2. Type the operation string in the rectangular box. Press <enter>. The rectangular
box closes and the operand appears in the comparison or operate block.

Note :

FT

_HTw

FH

#Cl+..

Fa_] Fio

Operate

AMHD @ = ZMH3+ X EHD

When it is not possible to see the online instruction or symbol in the rung, the whole instruction
or symbol is displayed in the status bar at the bottom of the editor (Ladder Viewer).

RUNG ©&

»“THMO

" |IN

TTPE
TB

TEMPORIZATI
ON_COMMAND

ADJ T
#THO- P 99993

a

OUTPUT
—

TON,
1 min

RUNG 1

END OF PROGRAM
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7.7 Inserting a rung title, label, or comments

1. Select a rung header by double-clicking with the mouse pointer or use the arrow
keys to select the rung header and press <enter>. The Rung Header dialog box
appears.

Rung Header

[~

L
(") Standard (JLabel =L (") Subroutine SRn:
(Clinitial Step =%=i (®iBe (Cy=x= POST

LabelSubroutine~Step Number:

Title:|

Comment:|

2. In the Rung Header Type field, select one of three options :
Select Standard to display only the rung number, the title, and comments.

SelectLabel to designate the rung as a jump destination. A label (%Li:) is used with
a jump instruction as a jump destination. The label is displayed beneath the rung
number in the header. See Section 2.4-3 in part B for more information about jump
instructions.

SelectSubroutine to designate the rung as a call destination. The subroutine label
(SRn:)isusedin aprogram as a call destination. See Section 2.4-3 in part B for more
information about subroutine instructions.

3. If either the Label or Subroutine header type is selected, the Label or Subroutine
Number field becomes active.

In the Label or Subroutine Number field, declare the identifying number for the
label or subroutine. For example, to declare subroutine number 7, select the
Subroutine header type and enter7 in the Label or Subroutine Number field. If you
enter a value that is already used elsewhere in the program, an error message is
displayed when you press Ok.

4. In the Title field, enter up to 122 characters to describe the purpose of the rung.

5. IntheComment field, enter upto 4 lines of 122 characters of text to further document
the purpose of the rung.

6. Select Ok to close the Rung Header dialog box and update the Ladder Viewer.
Select Cancel to close the dialog box, leaving the rung header unchanged.
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7.8 Using the Ladder Editor Tools menu

The Ladder Editor window is used for inserting, creating, and editing rungs in a ladder
program. The table shown in appendix A.2-4 in part G lists the options on the Ladder
Editor Tools menu and the corresponding buttons on the tool bar.

File Edit UView Tools Configuration PLC HWindow Help
- Ualidate Program tor - Insert Rung

v | & 0

Ualidate Bung  Cirl+Enter —
HE'IF 4 |-|§+|- -IrNsl- rf Cancel Rung )171191"“’;5 -Ir-iﬁ' |
I] RUNG & New Rung Cirl+A

Clear Rung

Previous Rung Cirl+Up
Next Rung  Ctrl+Down

Toggle Grid

7.8-1 Validate Program

Use Validate Program to compile a program and check for errors. See Section 10.1 for
more details on validating a program.

7.8-2 Validate Rung

Use Validate Rung to validate an individual rung from the Ladder Editor window.

1. Select Validate Rung from the Ladder Editor Tools menu or the Ladder Editor tool
bar.

2. If the rung does not have any errors, the Ladder Editor window closes and the
Ladder Viewer window is updated with the validated rung.

3. If the rung has errors, an error message appears describing the error.amme.

7.8-3 Cancel Rung

Use Cancel Rung to exit the Ladder Editor window and return to the Ladder Viewer
window, without adding any changes to the current rung.amme.

7.8-4 New Rung

Use New Rung to validate and store the current rung in the Ladder program and start

a new rung.

1. Select New Rung from the Ladder Editor tools menu or the Ladder Editor tool bar.

2. The Ladder Editor window is cleared for the insertion of a new rung. The rung
number will be the next sequential number in the Ladder program. The Ladder
Viewer window displays the validated rung updated from the Ladder Editor window.
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7.8-5 Clear Rung

Use Clear Rung to clear the currentrung in the Ladder Editor window. The Ladder Editor
window remains open with an empty programming grid.
1. SelectClear Rung from the Ladder Editor tools menu or the Ladder Editor tool bar.

2. The Ladder Editor window displays the current rung cleared of all previous
instructions.

7.8-6 Previous Rung

Use Previous Rung to validate and store the current rung and select the preceding rung.

1. SelectPrevious Rung from the Ladder Editor tools menu or Ladder Editor tool bar.

2. The current rung is validated and stored to the Ladder program. The Ladder Editor
window then displays the rung preceding the current rung.

7.8-7 Next Rung

Use Next Rung to validate and store the current rung and select the following rung in
the Ladder program.

1. SelectNext Rung from the Ladder Editor tools menu or the Ladder Editor tool bar.

2. The current rung is validated and stored to the Ladder program. The Ladder Editor
window then displays the following rung.

7.8-8 Toggle Grid

Use Toggle Grid to switch from having the grid displayed to having it not displayed in

the Ladder Editor window.

1. Select Toggle Grid from the Ladder Editor Tools menu or from the Ladder Editor
tool bar.

2. The Ladder Editor window is displayed without the grid. Select Toggle Grid again
to display the grid.
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7.9 Usingthe Ladder Viewer Tools menu

The Ladder Viewer window is used to display and view a program. The Tools menu
for this window has a few editing options and many display options. The table in
appendix A.2-5 in part G lists the options on the Ladder Viewer Tools menu and the
corresponding buttons on the tool bar.

File Edit Uiew Configuration PLC Wind

Insert Rung Ins
Insert List Cirl+ins

Edit Current Rung Ctri+E
Delete Current Rung Cirl+D

— Yorrid Show Sumbols  Cirl+F2
TER Show Addresses Cirl+F3
'SQDJ 1 Line Address or Symbol
ZCo. P | 3 Lines Address or Symbol
HID- = |y, 3 Lines Address and Symbol

Toggle Rung Header Cirl+H
lco Toggle Grid

RUNG 2 Toggle Ladder. List
Show All As Ladder

Grafcet Step Table

7.9-1 Validate Program

Use Validate Program to compile a program and check for errors. See Section 10.1 for
more details on validating a program.

7.9-2 Insert Rung

Use Insert Rung to insert a new rung just before the rung selected in the Ladder Viewer
window.

To insert a rung :

1. Select the location where the new rung will be inserted. Select Insert Rung from
the Ladder Viewer Tools menu or from the Ladder Viewer tool bar. The Ladder
Editor window appears above the Ladder Viewer window.

7.9-3 Insert List

Use Insert List to insert a new rung just before the rung selected using the List Rung
Editor.

1. Select the location where the new rung will be inserted. Select Insert List from the
Ladder Viewer Tools menu. The List Rung Editor window appears.

2. After entering the desired instructions in the List Rung Editor window, select
Validate to check the new rungs for errors and reversibility warnings. Select Ok to
return to the Ladder Viewer window with the new rung shown in the Ladder format.
Select Cancel to return to the Ladder Viewer window without adding the new rung.

If the rung inserted using the List editor is not reversible, the new rung in the Ladder
Viewerwindow displays the Listinstructionsinstead of the Ladder format. Reversibility
rules are explained in Sections 7.4 and 7.5 of part B.
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List Rung Editor
LD zI8.1 *
ST =x08.3

- -

Errors < Reversibility Warnings

validate | ok | Cancel |

7.9-4 Edit Current Rung

Use Edit Current Rung to make changes to the selected rung.

1. Selecttherungto be edited. SelectEdit CurrentRung fromthe Ladder Viewer Tools
menu or from the Ladder Viewer tool bar. The selected rung is displayed in the
Ladder Editor window. It is also possible to open the Ladder Editor window by
double-clicking on the rung with the left-hand mouse button.

7.9-5 Delete Current Rung

Use Delete Current Rung to remove the selected rung or block of rungs (highlighted)

from the Ladder program. This includes the rung, rung header, and any label or

subroutine declarations.

1. Selectthe rung to be deleted. SelectDelete Current Rung from the Ladder Viewer
Tools menu or from the Ladder Viewer tool bar.

2. The Ladder Viewer window will update with the selected rung deleted.

7.9-6 Show Symbols

Use Show Symbols to display the symbols for instructions in the Ladder program. Either

one or three lines of symbols are displayed, depending upon the option selected as

described in Sections 7.9-8, 7.9-9, or 7.9-10.

1. Select Show Symbols from the Ladder Viewer Tools menu or from the Ladder
Viewer tool bar.

2. The symbols will be displayed above the instructions in either a one-line or three-
line format.

7.9-7 Show Addresses

Use Show Addresses to display the address for instructions in the Ladder program.

Either one or three lines of addresses are displayed, depending upon the option

selected as described in Sections 7.9-8, 7.9-9, or 7.9-10.

1. Select Show Addresses from the Ladder Viewer Tools menu or from the Ladder
Viewer tool bar.

2. The address will be displayed above the instructions in either a one-line or three-
line format.
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7.9-8 1 Line Address or Symbol

Use 1 Line Address or Symbol to display one line of either the address or symbol,

depending on which one is selected as described in Sections 7.9-6 and 7.9-7.

1. Select1 Line Address or Symbol from the Ladder Viewer Tools menu or from the
Ladder Viewer tool bar.

2. The addresses or symbols will be displayed above the instructions in a one-line
format.

7.9-9 3 Lines Address or Symbol

Use 3 Lines Address or Symbol to display three lines of either the address or symbol,

depending on which one is selected as described in Sections 7.9-6 and 7.9-7. This

option affects coils and contacts only. List rungs, compare blocks, and operate blocks

will show only one line; either Symbols or Addresses depending on which one is

selected in the Display Attributes field of the Preferences dialog box.

1. Select3Lines Address or Symbol from the Ladder Viewer Tools menu or from the
Ladder Viewer tool bar.

2. Theaddresses or symbols will be displayed above the instructions in a three-line format.

7.9-10 3 Lines Address and Symbol

Use 3 Lines Address and Symbol to display three lines of both the address and symbol.

This option affects coils and contacts only. List rungs, compare blocks, and operate

blocks will show only one line; either Symbols or Addresses depending on which one

is selected in the Display Attributes field of the Preferences dialog box.

1. Select 3 Lines Address and Symbol from the Ladder Viewer Tools menu or from
the Ladder Viewer tool bar.

2. The addresses and symbols will be displayed above the instructions in a three-line
format. The symbols will be listed above the addresses.

7.9-11 Toggle Rung Header

Use Toggle Rung Header to switch from having the rung headers displayed to having

them not displayed.

1. SelectToggle RungHeader fromthe Ladder Viewer Tools menu or fromthe Ladder
Viewer tool bar.

2. The Ladder Viewer window will be displayed without the rung headers. Select
Toggle Rung Header again to display the rung headers.

7.9-12 Toggle Grid

Use Toggle Grid to switch from having the grid displayed to having it not displayed.
1. SelectToggle Grid from the Ladder Viewer Tools menu or from the Ladder Viewer
tool bar.
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2. The Ladder Viewer window will be displayed without the grid. Select Toggle Grid
again to display the grid.

7.9-13 Toggle Ladder/List

Use Toggle Ladder/List to switch between the Ladder format and the List format for the
selected rung or rungs. To toggle the entire program between the two formats, select
List Editor or Ladder Editor from the View menu.

If a rung is being toggled to go from the List format to the Ladder format and the
reversibility rules are not met, the rung will stay in the List format. See part B for an
explanation of the reversibility rules.

1. Select the rung to be toggled. Select Toggle Ladder/List from the Ladder Viewer
Tools menu.

2. The selected rung will change from the Ladder format to the List format. For the
selected rung, select Toggle Ladder/List again to return to the Ladder format.

7.9-14 Show All As Ladder

Use Show All As Ladder to display the entire program in the ladder format. This would
be used if some ofthe rungs had beentoggled to the List format and you wanted to switch
the entire program back to the Ladder format without proceeding one rung at a time.

If a rung is in the List format and the reversibility rules are not met, that rung will stay
in the List format. See part B for an explanation of the reversibility rules.

1. Select Show All As Ladder from the Ladder Viewer Tools menu.
2. The Ladder Viewer window appears with all reversible rungs in the Ladder format.
All non-reversible rungs will stay in the List format.

7.9-15 Table of Grafcet steps (see Section 9.3 Part C)

7.10 Using the Ladder Viewer Edit menur

7.10-1 Introduction
Inthe Ladder Viewer window, you can edit a program using the options in the Edit menu.

File Edit View Tools Configuration PLC Hindow Help

Undo Cirl+Z2

Cut Cirlex

Copy Ctri+C

Paste Ctri+ld

Find  Cirbf  |FoL_SH SRL_SH
Replace CirkR |»108.5 x1@.4

Atableinappendix A.2-8in part G lists the Edit menu options and how they are selected.
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7.10-2 Marking a block

To use the Cut or Copy options, you need first to "mark" or highlight the rungs that you
want to cut or copy. You cannot mark a portion of a rung; you must mark the entire rung.
To mark a Ladder block :

1. Position the cursor at the beginning of the first rung you want to mark.

2. Hold down the <shift> key.

3. Use the up or down arrow keys to move to the end of the last rung you want to mark.
4. Release the <shift> key. The highlighted area is the marked block.

7.10-3 Undo

Use Undo to reverse the last Cut, Paste, or Delete operation performed. For example,
use Undo to restore a block of rungs that you cut, or to delete a block of rungs that you
pasted from the clipboard.

From the Ladder Viewer window :

1. Select Undo from the Edit menu.
2. The last editing operation will be reversed.

7.10-4 Cut

Use Cut to move rungs from one place to another within the same program or from one
program to another. Cut can be used in the offline or online stopped states.

The clipboard is an internal memory buffer that stores blocks of lines that you cut or copy.
If you close one program file and open another, the contents of the clipboard are
retained. The contents of the clipboard are overwritten if you cut or copy another block
of rungs.

From the Ladder Viewer window :

1. Mark the block of rungs you want to cut as described in Section 7.10-2.

2. Select Cut from the Edit menu. The marked block is deleted from the Ladder
program, but retained in the clipboard.

Ifyou want to delete the marked block without copying itto the clipboard, press<delete>.
Use <delete> when you want to remove rungs that you do not intend to use elsewhere
in the program. When you use <delete>, the contents of the clipboard remain the same.
Additionally, the current rung in a program can be removed by pressing <delete>. The
rung does not have to be marked for this to occur.

When any program rung is deleted, the Ladder Viewer window closes the rung and
automatically re-numbers the remaining program rungs.
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7.10-5 Copy

Use Copy to duplicate a marked block from the program to the clipboard. Copy does
not remove the block of marked rungs. Copy is used with the Paste option to duplicate
rungs within the same program or to copy a block of rungs from one program to another.
Copy can be used in the offline or online stopped states.

From the Ladder Viewer window :

1. Mark the block of rungs you want to copy as described in Section 7.10-2.

2. Select Copy from the Edit menu. The marked block is copied to the clipboard for
a future Paste operation.

7.10-6 Paste

Use Paste to insert rungs cut or copied to the clipboard at a new location in the program
or in a different program. The Paste option does not change the contents of the
clipboard. Paste can be used in the offline or online stopped states.

From the Ladder Viewer window :

1. Cut or copy a marked block as described in Sections 7.10-2, 7.10-4, and 7.10-5.
2. Select the rung where you want to insert the marked block.

3. Select Paste from the Edit menu. The marked block is inserted before the rung
selected in the Ladder program.

Paste can be used to copy rungs from one part of a program into another part of a
program. It can also be used to copy lines from a source program to a completely
separate target program.

7.10-7 Find

Use Find to locate each occurrence of an operand, rung, or comment string in a Ladder
program. The Find option can be used in the offline, online stopped, or online running
states.

For operands :

* There is no implicit inheritance; that is, if function block %TMO is to be found, only
function block %TMO will be found. 'AND %TMO0.Q" will not be found.
» Subroutines SRn: and labels %Li: are treated as operands.

For Comment Strings, the search operates on comments, operands, operators, labels,
and subroutines.

From the Ladder Viewer window :

1. Ifyouwantonly to search a specified portion of the Ladder program, mark the block
of rungs to be searched.

2. Select Find from the Edit menu. The Find dialog box appears.
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3.

Eind Options —————————
[Operand | (¥)Search Al
| | OSearch From Cursor

‘ 0K I | Cancel I

In the Find field, select Operand, Rung, or Comment String. Operand is used to
find an address or symbol in the Ladder program. It does not matter whether
addresses or symbols are shown for a search to be conducted for the other. For
example, if addresses are currently shown in the Ladder program, you can conduct
a search for a symbol.

Rung is used to locate a specific rung in the Ladder program by rung number. If a
rung number is entered that is greater than the last rung number of the program,
the last rung appears.

Comment String is used to locate each occurrence of a specific string of text in the
rung headers.

Range : Operand, Rung, or Comment String
Default : Operand

Note : If the program was originally written in List and reversed to Ladder, comments may be
present in the program that are "hidden"; that is, they are not shown on the Ladder rung header.
However, if a search is conducted for a Comment String that includes any of these comments,
they will be found in the search.

4.

In the blank field under the Find field, enter the value for Operand, or the Rung
number to be found. For a Comment String, enter the text to be found.

If Operand is selected in the Find field, enter an address or symbol.

If Rung is selected in the Find field, enter a program rung number.

If Comment String is selected in the Find field, enter a specific string of text.

In the Options field :

SelectSearch All to search from the beginning of the program, or in a marked block.

Select Search From Cursor to search from the current position of the cursor up to
the end of the program. Do not select Search From Cursor to search in a marked
block of rungs.

Select Search Selected Region to search only in a marked block.

7122



Developing a Ladder program 7

6. Select Ok to begin a search. Select Cancel to return to the Ladder Viewer window.

For each instance of the value that is found in the Ladder program, the following
dialog box is displayed.

7. After the last instance of the value or text is found or if the search does not find any
instance of the value or text you specified, an Information dialog box will appear
stating "lItem not found." SelectOk to end the search and return to the Ladder Viewer
window.

7.10-8 Replace

Use Replace to locate each occurrence of an operand or comment string and replace
it with another operand or comment string. Replace can be used in the offline or online
stopped states.

For operands, you can only replace :

« bits by bits (for example, %I10.0 with %M2),

« words by words (for example, %MW100 with %SW12)

« function blocks with like type function blocks (for example, %TMO with %TM2 is
allowed, whereas %TMO with %C3 is not allowed)

« immediate values with other immediate values.

There is no implicit inheritance; that is, if function block %TMO is replaced with %TM2,
only the function blocks are replaced. %TMO0.Q is not replaced with %TM2.Q.

Replace will not work if either the source or target operand is an unresolved symbol.

Replace label and subroutine will not operate on the declaration of the label or
subroutine. A label or subroutine declaration may be replaced with another label or
subroutine declaration.

For Comment Strings, anything that can be found by a string in the Ladder can be
replaced.

From the Ladder Viewer window :
1. If you want only to find and replace an operand or comment string in a specified
portion of the Ladder program, mark the block of rungs to be searched.

2. Select Replace from the Edit menu. The Replace dialog box appears.
3. Inthe Find field, select either Operand or Comment String .
Operand is used to find and replace an address or symbol in the Ladder program.

Comment String is used to find and replace a specific string of text in the rung
headers.
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Eind Options

[Operand (#)Search All

| | OSear‘ch From Cursor
Replace with: OSearch Selected Region

4. In the blank field under the Find field, enter the value for the Operand, or the text
for the Comment String, to be found and replaced.

If Operand is selected in the Find field, enter an address or symbol.
If Comment String is selected in the Find field, enter a specific string of text.

5. In the Replace with : field, enter the value or text that is to replace the found value
or text.

If Operand is selected in the Find field, enter an address or symbol.
If Comment String is selected in the Find field, enter a specific string of text.
6. Inthe Options field:

Select Search All to find and replace from the beginning of the program, or in a
marked block.

Select Search From Cursor to find and replace from the current position of the
cursor up to the end of the program. Do not select Search From Cursor to search
in a marked block of rungs.

Select Search Selected Region to find and replace only in a marked block.

7. SelectReplace All tofind each occurrence of the specified value or text and replace
with the value or text specified in the Replace with: field. These operations are
performed automatically. After all of the occurrences have been found and replaced,
an Information dialog box appears stating the number of occurrences replaced.
Select Ok to return to the Ladder Viewer window.
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Developing a Ladder program 7

8. Select Ok to begin the find and replace operation. Select Cancel to return to the
Ladder Viewer window.

For each instance of the value or text that is found in the Ladder program, the
Replace dialog box is displayed.

Replace

Replace Al

9. Inthe Replace dialog box, select Replace, Find Next , Replace All , or Cancel.

Replace changes the current value or text to the value or text specified in the
Replace with: field.

Find Next makes no changes to the value or text currently highlighted and searches
for the next occurrence of the value or text.

Replace All finds each occurrence of the specified value or text and replaces each
occurrence with the value or text specified in the Replace with: field. After all of the
occurrences have been found and replaced, an Information dialog box appears
stating the number of occurrences replaced. Select Ok to return to the Ladder
Viewer window.

Cancel exits the find and replace operation and an Information dialog box appears
stating the number of occurrences replaced. Select Ok to return to the Ladder
Viewer window.

<6> occurences replaced

10. After the last occurrence has been found and replaced, an Information dialog box
appears stating the number of occurrences replaced. Select Ok to return to the
Ladder Viewer window.
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8 Developing a List program

8.1 Introduction

The List Editor is a simple line editor for writing and editing List programs. The List Editor
is selected using the Preferences option from the View menu.

You can use the List Editor in the online or offline state. However, in the online run state,
you can only insert, delete, or modify certain instructions and use certain options.

Some instructions require balancing or complementary instructions. For example, a
BLK instruction requires an END_BLK instruction. An instruction modified by a
parenthesis requires a closing parenthesis—all in the same scan.

To maintain an effective scan rate, the PLC accepts a single instruction line at a time.
Consequently, there is no mechanism to write these complex instructions without Neg
severely diminishing the performance of the PLC. Therefore, you cannot insert, modify,
or delete some instructions while the PLC is in the online state and running.

8.2  Configuring the List Editor

To configure the List Editor:
1. Select Preferences from the View menu to display the Preferences dialog box.

Preferences

— List~Ladder Animation —
Hex

@ Decimal

r— Ladder Information ——————————— — Display Atiributes
OSJmhuls

@ﬂddresses
[<] Display Toolbars
Dﬂuln Line Validate

Hgs I Cancel I

2. Inthe Editing field, select List. The Ladder Information field is not active when List
is selected.

3. After selecting Listin the Editing field, the Auto Line Validate field becomes active.
In the online state, program lines are automatically validated as you enter them.
SelectAuto Line Validate toautomatically validate program lines as you enterthem
in the offline state.

Use Auto Line Validate to help debug a program as it is written. Auto Line Validate
does not replace the Validate Program option. Before you transfer a program to the
PLC, run Validate Program.
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Do not select Auto Line Validate if you prefer to write a program with syntactical
errors and unresolved symbols. If Auto Line Validate is selected, errors and
unresolved symbols must be corrected before you can exit the line.

Default: Auto Line Validate is not selected.

4. You animate a program to display the current value of a variable in the PLC. In the
List/Ladder Animation box, select the number format for displaying the current
values when the program is animated.

Range: Hexadecimal or Decimal
Default: Decimal

5. In the Display Attributes field, select the desired attribute, either Symbols or
Addresses, to be displayed with the line number and operator.

Default: Addresses

6. Select Display Toolbars to display the tool bars in all editor windows.

7. Select Ok to commit the values you selected. Select Cancel to exit the dialog box
without changing the preferences selected.

8.3  Using the List editor

1. Select the List Editor from the View menu. The List Editor window is displayed.

PL7-87 — c\pl7B7 app™appli.pl7

File Edit View Tools Configuration PLC Uindow Help
E LIST Editor
(0 I o P s [ [ 5 R [ [ [ S I

a BLK BOTTLE_COUNTER

1?7 LD »Iia.1 (=INITIALISATION )

g ED »Iie. 2

4 cu

S END_BLK
- ——— (= THIS IS A REMARKE =)

7 LD »C1.D

8 5T »x0A. 1

2. Type instructions directly from the keyboard or select operators and operands from
the instruction bar using either the keyboard or a mouse. Maintain a space between
the operator and the symbol or between the operator and an address.
The List instruction bar displays the most commonly used List operators and
operands. The instruction bar enhances the speed and accuracy of writing a List
program. For more information about the instructions in the bar, see appendix A.2-
6 in part G.

3. You can enter a symbol, such as START_SWITCH, rather than an address, such

as %I0.7. For more information about using symbols in your program, see section
6, "Defining symbols."
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Developing a List program 8

4. Optionally, you can enter a line comment at the end of a program line. A line
comment is free-format text you enter to document a program. Write the comment
between two markers or comment delimiters. The comment delimiters are an open
parenthesis followed by an asterisk (* before the comment and an asterisk followed
by a close parenthesis *) after the comment, as shown below:

(*THIS IS A COMMENT.*)

5. Maintain at least one space between the operator, operand, and comments, as
shown below:

LD START_SWITCH (*START CONVEYOR¥)
6. After you write a line, press <Enter>.

PL7-07 PC Programming Software automatically reformats the line for you and
assigns the completed line a line number. The cursor advances to a new line.

The number to the left of a program line is called a program line number. These
numbers help you locate individual program lines when you want to debug
problems found during Validate Program. These numbers correspond to the
program line numbers in the FTX 117 Hand Held Programmer.

8.4  Using the List Editor Tools menu

The List Editor Tools menu is used for validating the program and showing either
symbols or addresses.

PL7-87 — c:~pl7B7 ~app~appli.pl7

File Edit Uiew Configuration PLC Llindouw Help -

8.4-1 Validate Program

Use Validate Program to compile a program and check for errors. See section 10.1 for
more details on validating a program.

Show Addresses Cirl+-F3 rgarroN">
Grafcet Step Table

8.4-2 Show Symbols

Use Show Symbols to display symbols, instead of addresses, in the List Editor. If an
address has a corresponding symbol, the symbol appears in the program. If an address
has no corresponding symbol, the address appears.
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Use Show Symbols in either the offline or online state. Selecting Show Symbols does
not restrict your ability to insert symbols or addresses in any way.

To display symbols in the List Editor, select Show Symbols from the Tools menu.
Symbols, rather than addresses, are displayed.

File Edit VUiew Tools Configuration PLC UWindow Help

LIST Editor
D[ TR O EOH T e L
8 Lb 1 *+
1 STN FREEZE_BIT
2 LD  COLD_STRT
3 OR___ UARM_STRT

7

SHIFT

8.4-3 Show Addresses
Use Show Addresses to display addresses, instead of symbols, in the List Editor. The
address appears in the program whether or not it has a corresponding symbol.

Use Show Addresses in either the offline or online state. Selecting Show Addresses
does not restrict your ability to insert addresses or symbols in any way.

To display addresses in the List Editor, select Show Addresses from the Tools menu.
Addresses, instead of symbols, are displayed.

File Edit Uiew Tools Configuration PLC UWindow Help

LIST Editor
2 [L0] STy OR oA N e =P
0 LD 1 4]
1 STN S8 =
2 LD xso -
3 OR __ xS1

8.4-4 Grafcet Step Table (see Section 9.3 Part C)

8.5 Using the List Editor Edit menu

8.5-1 Introduction

In the List Editor window, you can edit a program using the options in the Edit menu.
File Edit View Tools Configuration PLC Uindow Help

Undo Ctri+Z LIST Editor

Cut  Cirl+X §oh i
8| Copy Cirl+C +
1 Paste  CirlVy ]
z K_VAR
3| Find Ctri+F H
"f Replace Cirl+R -l-.

Atable inappendix A.2-8 in part G lists the Edit menu options and how they are selected.
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Developing a List program 8

8.5-2 Marking a block

To use the Cut or Copy options, you need first to mark or highlight the lines that you want
to cut or copy. You cannot mark a portion of a line; you must mark the entire line.

To mark a List block:

1. Position the cursor at the beginning of the first line you want to mark.

2. Hold down the <shift> key.

3. Use the up or down arrow keys to move to the end of the last line you want to mark.
4. Release the <shift> key. The highlighted area is the marked block.

8.5-3 Undo

Use Undo to reverse the last Cut, Paste, or Delete operation performed. For example,
use Undo to restore a block of lines that you cut or to delete a block of lines that you
pasted from the clipboard.

From the List Editor window:

1. Select Undo from the Edit menu.

2. The last Cut, Paste, or Delete operation will be reversed.

8.5-4 Cut

Use Cut to move lines from one place to another within the same program or from one
program to another. Cut can be used in the offline or online stopped states.

The clipboard is aninternal memory buffer that stores blocks of lines that you cut or copy.

If you close one program file and open another, the contents of the clipboard are

retained. The content of the clipboard is overwritten if you cut or copy another block of

lines.

From the List Editor window:

1. Mark the block of lines you want to cut as described in section 8.5-2.

2. Select Cut from the Edit menu. The marked block is deleted from the List program,
but retained in the clipboard.

Ifyouwant to delete the marked block without copying itto the clipboard, press<delete>.

Use <delete> when you want to remove lines that you do not intend to use elsewhere

in the program. When you use<delete>, the contents of the clipboard remain the same.

Additionally, the current line in a program can be removed by pressing <delete>. The

line does not have to be marked for this to occur.

When any program line is deleted, the List Editor window closes the line and
automatically re-numbers the remaining program lines.
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8.5-5 Copy

Use Copy to duplicate a marked block from the program to the clipboard. Copy does

not remove the block of marked lines. Copy is used with the Paste option to duplicate

lines within the same program or to copy a block of lines from one program to another.

Copy can be used in the offline or online stopped states.

From the List Editor window:

1. Mark the block of lines you want to copy as described in section 8.5-2.

2. Select Copy from the Edit menu. The marked block is copied to the clipboard for
a future Paste operation.

8.5-6 Paste

Use Paste to insert lines cut or copied to the clipboard at a new location in the program
or in a different program. The Paste option does not change the contents of the
clipboard. Paste can be used in the offline or online stopped states.

From the List Editor window:

1. Cut or copy a marked block as described in sections 8.5-2, 8.5-4, and 8.5-5.

2. Select the line where you want to insert the marked block.

3. SelectPaste from the Edit menu. The marked block is inserted into the List program.
Paste can be used to copy lines from one part of a program into another part of a
program. It can also be used to copy lines from a source program to a completely
separate target program.

8.5-7 Find

Use Find to locate each occurrence of an operand, line, or string in a List program. The

Find option can be used in the offline, online stopped, or online running states.

For operands:

« It is not necessary to qualify the operand by a specific instruction (for example, find

%M1 in all occurrences of LD).

» There is no implicit inheritance, that is, if function block %TMO is to be found, only

function block %TMO will be found. 'AND %TMO0.Q" will not be found.

» Subroutines SRn: and labels %Li: are treated as operands.

For Text Strings, the search operates on comments, operands, operators, labels, and

subroutines.

From the List Editor window:

1. Ifitis desired to only search a specified portion of the List program, mark the block
of lines to be searched.

2. Select Find from the Edit menu. The Find dialog box appears.
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3.

Eind Options
|I]perand |ﬂ @Search All

Search From Cursor
| |

ok | | cancel |

In the Find field, select Operand , Line, or Text String .

Use Operand to find an address or symbol in the List program. It does not matter
whether addresses or symbols are shown for a search to be conducted for the other.
For example, if addresses are currently shown in the List program, you can conduct
a search for a symbol.

Use Line to locate a specific line in the List program by line number.

Use Text String to locate each occurrence of a specific string of text in the program
lines.

Range: Operand, Line, or Text String

Default: Operand

In the blank field under the Find field, enter the value for the Operand or Line number
to be found. For a Text String, enter the text to be found.

If Operand is selected in the Find field, enter an address or symbol.

If Line is selected in the Find field, enter a program line number.

If Text String is selected in the Find field, enter a specific string of text.

In the Options field:
SelectSearch All to search from the beginning of the program, or in a marked block.

Select Search From Cursor to search from the current position of the cursor up to
the end of the program. Do not select Search From Cursor to search in a marked
block of rungs.

Select Search Selected Region to search only in a marked block.

Select Ok to begin a search. Select Cancel to return to the List Editor window.

For each instance of the value that is found in the List program, the following dialog
box appears.
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Find

7. After the last instance of the value or text is found or if the search does not find any
instance of the value or text you specified, an Information dialog box appears stating
"ltem not found". Select Ok to end the search and return to the List Editor window.

8.5-8 Replace

Use Replace to locate each occurrence of an operand or text string and replace it with
another operand or text string. Replace can be used in the offline or online stopped
states.

For operands, you can only replace:

« bits by bits (i.e. %10.0 with %M2),

» words by words (i.e. %MW100 with %SW12)

« function blocks with like type function blocks (i.e. %TMO with %TM2 is allowed,
whereas %TMO with %C3 is not allowed)

* immediate values with other immediate values

There is no implicit inheritance; that is, if function block %TMO is replaced with %TM2,

only the function blocks are replaced. %TMO0.Q is not replaced with %TM2.Q.

Replace will not work if either the source or target operand is an unresolved symbol.

Replace label and subroutine will not operate on the declaration of the label or

subroutine. A label or subroutine declaration may be replaced with another label or

subroutine declaration.

For Text Strings, anything that can be found by a string in the List can be replaced.

From the List Editor window:

1. Ifitis desired to only find and replace an operand or text string in a specified portion
of the List program, mark the block of lines to be searched.

2. Select Replace from the Edit menu. The Replace dialog box appears.

Find Options ——
[ operand E (®)Search All
1 | OSearch From Cursor

Replace with:

| K I | Cancel I | Replace All I
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In the Find field, select either Operand or Text String .

Operand is used to find and replace an address or symbol in the List program.
Use Text String to find and replace a specific string of text in the line headers.
Range: Operand or Text String

Default: Operand

In the blank field under the Find field, enter the value for the Operand or the text for
the Text String to be found and replaced.

If Operand is selected in the Find field, enter an address or symbol.

If Text String is selected in the Find field, enter a specific string of text.

In the Replace with: field, enter the value or text that is to replace the found value
or text.

If Operand is selected in the Find field, enter an address or symbol.

If Text String is selected in the Find field, enter a specific string of text.

In the Options field:
SelectSearch All to search from the beginning of the program, or in a marked block.

Select Search From Cursor to search from the current position of the cursor up to
the end of the program. Do not select Search From Cursor to search in a marked
block of rungs.

Select Search Selected Region to search only in a marked block.

SelectReplace All to find each occurrence of the specified value or text and replace
with the value or text specified in the Replace with: field without confirming each
instance. After all of the occurrences have been found and replaced, an Information
dialog box is displayed stating the number of occurrences replaced. Select Ok to
return to the List Editor window.

Select Ok to begin the find and replace option. Select Cancel to return to the List
Editor window.

For each instance of the value or text that is found in the List program, the Replace
dialog box appears.

Replace

Replace fil
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9.

In the Replace dialog box, select Replace , Find Next , Replace All , or Cancel.

Replace changes the current value or text to the value or text specified in the
Replace with: field.

Find Next makes no changes to the value or text currently highlighted and searches
for the next occurrence of the value or text.

Replace All finds each occurrence of the specified value or text and replaces each
occurrence with the value or text specified in the 'Replace with:' field. After all of the
occurrences have been found and replaced, an Information dialog box is displayed
stating the number of occurrences replaced. Select Ok to return to the List Editor
window.

Cancel exits the find and replace operation and an Information dialog box appears
stating the number of occurrences replaced. Select Ok to return to the List Editor
window.

<6> occurences replaced

10. After the last occurrence has been found and replaced, an Information dialog box

appears stating the number of occurrences replaced. Select Ok to return to the List
Editor window.
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9 Grafcet Help

9.1 Introduction

This section describes the Grafcet help functions available from Ladder.

9.2  Showing Grafcetinstructions

Grafcet instructions can be divided into two types.

Group 1 Group 2
=*=j #
i #i

=*=POST | #Di

Type 1 instructions are treated as labels or subroutines. Declarations of steps or post-
processing are shown continuously in the rung headers.

*I0. 4
:

#»Ia-5
:

[===—rosT) Gy

These instructions are available in the rung header dialog box. When incorrect data
is entered (value or declaration of an existing step), an error message is displayed in
the status bar after clicking on OK.

Rung Header

{_1Standard {_ILabel xLi: {_)Subroutine SRn:
{_IInitial Step === (®ibe ep : { 1=== POST

Label/SubroutineStep Number:

Title:| |
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Type 2 instructions are shown as reversible instructions having the same properties
as coils (S, ST ...). These Grafcet objects are available on the Extended Ladder Editor
Palette.

PLY-BY - c“windows>oven_4.pl7
iguration PLC Hindow Help

LADDER Viewer

#o—

#o—

9.3 GrafcetStep Table

In order to facilitate displaying the Grafcet status, a table of Grafcet steps is available
from the Tools menu in the List or Ladder editors.

Grafcet Step Table

(2] (=] [ [=] [<]
[Ergesen]

This table shows the list of steps defined in the program in ascending order of steps.
The initial step is represented by a double square (example: step 1).

If the software is online, the window is animated and the active step or steps are
highlighted.

It is possible to move through the various steps using the keyboard (keys and =) or
the mouse. The selected step is outlined in red. By double-clicking on this step or
pressing <Enter>, the part of the program associated with this step can be directly
accessed in the List or Ladder editor.
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10 Validating and reversing a program

10.1 Validating a program

Validate Program compiles a program and checks it for errors. Compiling a program
means to translate a program into binary machine code, a low-level language which
can be executed by the PLC.

In addition to compiling a program, Validate Program also :

 checks that the syntax of each program line or rung is correct.

« checks that each symbol used in a program has a corresponding address.

¢ checks that the structure of the program is correct.

« creates a binary program file.

« posts messages in the Validation Errors window.

You can validate a program, in the offline or online states, using these options :

1. Validate Program (Offline)—In the offline state, select Validate Program from the
Tools menu to check and compile a program at any time, from any editor.

2. Validate Program (Online)—In the online state, each program line you enter is
automatically validated, before it is sent to the PLC. Therefore, you do not need to
run Validate Program, although you can choose to run it.

After you run Validate Program, one of two messages is displayed.

If the program has no errors, the following appears :

Information

The Program contains B Error(s), 8 |+ ]

Warning(s) | |
The program is executahle and CAN be

transferred to the PLC

If the Validate Program process detects an error, the following appears :

Error

The Program containz 2 Error(sl, 8 Lt ]

Warning(s) |
@ The program CANNOT be transferred to
the PLC
See the Ualidation Ervor Window for
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10.2 Viewingvalidation errors

Validation Errors displays error and warning messages posted by the Validate
Program process.

1. Select Validation Errors from the View menu to display the Validation Errors
window.

File Edit View Tools Configuration PLC Window Help

Ualidation Errors
KERROR> Line 17 : The BLK instruction on Line 12 did not have a corresponding END_BLK.
<ERROR> Line 17 : Function Block cannot be nested.

The format of each message is :

* type of message—error or warning.
« the number of the offending line or rung.
* an explanation of the problem.

There are two types of messages—error and warning messages. An error message
indicates a problem in the application that prevents the creation of an executable
program. A warning message indicates instructions that are not reversible, or instruc-
tions that, in relation to other instructions, may cause operational uncertainties.

10.3 Reversingaprogram

An application program written in Ladder can be converted - or reversed - to List.
Likewise, a program written in List can be reversed to Ladder if certain reversibility rules
are observed. These rules are further explained in Sections 7.3 and 7.4 of Part B.

Note :

In the case where a program written in List is reversed to Ladder and the rules are not met, the
corresponding rungs in the Ladder Editor window will display the List instructions instead of the
Ladder format.

To reverse from the List Editor to the Ladder Editor :

» Select Ladder Editor in the View menu
« Adjust the display by selecting Preferences in the View menu

To return from Ladder Editor to List Editor :
« Simply select List Editor in the View menu.
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Section 11

11 Archiving an application

11.1 Introduction

An application file is archived by selecting either Save or Save As from the File menu.
A binary file *. APP is archived by selecting Save As from the File menu.

e Save is used to commit changes to an existing application.
« Save As is used to save the current application or binary file to a new file.

11.2 Save

To commit changes to an existing application file:

1. Select Save from the File menu. The file will be saved to the current directory.

11.3 SaveAs

To save the current application or binary file to a new file:

1. Select Save As from the File menu. The File Selection dialog box appears.

File Selection

Filename: Directories:
| *.pl? | cpl?787~app
appli.pl? # [=Ec

Ll | &p7e7

G

& ]

List Files of Type: Drives:
[=e [ Concer |

Binary (*.app)

2. Inthe List Files of Type field, open the selection box and select either the .pl7 or
.app file type. The .pl7 file extension identifies application files. The .app file type
identifies binary files.

A binary file (.app extension) is used for transferring a file to the FTX 117 terminal
via a PC card (memory card). See appendix A.7 in part G for more information.

3. Inthe Drives field, select the drive where you want to store the file.
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4. Inthe Directories field, select the directory where you want to save the file.

5. In the Filename field, over type the asterisk (*) with a standard DOS file name.
If a filename does not comply with DOS file naming conventions, an "Invalid
Filename" message appears.
If you type afilename that already exists in the directory, an error message appears:
"The file selected already exists. Overwrite?" Select Ok or Cancel.

6. Select Ok to save the file. Select Cancel to close the File Selection dialog box
without saving the file.
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12 Transferring an application

12.1 Introduction

PL7-07 software provides 2 methods of protecting the application while it is being

debugged :
* Total read and write protection.

This option particularly prohibits duplicating programs thus guaranteeing
the inviolability of the programmer's expertise.
It is executed when the application is transferred into the PLC memory.

» A write protection, with access to the application display and to the variable

settings.

A password provides this protection (see Section G-A.4).

12.2 Transferringanapplication

Select Transfer from the PLC menu to copy an application to one of three hardware

storage areas :

1. PC RAM (Random Access Memory).

2. PLC RAM.

3. The PLC EEPROM (Electrically Erasable Programmable Read-Only Memory), a
secondary or backup memory storage area on the PLC.

The Transfer option in the PLC menu displays four sub-menu options :

F — co~pl7AT ~app™~appli_pl7

Hindow Help

PLC Address

Connect C(onlinel
Disconnect (offline)
PLC Operations

PC => PLC
PLC => EEPROM
EEFROM -> PLC

Run
Stop Cirl+F5
Init
Toggle Animafion Cirl+FG6

12.2-1 PLC => PC

Select PLC => PC to transfer the application from the PLC RAM to the PC RAM :

If you begin from the initial state, with no application open :

1. Select PLC => PC.

From the initial state, the transferred application becomes the current application.
The word default appears in the title bar of the application.

12/1



If you begin from the offline state, with an application open :

1. Select PLC => PC.

The PLC application overwrites the program and configuration in the PC, but keeps
the symbols.

If the application is password protected, you are prompted to change security levels.

1. Select Ok to display the Security dialog box. In the Enter Password field, type the
correct password. Select Ok. The application is displayed at the supervisor level.

2. Select Cancel to display the application at the operator level.
For more information about software Security features, see appendix A.4 in part G.

12.2-2 PC => PLC

Select PC => PLC to copy the current application on the PC to the PLC.
To transfer the application from the PC RAM to the PLC RAM :

1. Open the application file (.pl7) or binary file (.app) that you want to transfer.
2. SelectPC =>PLC.

3. Ifthe application and PLC versions are not the same, the message, "The application
and PLC are different versions" appears.

Select Ok to continue transfer.

Select Cancel to change the version of the PLC. For more information, see Section
5.21.

4. If the application in the PLC contains a password, you are prompted to confirm
transfer of the application.

If you know the password, select Ok to transfer over the protected application.
If you don't know the password, select Cancel to end the transfer process.

5. If you select Ok, a Security dialog box appears. Enter the correct password and
select Ok.

6. Ifthe PLCand PC applications are different, then you are prompted to select whether
you want to overwrite the application in the PLC.

Select Ok to overwrite the application.

Select Cancel to end the transfer process. (To back up the PLC application to the
PC, see Section 12.2-1.)

7. You are prompted to select whether you want to protect the application.

Select Yes to protect the application in the PLC or No to leave the application
unprotected.

8. When the transfer to the PLC is completed, the message, "Transfer Successful,"
appears in the status bar.
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12.2-3 PLC => EEPROM

SelectPLC =>EEPROM o copy an applicationfromthe PLC RAMtothe PLC EEPROM.
The PLC EEPROM can store one application. It is strongly recommended to transfer
an application into the EEPROM as soon as it has been debugged.

To transfer the application from the PLC RAM to the PLC EEPROM :

1. Select PLC => EEPROM from the Transfer sub-menu.
2. The PLC => EEPROM dialog box has two options :

TSX -> EEPRDM

You can set the protection and the master
options for the EEPROM. I the EEPROM is
protected, the RAH will also be protected.
Press Ok to copy the program in the RAM
to EEPROM and set the options.

Options
[JProtected
|:| Master

| i I | Cancel I

The Protected option lets you protect the application in the PLC, unless you have
already protected it during the PC => PLC transfer process. If protected in the PLC,
an error message warns you that you cannot copy or write the application to the
EEPROM because neither read or write is allowed.

The Master option lets you set the application in the EEPROM as the master, which
means that each time you power up, the PLC compares the application which is
presentin RAM with thatin EEPROM and, if a difference is detected, the application
stored in EEPROM is copied to the PLC RAM, and the PLC is set to RUN (unless
an R/S input configured in the application is at STOP).

To modify a master application :

e retrieve the application to the PLC or PC RAM

» modify the application then validate the modifications

» transfer the application back to EEPROM by selecting the Master option.

3. Afterthe applicationis transferred from the PLC RAM to the EEPROM, the message,
"Transfer Successful,” appears in the status bar.
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12.2-4 EEPROM => PLC (EEPROM to PLC)

Select EEPROM => PLC to transfer the application that you backed up to the EEPROM
to the PLC primary storage area.

To transfer an application stored in the EEPROM to the PLC, simply select PLC =>
EEPROM from the Transfer sub-menu. After the application is transferred, the status
bar displays the message "Transfer Successful.”
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13 Starting up an application

13.1 PLCAddress

In order to be able to communicate directly with a TSX Nano UNI-TELWAY Slave, PL7
07 software enables the target address to be defined.

After having chosen this address, the user selects the required action in the PLC menu
(Transfer, Connect, PLC Operations).

PLC Address

The default address offered is the system address 0.254.0.

The user must then enter the address of the PLC to which he wishes to connect using

the following format : Network.Station.Gate.Rack/Module.Slave Address:

« Network isthe number of the network which enables the target address to be reached
(0 to 127), the default value is 0.

« Station is the number of the station on the network (0 to 254), the default value is 254.

¢ Gate is the mechanism which enables the unit of communication within the selected
station to be chosen. As 0 is the station system gate (its UNITE server), 5 is the gate
which enables communication with a remote PLC. The default value is O (in this case
it is not necessary to complete the other fields).

* Rack/Module is used if the gate number is 5. It corresponds to the physical situation
of the UNI-TELWAY Master module. The default value is 254 and means that the
TSX Nano is connected to the same UNI-TELWAY bus as the PL7 07.

The value 0 indicates another UNI-TELWAY bus (PCMCIA for example).

 Slave address is the address of the TSX Nano PLC on the UNI-TELWAY bus.

The default value is 4 in local mode and 104 in remote mode.

To help the user, 3 key words are available and can be entered directly :

e SYS corresponds to the system address 0.254.0,

e LOC corresponds to the local address 0.254.5.254.4. The slave address 4 should
be changed if it does not correspond with that of the target PLC.

* REMcorresponds to the remote address 0.254.5.0.104. The Rack/Module and Slave
addresses should correspond to the address of the target TSX Nano.

OK validates the values entered.
Cancel exits without changing the address values.
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13.2 Connect

Select Connect from the PLC menu to initiate communication between the PC and the
PLC.

To connect the PC to the PLC :

1.
2.

Select Connect from the PLC menu.

If the applications in the PC and the PLC are the same and the application in the
PLC is not protected, the PC connects to the PC and the application state changes
from offline to online.

If the application in the PLC is protected, you are prompted to choose whether you
want to monitor the PLC. Select Ok to monitor the PLC or Cancel to end the
connection process and return to the offline or initial state.

If the applications in the PC and the PLC are different and the application in the PLC
is not protected, the Connect to PLC dialog box appears. Select an option :

Connect to PLC

The applications on the PC and the PLC are different. Chose an option
below to continue.

PLc-> Pe || Pe P ||

onitor I |

=

Select PLC -> PC to transfer the application in the PLC to the PC. The application
state changes from offline to online.

Select PC -> PLC to transfer the application open on the PC to the PLC. An
Information dialog box appears informing you that you are about to overwrite the
PLC application. Select Ok to continue the transfer or Cancel to abort. If you select
Ok, the transfer is completed and the PC connects to the PLC. The application state
changes from offline to online.

SelectMonitor if you only wantaccessto the application data pages and do not want
to modify the application program, configuration, or symbols. The application state
changes from offline to monitor.

Select Cancel to end the connection process and return to the offline state.
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13.3 Stop/Run/Init

From the PLC menu it is possible to run, stop or initialize the PLC without displaying
the PLC operations window. To do this, directly select the actions RUN, STOP or INIT.
A dialog box confirming these choices will appear before the request is executed.

PLY-B7 — c™pl7d7™app™appli.pl?
Configuration Hindow Help

Transfer »
Connect (online)

PLC Operations

Run

Stop Cirl+F5
Init

13.4 PLCOperations

Select PLC Operations from the PLC menu to display the PLC Operations dialog box.

m (2) (3
- PLC Operations - T5X @7 2B-24 - Uersion 1.0
Status —————————————— Switches ——————————— Scan Time (msec)
10 Forced D Selector: Base PLC (8) Maximum: a
RAM Executable @ Potentiometer B: 133 Current: a
RAM Protected ) Potentiometer 1: 132 Hinimum: 152
(4)——Real Time Clock
r PLC Date: 9-3-1995 PLC Time: 9:15:81 |
ee 1o seseee
RUN ERR A 1 9 18 11 12 13
(5) ®® ‘9o L
CoM 1-0 A 1 9

6y —swop || R ][ wmit | [ set Time ][ Advanced | [ cose ]

The fields are numbered and described below :

(1) The Status field check boxes indicate whether :
One or more input or output bit is forced either 1 or 0.
An executable application is stored in the PLC RAM.
The PLC RAM protection bit was set to 1 during the Transfer process.

(2) The Switches field displays the settings you selected for the controls on the PLC.
For information about setting the PLC function code and potentiometer switches,
see Sections 1.8 and 1.10 in Part A.
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(3) The Scan Time (msec) field, displays the minimum, current, and maximum scan
time, expressed in milliseconds. For more information about program execution,
see Section 1.3 in Part A.

(4) The Real Time Clock displays the current date and time. You can change the date
and time by selecting theSet Time pushbutton atthe bottom of the window. For more
information, see Section 13.4-2.

(5) The LEDs in the PLC Operations window simulate the LEDs on the base PLC. For
more information, see Section 1.9 in Part A.

(6) TheStop/Run/Init/Set Time/Advanced/Close  pushbuttons letyou control applica-
tion execution on the PLC and view PLC system information.

13.4-1 Stop/ Run/Init
To start executing an application in the PLC :

1. SelectRun.

2. Awarning message prompts you to confirm your decision to execute the application
on the PLC.

SelectOk to run the PLC. SelectCancel to return to the PLC Operations dialog box,
leaving the state of the PLC unchanged.

To stop executing an application in the PLC :

1. SelectStop.

2. A warning message prompts you to confirm your decision to stop the execution of
the application in the PLC.

SelectOk to stop the PLC. SelectCancel to returnto the PLC Operations dialog box,
leaving the status of the PLC unchanged.

Select Init to initialize the PLC RAM. The initialization resets all memory variables.

1. Selectlnit.

2. A warning message dialog box prompts you to confirm your decision to initialize
the PLC.

SelectOk toinitialize the PLC. SelectCancel to return to the PLC Operations dialog
box, leaving the status of the PLC unchanged.

13.4-2 Set Time
To set the PLC real time clock :

1. Select Set Time from the PLC Operations window.
2. In the PLC Date field, enter the current date, displayed as month/day/year.

3. Inthe PLC Time field, enter the current time. The time value appears in military
format, hours:minutes:seconds. For example, 12 noon is 12:00:00, 2:15 PM is
14:15:00, and midnight is 00:00:00.
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PLC Date: 921995
PLC Time: |1:39:49

Ok Cancel I

4. SelectOk toupdate the PLC date andtime. SelectCancel to returnto the PLC dialog
box.

13.4-3 Advanced C

SelectAdvanced to display read-only PLC system information, which you can view but
cannot change.

A checked box indicates that the state is active. Use this information to check the PLC
RAM and PLC EEPROM status and to diagnose problems.

RAM — EEPROM
Valid | Valid [
Executable E Executable @
Protected I:‘ Protected I:‘
Compatible with 0S | Compatible with 0S <
Different than EEPROM | Master (Autoload) [
Last PLC stop — PLC
’_ 3-13-,1995 23:31:23 | GRAFCET over-run |:|
Hatchdog time out I:‘
Clock Calendar present @
Some 170 is forced I:‘
RAM options
Valid Indicates whether there is an application stored in the PLC RAM.
Executable Indicates whether the application in the PLC RAM is executable.
Protected Indicates whether you chose to protect the PLC RAM during the

transfer from PC to PLC. (See Section 12.4)

Compatible with OS Indicates whether the PLC version declared in the application
configuration is the same as the target PLC operating system.

Different than EEPROM Indicates whether the application in the PLC is different from the
application in the EEPROM.
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EEPROM options
Valid

Executable

Protected

Compatible with OS

Master (Autoload)

PLC options

GRAFCET over-run

Watchdog Time out

Indicates whether there is an application stored in the PLC
EEPROM.

Indicates whether the application in the EEPROM is executable.

Indicates whether you chose to protect the EEPROM during the
PLC => EEPROM transfer process. (For more information, see
Section 12.4.)

Indicates whether the PLC version declared in the application
configuration is the same as the target PLC operating system.

Indicates whether you selected the Master option during the PLC
=>EEPROM transfer process. (For more information, see Section
12.4)

Indicates whether the time needed to execute the Grafcet struc-
ture was greater than the scan time allowed.

Indicates whether the scan time of a program exceeded 150 ms,
causing the Watch dog timer to stop the PLC. (For more informa-
tion, see Section 1.3 in Part A.)

Clock Calender present Indicates whether the PLC has the Real Time clock feature.

Some 1/O is forced

Indicates whether one or more input or output bits is forced ON
or OFF.
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14 Debugging and adjusting an application

14.1 Introduction

This section explains the various features of the PL7-07 PC programming software that
can assist you in debugging and adjusting an application. These include animating a
program, working with data variables, and using data pages.

14.2 Animating a program

Animating a program allows you to view the values of the variables when a program
is online, either running or stopped. This is useful for debugging because it allows you
to view the change in values as the program runs to compare the actual values against
expected values.

14.2-1 Animating a Ladder program
With the Ladder Viewer window displayed and the program online, either running or
stopped :
1. Select Toggle Animatio n from the PLC menu.
2. The Ladder Viewer window is displayed with the following :
« the title bar shows the word, "animating".
« contacts, coils, and special objects with a logical result of 1 are highlighted.

* the data variables of function blocks, compare block, and operate blocks are
shown. This includes current and preset values. For other than binary values, the
number is displayed in either hexadecimal or decimal, depending on the format
selected in the Preferences dialog box.

File Edit View Tools Configuration PLC UWindow Help
iewer - Animating

/susu /susa L 4EWSBL %ESUSO: “Ma
5]
RUNE 13

—1’—£ﬂ=’ﬁ'

HEEKLY_COUM
TER

[+

s D
ADJ ¥

M2 cu F

| L
#ce .y 18
w“Ce.P 3999

3. When the Ladder Viewer window is animated, select Toggle Animation from the
PLC menu to turn off animation.

14/1



14.2-2 Animating a List program

With the List Editor window displayed and the program online, either running or
stopped :

1. Select Toggle Animation from the PLC menu.

2. The List Editor window is displayed with an additional column just to the right of the
line number. The column contains the value of the operand for that line. When an
instruction line has more than one operand, the value of each of the operands is
displayed and separated by slashes. Additionally, the title bar shows the word,
"animating".

File Edit Ujew Tools Configuration PLC Hindow Help
= LIST Editor - Animating
ol 2 5 N R A 5 I e R T R
] LD #418.1 |+
18 AND «18.8
21 nND “M3 1
3f1 AND »18.5
4 8 nND #18.4
58 3 »MBa
6 8 LD “M2
7TF1 AND »18.5
8 A OR »18.2
98 R »Ma
18 B-/= LD [ »MUB = 3AeA1 1
11 8/ [ zMUB =11
12 8 LD »Ma
13 8 ST «08 .8

Binary operands are displayed as either 1 or 0. Word operands are displayed in either
decimal or hexadecimal format, depending on the format selected in the Preferences
dialog box.

The following values are not animated, but rather are represented by an asterisk :

* labels (%Li)

* subroutines (SRn)

« instructions that require no operand, NOT, NOP, END
e immediate values

* indexed words

* bits extracted from words

« table of words

« string of bits, such as %MO0:5

Forced bits are displayed with an 'f, paired with the forced state, either 0 or 1. A hit
operand that is forced on, is displayed as 'f 1', and a bit operand that is forced off, is
displayed as 'f 0'. See Sections 14.4-7 through 14.4-10 for more information on forced
values.

3. When the List Editor window is animated, select Toggle Animation from the PLC
menu to turn off animation.
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14.3 Using the Data Editor

The PL7-07 PC programming software uses the variables listed in appendix A.3 of part
G to assist in writing the program. The Data Editor is used to view and modify these
variables to assist in debugging a program. Additionally, the Data Editor can be used
to force the values of input or output bits.

Inthe Data Editor window, you can define a list of PLC variables that you want to monitor
and save. This list is called a "data page".

To display the Data Editor window, select Data Editor from the View menu.
File Edit View Tools Configuration PLC Hindow Help

= Data Editor
glxlolce] (] Di] BfjE]e] [eietls]s]

Address Current Value Retained Value Symbol

The following gives an explanation of each column of the data page.
Address A specificlocationin memory, always preceded by a percent sign (%).

Current Value  The actual value of the variable in the PLC. The value of the variable
changes as the program runs. In the online state, you can animate
the data page and watch the Current Value change as the
program runs. An asterisk (*) appears in this column before the
first time the data page is animated. After the first time the data
page is animated and subsequently turned off, the Current Value
column retains the last updated value.

Retained Value The value specified as an initial value. When the Write Retained V
Values function is performed, these values are written to the PLC.

Symbol The name assigned to an address in the Symbol Editor to identify the
purpose of the variable.

14.3-1 Animating a data page
Animating a data page displays and updates the Current Value column of the data page
as the PLC program runs.

1. Before the data page is animated for the first time, the Current Value column
contains asterisks (*).

File Edit View Tools Configuration PLC HWindow Help

Address ) Current Value Retained Value Symbol

<M1 * a ROLL_DOWN_VAR +
M2 = a GANTRY_FOR_LATCH_VAR

M3 * 1 SCHED_BLOCK_VAR

M4 * a MONDAY_TEST_VAR
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2. With the data page displayed and the PLC online, either running or stopped, select
Toggle Animation from the PLC menu to animate the data page.

3. The Current Value column is displayed with the current values from the PLC for the
addresses listed in the data page. The title bar shows the word, "Animating".

File Edit View Tools Configuration PLC Window Help

ﬂdr‘ess ) Current Value Retained Value Symbol

<M1 8 8 ROLL_DOUN_VAR +
M2 8 8 GANTRY_FOR_LATCH_VAR

M3 1 1 SCHED_BLOCK_VAR

M4 a a HONDAY_TEST_VAR

4. When the data page is animated, select Toggle Animation from the PLC menu to
turn off animation. The Current Value column retains the last updated value.

14.4 Using the Data Editor Tools menu

The Data Editor Tools menu is used to construct, edit, and save a data page.
Additionally, from the Data Editor Tools menu you can modify and force values for
selected variables in the program. The table in appendix A.2-7 of part G lists the options
in the Data Editor Tools menu and the corresponding buttons on the tool bar.

File Edit UView Tools Configuration PLC HWindow Help
- Ualidate Program
m; e el R |
Address Cur

Insert Ins
Delete  Del
Add Next Instance  Cirl+Down
Add Previous Instance  Cirl+Up

[+

Force 1

Force B

Clear Force

Clear All Force

Read Retained Values
Write Retained Values
Write Data Value

Open Data Page
Save Data Page
Save Data Page As

14.4-1 Editing a data variable
To edit a single data variable on a data page :

1. With the data page displayed, double-click or press<enter> on the row with the data
variable to be edited. The Data Object Edit dialog box appears.
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Data Object Edit

Address or Symbol to Insert:

[=18.1 |
Address: Symbol:
[18.1 | [sTART_PB
Display Format: Retained Value: (Decimal
| Decimal m | a |

2. The Address and Symbol fields display the address and symbol for the data
variable to be edited. A symbol must have an assigned address, however, an C
address does not necessarily have an assigned symbol.

3. Inthe Display Format field, select the number format to determine how the value
appears on the data page.

Range : Decimal, Hexadecimal, Binary, ASCII
Default : Decimal

4. IntheRetained Value field, enter the desired initial value for the variable. This value
is written to the PLC with all the other initial values of the data page when you perform
the Write Retained Value operation.

5. Select Ok to commit the changes to the data variable displayed in the dialog box
or Cancel to return to the Data Editor window without making any changes.

14.4-2 Validate Program

Use Validate Program to compile a program and check for errors. See Section 10.1 for
more details on validating a program.

14.4-3 Insert
Use Insert to add a variable to the data page.

1. From the Data Editor window, select Insert. The Data Object Edit dialog box

appears.

Address or Sumbol to Insert:

Address: Symbol:
| |

Display Format: Retained Ualue: (Decimal}
| Decimal H | 3] |
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2. Inthe Address or Symbol to Insert field, enter the address or symbol to be added
to the data page.

Symbol names must have an associated symbol in the symbol table to be used in
the data page. If a symbol name is entered that is not in the symbol table, an Error
dialog box appears stating, " Invalid or Undefined symbol or address". Select Ok
to return to the Data Object Edit dialog box. For more information on symbols, see
Section 6, "Defining symbols."

3. The Address and Symbol fields are used to display the corresponding symbol for
an address entered in step 2 or display the corresponding address for a symbol
entered in step 2. A symbol must have an assigned address, however, an address
does not necessarily have an assigned symbol.

4. Inthe Display Format field, select the number format to determine how the value
will be displayed on the data page.

Range : Decimal, Hexadecimal, Binary, ASCII
Default : Decimal

5. In the Retained Value field, enter the initial value for the variable. This value is
written to the PLC with all the other retained values on the data page when you
perform the Write Retained Values operation.

6. Select Ok to commit the values to the data page or Cancel to exit and return to the
Data Editor window.

14.4-4 Delete
Use Delete to remove a variable from the data page.

With a data page displayed, highlight the variable to be removed. Select Delete. The
variable is removed from the data page.

14.4-5 Add Next Instance

Use Add Next Instance to add the following sequential instance of the variable
highlighted on the data page.

With a data page displayed, highlight the desired variable of the same type to be added.
Select Add Next Instance . A new variable of the same type is added to the data page
with the following sequential number.

For example, if %10.3 is currently highlighted, selecting Add Next Instance adds the
variable %10.4 to the data page.

14.4-6 Add Previous Instance

Use Add Previous Instance to add the preceding sequential instance of the variable
highlighted on the data page.

With a data page displayed, highlight the desired variable of the same type to be added.
Select Add Previous Instance . A new variable of the same type is added to the data
page with the previous sequential number.
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For example, if %I10.3 is currently highlighted, selecting Add Previous Instance adds
the variable %10.2 to the data page.

14.4-7 Force 1

Use Force 1to setorforce aninput or output bitto 1, evenifthe calculated value is different
from the forced value. When a variable's value is forced, the value stays forced until it is
cleared—even if the PC is disconnected from the PLC and you exit the PL7-07 PC
programming software.

Force 1 is available when the PLC is online, either running or stopped. The Current Value
column in the data page has a 'F' next to the value if it is a forced value and the data page
is animated. The table in appendix A.3 in part G lists the variables that can be forced.

With a data page displayed and animated, select Force 1. The selected variable displays
a 'F' next to the current value of 1. For example, the following shows input %I0.3 with a
forced value of 1.

File Edit View Tools Configuration PLC HWindow Help
. i Data Editor — Animating
loefoo] [l Do) [28]Es

Address Current Ualue Retained Ualue Symbol
18.8 1 2] PROX_SEN T
18,1 2] 2] START_PB
18,2 2] 2] STOP_PB
218.3 F1 2] GFL_SWITCH
+10.4 1 a GRL_SUITCH

14.4-8 Force 0

Use Force 0to set or force aninput or output bitto 0, even if the calculated value is different
from the forced value. When a variable's value is forced, the value stays forced until it is
cleared—even if the PC is disconnected from the PLC and you exit the PL7-07 PC
programming software.

Force 0 is available when the PLC is online, either running or stopped. The Current Value
column in the data page has a'F' next to the value if it is a forced value and the data page
is animated. The table in appendix A.3 in part G lists the variables that can be forced.
With a data page displayed and animated, select Force 0. The selected variable displays
a'F' next to the current value of 0.

14.4-9 Clear Force

Use Clear Force to remove a forced value from a variable on the data page. Clear Force

is available when the PLC is online, either running or stopped.

1. With a data page displayed and animated, select Clear Force toremove the forced
value for the highlighted variable .

2. The Data Editor window displays the variable with the forced value removed.

14.4-10 Clear All Force

Use Clear All Force to remove all forced values from a data page. Clear All Force is
available when the PLC is online, either running or stopped.
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1. With a data page displayed and animated, select Clear All Force to remove the
forced values for the entire data page.

2. The Data Editor window displays the data page with all forced values removed.

14.4-11 Read Retained Values

Use Read Retained Values to transfer the Current Values from the PLC to the Retained
Values on the data page. Read Retained Values is available when the PLC is online,
either running or stopped.

1. With adata page displayed and animated, select Read Retained Values to transfer
the values in the Current Value column to the Retained Value column.

2. The data page appears with the Retained Value column updated with the values
from the Current Value column.

14.4-12 Write Retained Values

Use Write Retained Values to transfer the Retained Values on the data page to the
Current Values in the PLC. Write Retained Values is available when the PLC is online,
either running or stopped.

1. With adata page displayed and animated, selectWrite Retained Values to transfer
the values in the Retained Value column to the Current Value column for all
variables on the data page.

2. The Current Value column appears with the values from the Retained Value

column, unless they changed immediately after being written to the Current Value
column.

14.4-13 Write Data Value

Use Write Data Value to momentarily send, or write, a single data value to the PLC. Write
Data Value is available when the PLC is online, either running or stopped. The table
in appendix A.3 in part G lists the variables that can have values written to them.

Write Data Value is available from the Data Editor window, whether or not a data page
is opened.

1. With the Data Editor window open, select Write Data Value . The Write Data Value
dialog box appears.

Hrite Data Value

To select another Data Object, enter either the address or the symbol name
in the Data Object field. Then press Enter.
Data Object: [%TH4.P |
Current Value: l:l
Hrite Data Value: l:l

[1]3 I Cancel I
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2. Enter the data variable in the Data Object field.
3. The Current Value field displays the current value for the selected variable.

4. Select the display format for the value. This format selection is only for the display
of the value being entered in the Write Data Value dialog box.

Range : Decimal, Hexadecimal, Binary, ASCII
Default : Decimal

5. Inthe Write Data Value field, enter the value you want to write to the PLC for the
data variable.

6. Select Ok to write the value to the PLC or Cancel to return to the data page without
writing the value to the PLC.

14.4-14 Open Data Page
Use Open Data Page to open a data page that was previously saved.

1. With the Data Editor window displayed, select Open Data Page from the Tools
menu. The File Selection dialog box appears.

File Selection

Filename: Directories:
[*.dat | epl?7@7~dat
BEREE
L] | E5pive7

List Files of Tupe: Drives:

5] [ Concel |

2. Inthe List Files of Type field, open the selection box and select either the .dat file
type or select to have all file types listed (*.*).

Default : .dat
3. In the Drives field, select the drive where the data files are stored.

4. Inthe Directories field, select the PL7-07 directory or the directory where the data
files are stored.

5. Inthe Filename field, select the data file to be opened.
6. Select Ok to open the data file or Cancel to return to the Data Editor window.
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14.4-15 Save Data Page
Use Save Data Page to save changes to an existing data page file.

After making the desired changes to a data page, select Save Data Page to save the
changes to the data page file.

14.4-16 Save Data Page As
Use Save Data Page As to save a data page to a new file.

1. With the Data Editor window open and a data page displayed, select Save Data
Page As. The File Selection box appears.

File Selection

Filename: Directories:
=.datl | erpl?B7~dat
* =«
|| | &= pive?

v o« |

List Files of Tupe: Drives:

[Data (*.dan) [Ec _I

2. Inthe List Files of Type field, select the default file extension, .dat.
3. In the Drives field, select the drive where the data file will be stored.

4. Inthe Directories field, select the PL7-07 directory or the directory where the data
files will be stored.

5. Inthe Filename field, over type the asterisk (*) with a standard DOS file name.

If the file name does not comply with DOS file naming conventions, an "Invalid
Filename" message is displayed.

If a file name is selected that already exists in the directory, an error message is
displayed : "The file selected already exists. Overwrite?" Select Ok to overwrite the
file or Cancel to return to the File Selection dialog box.

6. Select Ok to save the data file or Cancel to return to the Data Editor window.
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14.5 Modifying the program in RUN mode

The List program editor allows the List program to be modified when the PLC is in RUN

mode.
& CAUTION

UNEXPECTED EQUIPMENT OPERATION
For obvious safety reasons, it is advisable to program a PLC in STOP.

Itis possible, however, to program a PLC whichisin RUN mode so that program
modifications not requiring the application to be stopped can be performed.
However, these modifications remain the responsibility of the user.

Before any modifications are performed, certain conditions for programming
aPLC while running mustbe fulfilled. Itis essential to know the consequences
of the modifications on the application, and to take any necessary actions to
determine what these are.

Failure to observe this precaution can result in equipment damage, severe
personal injury, or death.

Modifying in RUN mode

The process for modifying in RUN mode is identical to that for programming in RUN
mode. The modification takes effect as soon as the current entry is confirmed.

Restrictions

The following table shows the restrictions on use and on modification when the PLC
is in RUN mode :

Mode/Function Access
Configuration Access to display only
Programming All modifications/insertions/cancellations of instructions

are permitted, except for instructions which modify the
structure of the program :

e parentheses

 Grafcet instructions

* labels

e jump : JIMP and SR subroutine calls

* master control relays MCR and MCS

* block instructions : BLK, OUT_BLK, END_BLK
* MPS, MPP

The following instructions are not active :

« find and replace
* program transfer to EEPROM
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15 Printing

15.1 Introduction

PL7-07 PC Programming Software can print the whole or part of an application.

15.2 Print Setup

Print Setup is used to define a printer ID or file name and the page layout.
To setup a printout:

1. Select Print Setup from the File menu. The Print Setup dialog box appears.

— Margins — Output To
Top E lines @Primer |—
Bottom lines (IFile [ |
Left chars — Printer Setup
Right chars Printer |Epson Printer
Page Adjust Send Before Print |__.__.__.__.__.__.__.__.__.__ |
Top Edge lines Send After Print |__.__.__.__.__.__.__.__.__.__ |
Left Side chars Paper Size
(®A4 (21 » 29.7 cm) (letter (8-1/2 & 11 ‘

2. In Printer Setup open the printer selection box to select a printer type:
Values: Text Printer, HP Compatible, Epson Printer.

Default: Epson Printer

The lines Send Before Print and Send After Print enable specific commands to be
sent to the printer before exiting the file and after printing.

Default : None.

3. Select the printing format in Paper Size:
Values: A4 (21 x 29.7 cm), Letter 8 1/2 x 11
Default: A4

4. IntheOutputto (printer orfile)field, type either the printer ID, such as LPT2(parallel
port #2), or a file name, such as PRINTOUT.TXT, using a standard DOS file name.

Default: LPT1 (parallel port #1)
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5. To define the page header and footer, select the Header/Footer button to display
the following window:

Print Setup - Header~Footer

— Header Lines
Bottle preparation software

\ Ladder
\

— Footer Lines

HOET&CHANDON
[Project 45
‘Boﬂling society
Desi :[0BOND | Company : [SA UK Date : [B7/20-96 |
Program : ’W‘ Revision : ’Bl—| PLC :
Section : Page Number :

You can type up to three lines of text to display at the top of each page. You can also
type up to three lines of text to display at the bottom of each page.

Similarly, it is possible to print at the bottom of the page the name of the originator,
the company and the program as well as the date, the version and the type of PLC
used.

6. To define the cover page of the application file, select the Cover Page button in the
Print Setup dialog box:

Print Setup - Cover Page
Title

| Bottles software

Date Author Version Comments

a7.,28-96 J BOND 8z final version

]

Enter a title of up to 20 characters and the development history of the application:
Date, author, version and comments.
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7.

10.

11.

12.

If a comments page is required at the beginning of the application file, select the
Comments button in the Print Setup dialog box:

Print Setup - Comments

Bottles preparation softuware
Final version : 82

Starting on the B7-28-96

0K I | Cancel

This editor enables a page of 60 lines of 70 characters each to be entered.
Line advance is obtained by using carriage return (ENTER) when entering.

In Margins , enter a number in the field Adjust Page Left to increase or decrease the
width of the left margin by the number of characters required. Enter a number in the
field Page Adjust Top Edge to increase or decrease the top margin by the number
of lines required.

In Margins , define the width of the left and right margins in numbers of characters.
Define the width of the top and bottom margins in numbers of lines.

It is necessary to make sure that the number of margin lines correspond with the
header and footer.

Select Save Default to save the printer and page layout values you selected as the
default values for future printing operations.

Select Restore Default to overwrite the current values with the values that you
saved earlier by using the Save Default button.

Select Ok to save your settings. Select Cancel to exit without saving the settings
you defined.
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Printing 15

15.3 Print

Select Print from the File menu. The Print dialog box appears.

[Z] Cover-Comments
[E Configuration

[Z] Suymbols

[E Cross Reference
&4 List

[Z] Ladder

E Summary

(®)Print All

Settings... |
Settings... |
Settings... |
Settings... |

I Cancel I

The options in the Print dialog box let you define the scope of your printout. Select Print
All to print the entire application. Or, print only specific application parts by selecting
the appropriate checkboxes. Select Ok to print. Select Cancel to exit the Print dialog

box without printing.

15.3-1 Configuration Print Settings

If you want to print some, but not all, configuration data:

1. In the Print dialog box, select the Configuration Settings  button to display the

Configuration Print Settings dialog box.

Configuration Print Settings

[ Timers

E Counters

E] Constants
EILIFO-FIFO Registers
E] Drum Controllers

[ System Information

(% Print Al

[<]Fast Counter
[d=PLS ~ =PUM
E] Latch Input

E Fitter

E]I/IJ Extension
[<] Schedule Block

2. Selectthe checkboxes for the Configuration data that you want to print. SelectPrint
All to print all configuration data for an application.

Default: All configuration data items selected.

3. Select Ok to save your changes. Select Cancel to return to the Print dialog box

without saving your selections.
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15.3-2 Symbols Print Settings
To define a printout of application symbols:

1. Inthe Print dialog box, select the Symbols Settings button to display the Symbols
Print Settings dialog box.

Symbols Print Setfings

Order By
{#)Resolved Address

{_)Symbol Name

e |

2. Inthe Order By field, select Resolved Address to sort the operands by address
or select Symbol Name to sort the operands by symbol name.

Default: Resolved Address

3. Select Ok to save your changes. Select Cancel to return to the Print dialog box
without saving your selections.

15.3-3 Cross Reference Print Settings
To define a printout of cross reference program elements:

1. Inthe Print dialog box, select the Cross Reference Settings button to display the
Cross Reference Print Settings dialog box.

Cross Reference Print Setfings

Program Elements ——
(O All

(® Selected

| 0K I | Cancel I

2. In the Program Elements field, select All to print all elements of a program or
Selected to only print those elements that you selected in the Generate Cross
Reference dialog box. If you want to re-select those elements, select Cross
Reference from the View menu and regenerate the cross reference.

Default: All

3. Select Ok to save your changes. Select Cancel to return to the Print dialog box
without saving your selection.
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15.3-4 List Print Settings
To define a printout of List program lines:

1.

Inthe Printdialog box, selectthe List Settings button to display the List Print Settings

dialog box.
List Print Settings

Range Attributes
@H_II @1 Column with Addresses

O&I Lines Oi Column with Sumbols
From: I:l ()2 Columns with Addresses
To:

Cancel I

In the Range field, select All to print all list lines. Or, select By Lines and enter the
first and last numbers of the program block that you want to print.

Default: All

In the Attributes field, select:

¢ 1 Column with Addresses to print the application code with the addresses of the
objects.

¢ 1 Column with Symbols to print the application code with the symbols associated
with the objects.

¢ 2 Columns with Addresses to print the code in a condensed form in two columns
with the addresses of the objects.

Default : 1 Column with Addresses.

Select Ok to save your changes. Select Cancel to return to the Print dialog box
without saving your changes.

15.

To

3-5 Ladder Print Settings
define a printout of Ladder rungs:

In the Print dialog box, select the Ladder Settings button to display the Ladder Print
Settings dialog box.

Range —— Attributes
@l @4 Tines with Addresses + Symbols!
OBg Rung Ol line with Addresses
From: I:l (7)1 line  with Symbols
To: |—|
‘ 0K I | Cancel I
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2.

In the Range field, select All to print all ladder rungs in the file. Or, select By Rung
and enter the first and last rung numbers of the Ladder block that you want to print.

Default: All

In the Attributes field, select:

* 4 lines with Addresses + Symbols  to print the application code with the symbols
and addresses of the objects. 3 lines are available to display the entire symbol and
one line for the address. These 4 lines are displayed above the graphic element
in the Ladder rung.

» 1 line with Addresses to print the application code with the addresses of the
objects.

« 1line with Symbols to print the application code with the symbols associated with
the objects.

Default : 4 lines with Addresses + Symbols.

Select Ok to save your changes. Select Cancel to return to the Print dialog box
without saving your selections.
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Section 16

16 Cross referencing an application

16.1 Introduction

The cross reference list provides a useful list of the operands, symbols, lines and
operators. For example, during troubleshooting or debugging, it allows the item of
interest to be easily located and cross referenced to other locations in the program
without having to search through the entire program.

16.2 Generating anew Cross Reference list

To generate a cross reference list for the first time after an application has been opened:

1. Select Cross Reference from the View menu. An Information dialog box appears.
Select Ok to display the Generate Cross Reference dialog box. Selecting Cancel
will display the Cross Reference window without generating the cross reference

list.
— Reference By Ranget ————————— Sort By:
(#)Rung Number —‘ ’7@)9“ () start m
(C)Line Number End [999 ]
— El :
gFast Counter ESgslem Bits @Eonslanl Words
[ zPLS. %PLIM [ Hemory Bits [l Message Block
|E Timers |E Input Bits @ Grafcet
& Counters E Dutput Bits E Labels
|E Drums ESgslem Hords @ Immediate Values
& Shift Bit Registers Eﬁamnrg Hords E Subroutines
gﬁiep Counters Elnpui Words @Unr‘esulued Symbols
&Hegister‘s Eﬂutput Hords Eﬂ., E, D, F
(®)All Elements
Cancel I
Note:

It is advisable to validate the program before generating cross references.
The cross reference list is not saved when the application is closed. Therefore, when the
application is re-opened, the cross reference list must be generated.

2. In the Reference By field, select whether you want to reference by ladder rung
number or list line number.

3. In the Range field, define the scope of the display.
Select All to display all list lines or all ladder rungs in a program.
Default: All
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Select Start/End to mark a specific block of the program that you want to display.
The range for both fields is 0 to 999. For Start, the default value is 0. For End, the
default value is 999.

4. Inthe Sort By field, select one field to act as the key field when the cross reference
list is displayed. These options correspond to the Sort options in the Tools menu.

Values: Operand, Symbol, Line/Rung Number, Operator
Default: Operand

For example, if Sort by Operand is selected, the following window appears—sorted
alphabetically and numerically by operand.

PL7-B7 - c:>\pl7B7~app™appli.pl?
File [dit View Tools Configuration PLC UWindow Help
Cross Reference

o m B it Ho——————— o o m +
| »Ia. 8 I START_INPUT I I LD I
o m B it Ho——————— o o m +
I »xI8.1 I AUTD_INPUT I 4 I LD I
o mm e e e e T ittt o mm +
1 »I8.2 I MANUAL _INPUT I 1 I ORH I
I I I 8 1 LD I
o mm e e e e T ittt o mm +
1 »I8.3 I RESET_INPUT I a I ORN I
I I I iz 1 LD I
L e e B e e e e e B L e e +
1 »I8.4 I COUNT_INPUT I 15 1 LD I
L e B e e e T L LT e B e L e +
I »xI8.5 I OVER_FLOW_TINPUT I i8 1 LD I
L e B e e e T L LT e B e L e +
[y ] I RESET I 2 I 5T I
L e B e e e T L LT e B e L e +
I =M1 | HIGHT _LEVEL I 18 I 5T I
o m B it Ho——————— o o m +
I =M2 I FLOP I [ I 5T I
o mm e e e e T ittt o mm +

When Sort By Operand or Sort By Symbol is selected, a separation line frames each
operand or symbol so that the information is easier to read.

5. Inthe Elements field, select the check boxes that correspond to the program items
that you want listed.
The selection of specific program items from the Elements field allow you to define

the scope of your display more narrowly. For example, you can choose to list only
program lines or rungs that have timer function blocks.
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Cross referencing an application 16

16.3 Updating an existing Cross Reference list

An existing cross reference list will need to be regenerated in the following cases:

* Modification of the Rung Number system of reference to Line Number or vice versa
in the Reference By field,

« Modification of the range of the cross reference,

» Modification of the current cross reference list (adding or deleting elements),

* Any change to the application program and/or symbols.

1. Ifthe cross reference listis to be updated while the cross reference list is displayed,
select Generate Cross Reference from the Tools menu.

The Generate Cross Reference dialog box will appear. After selecting all the
desired fields in the dialog box, select Ok to generate a new cross reference list.

Select Cancel to return to the existing cross reference list.

2. If you do not have the cross reference list displayed, select Cross Reference from
the View menu.

The current cross reference list will be displayed. Select Generate Cross Reference
from the Tools menu. The Generate Cross Reference dialog box will appear.

After selecting all the desired fields in the dialog box, select Ok to generate a new
cross reference list. Select Cancel to return to the existing cross reference list.

3. If you only desire to re-order the existing cross reference list by a different key field
(while the cross reference list is displayed), select the desired key field from the
Tools menu.

The options are Sort by Operand, Sort by Symbol, Sort by Line/Rung, and Sort by
Operator.

After the desired key field is selected, the program will re-order the cross reference
list by the selected key field.
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Section 17

17 Exporting source files

17.1 Introduction

Using a PL7-07 application it is possible to generate a text file using a source program
export function. This text file is compatible with the PL7 Micro import function.

This operation transfers a PL7-07 application for TSX Nano PLC to the PL7 Micro
programming software for TSX Micro PLCs.

17.2 Principle

To perform the export, the application must previously have been open in PL7-07. The
function can be accessed from the File-Export-Source program menu:

Edit Uiew Tools Configuration

Hew Cirl+N
Open Ctrl+0
Save Cirl+5
Save As
Close
Import »
ASCH Program
Symbols
Security [ 3 =
Print Cirl+F
Print Setup
Exit Cirl+0.

A browser window is used to select the name and the target directory where the file to
be exported will be placed.

The file extension, *.IL for List or *.LAD for Ladder, is automatically selected according
to the editor selected in preferences. If the user changes the export file extension, the
format (List or Ladder) of the file will change. It is therefore possible to select the format
of the export file independently of the language chosen to create the application.

Note
The application to be exported must be valid in List or reversible List/Ladder.
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An export file contains:

* An information header

» The List or Ladder program

» The configuration objects compatible with PL7 Micro : %TMi, %Ci, %Ri, %DRi, %Kwi

» The symbols associated with objects compatible with PL7 Micro : %Mi, %MWi, %Si,
%SWi, %li.j, %Qi.j

The contents of the exported program, to conform with the application structure of PL7

Micro do not contain:

 Line or end of line comments placed in the rung

» Subroutines

» Grafcet steps

» Post-Grafcet processing (POST)

» Objects which are not compatible with PL7 Micro : Fast counters, etc.

In the exported program, positions containing unsupported object addresses are
replaced by a blank.
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1 Troubleshooting and fault analysis

1.1 Troubleshooting using status LEDs

The user is informed about the operating mode together with any PLC operating faults
by the status LEDs on the front panel.
Note :

Each time the PLC is switched on, all the LEDs are lit for a period of approximately one second
corresponding to the self-test phase. Outputs are not activated.

1.1-1 Troubleshooting the "base PLC" PLC or peer PLC

LED status Meaning Probable cause
RUN O PLC off or application PLC not powered or syntactically
LED not executable invalid application.

4] PLC in STOP

Required stop (controlusing RUN/STOP
%I0.. input orthe terminal) or stop caused
by an execution fault (watchdog timeout,
or use of a function which has not been
implemented or is prohibited).

‘ PLC in RUN Normal operation.
ERR O Operation OK Normal operation.
@ Application not executable Application not present, invalid,
checksum fault, watchdog timeout.
‘ Internal faults . Hardwarg V\{atchdog timeout. -
« Self-testsindicate afault (Prob accessing
RAM, EEPROM or schedule block).
« Mis-wiring on extension port
1/10 O Operation OK Normal operation.
LED 1/0 faults :
‘ 1/0 fault * Qutputs failed
» Sensor supply fault.
« Configuration fault.
COM O No exchange present on
LED extension link
‘ Exchanges present on
extension link
@ Exchanges present on
Modbus link
O LED off @ LED flashing . LED lit continuously
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1.1-2 Troubleshooting the I/0 extension

LED status

Meaning

Probable cause

RUN

O

Extension off or

Extension not powered, not

Exchanges present on

LED not connected to connected or connection error
extension link on extension connection cable.
Base PLC in STOP Identical to those of base PLC.
(same as base PLC
LED)
Base PLC in RUN Normal operation.
(same as base PLC
LED)
ERR O Operation OK Normal operation.
LED
‘ Internal faults » Hardware watchdog timeout.
* Self-tests show a fault.
» Mis-wiring on the extension port
110 @ Operation OK Normal operation.
LED
‘ Extension 1/0 1/O faults :
fault « Outputs failed
» Sensor supply fault.
COM O No exchange present
LED on extension link

extension link

Q LED off

@ LED flashing

. LED lit continuously

1/2



Troubleshooting and fault analysis 1

1.1-3 Troubleshooting the "base PLC" PLC, peer PLC or I/O extension

LED status Meaning Probable cause
LED O Input not active Normal operation if sensor not
10 to 113 conducting.

. Input active Normal operation if sensor is conducting
LED O Output not active Normal operation if output not activated.
00 to 09

’ Output active Normal operation if output activated.
O LED off . LED lit continuously

If LEDs 15 (TSX Nano 101/0), 17 (TSX Nano 14 1/0), 18 (TSX Nano 16 1/0), 111 (TSX Nano
20 1/0) or 113 (TSX Nano 24 1/0) are flashing (series of 5 short flashes every second),
the memory display mode is enabled. (1)

LEDs I0to I7 and OO0 to O7 show state 0 (off) or 1 (lit) of internal bits %M112 to %M127.

LED Meaning Type LED Meaning Type

10 %M112 TSX Nano 00 %M120 TSX Nano
11 %M113 10/14/16 o1 %M121 10/14/16
12 %M114 20/24 110 02 %M122 20/24 110
13 %M115 03 %M123

14 %M116 TSX Nano 04 %M124 TSX Nano
15 %M117 20/24 110 05 %M125 20/24 110
16 %M118 06 %M126

17 %M119 o7 %M127

(1) In this case, system bit %S69 is at state 1.

1/3



1.1-4 Troubleshooting TSX AMN 4000/4001 analog modules

LED status Meaning Probable cause
RUN O Module off or application Module not powered or connected
LED not executable
. Application in RUN Normal operation.
ERR O Operation OK Normal operation.
LED
(X) Incorrect module Modify the position of the selector switch
addressing on the front panel of the module
. Internal faults « Self-calibrationfault.
« Self-testsindicate afault.
1/0 O Operation OK Normal operation.
LED
‘ High or low stops
exceeded on
analog inputs
COoM O Communication in progress
LED
. Exchanges in progress on

extension link

O
=
G
S

(:) LED flashing . LED lit continuously
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1.2 Fault analysis using system bits and words

If afaultis detected, the PLC system sets a system bit or word corresponding to the error
which has been detected. The application program can use this information.

The FTX 117 terminal or PL7-07 Data editor (on FTX 417/507, FT 2000 or compatible
PC) can display system bits (%S key) and system words (%SW key). See Data editor,
Part C, Section 9 in the FTX 117 manual, or Part C, Section 14 of the PL7-07.

1.2-1 System bits

System Function Description

bit

%S10 170 Normally at 1. It is set to state 0 when an I/O fault is detected on the
fault base PLC or the peer PLC (configuration fault, exchange fault,

hardware fault, disconnection of protected solid state output). Bits
%S118 and %S119 indicate in which PLC the fault is and words
%SW118 and %SW119 detail the nature of the fault. (See Section 5.2)

Bit %S10 is reset to state 1 when the fault is cleared.
%S11 Watchdog Normally at O, it is set to state 1 by the system when the program
timeout execution time (scan time) exceeds the maximum scan time (150
mssoftware watchdog). Watchdog timeout causes PLC to change to STOP).

%S19 Scan period Normally at 0, this bit is set to 1 by the system in the event of a scan

overrun period overrun (scan time greater than the period defined by the user
(periodic at configuration or programmed in SWO0).
task) This bit must be reset to 0 by the user.

%S71 Exchange Initially setto 0. Itis set to 1 when an exchange via the extension link
via extension is detected. This bit is set to 0 when no exchange is performed via the
link extension link. Word %SW?71 in the base PLC shows the list and status

of the available extensions.

%S118  I/O fault Normally at O. It is set to 1 when an I/O fault is detected on the base
on base PLC. Word %SW118 determines the nature of the fault. Bit %S118 is
PLC reset to 0 when the fault is cleared.

%s119 /O fault Normally at 0. It is set to 1 when an I/O fault is detected on the peer
on peer PLC. Word %SW119 determines the nature of the fault. Bit %S119 is
PLC reset to 0 when the fault is cleared.
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1.2-2 System words

System Function
word

Description

%SW71 Devices on
PLC comm
link

Shows the comm status of each peer PLC and 1/O ext. with the
base PLC :

bit 1 : /0O extension

bit 2 : peer PLC n°2

bit 3 : peer PLC n°3

bit 4 : peer PLC n°4

Bit at O if there is no extension or peer, no power, not wired or a fault.
Bit at 1 peer PLC present and exchange with the base PLC.

%SW118 Base
PLC
status

Shows faults detected on the base PLC.

bit 0: 0= failure of one of the outputs (1)

bit 3: 0= sensor supply fault

bit8: 0= TSX 07 internal fault or hardware fault

bit9: 0= external fault or comm. fault

bit 11 : 0= PLC performing self-tests

bit 13 : 0= configuration fault

All other bits of this word are at 1 and are reserved. Thus, for a PLC
which has no fault, the value of this word is : 16#FFFF.

%SW119 Peer
PLC
status

Shows faults detected on peer PLC (this word is only used by the
base PLC). The bit assignment of this word is identical to that of word
%SW118, except for :
bit 13 : not significant
bit 14 : peer PLC now missing although it was present at initialization

(1) after a shortcircuit or overload of the protected transistor outputs.
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Important

The example described in this section is for information only. When used in an
industrial application it will require modifications depending on the safety rules
which apply to the sector of activity concerned.
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1 Specifications : automatic car wash

11

Description of the application

A car wash comprises :

* A gantry supporting a horizontal roller and vertical rollers, driven by a motor with two
operating directions (forward and reverse).

* A motor to rotate the horizontal roller and vertical rollers.

¢ A motor to raise and lower the horizontal roller.

Limit switches control :

< Upper limit of the horizontal roller
e Forward and rear limit of the gantry.

Rotation
of rollers

-

q

Raise
gantry

iy

T,

v §
—
Move gantry \ §
down —| §
"\

=

-

reverse

Roller upper

/ limit switch

=

Gantry forward

=1

Vehicle present

~J
-

Gantry rear

limit switch proximity sensor limit switch
< Cycle indicator ___ Start / Stop
lamp pushbutton .,  pushbutton
&4

? Manual raise
W‘ — roller pushbutton

L

—
ol
i

Manual gantry
" reverse pushbutton

|
L
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1.2 Application operation

1.2-1 Automatic wash cycle

Initial conditions : The gantry is at the "rear" position (rear limit switch) and the horizontal
roller is in the raised position (upper limit switch). A vehicle is present in the washing
area (vehicle present proximity sensor).

When the initial conditions are fulfilled, pressing the start pushbutton starts the following
cycle :

» Cycle indicator lamp is lit, followed by a ten second wait period (KAO).
* The horizontal roller moves down (KM1) for five seconds (KAL).

» The rollers start to rotate (KM3) and the gantry moves forward (KM4). It is presumed
inthis example that the water spray pumps are activated at the same time as the motor
which rotates the rollers.

» Forward movement of the gantry is stopped by the gantry forward limit switch and the
gantry reverse command is given (KM5).

» Gantry reverse and rotation of the rollers are stopped by the gantry rear limit switch.
The command is given to raise the horizontal roller (KM2) up to the upper limit switch
which ends the cycle.

A real-time clock controls the times (Monday to Saturday, 8.00 to 19.30). Outside these
times, no start request is accepted.

A weekly counter counts the number of washes performed. It is automatically reset to
zero every Monday at 8.00 a.m. Another module counts the total number of washes
performed over the weeks.

1.2-2 Manual immediate stop

A latching pushbutton can stop the cycle at any time (immediate stop of all motors). To
start a new cycle, the following operations must be performed :

» Raise the horizontal roller to the upper position (to upper limit switch) by holding down
the manual raise roller pushbutton.

» Return the gantry to the rear position (up to rear limit switch) by holding down the
manual gantry reverse pushbutton.

* Release the stop pushbutton.
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Application example

1

1.3  Graphic representation of the wash cycle

The Grafcet chart below is a graphic representation of the automatic operation of the

car wash.

@ Vehicle waiting
—+— Initial conditions and start pushbutton
1 10 s time delay Indicator
start cycle lamp lit
A —T— 10 s time delay (KAO)
Move roller .
2 down (KM1) 5 s time delay
5 s time delay (KA1)
A 3 Rotate rollers 4 Gantry forward
(KM3) (KM4)
——Forward limit switch
5 Gantry reverse
(KM5)
—— Rear limit switch
A 6 Raise roller Washing
(KM2) counter
—— Upper limit switch

1/3




1/4



Section 2

2 Hard-wired solution

2.1 Powercircuit

H = 1
oty N

NN d‘J\‘ VA d‘J\‘
KM1N N VAN T\KM2 KM3\ N KM4\ \ VAT \KMS L
440V (or 380V)
SO;LL
‘ : i : i ‘ ~1 24v
Fid N [ [ R [ i
U4 |v4a
\Y
— 24V
Raise/move Rotate Gantry Control
down roller rollers forward/reverse circuit

2.2  Controlcircuit

The diagram overleaf shows the automatic operation and manual stop. The real-time
clock and totalling counter are not shown in this diagram.

Two control relays with mechanical latching memories (KAO and KA2) memorize the
stage reached in the cycle. This means that after a power outage, the cycle continues
from the state where it stopped. The two time delays are provided by two time-delay
options on KAO and KAL.

The rear and forward limit switches require two additional control relays (KA3 and KA4)
due to the large number of contacts used in the layout.
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24V

i

Immediate & Manual
stop E-N-® raise
Cycle [EE-\ KA2
pushbutton Rear limit
Vehicle KAO switch
present P\ KA2 KAO ey KAT eyl
Upper limit
KA1 switch
KA3 KA3 &
KA4 — KM2 KM1
. KM2
KAO -~ Qf) KA1 IZ['] KM1 N/
> Move roller Raise
down roller
Manual
E-N-2 return
KM3
KA1 KA2 /  KA2 KAo [
Fwd. limit Rear . l_Jppe_r . .Reaf
KA1 switch limit switch F_wc_. limit switch| limit switch
S O O timit 1 P
% % swnch%
KM2 KM5 KM4
KM5 .
KM3 KM4 —Nf- KA2 [|:|——'>———{|:| KA3 [|:| KA4 [|:|
Rotate Gantry Gantry
rollers forward reverse
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3 Solution using TSX Nano PLC with 16 1/0

3.1 Powercircuit

This layout is identical to that for the hard-wired logic solution. The 110VAC supply to
the TSX Nano PLC is provided via a 440VAC(or 380 VAC)/110VAC transformer. The
supply voltage to the outputs is 24VAC and provided by a second transformer.

—| N|] ™
Y R | R

AN

| |
I 1T 1 I 1T T J_l
SANS\SN %%%% a3 P-H-\ a+ )
NN dJ\c A AN d‘J\‘
KM\ N V- \ KM2 M\ N KMa\ N V- \ KMS L
440V (or 380V)
Ch
‘ ] i b ] ~1 110v
FiiJ 3 Ji 20 e e | s e [ Il
U4 |v4
VvV V
TSX Nano
PLC
~ 110V
Raise/lower Rotate Gantry
roller rollers forward/reverse
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PLC connection diagram

Manual gantry reverse

Manual raise roller

Upper limit switch
Rear limit switch

Forward limit switch

A 110V Stop cycle
\ A 4 Start cycle
U4 | va Vehicle present

3A|:
110V

N~—"124v

——24v TSX Nano with 16 /O

Extension
r 1

c|0|1]|2|3|C|4|5|C|6 A | B [SG
~ I
KM2 KMS
d_f k1 KM4
d_f ®KM1 KM3:| KM4
[: KM2 KM5

| Gantry reverse

Gantry forward
| Rotate rollers

Raise roller

| Move roller down
Cycle indicator lamp
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Solution using TSX Nano PLC with 16 I/O0 3

3.3 Partslist

3.3-1 PLCinputs

Iltem Address Description

Vehicle present %10.0 Vehicle proximity sensor

Start cycle %I10.1 Start pushbutton

Stop %10.2 Stop pushbutton

Forward limit switch %I10.3 Gantry forward limit switch
Rear limit switch %10.4 Gantry rear limit switch

Upper limit switch %10.5 Roller upper limit switch
Manual raise %10.7 Manual raise roller pushbutton
Manual return %10.8 Manual gantry reverse pushbutton

3.3-2 PLC outputs

Item Address Description

Indicator lamp %Q0.0 Cycle indicator lamp

KM1 %Q0.1 Move roller down contactor
KM2 %0Q0.2 Raise roller contactor

KM3 %0Q0.3 Rotate rollers contactor
KM4 %Q0.4 Gantry forward contactor
KM5 %Q0.5 Gantry reverse contactor

3.3-3 PLC internal variables

Type Address Description

Internal bit %MO Start latch variable (KAO)

Internal bit %M1 Move roller down variable (KA1)
Internal bit %M2 Gantry forward latch variable (KA1)
Internal bit %M3 Schedule block output variable
Internal bit %M4 Monday test variable

Internal bit %M5 Variable to create pulse on %M4
Internal bit %M6 Variable to create pulse on %M
Internal bit %M7 Variable to test timer output on %TM1
System word %MWO Wash number totalling counter
System word %SW50 Real-time clock current seconds/day
Timer function %TMO Start time delay

Timer function %TM1 Move roller down time delay
Counter function %CO0 Weekly wash counter

Schedule block function ~ RTCO Schedule block
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3.4  Equivalentelectrical scheme

The circuit diagram modified for the PLC solution, which is directly based on the control
circuit of the hard-wired solution in Section 2.2, is as follows.

| Stop |7 |
10.2 10.2 10.2
Cycle
pushbutton [Z]E- M2 \ 10.7
10.1
M3
Vehicle \ T™MO0.Q
present <>- M2 MO e M 10.4
10.0
™1.Q
10.5 W 10.5 & 105 [
10.4 — Q0.2 Q0.1
] Q0.2
MO ”m———£|:| Qo.oéf) M1 |z|:|:| Qo.1 VN
Move Raise
roller down roller
|7 I
10.2 10.2
Q0.3 10.8
KA1 M2 /M2 Mo /
™1.Q
e 103 / 10.4 10.3
Q0.2 Q0.5 Q0.4
Q0.5 .
Q0.3 Q0.4 —Nf- M2 [|:|——'>———{|:|
Rotate Gantry Gantry
rollers forward return

Control relays KAO, KA1 and KA2 are replaced by internal bits %M0, %M1 and %M?2.
Control relays KA3 and KA4 are not applicable, since the number of tests on a single
PLC variable is not limited in a program.

The rising edge at internal bit %M4, set to state 1 every Monday (by testing the first four
bits of system word %SW50) sets the weekly wash counter (counter %CO0) to zero.
The totalling counter for the total number of washes (internal word %MWO) is
automatically reset to 1 when it reaches 30 001.
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Solution using TSX Nano PLC with 16 I/O0 3

35

Ladder program
The reversible Ladder program is as follows:
SCHED RUL GRL START_LATCH
START_PB PROX_SEN _BLOCK VAR _SWTCH _SW TCH
11 11 11 11 11 /S\
1 1 1 1 1 \>)
%0.1 %0.0 %8B %0.5 %0.4 90
GANTRY_FOR  RUL
TLATOHVAR  _SW TCH START_LATCH
1L 1L IR\
1 11 Y
% %0.5 YY)
STOP_PB
11
L
%0.2
START_LATCH | ND_LAVP
1L [/
LA} \/
%0 %0
IND_LAMP START_TI ME_DELAY
9aND
—] IN Q
%0
TART T NE ROLL_DOWN
“DELAY_Q VAR |
1L 7\
LA} \/
9%IM. Q %0 |
ROLL DOWN ROLL_DOWN_TI ME_DELAY
VAR~
- oaTML
—] IN Q
oML
STOP_PB  ROLL DOM ROLL DOMN  ROLL_RAI SE ROLL_DOWN
_VAR™ _TI NE_DELAY -
; \
—I—— Il ()
%0.2 oML WM. Q 9.2 %D. 1
GANTRY FOR GRL RUL
LATCHVAR _SWTCH _SWTCH ROLL_DOWN ROLL_RAI SE
I [/ \
i | i ji—i ()
W  %0.5 %. 2
STOP_PB MAN_RAI SE
%0.2  %0.7
ROLL DOWN ROLL_DOWN ROLL
VAR "FINVE_DELAY. Q _RAISE ROLL_ROTATE
11l 11l 11l 7\
L) L) L) \/
%Y. 3

oL %M. Q 9. 2
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STOP_PB ROLL GANTRY FOR GFL GANTRY GANTRY
— = _ROTATE _LATCH VAR _SWTCH _REV _FOR
I\
—I— I—I—It ()
%0.2  %0.3 %R %0.3 %Y. 5 %0 4
GANTRY_FOR
GFL_SW TCH _LATCH VAR
L (<)
{5)
%0.3 %
STOP PB ROLL GANTRY_FOR GRL GANTRY GANTRY_REV
- _ROTATE _LATCH_.VAR _SWTCH _FOR
IL / \
I———— it \)
%0. 2 %. 3 %R %0. 4 %Q. 4 %0. 5
STOP_PB  MAN_RET
11 11
|1 1
%0.2 %0.8
START_LATCH GANTRY_FOR
_LATCH VAR
11 IR\
LU \'/
%MD %R
SCHED SCHED SCHED  SCHED MONDAY
BLOCK BLOCK BLOCK _BLOCK TEST_VAR
%JRRENT: %JRRENT: %RRENT: %JRRENT: - -
[/ \
—— Il ()
Y8WB0: X0 %SWB0: X1 %SWB0: X2 YBWB0: X3 oH
MONDAY PULSE_VAR WEEKLY_COUNTER
_TEST_VAR -
— %0
—— ——I—r E
% %6
D
GANTRY_FOR S
_LATCH VAR
11 (eV] F
11
%R D
MONDAY_TEST PULSE_VAR
_VAR
11 ()
LU \/
%V %6
GANTRY_FOR_PULSE_VARI
TLATCHVAR™ - CPERATE —
11 111 I NC %W\
11 it |
%R %6
MONDAY_TEST PULSE_VARI
_VAR
1/1L [\
1T \/

%2 a6
COVPARE __ OPERATE —
|%AMJ=30001 90MD: =1 ||

I (enD) I

A |
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Solution using TSX Nano PLC with 16 /0 3

3.6  Functionblock configuration

The function blocks can be configured for timers %TMO and %TMZ1and counter %CO0O
from the Configuration menu.

 Start time delay %TMO

Timer: Symbok: [START_TIME_DELAY

Preset:

Timer Type Timebase —— Ad just
() TON 11 ms (#)188 ms INe
JTOF (118 ms (1 sec (% Yes

OTP ()1 min

‘ ik I | Cancel I

* Move roller down time delay %TM1

Timer: Symbok: [ROLL_DOWN_TIME_DELAY

Timer Type Timebase —— Ad just
(&) TON 11 ms (€188 ms JHo
OTDF OlB ms Ol sec @Yes

OTP ()1 min

‘ ik I | Cancel I

» Weekly wash counter %CO

COUNTERS
Counter: Symbol: [HEEKLY_COUNTER

Adjust
Preset: 9959 F@ No (Oes

| itk I ‘ Cancel I

3.7 Programming the RTC schedule block

The schedule block RTCO is configured from the Configuration menu. This programming
corresponds to the opening of the car wash :

) From 2 January Schedule Bl [:E T (RT d
H f'
to 31 December chedule 2lac 6] onfigure

Output Bit: [xM3

* Monday,Tuesday, Start Month: [January ¥ Start Date:
Wednesday, Thursday, End Month: [December  [#] End Date:
i Days of Heek
F”day’ and Saturday [ Monday B4 Tuesday [ Wednesday (4 Thursday
e From 8:00 to 19:30. [ Friday B saturday [ Sunday

Start Time: Stop Time:
Cancel I
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1 Terminal port communications

1.1 Characteristics of the terminal port

¢ Characteristics

Type of link . RS485
Protocol : UNI-TE format V2
(V1 format for TSX Nano < V3.1).
Baud rate : 9600/19200 bits/s
1 start bit, 8 bit data, odd parity, 1 stop bit
Type of connector : 8-pin rapid connect mini-DIN
Max. link distance
FTX117 :10m
UNITELWAY devices : 10 m (without junction box)
ASCII devices :10m

e Connector pinout - UNI-TELWAY devices

D+

D-

Not connected
/DE

/IDPT

Not connected
oV

5V

N U~ WNPRP

The signal /DPT is used to select the operating mode of the terminal port :
/DPT =1 UNI-TELWAY Master mode
/DPT =0 UNI-TELWAY Slave mode or ASCIl mode.

Connect pins 5 to 7 to select ASCII mode.

Notes :

Equipment should be connected with the power off (except for programming terminals).
The use of ASCIl and UNI-TELWAY devices is exclusive.
An ASCII device must be disconnected to allow the use of a programmer (FTX117 or PC).
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1.2 General information about the terminal port

The TSX Nano terminal port can operate in three different modes :
e UNI-TELWAY Master (TSX 07 2. TSX 07 3.),

e UNI-TELWAY Slave (TSX 07 3. only),

« ASCII (TSX 07 2. TSX 07 3.).

The operating mode of the terminal port is selected by software configuration and using

signal /DPT (pin n°5) on the Mini DIN socket :

* Whensignal /DPT is at 1 (pin n°5 not connected), the terminal portis in UNI-TELWAY
Master mode.

* When signal /DPT is at O (pin n°5 connected to pin n°7=0V), the terminal port is in
ASCIl mode or UNI-TELWAY Slave mode. The selection is made by software
configuration using the programming tools PL707 and FTX 117 (ASCIl mode by
default).

The state of /DPT is shown by system bit %S100.

Configuration screen :

PROGRAMMING PORT

Tupe
(IASCH (JUNI-TELWAY Master (30 ‘

Bits~sec
r (J1zem (j248m (4868 (#9688 119268 ‘
UNI-TELWAY Slave Base Address: [ 4]

Parity ———————— Data Bits
(®)0dd (%8 Bits ()7 Bits

(OEven & Stop Bits
{_'None ’7 (@1 Bit ()2 Bits
UNI-TELUWAY Time out
r Master and Slave Modes (char.): 38 ‘
| 0K I | Cancel I
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Terminal port communications 1

1.3 TSX Nano in ASCIl mode

This character mode, simplified on the TSX Nano is used to transmit (TSX 07 2.and TSX
07 3)and/orreceive (TSX 07 3.only) a character string to/or from a simple device (printer
or terminal) without flux control.

This mode is designed to operate in a point-to-point link.

The terminal port configuration can be modified on TSX 07 3. modifications are made
in the PLC configuration screen :

e Type: Half-Duplex

* Speed : 1200, 2400, 4800, 9600 or 19200 bds

e« Format: 1 start bit, 7 or 8 data bits , 1 or 2 stop bits

e Parity : even, odd, none.

The values in bold are the default values, they cannot be modified on TSX 07 2..

ASCII configuration screen :

PROGRAMMING PORT
Tupe -
r© E

I  JUNI-TELWAY Master { JUNI-TELHAY Slave |

Bits/sec
rO1zaa {2488 (14868@ ($)968@ (_)19268 |
UNI-TELHAY Slave Base Address: 1]

Parity —————————— Data Bits
{®10dd (18 Bits ()7 Bits
OEUE" Stop Bits
 INone F @1 Bit ()2 Biis

r UNI-TELHAY Time out |

Master and Slave Modes (char.):

[1].4 Cancel I

Programming in ASCII mode is possible using the EXCH instruction, as well as the
exchange control function block %MSG. See section 3.4-6, part B.
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1.4 TSXNano Master on UNI-TELWAY

The TSX Nano is compatible with other UNI-TELWAY devices such as man-machine
interfaces (MMI), identification devices and drives. This section provides general
guidelines for connecting these devices on the UNI-TELWAY bus. Refer to the user
manuals for the devices to obtain specific information.

When the TSX Nanois the UNITELWAY communication master for slave devices which
are connected to the TSX Nano terminal port, it controls the network and polls the slave
devices at periodic intervals.

Example of architecture

TSX Nano Master

(TLITTITTTITTITTITTN
Client ‘ ‘ Client/server
e
| ’7 |
LTI TTTTTTT kb
1
{” ! B8
A8883a0 88!
ATV 16 CcCX 17

The TSX Nanois normally a UNI-TE server. However it can provide limited UNI-TE client
services for TSX 07 2. :

« Configurations
Most UNI-TELWAY devices require the use of two addresses. The first address is
configured physically by the user using microswitches; the second address is generally

the physical address +1. The TSX Nano can communicate with a programming terminal
and up to two additional UNI-TELWAY devices.

Address assignment :

0 : TSX07 (communication master)

1 : programmer (FTX117 hand-held terminal or PL7-07 software)
2-3-5 : client device only (TSX 07 2¢)

4 : client and/or server device (TSX 07 2°)

2-3-4-5: client and/or server devices (TSX 07 3¢)
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Terminal port communications

1

Summary of devices that can be connected to various addresses.

Reference Permissible Addresses
Device 1 2,3 4.5
Programming Yes No No
terminal
MMI No Yes Yes
Identification
devices No Yes Yes
Speed controller No Yes (1) Yes

(1) TSX Nano V3 only

The terminal port configuration cannot be modified in UNI-TELWAY Master mode. It
manages 5 slave link addresses depending on the transmission format as follows :

e Type: Half-Duplex

e Speed : 9600 bds

e Format: 1 start bit, 8 data bits, 1 stop bit
e Parity : odd.

The Time-out parameters can be set in the configuration screen.

* UNI-TE server function :
The TSX Nano responds to commands initiated by the client. A client is an intelligent
device which can initiate communication with the TSX Nano. It can write data to or
read data from the TSX Nano.

TSX Nano (FEETTTTTTT

Server ﬁ
\

\Request

I I

Confirmation
report

Client Client

Addressing

The TSX Nano is always address 0 (master).

e The TSX Nano polls for addresses 1 to 5

e The programmer (either the FTX117 or the PL707 software) is always address 1
* Generally, the address of a UNI-TELWAY device is set by microswitches at a junction

box or by cable connection.
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Notes :

- Communication between slaves is not possible when the bus master is a TSX
Nano.
- The TSX 07 2. cannot be a UNI-TELWAY slave.

All the bus devices can interrogate the TSX Nano server system by using the target
address 0.254.0. The TSX Nano UNITE server only responds to frames sent to this
address. Messages containing a different target address will be ignored.

* TSX Nano as a client :

The TSX Nano initiates communication with the server. The server is an intelligent
device which executes the commands sent by the TSX Nano.

TSX Nano ]
Client

JJ:D::IDJ’EEH Request
Confirmationreport / \ |

(TSX 07 2)

Server

—

The TSX 07 3« Master can send a request to any slave with an address between 1 and
5 using the EXCH instruction. It uses source address 0.254.16.

The TSX 07 2¢ can only send a request to slave at address 4 (using the EXCH
instruction). Consequently, only WRITE and UNSOLICITED DATA (unconfirmed)
requests may be used. Source address 0.254.10 is used.

WARNING :

The UNI-TE client function of the TSX 07 3. reverses the data transmitted (most
significant/ least significant) in relation to TSX 07 2.. Applications which operate
with TSX 07 2. must be modified to take account of this reversal if they are loaded
onto a TSX 07 3..

Programming in UNI-TELWAY Master mode is possible using the EXCH instruction,
as well as the exchange control function block %MSG. See section 3.4-6, part B.
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Terminal port communications 1

1.5 TSX Nano Slave on UNI-TELWAY

This protocol is only available with TSX Nano version 3 or later (TSX 07 3.).
It is used for simultaneous, multidrop connection of several devices (PLC, program-
ming terminal, MMI device, speed controller, etc.).

Example of architecture
TSX 37

8 — A
| I

o DO
() . (FC) ] =
o) (RESaRRARRRRARAAN) q [Fhiolle
TSX Nano ATV 16 TSX Nano TSX 37

Unlike Master mode, the terminal port configuration can be modified by the user in
UNI-TELWAY slave mode using the programming tools PL7 07 or FTX 417 in the PLC
configuration screen :

e Type: Half-duplex

e Speed : 1200, 2400, 4800, 9600 or 19200 bds

« Format: 1 start bit , 7 or 8 data bits , 1 or 2 stop bits
e Time-out: 30 to 255 (see section 1.6)

e Address: 4 (1to97)

e Parity : even, odd or none.

The values in bold are the default values.

The TSX Nano uses 2 consecutive logic addresses :

« ADO : base address (that of the configuration), known as server address. Any device
(local or remote) can address the TSX Nano system server using ADO as target
address.

e AD1=ADO0 + 1known as client address. With this address the TSX Nano can transmit
a request to any UNI-TELWAY bus device (Master or Slave) using the EXCH
instruction.

See section 3.4-6 part B.
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PROGRAMMING PORT

Tupe
()ASCH (CJUN-TELWAY Master (®JUNI-TELWAY Slave! |

Bits~sec
()1ze8 ()24@@ (/4888 (®)9688 {_)19288 |

UNI-TELWAY Slave Base Address: [4]
Parity —— Data Bits
(8)0dd (#)8 Bits ()7 Bits
OEUE" Q Stop Bits
("JNone r (®)1 Bit ()2 Bits

UNI-TELHAY Time out
’7 Master and Slave Modes (char.): 38 |

| [1].4 I ‘ Cancel I

The modification of terminal port characteristics made in the configuration screen
is only taken into account on a power restart or on modification of the signal /IDPT
on the Mini DIN socket (disconnection / reconnection of the terminal port).

1.6  UNI-TELWAY Time-out (TSX 073 .)

The link layer of the UNI-TELWAY protocol (Master or Slave) uses a time-out.
This Time-out corresponds to the duration of the transmission of a number of characters
sent on the line :

e TSX 07 3.: 30 characters by default. This duration is increased to 125 characters if
the TSX Nano does not have an application.

Once a frame has been transmitted, a device (Master or Slave) declares a Time-out.
If no acknowledgment is received before the end of the time-out, the exchange is not
acknowledged.

The transmitter repeats its frame as soon as the protocol allows.

The terminal port configuration screen is used to configure a Time-out of between
30 and 8000 characters.

Values between 30 and 250 inclusive correspond to an equivalent number of
characters. Values between 251 and 255 inclusive correspond to the following values :

e 251 =500 characters e 252 = 1000 characters  + 253 = 2000 characters
e 254 = 4000 characters » 255 = 8000 characters.

On power-up or on modification of the signal /DPT, the configured value is loaded into
the least significant bit of system word %SW14 (the most significant bit is ignored).

Thus, the Time-out value can be fine-tuned by writing the new value in the system word
%SW14. It will be taken into account at the end of the PLC scan.

A longer Time-out allows the TSX Nano to be connected to slow devices, for example
modem type.

Itis possible to reduce the value of the Time-out to 10 characters by using system
word %SW14.
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Terminal port communications 1

Important :

When connecting certain devices (eg modems) to a TSX Nano via the UNI-TELWAY
link, their response times mean that the time-out parameters must be set to value
255 (approximately 8 s at 9600 bd/s).

This value prevents all subsequent communication between the TSX Nano and a
programming terminal using the UNI-TELWAY link with standard parameters.

It is therefore necessary to :

- modify the value of the AUTOSPEED parameter (0 instead of 1) and the number
of UNI-TELWAY addresses (5 instead of 3) in the DUNTLW.001 file under DOS,
Windows 3.1/95/98 or using the XWAY tool under Windows NT.

- modify the timeout value of the PLC UNI-TELWAY link,

- reassign the initial values in DUNTLW.001 under DOS, Windows 3.1/95/98 or using
the XWAY tool under Windows NT.
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1.7  XBT operating terminals or CCX 17 operator panels

¢ PLCconnection

The XBT operating terminal or CCX 17 operator panel is connected via the TSX Nano
PLC terminal port using cable XBT Z968.

TSX Nano PLC
’UHHHHHHHH}‘

— e ~ [
I ¢ [ & [ S

| |
\[LLLIIIITITITTITTI

XBT-H

XBT-Z968 cable

e Characteristics of the link
- RS 485 link
- UNI-TE protocol

« XBT terminals which can be connected via the TSX Nano PLC terminal port

- XBT-A8 « - XBT-C8 -XBT-H

- XBT-B8 - XBT-K8 » -XBT-P

- XBT-BB8 » - XBT-M8 « -XBT-E
- XBT-A8 »

» CCX17 operator panels which can be connected viathe TSX Nano PLC terminal port
-TCCX 1720 F -TCCX 1720 L -TCCX1730L
-TCCX 17 20 FW -TCCX 17 20 LW - TCCX 17 30 LW
- TCCX 17 20 FPS -TCCX 17 20 LPS - TCCX 17 30 LPS

e Setup:

- XBT operator terminal :
(see technical documentation relating to the XBT being used)

- TSX Nano / XBT exchanges
The PL7 program sends messages to the XBT terminal via :
- EXCH instruction : to transmit messages
- %MSG function block : to control data exchanges
(see Part B, Section 3.4-6 : transmitting messages and controlling data exchanges).

¢ Comments
XBT and TSX 07 data syntax (1)

Data XBT or CCX17 syntax TSX Nano syntax
Internal bit Bi %Mi
Internal word Wi %MWi

(1) except XBT - H/P/E.
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1.8  UNI-TErequests supported by TSX Nano (server)

Standard requests

Service Request Request  Confirm Meaning

Hex. [Dec. |Hex. |Dec.

Data Read a bit 00 | 00 | 30 48 | Read a %Mi bit.
(read)
Read a word 04 | 04 | 34 52 | Read a %MWi word.
Read objects 36 | 54 | 66 | 102 | Read objects (%Mi, %Mi:L,
%Mwi, %Mwi:L).
Data Write a bit 10 | 16 | FE | 254 | Write a %Mi bit
(write)
Write a word 14 | 20 | FE | 254 | Write a %MWi word.
Write objects 37 | 55 | FE | 254 | Write objects (%Mi, %Mi:L,

%Mwi, %Mwi:L).

Operating RUN 24 | 36 | FE | 254 | Set device to RUN.
modes

STOP 25 | 37 | FE | 254 | Set device to STOP.

Special requests

Service Request Request  Confirm Meaning
Hex. |Dec. | Hex. |Dec.

Data Read a system 01 (01| 31 49 | Read a %Si bit

(read) bit
Read a constant 05 | 05 | 35 53 | Read a %KWi word
word
Read a system 06 | 06 | 36 54 | Read a %SWi system word
word
Read Grafcet 2A | 42 | 5A | 90 | Read %Xi Grafcet steps
steps

Data Write a system 11 | 17 | FE | 254 | Write a %Si bit

(write) bit
Write a system 15 | 21 | FE | 254 | Write a %SWi word
word
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2 Extension port communications
2.1  Characteristics of the MODBUS / JBUS extension port

The extension port of the TSX 07 3. can be used to connect other TSX Nano PLCs as
1/0O extension (see part A, section 1.4) or even as peer PLC (part A, section 1.10).
From TSX 07 3. , this extension port allows a MODBUS Slave type link.
Characteristics of the MODBUS link:

e Physical layer: RS485 non isolated, maximum length 200 meters

e Link layer: Asynchronous transmission
ASCII frame (7 bits) or RTU (8 bits)
Data rate: 1200, 2400, 4800, 9600 or 19200 bds
Parity: Even, odd or none
Number of stop bits: 1 or 2
Inter-character time: 3 (1 to 127) characters

e Physical configuration: ~ 28 devices max.
98 logic addresses (1 to 98)

« Services: Bits: 128 bits on request
Words: 120 words of 16 bits on request
Safety: on control parameter (CRC16) for each
frame (in RTU).

The values in bold are the default values.

Note: Devices should be connected with the power off.
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2.2 MODBUS /JBUS on TSX Nano
2.2-1 General

The data exchange services offered (%Mi and %MWi) are common to MODBUS and
JBUS, which allows MODBUS devices to communicate with JBUS devices.

The MODBUS/JBUS protocol allows data exchange between a Master and Slaves,
it does not allow direct communication between Slave devices, nor network
transparency.

MODBUS communication in ASCIl mode:

» Operation in ASCII mode is designed for connecting simple devices (screens, etc).
The frame is complete but the frames are twice as long as in RTU mode.

Detail of an ASCII frame:

Header(3A)| Slave no. | Function code | Data LRC CR LF*
1 byte 2 bytes 2 bytes 2n bytes 2 bytes| 1 byte | 1 byte

*The system word %SW67 can be used to set the parameters of the end delimiter
character (LF). It is written to 16#000A by the system on a cold start.

The user can modify this system word by program or by adjustment when the Modbus
Master uses an end delimiter character other than 16#000A.

MODBUS communication in RTU mode:

* Aframe in RTU mode does not have a header byte nor an end of message delimiter
byte:

Slave no. Function code Data CRC16
1 byte 1 byte n bytes 2 bytes
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Example of connection
By daisy chaining

TSX Micro

8 galallil
| el

TSX SCP 114
TSX SCP CU 4030
TSX Nano TSX Nano TSX Nano TSX Nano
LTI (NENENNNNRNENERERNRN) (NNRNENERNREERERN) (NERERERREREN)
— == =] —|
TSX SCA 50 hmmwﬂ%; hmmmmm\m%_—l; hmmm\mu&_—l; hummm%_l_
I\ /]
[
‘ 200 M max. 28 slave devices maximum
o) | 5
TSX Nano
pw | 4
A B SG
OovL 3 ><
OvVL 2
TSX SCA 50
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2.2-2 Configuring the MODBUS link

The extension link in MODBUS / JBUS is configured from the Configuration menu of
the PL7 07 by selecting Extension port.
The following dialog box appears:

EXTENSIDN PORT
Type N
(_JPLC Extension (@ € |

Bits~sec

1zes (2488 (14868 (89688 (119288 |
Extension Slave Address :
I;l Time Out (Char.) : El

10 Extension Data Bits

r ®8 ®RTW ()7 ASCID

PLC2 Parity ——————————————
’7@) Even

PLC 0dd

Hone

_l_l

PLC. Stop Bits
®)1 Bit ()2 Bits

1] Cancel I

In dynamic operation, the parameters (speed and format) cannot be modified.

There is no mechanism for adapting the speed of the TSX Nano Slave in relation to the
speed of the Master.

Any modification made to the speed and protocol format is takeninto accountby the TSX
Nano as soon as the configuration screen is enabled.

TheExtension, I/O Extension, AP2, AP3and AP4 fields are not significantif MODBUS
protocol is selected.

See part C section 5.19 for more details.
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2.2-3 Requests supported by the TSX Nano in MODBUS
The TSX Nano supports the requests listed below, others will be rejected with the
exception code 01: Function not known:

The MODBUS function only processes one request at a time, as in MODBUS protocol
the Master mustwait for a response from the slave or for atime-outto be triggered before
sending a new request to the slave.

Standard MODBUS requests :

e 01/02 : Read n consecutive internal bits : Access to bits %MO0 to %M127
* 05 : Write an internal bit : Access to bits %MO0 to %M127

e 15 : Write n consecutive internal bits: Access to bits %MO0 to %M127

« 03/04 : Read n consecutive words : Access to words %MWO to %MW255
* 06 : Write an internal word: Access to words %MWO to %MW255

« 16 : Write n consecutive words: Access to words %MWO0 to %MW255.

Details of these requests are given in section 2.3.
Access requests to the UNITE server of the TSX Nano:
e OF : Identification

* 4F :Read CPU

e 24 :RUN
« 25 :STOP
* 33 :INIT

Details of these requests are given in section 2.4.

Exception codes:

An exception code is returned by the slave when it does not know how to process the
request.
The response frame thus contains:

* The function code received, incremented by the value 16#0080
* The exception code which depends on the type of error.

The two exception codes processed by the TSX Nano are:
e 01: Function not known (request not supported by the TSX Nano)

» 03: Invalid data (bit or word number not managed by the TSX Nano, writing a bit with
a value other than 16#FF00 or 16#0000 etc).
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2.2-4 Managing the COM LED

Once the response to a request has been sent, the TSX Nano switches on the
communication LED for 50ms.

The LED then flashes, the frequency of the flashes depends on the exchanges between
the Master and the TSX Nano .

2.2-5 Associated bits and system words

When a MODBUS request is processed, the TSX Nano sets the system hit %S70 to 1.
This bit can be used by the user. Reset to 0 is the responsibility of the user.

The systemword %SW67 can be used to setthe parameters of the end of frame delimiter
character (LF) in ASCIl mode.

It is written to 16#000A by the system on a cold start.

The user can modify this system word by programming or by adjustment when the
Master uses an end of frame delimiter character other than 16#000A.
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2.3 Standard MODBUS requests

These requests can be used to exchange MODBUS objects by accessing objects %Mi
and %MWi of the TSX Nano.
The requests are detailed below in RTU mode. In ASCIl mode, the data is the same,
CRC 16 is replaced by LRC.

2.3-1 Reading n internal bits %Mi
Function 01 or 02

Question :
Slave No. of 1st bit | Number of bit
lor2 CRC 16
number PF | Pf | PF | Pf
1 byte 1 byte 2 bytes 2 bytes 2 bytes
Response :
Slave Number
number lor2 of bytes read Value eesssceel  Value CRC 16
1 byte 1 byte 2 bytes 2 bytes

Example : reading bit %M3 from Slave 2

Question 02 01 0003 0001 CRC 16

Response 02 01 01 XX CRC 16
00 if %M3 =0
01lif%M3=1
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2.3-2 Reading n internal words %MWi
Function 03 or 04

Question :
Slave No. of 1st word | No. of word
3or4 CRC 16
number PF | Pt | PF | Pf
1 byte 1 byte 2 bytes 2 bytes 2 bytes
Response :
Value Value
Slave 3or4 Number of 1st word of last word CRC 16
number of bytes read PE pf PE Pf
1 byte 1 byte 1 byte 2 bytes 2 bytes 2 bytes
Example : reading words %MW20 to %MW24 from Slave 6
Question 06 04 14 05 CRC 16
Response 06 04 0A XXXX | eeecoesseees|  XXXX CRC 16
Value Value
of %MW20 of %Mw24
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2.3-3 Writing an internal bit %Mi

Function 05
Question :
Slave No. of bit val - e 1
number 5 bF . alue of bit CRC 16
1 byte 1 byte 2 bytes 2 bytes 2 bytes

The "Value of bit" field has two possible values to the exclusion of all others :
* bit at 0 = 0000,
e bitat 1 = FFOO.

Response :
Slave No. of bit
number 5 oF of Value of bit CRC 16
1 byte 1 byte 2 bytes 2 bytes 2 bytes

Example : writing the value 1 in the bit %M3 of Slave 2

Question 02 05 03 FFOO CRC 16

Response 02 05 03 FFOO0 CRC 16
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2.3-4  Writing an internal word %MWi

Function 06
Question :
Slave No. of word | Value of word
6 CRC 16
number PF | Pf | PF | Pf
1 byte 1 byte 2 bytes 2 bytes 2 bytes
Response :
Slave No. of word | Value of word
b 6 CRC 16
number PF Pf PF Pf
1 byte 1 byte 2 bytes 2 bytes 2 bytes

Example : writing the value 16#3A15 in the word %MW12 of Slave 5

Question 05 06 ocC 3A15 CRC 16
Response 05 06 oC 3A15 CRC 16
2.3-5 Writing n internal bits %Mi
Function 15
Question :
Slave Address of 1st| Number of | Number| Value of
OF . . . . . . |CRC 16
number bit to write |bits to write | of bytes | bits to write
1 byte 1 byte 2 bytes 2 bytes 1 byte n bytes 2 bytes
Response :
Slave 0 Address of Number of CRC 16
number F 1st bit written bits written RC1
1 byte 1 byte 2 bytes 2 bytes 2 bytes
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2.3-6 Writing n internal words %MWi
Function 16 (H'10"

Question :
Slave 10 Number | Number | Number Value CRC 16
number of 1st word| of words | of bytes |of 1st word coseseeseesd
1 byte 1 byte 2 bytes 2 bytes 1 byte 2 bytes 2 bytes
Response :
Slave Number Number
number 10 of 1st word| of words CRC 16
1 byte 1 byte 2 bytes 2 bytes 2 bytes

Example : Writing values 1 and 2 to words %MW16 and %MW17 of Slave 11

Question 0B 10 0010 0002 04 0001 0002 |CRC 16

Response 0B 10 0010 0002 |CRC 16

2.3-7 Calculation of LRC

LRC: sum in hexadecimal, modulo FF, of the contents of the frame, excluding headers,
two's complemented and coded in ASCII.

Example of frame

ASCII frame

l3af30 31]30 38[30 30 30 30 36 31 36 32|33 34] oD oa| [k

Equivalent binary frame

| o1 [o8|00 00 61 62 |4872 |

Calculation of LRC

Sum in hexa, modulo FF, of the contents of the frame:
01+08+00+00+61+62=CC, = 1100 1100

one's complement: 0011 0011
add 1: . +1
0011 0100
Hexadecimal conversion 3 4
Coding in ASCII 33 34 LRC = 3334
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2.3-8 Algorithm for calculating CRC 16

Hex FFFF -> CRC 16

CRC 16 [ Byte -> CRC 16

Shift to right CRC 16

CRC 16 I POLY -> CRC 16

Next byte

Message ended

0 = or exclusive
n = Number of data bits

End

POLY = polynomial CRC 16 calculation = 1010 0000 0000 0001
(polynomial generator = 2 = x? = x1° = x19)
In CRC 16, the 1st byte transmitted is the least significant.
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2.4 Access requests by the TSX Nano to the UNITE server

The principle consists of coding a UNITE request within a MODBUS request in order to
interrogate the UNITE server normally servicing the terminal port.
This mechanism uses the specific function code: 65.

Principle:
MODBUS Master request to Slave

Function code: 65 Request code Category code Data

MODBUS Slave response to Master

Function code: 65 Response code Response data

The category code is always 7.

The UNITE response code can be used to find out the result of the operation performed
by the server.
There are three cases :

* Request response code = Request code + 30 H: The operation has been performed
by the server, additional information gives exact details of the result of the operation.

 Positive response code = 16#00FE: The operation has been performed correctly and
no additional information is transmitted in the response.

* Negative response code = 16#00FD: The server has not been able to perform the
operation (request not known, out of range value etc.).
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2.4-1 I|dentification

This service can be used to provide identification and structuring information on the
device which is targeting a request to the UNITE server.

The Identification request also provides basic diagnostic information, by showing the
state of the LEDs and the device and module Status.

Request code: OF
Response code: 3F

Report format: 27 bytes

Identification type (byte): Byte always equal to H'FF'.

Productrange (byte): This parameteridentifies the product range to which the device
belongs: H'0OB' = TSX Nano range.

Version (byte): Version number of the device, coded in two BCD 4-bit bytes: H'30' for
TSXO07 30/31.

ASCII string (character string): Specifies the product reference.

On the TSX Nano it consists of one byte (H'10") followed by ASCII text (16 bytes) as
follows:

"TSX 07 3'

'1-' if schedule block is present, '0-' if schedule block is not present

'10 "if 10 1/0, '16 "if 16 1/O, '16AC' if 16 I/O AC, '24"if 24 110

H'20'

H'20'

Device status (byte): Byte always equals 0 for the TSX Nano

State of LEDs (8 bit table): This byte indicates the state of the 4 indicator LEDs of the
TSX Nano:

RUN (bits 0 and 1), ERR (bits 2 and 3), I/O (bits 4 and 5), COM (bits 6 and 7).
Each LED is coded on 2 bhits:

00: Unlit

01: flashing

10: Lit

11: Not significant.

Base module type (byte): Byte equal to H'30' (type = CPU)

Manufacturer's reference  (byte): Byte equal to H'09'

Catalogue reference (byte): Defines the type of device:
H'01": Module 10 I/O

H'11": Module 16 I/O

H'21": Module 24 1/0

H'12": Module 16 I/O AC
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* Base module status (8 bit table): The values of these fields meet the standard for
configurable devices. A bit positioned at 1 indicates a fault.

Bit no. Class Comments
0 ERR-INT 1: TSX Nano hardware fault
1 ERR-EXT 1: Sensor supply fault
2 Reserved
3 MOD-At 1: Module in selftest
4 Reserved
5 ERR-CNF 1: Extension configured but absent or NOK
6 Reserved
7 Reserved

* Number of components (byte): Byte equal to 0 because the module does not have
any submodules.

2.4-2 Read-CPU
This service is used to diagnose the state of a TSX Nano PLC processor.

Request code: 4F
Response code: 7F

Format of report (14 bytes):
e Extension (byte): This field is used to transmit a transaction number: Not significant.
« State of LEDs (8-bit table): see Identification request.

e PLC status (8-bit table): Describes the physical state of the PLC:
Bit 0: RUN (1), STOP (0)
Bit 1: Application executable (1)
Bit 2: Cartridge present (always 1)
Bit 3: Forcing in progress (1)
Bit 4: Reserved: 0
Bit 5: Software fault (1)
Bit 6: Reserved: 0
Bit 7: Reserved: 0

e Address of the reserver (6 byte table): Describes the network address of the
application entity which has reserved the processor. On the TSX Nano, this value is
fixed at 16#00FF for each byte, to indicate that the processor is not reserved.
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» Type of application error (byte):  Byte always at O.

» Debug information (8-bit table):
Bit O: State of forcing (1: Active, 0: No forcing)
Bits 1 to 7: Always at 0.

* Productrange (byte): This parameteridentifies the product range to which the device
belongs: H'OB' = TSX Nano range.

e Application / PLC information  (8-hit table):
Bit 0: Application present in RAM (1)
Bit 1: Program in RAM with checksum OK (1)
Bit 2: Program in RAM executable (1)
Bit 3: Program in RAM protected (1)
Bit 4: Program in RAM differs from EEPROM program (1)
Bit 5: Application compatible with OS (1)
Bit 6: Schedule block present (1)
Bit7: 0

e Backup information (8-hit table):
Bit 0: Application present (1)
Bit1l: Checksum OK (1)
Bit 2: EEPROM application executable (1)
Bit 3: EEPROM application protected (1)
Bit 4: Auto load application (1)
Bit 5: Application compatible with OS (1)
Bit6: 0
Bit7: 0

2.4-3 RUN request
Request code: 24
Response code: FE

Negative result if:
¢ RUN / STOP input configured in STOP

» Application cannot be executed
» Software fault (watchdog overrun, launching nonexistent G7 step).

Sending this request to a TSX Nano already in RUN is not considered an error.
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2.4-4 STOP request

Request code: 25
Response code: FE

Negative result if the application in RAM cannot be executed.

A STOP instruction to a TSX Nano already in STOP is not considered an error.

2.4-5 INIT request

Request code: 33

Response code: 63

« Type of initialization  (byte to transmit): Must always be at 1.

* Report : Indicates the result of the initialization operation:
00: Initialization OK
01: Type of initialization other than 1
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2.5 Limitations

The TSX Nano Slave on MODBUS has the following limitations:

Physical layer: RS485 only. Does not automatically adapt to the speed of the Master.

Selector position: The MODBUS protocol is only enabled if the position of the PLC
rotary selection switch (automatically read on power-up) shows that TSX Nano is
being used as a PLC (positions 0, 5, 6 and 7).

Protocol: The protocol is Slave only.

Communication between Slaves: Direct communication between Slaves is not
possible. It can only be performed via the application program of the Master.

Changing, dynamically, from ASCII mode to RTU mode is not possible.
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Appendices

Appendices
A.1 Boolean instructions in List language with Ladder equivalent

LIST Instruction LADDER Equivalent Description

LD, LDN, LDR, LDF Hr H+ B+ B Load

ST,STN,R, S )y Ar R~ Hsr Store

AND, ANDN, ANDR, ANDF | 4 HH /PN Logical Bit 'AND'
A AH dH A _ B

OR, ORN, ORR, ORF 1 :]- -l/:]- _|P:]- _|N:]- Logical Bit 'OR

AND(, OR( (nest 8 levels) 1 'T: :]- I H : :T Parentheses

XOR, XORN, XORR, XORF |4xorF4xorNF 4x0orrF 4xorFF| EXclusive 'OR’

N Not Reversible Logical ‘'NOT'

END, ENDC, ENDCN &> H D End of Program

ENDCN is not reversible

%Li Label Definition

JMP, JMPC, IMPCN F—>%t HE—>)wuL Jump to Label

JMPCN is not reversible O<i<16

SRn H—>)sri Subroutine Call

RET —&eD Return

IMCrR, MmCs -(MCR)- -(MCS)- Master Control
Relay

NOP Not Reversible No Operation

A.2  Tool bar and instruction bar menu options

In the following tables, the Keys refer to the keystrokes necessary to step through the
menus. The Quick Key s are used to shortcut the menu to activate the desired function.
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A.2-1 Configuration Editor menu options

Button Description Keys Quick Keys
. Application Name Alt+C, N None
E Timers Alt+C, T None
ad

Counters Alt+C, C None
E Constants Alt+C, O None
E LIFO/FIFO Registers Alt+C, R None
. Drum Controllers Alt+C, D None
Fast Counter Alt+C, F None
it %PLS/%PWM Alt+C, P None
Input Filter Alt+C, | None
_ Latch Input Alt+C, A None
| 8]

L Run/Stop Alt+C, U None
m PLC Status (Security) Alt+C, L None
Scan Mode Alt+C, D None
Terminal port Alt+C, | None
Extension Port Alt+C, X None
_ Schedule Block Alt+C, S None

None Change PLC Version Alt+ C, H None
Validate Configuration Alt+T, L None
Cancel Configuration Alt+T,C None
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=

L Help None F1

A.2-2 Symbols Editor tools menu options

Button Description Keys Quick keys
=] Insert Alt + T, | Insert key
Delete Alt + T, D Delete key
== Sort by Address Alt+ T, A None
Sort by Symbol Alt + T, S None
E Find Alt + E, F Ctrl + F
A.2-3 Ladder Editor instructionbar  options
Button Description Keys Quick keys
HELF
L Help text window F1 None
2 Contact F2 B.2.1-3
T
F3 Negated Contact F3 B.2.1-3
I} Rising Edge Contact F4 B.2.1-3
FS Falling Edge Contact F5 B.2.1-3
—
Fb Horizontal Connector F6 None
;]{ Down Connector F7 None
Erase Down Connector F8 None
+{
Fq Horizontal Connector fill F9 None
I
FIO Compare Block F10 B.3.1-5
@ Coil Shift + F2 B.2.1-4
Negated Coil Shift + F3 B.2.1-4
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A.2-3 Ladder Editor instruction bar options (continued)

Button Description Keys Reference
{R}
Fy Reset Coll Shift + F4 B.2.1-4
{5}
F5 Set Coil Shift + F5 B.2.1-4
oY
:hr Jump or Subroutine Call Shift + F6 B.2.4-3, B.2.4-4
g‘ Operate Block Shift + F7 B.3.1-3 - .1-9
“IH
FE Timer function block Shift + F8 B.2.2-3
|-,:_
Fa Counter function block Shift + F9 B.2.2-4
Fil Extended Ladder Palette Shift + F10 None
A.2-3.1Extended Ladder Palette options
Button Description Keys Reference
XOR Exclusive OR Alt + X B.2.1-7
XORN Exclusive OR negation Alt + O B.2.1-7
XORR Exclusive OR rising edge Alt+R B.2.1-7
XORF Exclusive OR falling edge Alt + F B.2.1-7
OPEN Open contact Alt + P None
SHORT Short contact Alt +H None
%Ri LIFO/FIFO register function block Alt + G B.2.2-5
%SBRi Shift bit register function block Alt + B B.3.4-7
%DRi Drum controller function block Alt+U B.2.2-6
%SCi Step counter function block Alt + N B.3.4-8
%FC Fast counter function block Alt + A B.3.4-5
%PLS Pulse generator function block Alt + L B.3.4-4
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A.2-3.1 Extended Ladder Palette options (continued)
Button Description Keys Reference
%PWM Pulse width modulation Alt + W B.3.4-3
%MSG Message block Alt + K B.3.4-6
RET Return to program from subroutine  Alt+ T B.2.4-4
END Unconditional end of a program Alt + E B.2.4-1
MCS Master control start Alt+S B.2.4-5
MCR Master control relay Alt+M B.2.4-5
-(#)- Deactivate current step without None B.2.3-1

activating any other step

-(#i)- Activate step i after deactivating None B.2.3-1
current step

-(#D )- Deactivate step i and the current step None B.2.3-1

A.2-4 Ladder Editor Tools menu options

Button Description Keys Quick Keys
None Validate Program Alt+T,V None
Validate Rung Alt+T,R Ctrl + Enter
. Cancel Rung Alt+ T, C None
E New Rung Alt+ T, N Ctrl + A
E Clear Rung Alt+T, L None
E Previous Rung Alt+ T, P Ctrl + Up
E Next Rung Alt+ T, X Ctrl + Down
Toggle Grid Alt+T, G None
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A.2-5 Ladder Viewer Tools menu options

Button Description Keys Quick Keys
None Validate Program Alt+T,V None
=|'_:l
= InsertRung Alt+T, R Ins
None InsertList Alt+T, L Ctrl +Ins
EditCurrentRung Alt+T,E Ctrl+E
=
Delete CurrentRung Alt+T,D Ctrl+D
Show Symbols Alt+T,S Ctrl+F2
D.l_ro
p ShowAddresses Alt+T,A Ctrl+F3
-l 1 Line Address or Symbol Alt+T,1 None
. -l 3Lines Address or Symbol Alt+T,3 None
i 3Lines Addressand Symbol Alt+T,N None
Toggle RungHeader Alt+T,H Ctrl+H
Toggle Grid Alt+T,G None
L] Toggle Ladder/List Alt+T, T None
]
ShowAllAsLadder Alt+T, W None
|E Table of Grafcet steps Alt+T, F None
A.2-6 List Editor instruction bar options
Button Description Keys Reference
?
Ed Help F1 None
LD
7] Load F2 B.2.1-3
1)
F3 Store F3 B.2.1-4
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A.2-6 List Editor instruction bar options (continued)

Button Description Keys Reference
|HHH
AND F4 B.2.1-5
OR
I3 OR F5 B.2.1-6
Exclusive OR F6 B.2.1-7
@ Enableinput/instruction F7
|I1Pq
13:] Memorypush F8 B.2.1-10
Beginfunctionblock F9 B.2.2-2
SR _
Callordeclare subroutine F10 B.2.4-4
I _
Ed Jump Shift+F1 B.2.4-3
xl _ .
2 Inputbitof module 0 Shift+F2 B.3.1-2
0
E3 Outputbitof module 0 Shift+F3 B.3.1-2
xM
FY Memory bit Shift+F4 B.3.1-2
x5 _ .
F5 System bit Shift+F5 B.3.1-2
)
FT Timervariable Shift+F7 B.2.2-3
R .
[T Memoryread Shift+F8 B.2.1-10
LI T]
ELH . .
Fq Wires block outputs Shift+F9 B.2.2-2
RET . :
Returnfromasubroutine Shift+F10 B.2.4-4
xL
F1i Label Alt+F1 B.2.4-3
<IN
Fa Inputword Alt+F2 B.3.1-1
=00
F3 Outputword Alt+F3 B.3.1-1
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A.2-6 List Editor instruction bar options (continued)

Button Description Keys Reference
@ Memoryword Alt+F4 B.3.1-1
xSIIl
Systemword Alt+F5 B.3.1-1
@ Constantword Alt+F6 B.3.1-1
% El
EL Counter Alt+F7 B.2.2-4
Move top of stack to accumulator Alt+F8 B.2.1-10
|EE§
LI End of function block Alt+F9 B.2.2-2
@ Endofprogram Alt+F10 B.24-1
A.2-7 Data Editor Tools menu options
Button Description Keys Quick Keys
None Validate Program Alt+T,V None
E*n
B Insert Alt+T, 1 Ins
% Delete Alt+T,D Del
K7l )
| el Add Previous Instance Alt+T,P Ctrl+Up
T
PR | Add NextInstance Alt+T, N Ctrl+ Down
1
& Force 1 Alt+T,1 None
& 0
| M | Force0 Alt+T,0 None
(€] .E'_ ClearForce Alt+T,C None
_ﬂ Clear AllForce Alt+T, L None
Kl
4 Read Retained Values Alt+T,R None
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A.2-7 Data Editor Tools menu options (continued)

Button Description Keys Quick Keys
=
- Write Retained Values Alt+T, W None
ol .
Write Data Value Alt+T, T None
None OpenDataPage Alt+T,0 None
None Save DataPage Alt+T,S None
None Save DataPage As Alt+T,A None
2
| Help None None
ug
| T | Toggle Number Format None None
_& Toggle Animation None None
A.2-8 Editmenu options
Edit menu options Keys Quick keys
Undo Alt+E,U Ctrl+Z
Cut Alt+E, C Ctrl+X
Copy Alt+E,O Ctrl+C
Paste Alt+E, P Ctrl+V
Find Alt+E, F Ctrl + F
Replace Alt+E,R Ctrl+R

A9




A.3 PL7-07 PC programming software variables

Variable Type Description Read/Write/Force

Counters (%C0-9%C15)

%Ci.PPresetvalue R,W(2)

%Ci.VCurrentvalue RW

%Ci.EUnderflow output (empty) R
%Ci.D Presetoutputreached R
%Ci.FOverflow output (full) R
Drum Controllers (%DR0-%DR3)
%DRI.S Currentstepnumber R
%DRIi.F Full (laststep reached) R

Fast Counter %FC

%FC.P Presetvalue R,W(2)
Y%FC.V Currentvalue RW
%FC.S0 Thresholdvalue SO RW
%FC.S1 Thresholdvalue S1 RW
%FC.THO Threshold bitO R
%FC.TH1 Threshold bit1 R
%FC.F Overflowoutput R
Grafcet Step Bit s(%X1-%X62) R
Input Bits (%10.0-%10.13and %I1.0-%I1.13) R,F(3)
Input Words (%IW;j.0-%IWj.1wherej=0,1,2,3,4) R,W
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A.3 PL7-07 PC programming software variables (continued)

Variable Type Description Read/Write/Force
Constant Words (YoKWO-%KWE3) R
LIFO/FIFO Registers (%R0-%R3)

%Ri.0 Outputword R
%Ri.I | Inputword R,W
%Ri.E Registerempty

%Ri.FRegisterfull

Memory Bits (Y%M0-%M127) RW
Memory Words (%MWO-%MW?255) R,W
Message (%MSG)

Y%MSG.E Communication erroroutput R
%MSG.D Communicationdone output R
Pulse Generator (%PLS)

%PLS.P Presetvalue R,W(2)
%PLS.N Number of pulses RW
%PLS.Q Currentpulse generation output R
%PLS.D Pulse generation done output R
Pulse Width Modulatio n (%PWM)

Y%PWM.P Presetperiod RW
%PWM.R Ratio of the period R,W
Output Bits (%0Q0.0-%Q0.9and %Q1.0-%Q1.9) R,W,F (3)
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A.3 PL7-07 PC programming software variables (continued)

Variable Type Description Read/Write/Force
Output Words (%QW].0-%QWj.1wherej=0,1,2,3,4) RW

System Bits (%S0-%S127) R,W(1)

Shift Bit Registe r(%SBRi.0-%SBRi.15,wherei=0-7) R

Step Counter (%SCi.0-%SCi.255, wherei=0-7) R

System Words (Y%SWO0-%SW127) R,W(1)

Timers (%TMO-%TM31)

%TMILLV Currentvalue R

%TMi.P Presetvalue R,W(2)

%TMI.Q Timerdone R

(1) Certain bits and system words cannot be written. No specific messages warn the
user in the List/Ladder editor. The Write on these bits or words has no effect in the
PLC.

(2) These variables can be written if the Adjust Option is selected in the configuration.
If the Adjust Option is not selected, the Write access in the Data editor will display
a message, "PLC operation not available".

(3) Forcing the Run/Stop input or PLC status (security) output is authorized by the
programming tools, the input or output is signaled as being forced but the PLC does
not take the forcing into account.

Note: For all the variables that are not allowed to Write, a message warns the user in the
Data editor.
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A.4  Security features

The security features for the PL7-07 PC programming software includes password
protection to prevent unauthorized changes to an application and the ability to change
security levels. When you define a password, you restrict access to an application by
creating the following two levels of security:

 Supervisor Level —allows you to modify any part of the application.

» Operator Level —allows you to modify symbols and data pages, but does not allow
you to modify the application program and configuration data. An application that is
password-protected defaults to the operator level each time it is opened.

A.4-1 Entering a password for the first time
1. Open the application to be password protected.

2. Select Securit y from the File menu. Select Change Password from the Security
sub-menu. The Change Password dialog box appears.

Change Password

Enter Old Password: ﬂ:l
Enter Hew Password: l:l
Confirm New Password: l:l

0K I Cancel I

3. Do notenter any information in the Enter Old Password field. Tab to theEnter New
Password field and type a password from 1 to 8 characters.

4. In the Confirm New Password field, re-type the same password.

5. Select Ok to use the new password. The application title bar displays the words,
"Supervisor Level".
Select Cancel to close the dialog box without defining the password.

6. The application must be saved for the new password to take effect.

A.4-2 Changing a password

1. Select Security from the File menu. Select Change Password from the Security
sub-menu. The Change Password dialog box appears.

2. In the Enter Old Password field, enter the old password. Tab to the Enter New
Password field and type a new password from 1 to 8 characters.

3. In the Confirm New Password field, re-type the same password.

4. Select Ok to use the new password. Select Cancel to close the dialog box without
changing the password.

5. The application must be saved for the new password to take effect.
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A.4-3 Changing from operator level to supervisor level
1. SelectSecurit yfromthe File menu. SelectSupervisor Level fromthe Security sub-
menu. The Security dialog box appears.

Enter Password: l:l

oK I | Cancel I

2. Type the password. Select Ok to change to the supervisor level. Select Cancel to
return to the operator level.

A.4-4 Removing a password
1. To remove a password, select Security from the File menu. Select Change
Password from the Security sub-menu.

2. Atthe Change Password dialog box, type in the current password in the Enter Old
Password field.

3. Tab through the Enter New Passwor d and Confirm New Passwor d fields without
entering any information.

4. Select Ok to remove the password. Select Cancel to return to the application with
the password still in effect.

A.4-5 Password protection for files transferred to an FTX 117 terminal

The FTX 117 terminal only has keys for entering the alphanumeric characters 0 through
9andAthroughF. Ifafileistransferred fromaPC to the FTX 117 terminal with a password
that has characters other than 0 through 9 and A through F, then the password will not
be able to be entered. Changes to the file will not be possible from the FTX terminal.
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A.5 Instruction scan time and memory usage

Times is expressed in ps.
Size is expressed in bytes.

Boolean instructions

Instructions With bit operands
%1,%Q %M, %S, %X, 0/1, %MWi:Xi... (1)
Time Size Time Size
LD, LDN 0.2 2 0.4 4
LDR, LDF 0.5 4 - -
AND, ANDN 0.2 2 0.6 4
ANDR,ANDF 0.8 4 - -
AND(, AND(N 6.3 8 7 10
AND(R,AND(F 7 10 - -
OR, ORN 0.4 2 0.7
ORR, ORF 0.8 4 - -
OR(, OR(N 6.3 8 6.6 10
OR(R, OR(F 6.7 10 - -
XOR,XORN 0.2 2 0.6 4
XORR,XORF 0.8 4 - -
ST, STN (2) 0.2 (0.8) 2 0.9 (1.5) 4
SR (2) 0.8 (1.2) 4 1.5 (1.8) 6
N 0.6 4
) 15 8
MPS 0.6 4
MRD 0.2 2
MPP 0.2 2

These times must be multiplied by 3 when the instructions are written after program line
099.

(1) For word extract bits %MW16 to %MW255 and for all other types (%KWi:Xj,%SWi:Xj)
these times are multiplied by 1.5 and the sizes are increased by 2 bytes.

(2) The times given in parentheses are the scan times for the instructions when the
application has been initialized to use MCS/MCR instructions.
Summary : the choice of whether to use master relay instructions or not is made
when the application memory is cleared (see Part C, Section 4.6 of the FTX 117
manual, or Part C, Section 5.21 of the PL7-07 manual).
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Instructions on function blocks (in reversible programming)

Instruction Scan time (in ps) Memory usage (in bytes)
BLK %TMi 8 4
BLK %Ci 8 4
BLK %Ri 8 4
BLK %SBRi 8 4
BLK %SCi 8 4
BLK %DRi

BLK %FC 8 4
BLK %MSG 8 4
BLK %PMW 8 4
BLK %PLS 8 4
OUT_BLK 200 2
END_BLK 180 2
IN 1.2 4
R 0.6 4
Cu 0.7 4
CD 0.7 4
| 1 4
O 1 4
[§]

S 0.7 4

Instructions on function blocks (in non-reversible programming)

Instruction Scan time (i n ps) Memory usage (in bytes)
IN %TMi 48 4
CD %Ci (CU %Ci) 46 4
S %Ci 49 4
R %Ci 47 4
U %DRi

R %DRi

LD %SCi.j 9 6
CD %SCi (CU %SCi) 38 4
ST %SCi.j 10 6
R %SCi 36 4
BLK %PMW 42 4
BLK %PLS 53 4
CD%SBRi(CU%SBRI) 39 4
R %SBRi 37 4
I %Ri (O %Ri) 49 4
R %Ri 48 4
IN %PWM 36 4
IN %PLS 46 4
S %PLS 42 4
R %PLS 58 4
IN %FC 43 4
S %FC 69 4
READ 9.8 6
EXCH 160 - 700 8
R %MSG 25 4
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Numerical instructions

Instruction Scan time (i n ps) Memory usage (in bytes)
= 29.5 10
¥ 34 12
- 38 12
* 49 12
/ 48 12
REM 49 12
INC 28 6
DEC 28 6
AND 37 12
OR 37 12
XOR 37 12
NOT 29 8
SHL 34 10
SHR 34 10
ROL 35 10
ROR 35 10
BTI 40 8
ITB 40 8
SQRT 80 8

Comparison instructions

Instruction Scan time (in ps) Memory usage (in bytes)
LD[wordl comp word2] 18 8

AND[word1l comp word2]19 10
AND(Jword1compword2] 24 14

OR[word1l comp word2] 21 10

OR([wordl comp word?2] 25 14

comp : comparison operations =>,<=,<>,=,>=>

Grafcet instructions

Instruction Scan time (i n ps) Memory usage (in bytes)
=*=j 4
# 4
#i 4
#Di 6
=*=POST 4
-*- 6
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Instructions on programs

Instruction Scan time (us) Memory usage (in bytes)
END 0.4 2
ENDC, ENDCN 0.6 4
SR 14 4
RET 2 6
NOP 0.4 2
JIMP 7.8 4
JMPC, JMPCN 8 6
%Ln : 0.6 4
%SRn : 2 4
MCR 0.5 2
MCS 25 12
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A.6 Importing and Exporting ASCII program files and symbols files

The PL7-07 PC programming software allows you to import and export ASCII program
files and symbols files.

A.6-1 ASCII program files

List programs can be developed by external ASCII text editors. ASCII format program
import and export allows you to transfer these files between the PL7-07 software and
the ASCII text editor.

To import an ASCII program file:

1. With a new or existing application open, select Import from the File menu. Select
ASCII Program from the Import sub-menu. The File Selection dialog box appears.

File Selection

Filename: Directories:
[>.tut | expl7a?
* Fre +
= pI787
+ + 0K I
List Files of Type! Drives:
‘Teut [CAT Iﬂ ||:: m Cancel I

2. Inthe Drives field, select the drive where the text file is located.
In the Directories field, select the directory containing the text file to be imported.

4. Inthe List Files of Type field, select either Text (*.txt) or All (*.*) to display the files
in the selected directory.

5. Inthe Filenam e field, select the file name of the text file to be imported.

6. SelectOktoimportthe file. Select Cancel to close the dialog box without importing
the file.

To export an ASCII program file:
1. With an application open, selectExpor tfrom the File menu. Select ASCII Program
from the Export sub-menu. The File Selection dialog box is displayed.

2. IntheListFilesof Type field, selecteither Text (*.txt) or All (*.*). The .txtfile extension
identifies text editor files.

3. Inthe Drives field, select the drive where you want to store the file.
In the Directorie s field, select the directory where you want to save the file.
5. Inthe Filename field, over type the asterisk (*) with a standard DOS file name.

If the file name does not comply with DOS file naming conventions, an "Invalid
Filename" message is displayed.
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If you type afile name that already exists in the selected directory, an error message
appears: "The file selected already exists. Overwrite?" Select Ok or Cancel.

6. Select Ok to export the file. Select Cancel to close the dialog box without exporting
the file.

A.6-2 Symbols files
Symbols files can be created for common applications. Symbols import and export
allows you to transfer the symbols files between applications.

To import a symbols file:

1. With a new or existing application open, select Import from the File menu. Select
Symbols from the Import sub-menu. The File Selection dialog box appears.

File Selection

Filename: Directories:
| carwash.sym | e~pl7a?
* Fre +
= pI787
+ * 0K
List Files of Type! Drives:
‘ngbul (*_sym) Iﬂ ||:: m Cancel I

2. Inthe Drives field, select the drive where the symbols file is located.

In the Directorie s field, select the directory containing the symbols file to be
imported.

4. Inthe List Files of Type field, select either Symbol (*.sym) or All (*.*) to display the
files in the selected directory.

5. Inthe Filename field, select the file name of the symbols file to be imported.

6. Select Ok to import the file. Select Cancel to close the dialog box without importing
the file.

7. If Ok is selected in step 6, a message appears in the status bar.
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To export a symbols file:

1.

With an application open, select Export from the File menu. Select Symbols from
the Export sub-menu. The File Selection dialog box appears.

In the List Files of Type field, select either Symbol (*.sym) or All (*.*). The .sym file
extension identifies symbols files.

In the Drive s field, select the drive where you want to store the file.
In the Directorie s field, select the directory where you want to save the file.
In the Filename field, over type the asterisk (*) with a standard DOS file name.

If the file name does not comply with DOS file naming conventions, an "Invalid
Filename" message appears.

If you type afile name that already exists in the selected directory, an error message
appears: "The file selected already exists. Overwrite?" Select Ok or Cancel.

Select Ok to export the file. Select Cancel to close the dialog box without exporting
the file.

If Ok is selected in step 6, a message appears in the status bar.
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A.7 Transferring applications between a PC and the FTX 117 terminal
A.7-1 Applicationfiles
An application can be transferred froma PCto a FTX 117 terminal by the following ways:

« transfer the program from the PC to the Nano-PLC and then transfer from the PLC
to the FTX 117 terminal.

» save the program in the PC to a binary file (.app extension), and transfer the file to
the FTX 117 terminal viaa PC memory card (T FTXREM 3216, TFTX RSM 3216, OR
T FTX RSM 12816). The memory card must be formatted on the FTX 117 terminal.

Note : When a program is saved and transferred to the FTX 117 terminal (as a binary file),
symbols and comments are not saved or transferred.

Section 12, Transferring an application, details how to transfer from the PC to the PLC.
The TSX 07 Nano PLC FTX 117 Terminal manual details how to transfer from the PLC
to the FTX 117 terminal.

To transfer an application from a PC to a FTX terminal via a memory card requires the
application to be saved as a binary file (.app extension). When the application is saved
as a binary file, the symbols and comments are not saved. Therefore, if the application
is later transferred back to the PC, the symbols and comments will not appear.
Additionally, the word "DEFAULT" replaces the file name in the title bar. To re-name
the file, select Save As from the File menu and save the file with the desired file name.
For more information on Save As, see Section11.3.

To transfer an application from the PC to the FTX 117 terminal via a FTX 117 formattted
memory card:

1. With the application open, select Save As from the File menu. A File Selection
dialog box appears.

File Selection

Filename: Directories:
| carwash.app | a™
+ = a: +

List Files of Type: Drives:

| = a: m Cancel I

I+

Binary (*.app)
Application (*_pl7) +

+

2. Inthe List Files of Type field, open the selection box and select the Binary (*.app)
file type.

3. In the Drives field, select the memory card drive.
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4. In the Directorie s field, select the directory where you want to save the file.
5. In the Filename field, over type the asterisk (*) with a standard DOS file name.

If the file name does not comply with DOS file naming conventions, an "Invalid
Filename" message is displayed.

If you type afile name that already exists in the selected directory, an error message
appears: "The file selected already exists. Overwrite?" Select Ok or Cancel.

6. SelectOktosavethe binaryfile. SelectCancelto close the dialog box without saving
the file.

To transfer an application from the FTX 117 terminal to the PC via a memory card:

1. Select Open from the File menu. A File Selection dialog box appears.

2. Inthe List Files of Type field, open the selection box and select the Binary (*app)
file type.

In the Drives field, select the memory card drive.
In the Directories field, select the directory that contains the file to be transferred.
In the Filenam e field, select the file to be opened.

o o rw

Select Ok to open the binary file. Select Cancel to exit the dialog box without
opening the file.

The application transferred is now available on the PL7-07 software screen.

A.7-2 Data page files

Data page files (.dat extension) in the PC have the same file format as data table files
inthe FTX 117 terminal. However, a data table in the FTX 117 terminal contains 16 data
objects whereas a data page contains 64 data objects. The PL7-07 PC programming
software data page can hold up to 4 FTX 117 data pages.

A data page file is transferred to the FTX 117 terminal via a FTX 117 formatted memory
card. Use Save Data Page As (Section14.4-16) and save the file to a memory card.
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A.8 Troubleshootinginstallation problems

A.8-1 Installing PL7-07 PC programming software on a 5.25" drive

PL7-07 PC programming software is shipped on 3.5" diskettes. You can install the
software on a computer with a 5.25" disk drive, if you have another IBM-compatible
computer with both a 3.5"and 5.25" disk drive. You also need three to six formatted 5.25"
diskettes, depending on the language selected.

1.

On the computer with both the 3.5" and 5.25" disk drive, install installation Disk #1
in the 3.5" floppy disk drive.

With the DOS prompt at c:, select the drive letter for the 3.5" floppy drive, this is
typically a:.
At the a: prompt, type install and press <enter>.

4. Select the language for installing the program. The PL7-07 PC programming

9.

software can be installed in one of five languages—English, French, German,
Italian, and Spanish.

The PL7-07 PC programming software can operate in only one language at a time.
If support for multiple languages is required, create a new directory with a different
name and re-install the software in the new directory. If you re-install the software
in the same directory as the original installation, the newly-installed version will
overwrite the old one.

Select the disk drive where the program is to be installed.
Enter the disk destination subdirectory. The default subdirectory is \PL707.
Select the COM port to be used by the computer for communicating with the PLC.

The program files are automatically decompressed and written to the subdirectory
specified.

When prompted by the installation program, insert installation Disk #2.

10.The installation program prompts you with the following:

May | create/modify your AUTOEXEC.BAT file if needed (Y/N)? Select No.
May | create/modify your CONFIG.SYS file if needed (Y/N)? Select No.

11.When prompted by the installation program, re-insert installation Disk # 1.

12. After the installation is finished, the following information is displayed:

Make sure the changes were made to CONFIG.SYS:
FILES=30 (or higher)
DEVICE=C:\PL707\DUNTLW.EXE PROFILE=C:\PL707\DUNTLW.001
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13.

14.
15.

16.

17.

18.

19.

20.

and AUTOEXEC.BAT:
PATH=....,C:\PL707

Record this information. This information will be used to update the CONFIG.SYS
and AUTOEXEC.BAT files in the destination computer with the 5.25" disk drive.

COML1 is the default communications port. To change the COM port setting, edit
DUNTLW.001 in directory C:\PL707. In the Basic Parameters section, change the
COM setting in the line PORT=COMZ1.:0,8,1 to the desired COM port.

Remove the 3.5" installation diskette and insert a blank formatted 5.25" diskette in
the appropriate drive.
Type cd\ to return to the root directory.

To transfer the installed software to the 5.25" diskettes, type backup C:\PL707 b:/
s and press <enter>.

Backupis aDOS command. For more information about this command, refer to your
DOS instruction manual.

You are prompted for additional diskettes, as needed. Label or keep the diskettes
in the order in which they are backed up.

After the backup is complete, take the diskettes to the destination computer and
insert the first diskette in the 5.25" disk drive.

From the c:\ prompt, type restore a: c:\ /s . Follow the instructions displayed until
allinformation is restored. This assumes thata is the drive designation for the 5.25"
disk drive.

Add the information recorded in step 12 to the CONFIG.SYS and AUTOEXEC.BAT
files.

Reboot the computer.

A.8-2 Software installation problems
If you encounter a problem during or after installing the PL7-07 PC programming
software, check the following conditions.

1.

2.

3.

Check that these PL7-07 PC programming software files are installed:

DIALOG.ZNC ERRORS.MDX PRINTERS.DBF
DUNTLW 001 HELP.ZNC PRINTERS.DBT
DUNTLW.386 PAGES.DBF PRINTERS.MDX
DUNTLW.EXE PAGES.MDX RESWORD.TBL
ERRORS.DBF PL707.EXE PL707.1ICO
ERRORS.DBT PL707.INI

Do not install the PL7-07 PC programming software deep in the DOS directory tree
structure, such as 10 levels down from the root directory.

If you encounter either memory or communications errors while running the PL7-
07 software, you may need to reconfigure your memory manager or add lines to your
CONFIG.SYS file. Use the following guidelines for reconfiguring EMM386.EXE,
QEMM, and 386MAX.
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A.8-2.1 EMM386.EXE
EMM386.EXE is part of MS-DOS, versions 5.0 and later. EMM386.EXE supports VCPI,
but does not support DPMI.

You do not need to have EMM386.EXE installed. However, if you encounter
EMM386.EXE error messages when running PL7-07 software and EMM386.EXE is
installed, add the following line to your CONFIG.SYS file:

DEVICE=EMM386.EXE FRAME=NONE

The FRAME=NONE option leaves the EMS and VCPI interfaces active, but prevents
EMM386.EXE from allocating any page frames.

Regardless of the version you are using, you must be careful when selecting EMM386
configuration options. Some options conflict with one another and choosing them can
cause EMM386.EXE to conflict with Phar Lap's 286 | DOS-Extender.

One set of conflicting options is the NOEMS/FRAME=xxxx/RAM/Mx group. Each of
these EMM386.EXE switches affects the creation of an EMS page frame. Do not use
the options together, but rather, select only one option. Specifying FRAME=NONE is
satisfactory for most users.

A.8-2.2 QEMM
QEMM, by Quarterdeck Office systems, supports VCPI, but does not support DPMI. We
suggest that you add the following line to your CONFIG.SYS file:

DEVICE=QEMM.SYS FRAME=NONE

The FRAME=NONE option leaves the EMS and VCPI interfaces active, but prevents
QEMM from allocating any page frames.

Do not specify the QEMM configuration option NOEMS, if you want to run Phar Lap's
286 | DOS-Extender. This option disables the VCPI interface, so that Phar Lap's 286
| DOS-Extender cannot communicate, resulting in the following error message:

Fatal Error 286.1020: This program requires VCPI or DPMI in V86 mode.

A.8-2.3 386MAX
386MAX, by Qualitas, supports both VCPI and DPMI. If you encounter an error
message, we suggest you add the following line to your CONFIG.SYS file:

DEVICE=C:\386 MAX\386MAX.SYS PROFILE=C:\386 MAX\386MAX.PRO
where 386MAX.PRO is a profile file.

You can use either the NOFRAME or EMS=0 option without significantly affecting the
performance of Phar Lap's 286 | DOS-Extender. The NOFRAME option keeps the EMS
and VCPI interfaces active, but prevents 386MAX from allocating a 64 KB page frame
for EMS. The EMS=0 option also keeps the EMS and VCPI interfaces active, while
making all remaining memory available as extended (XMS) memory.
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Appendices

A.8-3 COM port problems during installation
In order for the PL7-07 PC programming software in your PC to communicate with the
PLC, you must have serial communications capability between the PC and the PLC.

When the PL7-07 PC programming software (DOS or Windows 3.1/95/98) or the X\WAY
communication tool (Windows NT) is first installed on your computer, the software
checks to see which serial COM ports (COM1 - COM4) are available. During the
installation, a listing of the available COM ports is displayed and you are asked to select
the desired COM port. If the word "None" is the only thing displayed, then no serial COM
ports are available. The following are the likely problems and the suggested actions
to take :

 There is no serial communications card in your computer. You need to install a serial
communications card and assign a COM port designation.

or
* All of the existing COM parts are being used. The following choices are recom-
mended :

« disable a device assigned to the COM port you would like to use for the PLC and
assign the PLC the COM port.
If installing PL7-07 under DOS or Windows 3.1/95/98, in the Basic Parameters
section of the DUNTLW.001 file, ensure PORT=COM?:0,8,1 is set to the desired
COM port, where ? is the COM port number.
If installing PL7-07 under Windows NT, install the UNI-TELWAY driver.

« share the COM port with another device. However, the PLC and the other device
cannot be operated at the same time. For example, if you share a COM port with
a modem, the PLC cannot be connected to the PC when the modem is being used.
If installing PL7-07 under DOS or Windows 3.1/95/98, in the Advance Parameters
section of the DUNTLW.001 file, ensure COMSHARE=YES.

Ifinstalling PL7-07 under Windows NT, the system sets this parameter automatically.

« install another serial communications card and assign a COM port designation.

A.8-4 Communication error when connecting the PC to the PLC
If a communication error is detected when you attempt to connect the PC to the PLC,
an Error dialog box appears. Select Ok to acknowledge the Error dialog box.
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1. Check to ensure the cable is properly connected between the PC and the PLC and
that power is available to the PLC.

2. In the CONFIG.SYS file, ensure the following line is present:
DEVICE=C:\PL707\DUNTLW.EXE PROFILE=C:\PL707\DUNTLW.001

3. Inthe CONFIG.SYS file, ensure FILES=30 (or higher)

4. Ensure there is no IRQ (interrupt) conflict between the PLC and any other device.

5. In the DUNTLW.001 file located in the c:\PL707 directory, ensure the proper port
is designated in the line PORT=COM?:0,8,1, where ? is the COM port number.

6. If your computer uses EMM386, it may be necessary to add REM at the beginning
of the line in the CONFIG.SYS file that designates EMM386 as a device. The REM
prevents the line from being read.

A.8-5 Video Display problems

(Software version V1.0 only)

If you are experiencing video display problems such that the characters in the dialog
boxes or the List Editor seem to be scrambled, it may be because your PC is using a
different font than the standard IBM character font. You may have to adjust your
CONFIG.SYS and AUTOEXEC.BAT files to use what is referred to by some PC
manufacturers as the "Material Font" in order to fix the problem. This is accomplished
by changing to the DOS code page.

For instance, changing the code page for DOS 6.2 in some PCs would be something
like the following example.

Using a text editor, edit the CONFIG.SYS file to include this statement :

DEVICE = C:\DOS\DISPLAY.SYS CON: = (EGA,437,1)

Again using a text editor, edit the AUTOEXEC.BAT file to include the following
statements :

C:\DOS\NLSFUNC
MODE CON CP PREPARE = ((850) C:\DOS\EGA.CPI)
CHCP 850

For more information on changing the code page, consult the DOS documentation that
came with your PC.
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A.9 Running PL7-07 in Windows

PL7-07 PC Programming Software for the TSX Nano runs in DOS, and therefore can
be run under Windows within the same constraints as other graphical DOS applica-
tions. Following the suggestions listed below should allow successful operation under
Windows.

A.9-1 Running PL7-07 under Windows 3.1

You should be running Windows 3.1 on a PC that has at least 4 Mb of memory.
Preferably, the PC should have 8 Mb of memory if other Windows applications, drivers,
and the like are open simultaneously. Further, faster CPUs and video cards in the PC
will only enhance performance of PL7-07.

A PIF file should be created for PL7-07 using Windows 3.1's PIF File Editor. The PIF
file tells Windows what kind of application PL7-07 is, and determines the PC resources
that Windows 3.1 will give to PL7-07. You can then "run” the PIF file while in Windows
3.1 which in turn will set up Windows for PL7-07, and then automatically run PL7-07.
For more information, see the Windows 3.1 documentation on creating and editing PIF
files.

The following parameters should be used when creating a PIF File for PL7-07:

Program Filename: [csPLTOTPLTOT.ERE |
Window Title: [PL707

Optional | |
Start-up Directory [copLror |

Video Memony: () Text (") LowGraphics () High Graphics

Menory Requirements: KB Required E KB Desired E
EMS Memony: KB Required D KB Desired D
XMS Memory: KB Required KB Desired
DisplayUsage:  (®) Full Screen E i [ Backer

O Windowed l:l Exclusive

|E Close Window on Exit

The Program Filename must include the DOS directory path to PL707.EXE. The path
in the above example is the default path created at installation time for PL707. If you
didnot choose to accept the default directory during installation of PL7-07, then enter
the directory path you had provided . The same directory should be used as the Start
up directory.
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Video memory should be set to text. PL7-07 will configure the video for you. Enter -
1 for the Memory Requirements. This will indicate to Windows 3.1 that PL7-07 should
be given all the conventional PC memory possible. PL7-07 only makes use of Extended
Memory. Therefore, set EMS Memory Required and Desired to zero, and set XMS
Memory Required to at least 2Mb. Set XMS Memory Desired to 4Mb if running on a
PC with at least 8Mb of RAM memory; otherwise set it to 2Mb.

Set the Display Usage to Full Screen. PL7-07 is a graphical environment under DOS,
and Windows requires that it be run as a full screen, as opposed to a window. If you
do not set this parameter in the PIF file to full screen, Windows 3.1 will provide an error
message and suspend the running of PL7-07 until the window is turned into a full
screen. This can be accomplished by pressing <alt><enter> together (holding done
the Alt key and pressing the Enter key).

It should be noted that some VGA or SVGA video cards, especially older models, do
not restore the full screen window properly after having either been minimized or turned
into a window. Please be sure that you are using the latest video driver for your video
card, available from the manufacturer of the video card. On some models, if the screen
is restored improperly, selecting a PL7-07 menu item can sometimes clean up the
display, but this is not always the case.

Leave the Execution parameters Background and Exclusive un-checked. It is also
advisable to set the Close Window on Close Window checkbox. In this way, the
termination of PL7-07 will automatically close the full screen window and return you
to Windows 3.1's Program Manager.

Select the Advanced button to obtain the PIF file Advanced Options dialog box. The
only parameters that need to be changed are the Display Options. For the best video
performance, only the Text checkbox should be set in the Display Options box.
Otherwise, the rest of the Advanced Options parameters can remain at their default
values.

Installing the PL7-07 icon under Windows 3.1

Select or create the Modicon Telemecanique Group
To create a group:

1 In Program Manager, select the File/New command.
2 In the New dialog box, select Group of programs then confirm by clicking on OK.
3 Enter the name of the group then confirm again by clicking on OK.

Install the PL7-07 icon

1 In Program Manager, select the File/New command.
2 In the New dialog box, select Program then confirm by clicking on OK.
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In the Program items propertie s dialog box:

3 Enter the name of the software "PL7-07".

4 Enter the command line C:\PL707\PL707.EXE (C being for example the disk drive
where PL7-07 is installed).

5 Select Change icon .
The message "No icon available in the file" appears.

6 Confirm by clicking on OK.

In the Change icon dialog box:

7 Fill in the Name field by entering the command line C:\PL707\PL707.ICO (C being
for example the disk drive where PL7-07 is installed) then confirm the various dialog
boxes by clicking on OK.

A.9-2 Running PL7-07 under Windows 95/98/NT

The user does not need to set any particular parameters to run PL7-07 under Windows
95/98/NT.

Installing the PL7-07 icon under Windows 95/98/NT

Select or create the Modicon Telemecanique Group
To create a group :

1 In the Start menu, go to the C:\Windows\Start menu\Programs  directory.
2 Select the File/New/Folde r command.
3 Enter the name of the group then confirm again by clicking on OK.

Install the PL7-07 icon

From the Modicon Telemecanique directory

1 Select the File/New/Shortcu t command.

2 Enter the full path for the PL707.EXE program and click on Next.
3 Select a name for the shortcut and click on Next.

4 Select an icon for the shortcut and confirm by clicking on Close .
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A.10 Example of prepositioning Grafcet steps

In this example, no initial step (=*=) is programmed, the chart is initialized on the rising
edge of input %I0.7 in preprocessing part of the program.
The example given in SectionB2.3-2 is repeated below.

Preprocessing %10.7 %S22 000 LDN  9%[0.7
In the preprocessing part 0l0.
of the program (area prior 4{/ ﬁ;? 001 S %S22
to the first Grafcet step), y 002 ST %MO
state 0 of input %I0.7 4< % 003 LDR  %I0.7
prompts a reset of the %10.7 %X1 004 S %X1
Grafcet chart (sets system —{p s% 005 S %S23
bit %S22 to 1) which %523
deactivates the active s
steps.
The rising edge of input
%10.7 pre-positions the
chart (activation of step X1
associated with resetting
system bit %S23 to 1).
[ 006 -*- 1
Seq_ug_ntial proqessing ‘%l %I0.3 5 007 LD %10.2
N_o initial step is declared; 4{ }_{ () 008 ANDN 9%l0.3
sihce step 1 has bee_n %l0.3  %l0.2 3 009 # 2
initialized by input 10.7 in 4{ ‘4{ ‘4@% 010 LD %10.3
preprocessing. =2 011 ANDN %I0.2
[ 0.4 1 012 # 3
#)— 013 -*- 2
= 014 LD %I10.4
%l 1 015 # 1
— [——#—{| | o016 - 3

017 LD %I10.5
018 # 1

Post-processing

(The Post-processing part %X1 %Q0.1 019 =*= EOST
of the program is the area ﬂ }—< % 020 LD oﬂ)Xl
following the =*= POST ins- %X2 9 Q0.2 8;; fg 0ﬁ)??l
truction). (
) — ()| | 023 sT %002
%X3 %Q0.3 024 LD %X3

% 025 OR( %M1
026 ANDN %0.2

027 AND  %I0.6

028 )

029 ST %Q0.3

%M1 %10.2 %10.6

H HH
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A.11 Actionsassociated with steps

The actions associated with steps can be programmed in two ways :

< By List sentences or ladder rungs associated with the step. In this case the List
sentence or ladder rung is not scanned unless the step is active.

* In the Post-processing module by using the step bit %Xi (see chapter B 2.3-2)
scanned on each cycle. Therefore, it is preferable for the actions to be pro-
grammed in the Post-processing module.

.3
%Q0.5 020 -»- 3
(s 021 LD 1
%M10 4 022 S %Q05
#)— 023 LD  %M10
o 024 # 4
05|l | oo o 1
R
- 027 R %Q0.5
028 oo
029 oo

The actions can be saved to logic conditions and are entered in the form of latched
instructions or coils (SET). Each SET instruction or coil must be resetto zeroby aRESET
coil.
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A.12 Index

A
Addition B 3/9
Address selector switch A 1/3, A1/12
Addressing
110 A 1/12
indexed B 3/4
Adjusting and debugging phase C 3/11
Advanced options C 13/5

Analog 1/0 A 1/24, A 1/25, B3/16, B 4/1
Analog input
Characteristics B 4/10
Connection A 3/16
Implementation B 4/7
Presentation A 1/24, A 1/25, B 4/1
Analog output A 1/26
Characteristics B 4/4, B 4/7
Connection A 3/16, A 3/17
Dimensions A2/1
Implementation B 4/12
AND (on word) B 3/11

AND, ANDN, ANDF, ANDR B 2/5
Animating a program
.app files (binary files)

C 2/7,C3/3,C 4/2, C 11/1, G Al22
Application files (.pl7)

archiving c1iin1
backup files for C 217
contents of C3/3
creating c7/1,C8/1
defined C2/7,C2/8
Application name (entry of) C5/3

Application protection C 12/3, C 13/2
Archiving applications c 111
Arithmetic operation B 3/9
ASCIl communications(see communication)
Assigning symbols to data variablesC 14/6
Assignment B 3/5

AUTOEXEC.BAT file C 2/3, G Al24
Auto Line Validate C 8/1, C8/2
B

BackupExtension= C 2/5
Backup files (.bak) C 217

C 8/2, C 14/1, C 14/3

Baud rate
extension port C 5/19
programming port F1/1
BCD conversion (instruction) B 3/13
Binary files (.app)
archiving c 111
definition of c2/7,C31
opening C 4/2
transferring G Al22
Bit register B 3/45
Bit strings B 3/3
forced C 14/2
list B 2/1
input A 1/13, G A/10
internal B 2/1
memory G A/11
output A 1/13, G A/11
system B 6/1, G A/12
word extract B 3/2
BLK, END_BLK, OUT_BLK B 2/12
Blocks, marking C 7/20, C 8/5
BTI B 3/13
C
Cables and accessories A 3/13, F 1/4
Cancel Configuration C5/3
CD
%C B 2/17
%SBR B 3/45
%SC B 3/47
Change PLC Version C 5/22
Changing a password G A/13
Clear force, clear all force C 14/7
Clear rung C 7/15
Clipboard C 7/20, C 8/5
COM (LED) A 1/20,D 1/1
COM port, PC C 2/1, G Al27
Combinational and sequential
(instructions) B 2/1
Comments
entering C7/12,C 8/2
finding strings C 7/21, C 8/6
"hidden" C 7/22
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in programs C 3/7

replacing C 7123
Communication (ASCII)
description B 3/30
wiring F1/1
Communication (inter-PLC)
configuration C 5/20
description A 1/13
use/program B 3/48
wiring A 3/14
Communication (UNI-TELWAY)
description B 3/39
requests F 1/11
wiring F1/1
Comparison (instruction) B 3/8
Compare blocks C7/9
Compatibility Preface
Compile (validation) C 10/1

CONFIG.SYS file
Configuration Editor

C 2/3, G AI26, G A/28
C3/8,C5/1,GAN

Configuration print settings C 15/3
Configuring PLC resources
from Configuration menu Cch5/1
from Configuration Editor C5/1
from Ladder Editor/Viewer C 5/2
from Symbol Editor C 5/2
Connect option C 13/2

Connections
analog inputs A 1/24, A 3/16, A 3/17
analog outputs A 3/18
110 A 3/1, A3/6, A3/13
1/0 extension A 3/14
PLC extension A 3/15
power supply A 3/4

ConnectingaPCtoaPLC C2/2,C4/2

Connecting an FTX 417/FTX 507/FT 2000
terminal to a PLC C2/2

Constants B 3/2, C5/5, G A/11
Convert (see also reversibility) B 3/13, C 3/7
Copy C 7/21, C 8/6
Counters C 5/5, G A/10
Creating new application files c4an
Creating symbols C 6/2

Cross refence C 16/1

Cross referencing an applicationC 16/1, C 16/3

Cu
%C B 2/17
%SBR B 3/45
%SC B 3/47
Cut C 7/20, C 8/5
Current value (BLK.V) B 2/11
D
D
%C B 2/16, G A/10
%MSG B 3/30, G A/11
%PLS B 3/18, G A/11
Data animation C 14/3
Data Editor C 3/8, C 14/3
Data Editor Tools menu options G A/8
Data files (.dat ) C 2/7, C 14/8, G A/23
Data pages C 14/3, G A/23
Date and time (current) C 13/4
Date and time of last stop B 5/4, C 13/5

Debugging and adjustment C 3/11, C 14/1

DEC B 3/9
Deleting symbols C 6/4
Description
PL7-07 features cin
TSX hardware A 1/4
Developing an application C 3/10
DEVICE= C 2/4, G Al24
Diagnostics G Al24
Dimensions, PLC A 2/2
Directories, PL7-07 C 2/3, C2/7
Display
Attributes C7/2,C8/2
Format C 8/2, C 14/5, C 14/6
Grafcet steps B 2/26
110 A 1/20
internal bits A 1/21
read-only PLC system info C 13/4
status A 1/20
Division B 3/9
DOS (MS-DOS) Cc2/1
Drum controllers B 2/22, C 5/7, G A/10
DUNTLW.EXE C 2/4, G Al24
DUNTLW.001 C 2/4, G Al24
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E

E %C

%MSG

%R
Edge (rising/falling)
Edit menu options
Editing data variables
Editing rungs
Editing symbols
EEPROM, PLC
Enable Input
END, ENDC, ENDCN
Entering a password
ERR
Errors (validation)
EXCH
Exchange words

Executing applications
Executing PL7-07 software

B 2/17, G A/10
B 3/31, G A/11
B 2/20, G A/11
B 2/2

G A9

C 14/4

C 7117

C 6/4

C4/2,C 1211
C 5/10

B 2/29

G A/13

A 1/20,D 1/1, D 1/2

C 92

B 3/30, B 3/44
B 3/38

C 13/3

C 2/10

Exporting files (see Importing/Exporting files)
Exporting source program to PL7 Micro C 17/1

Extended Ladder Palette ~ C 7/11, G A/4
Extension Port C 5/19
F
F %C B 2/17, G A/10
%DR B 2/23, G A/10
%FC B 3/21, G A/10
%R B 2/20, G A/11
Fast counter
configuration C 5/8
function A 4/4, B 3/21
variables G A/10
Faults D 1/1,D 1/5
FC B 3/21
FIFO B 2/21, C 5/6, G A/11
File management C 27
File types, PL7-07 C 2/4
Find
comments C 7/13
operands C 7/21, C 8/6
symbols C 6/3
text strings C 8/6
Forcing C 13/6, C 14/2, C 1417

Frequency meter
configuration
function

Function blocks
configuring

data variables of

display
programming

G

Glossary of terms

Grafcet
presentation
step tables

Grid, programming

H

Hexadecimal
HSC

I (%R)
Immediate value

Importing/Exporting files

ASCII program
symbol

%FC
%TM
%PLS
%PWM

INC

B 3/9

Indexed words

Indexing

Initial state

Initialization

Input bits

Input filters

Input words

Inputs
addressing
characteristics
special

C 5/10
A 4/5, B 3/24

Cc5/1
C 14/3
C5/1

B 2/11,B 2/12,C 7/6

Cc3/1

B 2/26, C 10/1, G A/10

C 10/2

C7/3,C7/4,C7/15

B 3/1
A 4/4,B 3/21

B 2/20, G A/11
B 3/1

C 2/7, G A/19
C 2/7, G A/19

B 3/20
B 2/13
B 3/19
B 3/17

B 3/4

B 3/4

C 3/8
A7/3,C13/4
G A/10

A 1/17, C 5/15
G A/10

A 1/13
A5/2
A 1/14
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Inputs (24 VDC) Ladder language B 1/4

characteristics A5/2 Ladder Viewer
connection A 3/6 using the crn
Inputs (115 VAC) Tools menu C 7/16, G Al6
characteristics A 5/2 Ladder/List equivalents G A1
connection A 3/8 Languages, PL7-07 support for C2/3
Insert Latch Input A 4/2, C 5/15
coil or jump/subroutine call c7/7 LD, LD(, LDN, LDF, LDR B 2/4
comparison block Cc7/9 LEDs A 1/20
contacts C7/6 LIFO/FIFO B 2/21, C 5/6, G A/11
down connector C 719 List Editor instruction bar G A6
graphic instruction C7/4,C7/12 List editor C3/7,C8/1
List C 7/16 List/Ladder equivalents G A/l
operand or symbol c7/11 Logic operation on words B 3/11
operate block C 7/10
rung C 7/16 M
ryng title, label, or comments C 7/13 Maintenance D 1/1
t|rper or counter block C7/8 Master option C12/3, C 13/6
Installing PL7-.07 software C 2/3 Max Frequency C 5/10
on 35 erve C 2/3 MCS, MCR
Instruct!on List language B 1/1 instructions B 2/32
Instruct!on memory usage G A/15 Memory Display Mode (MD) A 1/20
Instruct!on scan tlme. G A/15 Memory card C 42
Instructions (ladder, list) G A/l, G A9 application transfer G A22
Internal words B3/l data table transfer G A/23
VO (LED) . A 1/20,D 112 saving binary files c1lin
1/0 exte.nsmn' Memory
conflgurgtlon C 5/19 bits G A1l
connection A 3/15 PC C 3/10, C 1211
general A 1/13 PLC EEPROM
T8 B33 A7/4,C 412, C 12/1, C 13/6
J PLC RAM A 1/5, C 12/1, C 13/5
words G A/11
JMP, JMPC, JMPCN B 2/30 Menu charts C 3/5, C 3/6
Message (%MSG) G A/11
K Modbus F2/1
Keyboard, using the C3/4,C7/5 Monitor state C3/8, C13/1
Mounting A 2/2
L Mouse, using the C3/4,C7/5
MPS, MRD, MPP B 2/9
Label B2/30  mutiplication B 3/9
Ladder Editor C 317
using the C7/2,C7/3

Tools menu C 7/14, G A/3, G Al6
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N
Nano-PLC extensions

configuration C 5/19

description A 1/13

use/programming B 3/48
Negation B 2/7
NOP B 2/29
NOT (on word) B 3/11
Normal (scan) A 1/9, C 5/17
O
O (%R) B 2/20, G A/11
Object Browser C5/1,C6/4
Offline state C 3/9
Online state C 3/9
OPEN B 2/10, G A/4
Opening an existing application file C 4/1
Operands

finding C 7/23, C 8/6

inserting c7/11

replacing C 7/23,C 8/8
Operate blocks

inserting C 7/4,C7/10
Operating states, PL7-07

initial C 3/8

monitor C 3/9

offline C 3/9

online C 3/9
OR (on word) B 3/11
OR, ORN, ORF, ORR B 2/6
Output bits G A1l
Qutput words G A/12
Outputs

addressing A 1/13

characteristics A 5/3

special A 1/14
Outputs (relay)

characteristics A 5/4

connection A 3/8, A 3/10
Outputs (24 VDC, sink)

characteristics A 5/3

connection A 3/10, A 3/11

Outputs (24 VDC, source)
characteristics A 5/3

connection A 3/12, A 3/13
Overflow
index B 3/4
task A 1/9
P
Page margins C 15/3
Parentheses B 2/7
Password protection C 12/3, G A/13
Paste
program lines C 8/6
rungs C 7121
PATH= G A/25
PC card
(memory card, PCMCIA) C 2/4, C4/2
PCMCIA (see PC card)
Peer PLC
configuration C 5/19
description A 1/11
use/program B 3/48
Periodic (scan) A 1/8, C 5/17

.pl7 files (application files)
C2/7,C4/1, C 111
PL7-07 PC software

features cin

using mouse/keyboard C 3/4, C 7/5

variables G A/10, G A/12
PL7 Micro

exporting source files c171
PLC communications, configuring C 5/19
PLC diagnostics D11

PLC Operations C 13/3
PLC resources, configuring C 3/8,C5/1
PLC scan A 1/9
PLC status A 1/20,D 1/1
PLC status (Security) A 4/1, C 5/17
PLC system information C 13/5
PLC Version, Change C 5/20
PLS pulse generator C 5/13, G A/11
Post-processing (Grafcet) B 2/25
Potentiometers

description A 1/19

operation B 3/14
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Power return A7/l
Power supply (TSX 07) A 3/4,A5/1
Pre-processing (Grafcet) B 2/27
Preferences C7/2,C8/1
Preset Input C 5/9, C 5/12
Preset value (BLK.P) B 2/11
Printing
Configuration C 15/1
Cross References C 15/5
general C 1511
List/Ladder C 15/6
Symbols C 15/5
Program
create C7/1,C8/1
modify c7/1,C8/1
save Cc 11/1
Program animation C 14/1, C 14/3
Program jump B 2/30
Program size A 1/5

Programmable input filters A 1/16, C 5/15

Protected option C 12/3
Protected outputs A 1/18,B 7/4
Protected transistor output A 1/19, B 6/4

PWM pulse generator
A 4/8, B 3/17, C 5/14, G A/11

Q
Q (output)
%PLS B 3/18, G A/11
%TM B 2/13, G A/12
Quick keys C 3/4, G A/l
R
R (reset)
Boolean instruction B 2/2
%C B 2/17
%DR B 2/23
%MSG B 3/30
%R B 2/20
%SBR B 3/45
%SC B 3/47
READ (%FC.V) B 3/23, B 3/25
Read-only system information C 13/4
Read Retained Values C 14/8

Real time clock, setting the C 13/4
Reconfiguring memory managers G A/25
Reflex outputs A 4/3, B 3/22, C 5/10

Register (function blocks) B 2/20
Relay outputs

characteristics A 5/4

connection A3/7, A3/9
REM B 3/9
Removing a password G Al14
Replacing

comment strings C 7/23

operands C 7/23,C 8/8

text strings C 8/8
Requirements, system c2n
RET B 2/30
Retained values, in data page C 14/8
Reversibility B 7/6, C 3/7, C 10/2
ROL B 3/12
ROR B 3/12
RUN C 13/3
RUN (LED) A 1/20,D 1/1
RUN/STOP Input A 4/1, C 5/16
Rung header C 7/3,C7/13,C 7/18
Running PL7-07 software C 2/5
S
S (set)

Boolean instruction B 2/2

%C B 2/17

%FC B 3/20

%SBR B 3/45

%SC B 3/47
Scan mode C 5/17
Scan speed A 1/9
Scan time

description A 1/9, G A/15, G A/18
Scanning A 1/9
Schedule Block (RTC) B 5/1, C 5/18
Security features

changing levels G Al14

Operator level G A/13

Supervisor level G A/13
Security (PLC status) A 4/1, C5/17
Selecting

menu options C 3/4
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toolbar items C 3/4

using mouse/keyboard C 3/4, C 7/5
Sequential processing (Grafcet) B 2/27
Service conditions A 5/9
Set Time C 13/4
Shift (SHR, SHL, ROL, ROR) B 3/12
Shift bit register G A/13
SHL B 3/12
SHORT B 2/10, G A/4
Show Addresses C 7/17,C 8/4
Show All As Ladder C 7/19
Show Symbols C7/17,C 8/3
SHR B 3/12
Software variables, PL7-07 G A10, G A12
Software version can
Sorting symbols

by address C 6/3

by symbol C 6/3
Special contacts C7/4
Square wave generator (PLS) C 5/13
SQRT B 3/9
SRi B 2/30
ST, STN B 2/4

Starting/stopping the PLC

(see Stopping/starting the PLC)
Status bar C 3/1,C3/10,C 7/3
Step (Grafcet) B 2/26, C 9/2
Step counter B 3/46, G A/12
Stopping/starting the PLC

by RUN/STOP input A 4/1, C 5/16

priority of commands C 5/16
Subroutine B 2/31,C7/7
Subtraction B 3/9
Symbols files (.sym) G A/20
Symbol Editor C 3/8,C6/1, G A3
Symbols C 3/8,C6/1
System bits G A/12
System requirements c2/1

System wordsB 3/2, B 6/7, B 6/13, G A/12
T

TB (time base)
%PLS
%PWM

B 3/19, C 5/13
B 3/17, C 5/14

%TM B 2/13, C 5/4
Terminal port F1/1
Threshold Outputs A 4/3, B 3/21, C 5/10
Time-of-day clock

date-stamping, meas. of durationB 5/3

description B 5/4
schedule block B 5/1
setting date and time B 5/4, C 13/4
Timers B 2/13, C 5/4, G A/12
Titles, using with Print C 15/2
Toggle Animation C 14/1
Toggle Ladder/List C 7/19
Toggle Grid C 7/15
Transferring applications
general C4/2,C 12/1
EEPROM to PLC C 12/4
PC <=> FTX117 G A/22
PC to PLC C 12/2, C 13/2
PLC to EEPROM C 12/2
PLC to PC C 12/1, C 13/2
Transistor output A 1/13
characteristics A 5/3
connection A 3/10, A 3/13
Transition (Grafcet) B 2/26
Troubleshooting D 1/1, G Al24
TSX 07 wiring A3/l
TSX battery A 1/6
TSX AMN 400e analog modules A 1/25
characteristics A 5/5
connection A 3/17
principle B 4/2
Typographic conventions C 1/2
U
U (%DR) B 2/23
UNI-TELWAY communications C 2/5, F 1/1
Unresolved symbols C 6/4
Up counter C 5/9
Updating an existing
Cross Reference list C 16/3
Up/down counter
description A 4/6, B 3/22
configuration C 5/11
Using the PL7-07 editors
Configuration C 3/8, C5/1
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Data C 3/8, C 14/1

List/Ladder C3/7,C7/1,C7/8
Symbol C 3/8, C6/1
Using mouse or keyboard C3/4,C7/5
\%
Validate Configuration C 5/2
Validate Program
description C 1011
in Configuration Editor C 5/2
in Data Editor C 14/5
in Ladder Editor C7/14
in Ladder Viewer C 7/16
in List Editor C 8/3
in Symbol editor C 6/1
Validate Rung C7/14
Variables, PL7-07 G A/10, G A/12
Viewing validation errors C 10/2
W
Warnings (reversibility) C 10/2
Watchdog A 1/10
Windows C 1/1, G A/30
Word register B 2/20
Word table B 3/3
Words (definition, list) B 3/1
Write Data Value C 14/8
Write Retained Value C 14/8
X
XOR (on word) B 3/11
XOR, XORN, XORF, XORR B 2/6
#Di B 2/26, C 9/1
#i B 2/26, C 9/1
%Ci
B 2/17, C 5/5
%DRi B 2/23
%EXCH B 3/30, B 3/34
%FC B 3/21, G A/10
%IWxx G A/10
%Ix.y A 1/13, G A/10

%KWxx B 3/2, G A/11
%Li: B 2/30, C 9/1
%MSG B 3/30, G A/11
%MWxX B 3/1, G A/11
%MxxX B 2/1, G A/11
%PLS B 3/19, C 5/13, G A/11
%PWM B 3/17, C 5/14, G A/11
%QWXX B 3/49, G A/12
%Qx.y A 1/13, G A/11
%R B 2/20, G A/11
%S B 6/1, G A/12
%SBR B 3/45, G A/12
%SC B 3/47, G A/12
%SW B 6/7, G A/12
%TM B 2/13, C 5/4, G A/12
%X B 2/26, G A/10
1line C7/2,C7/18
3 lines (symbols AND addresses)
C7/2,C7/18
3 lines (symbols OR addresses)
C7/2,C7/18
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